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    Preface

    SmartCloud Control Desk is a comprehensive IT Asset and Service Management solution that helps reduce cost and minimize service disruptions. It does so through automated service request handling, efficient change management, and optimized asset lifecycle management across IT and enterprise domains.

    SmartCloud Control Desk helps to reduce total cost of ownership by using one unified solution to license, install, and manage multiple ITIL processes under one price point. It can also help reduce business risk by using advanced impact analysis and defining automated change procedures that ensure integrity of existing infrastructure while supporting business agility.

    SmartCloud Control Desk improves efficiency and quality of service by unifying asset, change, and problem management. It lowers cost and mitigates license compliance risk by performing end to end software asset management. 

    It also delivers an adaptive, role-based simplified UI that can be more intuitive for novice users, which reduces training costs, while allowing access from anywhere at anytime through mobile device support that includes BlackBerry, iOS, and Android. 

    In addition, SmartCloud Control Desk supports both a profit center business model for internal IT organizations, and an external Service Provider model. It allows organizations to manage customers and customer agreements and bills for managed assets, usage, and work activities while improving utilization rates and reducing unnecessary purchases by managing the IT asset lifecycle.

    You can deploy SmartCloud Control Desk in a variety of ways; traditional on-premise, SaaS, VM image. This approach can make it more affordable to meet your current business needs, and seamlessly move between delivery models while keeping the same functionality.

    This IBM® Redbooks® publication covers IBM SmartCloud® Control Desk product configuration, customization, and implementation best practices.
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Business context and solution overview

    This part presents a general business overview to provide context to organizations seeking advice on how to align IT with your organization. It also addresses important aspects that are required within each service management implementation when you consider a customer oriented approach.
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Business context

    This chapter provides a general business overview for organizations that are seeking advice on how to align IT within the organization.

    In a dynamic and globalized economy, where IT has its own agenda, interesting business and marketplace factors have emerged thanks to C-level studies, unraveling how both CIOs and CEOs are now targeting similar objectives.

    Never before have organizations found themselves in a more instrumented, integrated, and intelligent world as today, where challenges must have extraordinary solutions. 

    This chapter includes the following sections:

    •Business drivers for IT service management

    •Challenges: Aligning IT with the business

    •Conclusion

    1.1  Business drivers for IT service management

    Managing and working with IT is a complicated task for many organizations, especially managing complex and multivendor environments that include servers, software, telecommunications, and applications. Most organizations realize the value of IT within their business, and have basic management processes in place. They use best practices or other industry solutions and even provide mission critical applications, such as email and instant messaging.

    This is a common standard for companies around the world because technology supports line of business processes already, independently of the industry.

    For example, the energy and utility industry faces market forces that affect the business landscape around the world, requiring the transformation of business models as illustrated in Figure 1-1.

    [image: ]

    Figure 1-1   Global market forces induce a new approach in the energy utilities industry

    These forces can drive change across the value chain, a change takes place progressively over time and involves layers of instrumentation, integration, automation, and intelligence, as shown in Figure 1-2.
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    Figure 1-2   Change over time in progressive layers

    These layers can ultimately be a compelling reason for a shift in the business for the following reasons:

    •There are a growing number of participants in the energy value chain that the utility must take into account.

    •There are more applications and technologies to consider.

    •Analytics are being used everywhere, at all levels.

    •Progressive performance improvements can be realized by accessing data from other domains and third parties.

    Taking these concepts into consideration, you can propose a technology design, as shown in Figure 1-3.
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    Figure 1-3   Considerations for investments in grid operations for energy utility organizations

    Studying the energy and utilities industry identifies a factor that is substantially impacting how the business is managed and the transformation it has undergone in the past 10-20 years. Information Technology (IT) has dramatically changed the landscape for this and other industries. But the question remains, how does it drive, impact, and provide value in a measurable way to other industries.

    For the past 10 years, IBM engages C-level executives to analyze how they innovate through technology to succeed and respond to complexity in their organizations. 

    One of these studies, The 2012 IBM CEO Study1, interviewed 1,709 CEOs from 64 countries and 18 industries to understand how they manage and work with increasing interconnected and globalized marketplaces, societies, and governments. Over the years, technology has risen in the CEOs’ interest. For the fist time in the study’s history, technology is now considered the number one factor impacting organizations (Figure 1-4).
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    Figure 1-4   Technology is now the number one factor impacting organizations

    In the same study, CEOs identify how technology has created new industries and destroyed others. Businesses have started deploying sensors on previously unmonitored devices, such as water pumps and pressure gauges so that they are interconnected and instrumented, and to help control of their non-IT assets. Control over assets and components can provide value, reduce cost, and mitigate risk, as does being interconnected to core systems in the organization.

    Furthermore, the study also reveals the impact of human talent and innovation within the organization, as depicted in Figure 1-5. Technology is basically building the bridges and connecting people inside and outside the organization by altering the scope of control and overall organizational composition and structure. This applies especially to service providers and third-party vendors, who have an impact in the overall business as well.
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    Figure 1-5   Key sources of sustained economic value

    Some of the biggest challenges for organizations are the reduction of risk and cost, while increasing profits and earnings. The IT department is put under pressure to deliver IT services. If a business expands, demand for new employees increases proportionally. A logical reaction of an IT department is to incur more operational expenditure (OPEX) by hiring more personnel. The organization must realize that information is a mission critical element and key component in decision making, which relies heavily on IT systems. Even as a temporary measure, this cannot be a healthy practice within any organization.

    The second C-level study, The 2011 IBM CIO Study - The Essential CIO2, provides significant findings. It shows how CIOs keep up with the CEO’s top priorities. Maybe the most important parallel between the two studies is the identification of IT as a critical success factor, whether it is a public or private company.

    Taking the energy utilities industry again as an example, the study found that organizations in this market require better alignment in their initiatives by increasing efficiency, as shown in Figure 1-6.
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    Figure 1-6   Highlights about energy utility organizations

    Even though the findings illustrate potential behavior and decision making in the energy utility industry, these behavior patterns can be applied to other industry sectors.

    Consider the following goals when considering your organization’s challenges and meet their expectations:

    •Standardization and consolidation to address gaps and overlaps in IT.

    •Update and renewal of older systems, by planning ahead and controlling older system costs.

    •Tighten business and technology integration, by including internal customers in the planning processes.

    •Focus on the core, by evaluating the benefits of outsourcing and cloud computing.

    •Simplify, automate, and integrate.

    •Match human talent with business demands.

    IT faces more responsibilities. Besides managing and operating current information systems, IT staff are assigned to new project implementations, generating more overhead. The following tasks are faced by IT professionals on a day to day basis:

    •Reacting and solving incidents.

    •Performance management of IT services.

    •User satisfaction.

    •Release of new applications.

    •Capacity management of IT systems.

    •Change and configuration management of the complex and multi-vendor infrastructure.

    •Process automation.

    •Management of change within the IT infrastructure.

    With the pressure of service scope, and limitation of resources, IT must place special focus on user satisfaction, delivery of services, remote access interfaces, and general system administration. With these requirements, how can organizations stand up to the test?

    IT must identify key challenges to prioritize business execution and automation. This can be achieved by using knowledge, from both private and public organizations, to obtain the best possible outcome by aligning IT with the business.

    The Information Technology Infrastructure Library3 (ITIL) is a widely known, studied, and applied collection of best practices in the IT industry that aligns processes and commits to overall business goals. ITIL is not a mandate. It is a guideline towards the implementation of already tested initiatives that can save you time and money over an ad hoc model.

    ITIL is flexible. It is your organization’s culture, mission, vision, industry, regulations, laws, values, and experience that dictate the direction of the implementation. Some of the most important challenges that are faced by organizations are explained in 1.2, “Challenges: Aligning IT with the business” on page 11 to reduce rework and efforts to maximize overall value.

    1.2  Challenges: Aligning IT with the business

    Some organizations struggle to interlock IT and their business objectives. It is common to find customer and service provider (internal or external) initiatives that target cost reduction, process streamlining, and user satisfaction, even though these components are not related to IT.

    This is because of globalization dynamics, Internet and mobility, which require work and resources. Because IT consists of specialized knowledge about technology, subject matter experts in these areas tend to provide in-depth detail and precision, despite working with granular demands, and define clear technical requirements to deploy and configure the perfect system. However, perfection is the enemy of efficiency and effectiveness. This is especially true if the ultimate IT goal is to deliver and manage these offerings, which can lead to a dead end and make IT services unmanageable.

    Furthermore, you commonly hear about how the IT role is circled to minimize vulnerabilities and reduce related risks. This can be true, as many organizations lack understanding of how IT can automate processes within their business. These organizations often have the wrong impression that information technology reduces flexibility and adds business hurdles or obstacles when deploying them inside a server. The server is sometimes considered a black box to everybody outside IT. 

    This lack of understanding raises the bar for IT when facing the dilemma, between reducing risks for a “safer” organization, and expansion of more flexible, friendlier, and ubiquitous applications.

    The IBM approach is to provide organizations with solutions that can cope in a multi-vendor environment, while using good practices such as ITIL, and aligning IT with the business. To use this approach, you must identify key challenges that your organization might encounter. This ultimately enables you to set an accurate stage for any suite of IT solutions.

    IBM is heavily committed to the challenges that IT faces. As an IT company itself, IBM faces the same challenges of managing and using IT applications and services that provide the means for value generation, both for external and internal stakeholders.

    From this perspective, a challenge that must be addressed from the beginning is creating the service catalog.

    1.2.1  Recommendations for a service catalog

    Whenever a person goes into a restaurant, from a user perspective, there is always a general idea of what the selection scope is. In a chicken restaurant, for example, the user can select from dishes that include chicken as one of their components. This selection is expected from the user’s perspective because there is no other choice than to select an option from the menu.

    So how does this analogy reflect to information technology? Just like a restaurant, IT offers a menu, and it is called a service catalog.

    The service catalog is intended to provide the user with all the possible alternatives. From this point of view, a decision of picking meat in a chicken restaurant can translate into a similar scenario in an IT environment.

    The moment the user picks the dish from the menu, a whole set of processes are triggered in the restaurant. Some steps might include the kitchen, the bar, or even processes related to cooking and serving the dish. IT operates in a similar way.

    After the customer select the offering within the service catalog, other sub processes can be triggered to fulfill this request. These requests are generally fulfilled inside a black box from the user perspective. Because users do not see any value in the actions that are needed to fulfill a request, only a ticket number that represents their order is created for the users to keep track.

    Just like in modern restaurants, kitchens remain open, so everyone can see what the cooks are doing to fulfill a customers request. A similar thing applies to IT because IT operations must identify the steps to fulfill a user request in a transparent way within the IT support groups. Requests are generally tracked by associating all related activities that are needed to fulfill the request for the user.

    This service catalog example considers some important concepts while facing challenges. Just like a menu in a restaurant, menu items are prime offerings that are provided by the manager (IT). These are included as service offerings within the service catalog. It is the menu, or service catalog, that ultimately determines the type of chef, kitchen requirements, table cloths, and important investment decisions, such as restaurant location.

    When you create a service catalog, you have two different options: A request catalog and a more technical, or line of business oriented, catalog. Each has a different use and purpose. Based on previous engagements, a good recommendation is to analyze user behavior within the organization. Many users access standard services, like password reset, and generate requests for the IT department, which are usually well documented and addressed within the first level of support.

    A definition in the “request catalog” must express the full composition of sub processes that an organization needs to define to fulfill a user request. This definition helps to generate certainty within the organization, as all steps required to fulfill the requests are documented, or at least identified. An example of an offering within a service request catalog is shown in Example 1-1.

    Example 1-1   Password reset application
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    A password reset application contained within the following service catalog structure:

     

    Business Applications → Access Requests → Password Reset

     

    The details of the offering can include fields like service descirption, summary, cost and the application. 
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          Attention: The request catalog must include the user’s perspective. Failing to connect to the user can make the service catalog initiative fail.

        
      

    

    There is a second catalog that includes offerings that should not be available to everybody in the organization. This service catalog generally includes service offerings from specific lines of business, such as Human Resources, and Billing. These catalogs contain specific services that are focused on the particular needs of that line of business. Have these catalogs created by people who understand the business processes and the internal services they provide.

    Make the user’s interface in the service catalog intuitive, simple, and quick. If a user perceives a user-oriented approach with quick response from IT systems, that user will use it as the preferred method of contact.

    A self-service portal should provide quick reference for the user. By using graphics and good guidance in the interface, the users can then request services with ease. You can use multiple service catalogs in your organization.

     

    
      
        	
          Attention: A user who perceives slow response time from applications will probably stop using that method of contact.

        
      

    

    Include the IT delivery team in the design of a service catalog. Extra subtickets might be created to fulfill the tasks that are needed to complete a users’ request. The complete chain of subtickets should be completed in the allotted time as defined in the service level agreement (SLA) commitments.

    An SLA represents the organization’s expectation of ticket attention or resolution, no matter how many activities or tasks are required. When you define SLAs, you must obtain many details from the design and implementation teams that are working on the service catalog. Both processes have many dependencies.

     

    
      
        	
          Tip: Associating costs to offerings and displaying them in the service catalog applications is a good method to prevent users from casually requesting services that they do not have a business requirement for at the moment. This approach usually works even if users are not going to actually pay for the services.

        
      

    

    1.2.2  Service asset and configuration management using relationships and attributes

    On a day to day basis, tickets are created to request services. Almost all of them point to either an asset, or a configuration item (CI).

    In ITIL, these concepts are defined within the same section. However, they are seen as different components.

    Asset

    From an IT perspective, assets provide financial information for IT. An IT-asset is the financial representation of a server or application within the organization. Details of an IT-asset include asset owner, vendor, provider, authorized support, and warranty information. This record represents an investment of the organization, which must be tracked throughout its lifecycle. IT asset management is a discipline similar to regular enterprise asset management. However, it differs because it manages the assets from a technology perspective, considering caveats that are involved with maintenance, assignment, and usage.

    Generally speaking, the use of IT-assets within the organization applies to these items:

    •Notebooks, desktops, scanners, printers, and so on, targeted mainly for users.

    •Servers, switches, routers, and so on, targeted for general data center usage.

    IT asset management must track these components to manage associated warranties and surrounding services. For example, the inclusion of desktop provisioning within the service catalog is a good example of IT asset management as described in the following list. 

    Desktop provisioning typically includes the following steps:

    1.	A new employee requests a notebook from the service catalog.

    2.	After the request is submitted, it gets routed to the service line and fulfillment manager for approval.

    3.	After the request is approved, it is forwarded to the asset management process, where a new asset is assigned to the user.

    4.	After the asset is installed and deployed, the request is resolved.

    The assignment and management of IT assets is done through the request fulfillment process, which addresses the following tasks, which are usually performed by an on site representative:

    Install	Applications

    Move	Move desktop from one floor to the other

    Add	Desktop components, such a monitor or printer

    Change	Replace the user’s desktop

    A request fulfillment service, also referred to as IMAC, is generally requested within the service catalog.

    After the on site representative finishes delivery of a service, an IT asset management process is triggered to update the asset inventory and ownership.

    Software and applications are considered in the scope of an IT asset. A software catalog must include information about all the purchased software for adequate license management.

    Because both software and physical IT assets must be tracked, there are two different ways to manage these components.

    •Deployed assets or software

    Refers to the actual asset that is deployed, or “on the floor,” in the data center.

    •Authorized asset

    This is the asset controlled by a service management system. This is where all the actual operational activities, such as IMACs, are documented.

    The reconciliation between the assets can identify the status or maturity of IT assets because a reconciliation can compare the status of the asset (deployed) against the operational use (authorized). Based on these discrepancies, a report can be generated to determine unauthorized changes in a deployed asset without work orders or change tickets.

    There are many ways to manage deployed assets, either by data loading or by discovery.

     

    
      
        	
          Discovery advice: Include software libraries for software identification in a discovery tool. Because desktops and notebooks differ from regular servers, the correct discovery tools must be selected.

          Perform periodic software and hardware discoveries for deployed assets. Select a discovery tool that does not generate extra processor load in target systems. Generally, schedule your typical discovery to run late at night or early in the morning.

        
      

    

    Configuration item

    The use of configuration management within an organization can be considered one of the most important steps within ITIL.

    A configuration item (CI) is an element that must be tracked from an attribute, relationship, dependency, and scope perspective. These elements range from basic isolated to integrated and complex, and cover assets like applications, databases, web servers, and services.

    The definition and application of this process is vital because it can provide a common ground for most processes, and enable them to generate value for the organization. A CI can be described as the glue that fits all the pieces together.

    Some examples of CIs can be found in the following list:

    •Hardware

     –	Servers

     –	Routers

     –	Switches

    •Software

     –	Operating systems

     –	Applications

    •Services and processes

     –	Service level agreements

     –	Process documentation

     –	Policies

    As you can see, there is an overlap with IT assets. A server can be a CI and an asset. This can be confusing if the criteria and concepts are not clearly defined.

    To facilitate the management of these different views of IT resources, assets and CIs, and different levels of representation, discovered and authorized, IBM SmartCloud Control Desk provides reconciliation and synchronization features. For more information about IT resources representation in IBM SmartCloud Control Desk, see 4.1.1, “IT resources representation” on page 138.

    The CI server is used when that server requires the application of a firmware update. This process represents an operational task that is related to the service that CI enables.

    The asset server is used if that asset must be moved from one rack to the other.

     

    
      
        	
          Attention: You can include the related CIs in an asset movement because the physical movement of a server can affect applications and services.

        
      

    

    Just like IT assets, CIs also have an actual CI (the CI deployed within the data center) and the CI in the management system. These two can also be used to identify non-authorized changes within the infrastructure.

     

    
      
        	
          Better managing your CIs: Generally, use common data models because they are a proven source of reliable information for a CMDB.

          A discovery tool that can use a monitoring infrastructure can be a good alternative for CI discovery.

          An electronic discovery tool is the ideal way to discover and associate the CIs with their applications and services. This way, the CIs can be integrated into a system where incident, problem, and change management processes can use the information.

        
      

    

    1.2.3  Setting service level expectations

    The application of service level agreements within an organization must include important aspects, such as shifts, calendars, and general applications.

    It is common to find service level agreements that are based on user type (VIPs get a speedier time to respond), type of request (request, work order, incident), and event location. All of these topics must be addressed in terms of the applicability of SLAs within the business.

    The SLA considerations in Table 1-1 can provide some guidelines for your organization.

    Table 1-1   General considerations for SLA management

    
      
        	
          Application

        
        	
          Considerations

        
        	
          Recommendation

        
      

      
        	
          General ticketing (requests, incidents, problems, changes, work orders, releases)

        
        	
          •Measurable SLA times

          •Calendars and shifts

          •Holidays and non-labor days

          •Notifications

        
        	
          •Consider the usage of the SLA timer, and define policies and sub processes for its application.

          •Load as many calendars as the organization needs, and shifts that are covered by the resolver or owner groups.

          •Load calendars and non-labor days, as they are considered in the target SLA calculation.

          •Consider programming of escalations that depend on the priority of the ticket, and at adequate intervals. Too many notifications diminish the value of them.

        
      

      
        	
          Assets

        
        	
          Different assets might have different priorities.

        
        	
          Associate the assets if there is an organization initiative for their prioritization.

        
      

      
        	
          Configuration Items

        
        	
          Different CIs can have different impacts to the business.

        
        	
          Associate the CIs to the applicable SLAs to meet the organizations internal or external commitments.

        
      

      
        	
          Locations

        
        	
          Locations can have different importance due to their strategic objective in the organization.

        
        	
          Depending on the importance of locations, these can have higher or lower SLAs.

        
      

    

    After the service catalog is finalized and is ready to be published through the self-service portal, email, or phone, a support group must be ready to respond. This is the role of IT support.

    1.2.4  Request fulfillment

    In most organizations, IT support is made up of all the areas that provide resolutions towards the IT services provided. For example, a specific support group can be responsible to fulfill and track SLAs and manage user complaints.

    In an ITIL based model, define a single point of contact to increase user satisfaction and avoid the scenario that is shown in Example 1-2.

    Example 1-2   Multiple lines of support
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    Sandy: I have a problem with my user account.

    Robert: Call support they will help you.

    Sandy: Do you have the number?

    Robert: Ah... yes it is ether 623, 645 or 723. They are different though, I do not know who will be able to help you. Just call all three of them.

    Sandy: What a problem, I will see if someone around here can give me a hand.
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    Under this model, your organization should generally adopt what is most commonly called a single point of contact (SPOC). Also known as the service desk, this group of individuals concentrate their efforts into solving as many tickets as possible within their scope, whether they are simple application how to questions, or specific ERP user support. The service desk is intended to initially handle all requests, avoiding rework and other related expenses that can happen if you have multiple teams doing the same tasks.

    Depending on the organization, either a service desk, help desk, or call center can be implemented as detailed in Table 1-2.

    Table 1-2   Different types of first level support

    
      
        	
          Type

        
        	
          Features

        
      

      
        	
          Call Center

        
        	
          Basic call taking and routing of tickets to resolver groups.

        
      

      
        	
          Help Desk

        
        	
          Addresses basic technical issues, related to questions and solutions to users.

        
      

      
        	
          Service Desk

        
        	
          Provides a broader scope of actions that are based on the attention of support to services, such as ERP.

        
      

    

    Because the service desk is the single point of contact, a large number of issues are reported by the users, and created by the service desk.

    A good way to transmit the status of requests to users is by channeling this information through the self-service portal, or through simple notifications. Because a good percentage of incoming calls that are only follow-up calls, this can remove pressure from the service desk team if the user can clearly identify the ticket status, and the committed delivery date.

     

    
      
        	
          Do not overdo it: Notification strategy must be balanced. Sending notifications on every status change subtracts value from its real purpose. However, a reduced number of notifications can create overhead for service desk call takers, when users call again to request an update.

        
      

    

    After the ticket is resolved, a good way to measure user satisfaction is to send surveys occasionally. Users only respond in a positive way to surveys if they are short, straight to the point, and simple to use.

     

    
      
        	
          When to close: Remember to define ticket closure time frames. After a ticket is closed, it becomes a part of history records. In this status, tickets cannot be reopened. Only privileged users should have authority to edit closed tickets.

        
      

    

    After request fulfillment is in control of ongoing user requests, the overhead generated by user interactions can provide an additional opportunity for solutions and automations.

    1.2.5  Identification and resolution of incidents

    Incident management is one of the key challenges within an organization, and you need powerful capabilities to be successful.

    The more information you can about the gather about the unique nature of an incident at the beginning, the better. Incident management includes several interactions with several processes, including event management and change management.

    It is important to set adequate expectations within the organization during the incident management process. To create correct SLAs, you must consider factors like the ones described in 1.2.3, “Setting service level expectations” on page 17. This process is essential to enable the correct prioritization and assignment of resources to the incident.

    Some organizations are still struggling with incident diagnosis, confusing concepts like symptom, cause, and solution. 

    A good approach towards the correct diagnosis of an incident is shown in Example 1-3.

    Example 1-3   A visit to the doctor.
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    Axel: Good morning doctor. I am feeling very sick today.

    Dr. Bob: That is fine Axel. Please, tell me, where is it hurting?

    Axel: My stomach is hurting. After I had breakfast, I started feeling some aching. I think it was the oatmeal.

    Dr Bob: Thats fine, does it hurt here (stomach), here (kidneys) or here (liver) ?

    Axel: It is my stomach.

    Dr Bob: Ok, no problem. Did you have some milk with your oatmeal ?

    Axel: Yes, I did.

    Dr Bob: Do you happen to know if you are lactose intolerant?

    Axel: I don’t know.

    Dr. Bob: Ok, we will have some fast tests, but I think that’s pretty much it. Please, take these pills and you will be better.

    Axel: Thanks Doc.
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    Just like a doctor, the incident management team must identify the symptom, cause, and solution of an incident. If a user is experiencing disruption of a service, a similar approach can be taken to identify the symptom:

    1.	What is going wrong?

    2.	What is the cause (what is triggering the disruption)?

    3.	What is the solution (the steps to follow to restore normal operations)?

    Most often users are the first to identify a possible incident, due to their constant usage of IT services. In some cases, incidents are reported through automation.

    If the latter is the case, the event management system is key to obtaining information about a possible disruption of a service. For these scenarios, the event console can be used to create and dispatch the event, which should include troubleshooting information from the command center to avoid false positives.

    If an event is classified as an incident, it must be created and assigned to the correct owner group.

    After the incident is created, include prioritization, classification, and ownership to trigger the correct process. In the specific case of an automatically created incident, information about the configuration of the IT infrastructure is important, which helps assign priority and ownership of the incident.

    Because the incident is usually uncertain at first, have the owners of the affected CIs take initial ownership of the incident. Then create more tickets to underlying support teams to reduce time that is wasted when you reassign the ticket to other support groups.

    If the CMDB is used from the beginning of an incident, the support group can concentrate on the diagnosis. If it is not an expected behavior, create an incident by taking information from the CMDB and inherit impact, ownership, and extra relationship information to provide as many details as possible to the owner group responsible for the resolution.

     

    
      
        	
          Using the CMDB: The CMDB also provides information from extra support groups that must be engaged in the occurrence of an incident. 

        
      

    

     

    
      
        	
          Incident or not: Not all critical events actually represent an incident. Remember that, for example, change windows require the suspension of services and applications to commit the changes. In this case, the critical event is not an incident, but rather a planned outage.

        
      

    

    If an incident stays open, and a workaround must be applied to reestablish service, but the root cause for the incident has not been found, open a problem ticket.

    1.2.6  Rising to problem management

    The organization must be able to extract as much information as possible from a problem ticket (either proactive or reactive) to reduce the number of problems. The correct identification of problems, and their recurring appearances, can dramatically reduce overall downtime. Results can be seen in the long run. As level 3 and level 2 support groups involve themselves in known error and root cause documentation, the process enables the first level of support to increase their scope and resolution percentage.

    Make known errors available through the ticketing system to consolidate information in a single system, and provide this information to the whole organization.

    Remember that a problem cannot always be solved. Sometimes the overall solution of a problem is too expensive to implement. Document these problems as a known error, and publish them through the service portal.

    When a problem can be solved, and a viable solution is found, implement the solution by using the change management process.

    Document information about failure details for metric purposes, such as failure classes and codes.

    When an incident interlocks with problem management, both processes address the same issue, but their paths differ from the beginning. The objective of incident management is to reduce downtime, whereas problem management is focused on finding the root cause of the incident.

    These two processes ideally have different groups assigned, each one with a different set of skills. Generally, incident management teams look for instant solutions in reaction to an incident to re-establish service as quickly as possible, as seen in Example 1-4.

    Example 1-4   An incident management support group working for a solution
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    Dan: The application server xyz-1 is down.

    Alfredo: Engage the backup application server xyz-b1.

    Dan: Shouldn’t we try to find out what happend to that server first?

    Alfredo: We do not have much time left. We have a pretty agressive up time for that service.

    Dan: OK, no problem. I will route all server connections to the xyz-b1 server. Once I am done, I will resolve the incident. Please let Niraj know that a problem ticket will be assigned to him to investigate what went wrong.
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    However, problem management support groups try to address the issue that caused the service outage, as described in Example 1-5.

    Example 1-5   A problem management support group working to find the root cause
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    Niraj: Dan I need a copy of the application server and all of it’s components, so that I can replicate the error found on the incident this morning.

    Dan: No problem, I will send you a backup of the application server. That will contain everything you need to replicate the error.

    Niraj: Thank you. I will document the problem ticket and once I find the solution I will create a change record if it can be implemented.
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    These are examples of how incident and problem management differ from one another. But what happens if the root cause is found and is viable for implementation? How can organizations handle changes with minimal impact and increase the success rate for the organization?

    1.2.7  Handling change management: Identifying impact and increasing availability

    Change management is another important process within ITIL. It updates the IT infrastructure by altering the relationships, dependencies, and attributes of configuration items. This is why it requires a slightly different approach.

    Change management can be seen as an umbrella for the incident, problem, and change processes, as depicted in Figure 1-7.
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    Figure 1-7   Increasing change effectiveness to increase availability

    The success of change management within the organization can either reduce or increase the overall quality of the following processes:

    •Incident management

    Reduces the number of outages through good planning and execution of changes.

    •Problem management

    Reduces the number of unidentified incident causes by using good change management implementation. Sometimes a simple parameter change in a system property file can affect a service. It is not until someone identifies that the parameter has changed, that the real cause can be identified.

    •Configuration

    Correctly updating the relationships, dependencies, and attributes of CIs (a correct understanding of services) can help change management achieve correct change assessment, incident prioritization, and ownership.

    Based on the previous engagements the change management process is one of the most detailed and process oriented defined in ITIL. Because change management processes can update every CI, it must be robust to enable correct organizational planning.

    For example, obtain a change impact analysis for the CIs if possible. This can reduce the number of human errors due to incorrect impact association to a change. The CI’s impact can also relate to other processes, such as incident management.

    By balancing CI relationships, you can calculate impact based on CI depth levels. Based on your organization’s needs, you can opt to select a deeper or a shallower level. Usually, the highest CI impact within a relationship or dependency can determine the impact of the change, and therefore increase the overall risk of the change itself.

     

    
      
        	
          Change targets: A change normally targets a CI (service, application, infrastructure) or an asset.

        
      

    

    After change targets are loaded, create an impact assessment to identify the real business impact and risk of the change. A good practice is to conduct change management planning meetings, where stakeholders understand the reason for the change and their implications within the organization.

    Furthermore, adequate planning for the change, by using project management tools, is useful when you are coordinating the required activities for a change between impacted business divisions or groups.

    From the definition of the activities and their dependencies, a good estimate for the whole change window can be calculated. Consider extra concepts like change windows and blackout periods when you schedule the change.

    Consider pre-assigned change windows for critical CIs in your organization, especially for those that run core business applications such as ERPs, billing, and sales systems.

    Just like defining a change window, define a blackout period when those CIs are not eligible for change scheduling. This is a good practice within IT organizations. Blackout periods can be associated with specific CIs, and can be made available to all the stakeholders so that you can align expectations for change applicability for CIs.

    If an organization must determine the override of a change window or blackout period, obtain extra approvals. This helps with the overall success of the change and continuity of the business.

     

    
      
        	
          Do not rely on individuals: A good change management policy includes the association of change approver groups instead of individuals. This is a good way to provide flexibility to the process, especially when individuals are out on vacation or are unavailable to process a critical path workflow through the application.

        
      

    

    When the change and all the related activities are complete, conduct a post implementation review (PIR) to determine the success of the change. There are different approaches to this step within the change management discipline, and more details can be found within ITIL.

    PIRs should be conducted by a group of people who had no involvement in the change process, so that they can objectively determine the success or failure of the change.

    1.2.8  General guidelines for a support organization

    The support organization is made up of several groups, internal and external.

    A typical support organization might include these groups:

    •Level 1: Command center, service desk, or help desk

    Monitors events within the infrastructure and generally tracks all data center activity and runs scheduled jobs. After the level 1 group identifies an affected service, they can create an incident within their monitoring console. They are also in charge of dispatching tickets to other support teams, such as level 2 or level 3 support.

    •Level 2: Support groups

    Usually manage a part of the systems that are needed to provide services to the organization. They usually apply changes to the infrastructure and solve incidents.

    •Level 3: Support groups

    Usually expert support groups that have extensive knowledge in specific technical applications. Vendors can be included in this support level as part of warranties or support from software or hardware vendors.

    Depending on the type of the overall organization structure, there are some important decisions that you must make to deploy the best form of support into your organization. If the organization is looking to consolidate IT operations of different departments, an internal service provider model might the best option. If the organization is looking to provide IT services to other organizations, and act as a service provider, an external service provider model must be defined.

    An example of an IT support team, working to provide services within the IT organization, is depicted in Figure 1-8.
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    Figure 1-8   An example of an integrated IT support organization

    1.2.9  Extra challenges that you might face

    In 2011, IBM published a thought leader white paper called Gaining efficiency and business value through better management of your IT infrastructure4. It describes some of the challenges that organizations face to provide effective service delivery while saving costs.

    The white paper explains some of the challenges that must be identified to provide a good and better management of the IT infrastructure.

    1.2.10  Service Provider Edition

    Many internal IT organizations operate as a profit center and charge, through internal chargebacks, for the services they provide. Managed Service Providers provide IT Services to external customers and bill for these services. The Service Provider Edition supports these business models. 

    Asset information can be associated with customers, and customer agreements define the entitlements for customers, and the negotiated pricing rules. Customer billing for the assets managed or for asset usage, and fixed fees, can be billed automatically on a recurring schedule according to the terms of the customer agreements. Customers can also be billed for individual work activities, and for services and assets that are provided through the Service Catalog. 

    1.2.11  The unique IBM value proposition

    After challenges are clearly identified and addressed, the organization’s strategy and IT operations have a strong alignment. An important decision must be made to cover the IT needs as identified in this chapter.

    The unique IBM value proposition is based on best practices, where IBM is a contributor itself, backed by over 100 years of innovation around the world.

    IBM has applied technology and innovation through almost all industries, providing organizations with flexible and integrated solutions to help them reach their business goals.

    In addition, you can use the best practices approach of ITIL to achieve the results you are striving for, while keeping your organization’s business goals in sight.

    Just like the studies mentioned, IBM has a commitment to overall business improvement used through IT, while providing business solutions that fit your organization.

    In a world that consists of demanding, interconnected, integrated, and intelligent technology components, applications, and services, IBM provides a set of solutions that use cloud technology to increase its value to the organization.

    By using visibility, control, and automation, IBM provides a set of solutions that are lead by one of the most complete and integrated solutions in the market: IBM SmartCloud Control Desk.

    1.3  Conclusion

    Every organization that strives for business success must be able to face their IT challenges on a day to day basis. These challenges can be considered opportunities to streamline IT and improve the overall alignment between IT goals and expectations. But IT management today no longer operates in a glass house.

    Organizations around the world have identified the need to align IT operations with their business goals to succeed in the marketplace. IT must be used every inch of the way to help your organization become more efficient and effective in reaching those business goals.

    Chapter 2, “Solution overview and deployment strategy” on page 31 outlines important features and solutions that are needed to be successful with an IT service management implementation.

    

    1 The 2012 IBM CEO Study, Leading Through Connections can be found at http://www.ibm.com/services/us/en/c-suite/ceostudy2012

    2 The 2011 IBM CIO Study - The Essential CIO http://www.ibm.com/services/c-suite/cio/study.html

    3 For more information about the ITIL, see http://www.itil-officialsite.com/

    4 “Gaining efficiency and business value through better management of your IT infrastructure, Eight challenges to overcome for effective service delivery and cost savings”, http://www.ibm.com/common/ssi/cgi-bin/ssialias?infotype=SA&subtype=WH&htmlfid=SSW03005USEN
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Solution overview and deployment strategy

    This chapter addresses important aspects of a service management implementation are addressed. 

    Almost every organization today defines a set of business objectives for their IT operations to hold management and their departments accountable for investments. These investments can help an organization to visualize, control, and automate their current processes and increase its overall efficiency.

    This chapter introduces the following concepts to help you understand how IBM SmartCloud Control Desk can support IT operations deliver on these promises:

    •Meeting customer needs

    •Solution components

    •Deployment models

    •Deployment strategies

    •Deployment planning

    2.1  Meeting customer needs

    As shown in Figure 2-1, organizations today have a strong need to work in an interconnected, instrumented, and intelligent environment.
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    Figure 2-1   Investing to optimize dynamic business infrastructures to sustain delivery of business value

    IT landscapes today are increasingly complex, virtualized, distributed, and diverse. Cloud computing improves responsiveness and changes the economics of IT. 

    At the same time, the envelope of IT is stretching far beyond the data center, networks, and workstations to new classes of assets with embedded IT capabilities.

    IBM SmartCloud Control Desk provides organizations with the ability to maintain configuration integrity in response to planned changes and unplanned incidents and problems. These issues can be dealt with when they occur across this complex IT landscape to ensure continuity of service, speed of response, and efficiency in management.

    IBM SmartCloud Control Desk delivers an advanced architecture that uses key Internet concepts, standards, and technologies, including Java Platform, Enterprise Edition and service-oriented architecture (SOA). The web-based interface can be configured to map to your organization’s processes, data models, user and corporate user interfaces, and portal standards.

    IBM SmartCloud Control Desk can help your organization accomplish the following goals:

    •Bridge department silos

    Save time and process costs of applying simultaneous updates to related assets and configuration items.

    •Manage intelligent business assets

    Deliver repeatable business outcomes by managing both traditional applications and the intelligent IT enabled assets that support them.

    •Achieve more with less

     –	Empower users to solve their problems and help them access the services that they need.

     –	Enable IT to reduce downtime and mean time to repair, all with a reduced number of employees.

    •Improve quality of service in a dynamic infrastructure environment.

    2.1.1  Cloud or no cloud

    IBM SmartCloud Control Desk combines the capabilities of existing offerings (such as the Tivoli Change and Configuration Management Database, Tivoli Service Request Manager, and Tivoli Asset Management for IT) into a single unified cloud solution. If you are not running a cloud environment today, you are still able to access all the latest service management capabilities that can address your service management problems.

    In addition, the traditional non-cloud customer can feel comfortable and ready for transition when a cloud model becomes the organization’s mandate for the future.

    2.1.2  The benefits of IBM SmartCloud Control Desk

    Changing products is always a question of when the benefits surpass the planning, training, and purchase costs of selecting new software. Upgrading within the same product family also provides cost advantages. 

    If you are already using any of the previous Tivoli solutions, you can see the following benefits by shifting to IBM SmartCloud Control Desk: 

    •User interface improvements that include navigation panels

    •Single solution installation process

    •Single maintenance stream

    •New functionality that addresses a number of key challenges

    •Improved asset and CI integration, which enables you to load the CMDB with asset information

    Based on this solution consolidation, IBM SmartCloud Control Desk can provide an integrated approach towards an effective service management-oriented organization. This end-to-end model is depicted in Figure 2-2.
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    Figure 2-2   IBM SmartCloud Control Desk solution overview

    Business requirements seek smarter solutions, resulting in initiatives to manage assets and change. The following issues are aspects of the changing landscape:

    •Fading boundaries across business and IT assets

    Physical and infrastructure assets are increasingly embedded with software and therefore resemble assets in a traditional IT environment.

    •Velocity of changes impact business agility

    Manual processes cannot keep up with faster rates of change driven by cloud and virtualized environments. This is further impacted by planning and scheduling of work across IT and operations of lines of business.

    •Many organizations are not IT-savvy

    Increasing population of non-technical users request access to business services.

    To manage the changing landscape, new tools, ways of thinking, and dynamic business response are required. Taking the time to review your technology strengths is critical and helps define budget and planning decisions.

    Because IBM SmartCloud Control Desk is a unified solution, moving or upgrading to this version provides the following advantages:

    •Enhanced usability in user interfaces helps increase productivity with new left navigation, simplified interfaces for key applications, asynchronous validation, an all-new calendar, updated rich text editing, type ahead, and tightened consistency. Extra features include mobile devices.

    •Unified product benefits help to reduce restrictions that prevent users from working as needed across functional areas. All users can have access to all product functions that they require.

    •Using the Service Provider Edition, a single instance can be used to manage the assets of internal or external customers. Access rules can be defined to limit certain users to access one customer, or a group of customers, while providing a global, enterprise view to other users. The Service Provider Edition manages customers and customer agreements, which ensure that customers receive only the services to which they are entitled, and that customers are properly billed for the services that they receive. The same asset information used for configuration management is used for financial management of the assets, ensuring the correct billing and chargeback of the managed assets. This can eliminate the need to maintain, update, and reconcile separate asset databases.

    •A single install and maintenance stream reduces installation and maintenance time.

    •Latest platform updates in the Tivoli's process automation engine v7.5 deliver benefits in user interface, migration manager, import and export, scripting, help performance, and more.

    2.2  Solution components

    IBM SmartCloud Control Desk is an integrated IT Service Management solution. As a solution it approaches the business as an end-to-end entity, which helps align IT with business objectives. The following sections identify key elements within the design of IBM SmartCloud Control Desk to maximize functionality in your organization:

    •Main features and enhancements

    •Common services

    •IT asset management

    •IT change, configuration, and release management

    •IT service request, incident, and problem management

    2.2.1  Main features and enhancements

    By having a comprehensive service management approach, which is built on top of a common platform and delivered as a single suite, you can create a solid end-to-end solution. 

    This solution focuses on users, seeing the issue as a whole and not as separated silos, as shown in Figure 2-3.
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    Figure 2-3   An integrated solution based on certified ITIL processes

    IBM SmartCloud Control Desk enables your organization to handle enterprise management tasks from one service desk by managing requests from anywhere in the organization. By using the same service desk, you can minimize the number of tools that your staff uses, promote consistent execution of processes, and correctly prioritize the issues that have the greatest impact on the business.

    Few vendors bring together the capabilities to manage a large set of physical and digital aspects of business services. Today’s solutions focus on either the IT portion of the service or the line of business assets. Currently, most organizations have separate tools and processes in place, meaning that coordination between IT and line of business can be difficult.

    For example, when a service outage is reported on an IT-enabled asset, are the service desk users coming from the IT organization or the facilities team? If an asset must be taken offline for maintenance, is IT notified to reroute workflow? With Maximo Asset Management, IBM SmartCloud Control Desk can deliver a complete service and asset management solution that spans through IT, cloud, improved physical infrastructure, and traditional enterprise assets on a single platform.

    To provide all of these services, IBM SmartCloud Control Desk is built from a cross platform perspective that provides the framework for all these solutions to work in an integrated and instrumented fashion. Tivoli's process automation engine delivers this framework and enables all of the solutions to coexist and use each other, providing more value for the organization.

    2.2.2  Common services

    IBM SmartCloud Control Desk is based on a common platform, known as Tivoli's process automation engine. This platform provides the necessary tools, elements, and components to host all the applications that are contained within the solution.

    Capabilities of the Tivoli Process Automation Engine

    Table 2-1 shows the common platform capabilities.

    Table 2-1   Common platform capabilities

    
      
        	
          Feature

        
        	
          Benefits

        
      

      
        	
          Common user interface

        
        	
          Efficient process sharing due to common user interface.

        
      

      
        	
          Runbook automation

        
        	
          Helps automate and improve resolution of incidents through an integrated runbook capability that spans all functional areas, with the power and flexibility to make changes throughout the process.

        
      

      
        	
          Custom workflow

        
        	
          Easy to use Workflow Builder that includes Application Designer, Database Configuration, Escalations, Notifications, and Email Listener.

        
      

      
        	
          Common, versatile reporting engine

        
        	
          Report tooling includes ready to use reports, key performance indicators, and ad hoc query functions with upgrades on Query Based Report (QBR).

        
      

      
        	
          Integration framework

        
        	
          Seamless integration of ITIL-based frameworks, including support for web services, JMS, HTTP(S), database files (XML or flat), LDAP, launch-in-context, event NS batch/bulk processing, email, and workflow connectivity.

        
      

      
        	
          Global deployment support

        
        	
          Support for multiple languages.

        
      

      
        	
          Service provider support

        
        	
          Multi-customer enablement or service provider support allows management of multiple customers in a single instance deployment.

           

          A customer agreement defines entitlements for each customer. It also defines pricing rules for managing assets, usage of assets, for work performed in the repair or configuration of the assets, and for the fulfillment of Service Catalog offerings.

           

          Customer billing manages the billing or chargeback of recurring charges, or charges related to activities.

        
      

    

    Tivoli's process automation engine has a new user interface. Understanding its features is important to understanding its usefulness. Some of the features of the user interface are described in Table 2-2.

    Table 2-2   User interface enhancements

    
      
        	
          Feature

        
        	
          Description

        
      

      
        	
          Navigation and functionality

        
        	
          Intuitive interface, introducing left navigation controls in key applications, prioritized by user role and major use cases.

        
      

      
        	
          Ease of use and intuitive interface

        
        	
          Easier and more intuitive forms in the areas os service request, incident, and change. This is achieved through process flow improvement, and by removing fields.

        
      

      
        	
          Client-side validation

        
        	
          Faster validations that increase overall interface performance.

        
      

      
        	
          Reporting enhancements

        
        	
          Export of reports can now be done in the list view.

        
      

      
        	
          Asynchronous validation

        
        	
          Useful for multi-site customers.

        
      

    

    Mobile support: Key features

    More than ever, business is going mobile. If mobile has not been included or considered by a vendor solution, it is not a solution. The following list includes some of IBM SmartCloud Control Desk mobile activities that are supported for BlackBerry, iOS, and Android:

    •User creates or views service requests

    •Service request assignment to owner

    •Service request approval

    •Analysis and creation of incidents

    Runbook automation capabilities

    Businesses run day and night, and automated processes help support continuous business activity. IBM SmartCloud Control Desk supports the automation of the following operational processes:

    •Workflow designer and job plans

    •Workflow engine

    •Actions and scripts

    •Start centers

    •Inbox and work queue

    •Escalations

    •Notifications

    •Communication templates

    •Configuration Management Database (CMDB)

    Within the operational process of workflow design and job plans, IBM SmartCloud Control Desk has made more improvements. The following list notes those additional improvements for automation support for workflow designer:

    •Freshened look and feel and improved usability

    •Customized icons for actions (invisible on original canvas)

    •Improved scalability for large, complex workflows

    •Maximizes the built-in capabilities of iLog

    Furthermore, within the operational process of actions and scripts, IBM SmartCloud Control Desk includes a new script engine, with the following capabilities:

    •Full use of scripting API, part of JDK 6 (JSR)

    •Ships with Rhino and Jython, and allows other JSR223 compliant engines to be plugged in

    •Scripts can run against any object within various contexts

    Migration Manager

    The Migration Manager is an application included in IBM SmartCloud Control Desk that allows the migration of configuration data from one environment to another. With this application, manual migrations steps can be reduced, improving migration integrity. Main features (such as a detailed interface and the fast building and deployment of packages) address this specific function. For more information, see Migration Use Cases with the Migration Manager, SG24-7906-01.

    2.2.3  IT asset management

    In the dynamic and changing world of today, effective asset management can make a significant difference from a financial standpoint (for IT and non-IT organizations).

    A good starting point to harvest the real value of asset management is the identification of software licensing, and the reduction of the amount software bought by different departments within the same organization.

    By centralizing and consolidating information within a single point of management, and by updating license usage and purchasing, a cut in associated costs is possible.

    By using these capabilities, you can also reduce time, effort, and risk that are associated with compliance audits.

    IBM SmartCloud Control Desk provides an end-to-end process to address efficient asset management. The main capabilities are given in Table 2-3.

    Table 2-3   IBM SmartCloud Control Desk features and benefits

    
      
        	
          Feature

        
        	
          Benefit

        
      

      
        	
          Up to date, proactively managed authorized repository of assets

        
        	
          Gain deep visibility across the organization into assets owned, where they are located, maintenance details, and corporate compliance. Track and control all hardware assets. Manage a complete view of software entitlements across the organization.

           

          Provides a unified source for billing and chargebacks for the use of the assets.

        
      

      
        	
          Accurate inventory of deployed software

        
        	
          Automate license tracking to meet compliance requirements. 

        
      

      
        	
          Asset reports

        
        	
          Reduce unnecessary acquisition costs by identifying inactive assets or by redeploying underused assets. Use contract and entitlement information to improve negotiation points with vendors. Reduce costs that are related to over-licensing.

        
      

    

    Understanding IT asset management is critical to business decisions, negotiations with vendors, and technology strategy. An overview about the capabilities of IT asset management is shown in Figure 2-4.
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    Figure 2-4   IT asset management capabilities

    The following list includes some extra IT asset management features: 

    •License application

     –	Create and manage entitled licenses.

     –	Manage how licenses are internally allocated.

     –	Generate purchase requests and purchase orders.

    •Software Catalog application

     –	Integrates with the Software Knowledge Base Toolkit or can be populated by discovery.

     –	Provides a distinct list of software products.

     –	Provides the ability to create items that are used in procurement applications.

     –	Provides the ability to set aliases on products, including those discovered by Tivoli or third-party tools.

    •Deployed Software applications

     –	Lists all software instances that have been discovered.

     –	Provides details of individually installed software instances.

    •Self-Service application

     –	Provides users with a view of all assets that are assigned to them and their designated role. Allows them to validate information and initiate an effort to address any discrepancies.

    •Extra features:

     –	Added license to existing procurement cycle.

     –	Enhanced technology refresh and end-of-life function.

     –	Promotion of deployed assets to authorized assets (with default values).

     –	Software contract enhancements.

     –	Discovered and authorized support for virtual machines.

     –	Reconciliation usability enhancements.

     –	New and updated integration adapters.

     –	New license management reports.

    Asset lifecycle management

    Regarding IT asset management lifecycle, IBM SmartCloud Control Desk can provide and satisfy the following business elements:

    •Business need

     –	Improve visibility and control of all IT assets through their lifecycle.

     –	Obtain accurate asset data to enable appropriate and timely action across the business.

    •Business drivers

     –	Streamline purchasing and contract management.

     –	Improve planning capability.

     –	Improve asset usage by extending life.

     –	Improve employee/customer service.

     –	Optimize energy efficiency of assets.

    •Business value delivered

    Based on business drivers and needs, you can identify value in these goals:

     –	Reduce IT asset cost through visibility and control.

     –	Increase time to value with IT asset management best practices.

     –	Maximize lifetime productive value of assets.

     –	Improve efficiency through roles that drive UI and workflow.

     –	Better IT service that meets increasing business demand.

     

    
      
        	
          Key questions: Do you know what assets you own? Where are they located? Who owns them? Are they well kept and maintained? Do you have a procurement in place to keep them up to date?

        
      

    

    Audit readiness

    How prepared is your organization to face a software or general asset audit? IBM SmartCloud Control Desk can help you address the following challenges within the process:

    •Business need

     –	Be prepared for a 24x7 software audit

     –	Understand licenses and their relationship to contracts

     –	Accurate information about software inventory and usage in both distributed and mainframe environments

    •Business drivers

     –	Reduce business risk due to vendor-specific software audits

     –	Support requirements of internal audits

     –	One solution for all vendors, contract, and license types

     –	Centralized management of all contracts, licenses, and inventory for all vendors

    •Business value delivered

     –	Helps avoid license compliance penalties

     –	Reduces costs to conduct internal or external vendor audits

     

    
      
        	
          Key questions: What is your organization entitled to? What is deployed in your environment? Are you under purchased?

        
      

    

     

    
      
        	
          Key Product Solutions: The deployment of Tivoli Asset Discovery can electronically identify server software and hardware. This means that data center software and hardware can be discovered by using this add on component. However, for user computing assets, such as desktops and notebooks, the implementation of Tivoli Endpoint Manager for inventory can correctly discover hardware and software within your organization. They are both different in scope, and each have a different approach.

        
      

    

    An example of how audit readiness can work in your organization is shown in Figure 2-5.
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    Figure 2-5   An example of an audit process flow in IBM SmartCloud Control Desk

    Software asset management

    A correct software management approach can potentially reduce cost from licenses. By identifying which software you have deployed, how many people are actually using it, and how many licenses you have available, you can have a more controlled and consistent environment. You are also more prepared for an audit.

     

    
      
        	
          Tip: A controlled and identified software environment includes information about hardware and software. This process and information is valuable in correctly preparing for future application deployments, such as ERPs and CRMs.

        
      

    

    IBM SmartCloud Control Desk organizes and gathers critical software and hardware information, which makes asset management simpler. Having this information at the ready can help you address the following business challenges:

    •Business need

     –	Correctly understand purchased software contracts, agreements, and license entitlements.

     –	Deployed software inventory, software usage and associated hardware environment.

    •Business drivers

     –	Identification and reduction of no and low use software.

     –	Strong Sarbanes-Oxley section 404 approach.

     –	Strong vendor contract negotiation leverage.

     –	Use new technologies without increasing business expense or risk. Enable multi-core processor-based licensing, virtual machines, and cloud licensing models in your organization.

    •Business value delivered

     –	Reduce software budget.

     –	Mitigate audit risk.

     

    
      
        	
          Key questions: Are you using the software deployed? Are your contract and purchasing agreements efficient? When do your leases, warranties, and support agreements expire?

        
      

    

    An example of how IBM SmartCloud Control Desk provides a software acquisition cycle is shown in Figure 2-6.
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    Figure 2-6   IT asset management using IBM SmartCloud Control Desk 

     

    
      
        	
          Benefits: When the service desk has access to asset details, including contract and procurement information, the request fulfillment process becomes more efficient. The process is streamlined, incident and problem management processes expedited, and service levels and customer satisfaction is improved. 

          Service desk data can also provide information to asset management about frequency of issues within IT assets, potentially increasing efficiency and cost effectiveness.

        
      

    

    Extra solution functions have been included in IBM SmartCloud Control Desk:

    •Software license manager:

     –	Quickly create new licenses by selecting from a list of common predefined license templates.

     –	Quickly associate products to licenses. Available products are filtered based on selected attributes.

     –	View open PO/PRs based on selected license.

     –	View deployed software that is covered under license.

     –	Select and allocate capacity to multiple people.

     –	Add software consumption data from sources other than discovery tools for use in comparing licenses.

     –	License reservation for allocation based on the linkage between license and work order.

     –	Change asset status from a work order.

     –	SWBToolkit can now be downloaded from IBM to publish software catalog content.

    IT financial management

    IBM SmartCloud Control Desk, can provide insight into the organization’s financial status. Information such as total cost of ownership, IT costs, and service profitability can be calculated by using IBM SmartCloud Control Desk. Having this information can help you manage the following financial business challenges:

    •Business need

     –	Optimize the lifetime value of mission critical assets.

     –	Reduce total cost of ownership of IT assets.

     –	Understand IT costs to determine line of business product and service profitability.

    •Business drivers

     –	Optimize the lifetime value of mission critical assets.

     –	Financial management approval of shared technology investments (such as virtualization).

     –	Chargeback for business services delivered (such as cloud computing).

     –	Reduce costs through use of energy efficient assets.

    •Business value delivered

     –	Align IT spending with business objectives.

     –	Increase return on assets.

     –	Lower infrastructure costs.

     

    
      
        	
          Key questions: What are your asset costs? What is the total cost of ownership (TCO)? How much do your contracts cost? Can you allocate costs fairly and effectively?

        
      

    

    IT asset management architecture

    IBM SmartCloud Control Desk, provides a solution for organizations to reconcile their deployed assets and their authorized assets within a service management solution, as seen in Figure 2-7.
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    Figure 2-7   IT asset management in IBM SmartCloud Control Desk, including the reconciliation of assets

    2.2.4  IT change, configuration, and release management

    IBM SmartCloud Control Desk includes features to help your organization implement change management and in adding value with a Configuration Management Database (CMDB).These aspects provide valuable information for other processes, such as incident or problem and request fulfillment, as described in Figure 2-8.
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    Figure 2-8   Using CMDB’s power in IBM SmartCloud Control Desktop

    When using IBM SmartCloud Control Desktop for change management you are taking a close look at change configuration and release. This close look can identify the following types of business-related issues to change management:

    •Business need

     –	Reduce the overall impact of changes to the infrastructure by maximizing workflow.

     –	Ensure integrity of existing infrastructure during release of new hardware and software.

     –	Identifying relationships and attributes between services, applications, and infrastructure.

    •Business drivers

     –	Accurate determination of change risks and their relationships to the IT environment.

     –	Change scheduling, including windows, and blackout periods.

     –	Reduce number of incidents due to changes.

    •Business value delivered

     –	Business-oriented change management process.

     –	Integrated CMDB, including impacts to the business.

     –	Reduce time to update or deploy new software and hardware.

     

    
      
        	
          Tip: Have you identified the applications and service dependencies in your environment? Do you understand the implications of hardware outages to the overall service and application availability? Do you have a configuration item (CI) impact approach for your changes?

        
      

    

    IBM SmartCloud Control Desk can help you manage and update your overall IT infrastructure to drive change, configuration, and release management. Having processes integrated, and using discovery solutions like Tivoli Application Dependency Discovery Manager, IBM SmartCloud Control Desk can help you identify infrastructure, applications, and services, and how they are related to one another.

    This can be useful for environments where there is no precise idea on how services are configured between them. Having a discovery solution like Tivoli Application Dependency Discovery Manager fully uses electronic discovery. This reduces the labor expense and increases the precision and efficiency of the discovery of CIs deployed in your IT environment.

    It is common for organizations to realize they do not have the updated versions of the application topologies or know the overall impact to the business. IBM SmartCloud Control Desk helps your organization to identify and load all this information to provide a CMDB. A CMDB provides a single source of information and consistency for other processes such as incident or problem and request fulfillment.

    Some of the main capabilities of IBM SmartCloud Control Desk are described in the following sections.

    Change scheduling

    Change scheduling is an important concept within your IT service management deployment. Change windows dictate when the target CI is subject to regular change maintenance windows, according to business rules and policies. This means that IT and the business side are synchronized regarding core and non-core IT elements that must be serviced without impacting services that are provided to the organization’s users. Whether it is a bank, a hospital, or a school, today’s IT systems are part of key organization areas that provide service and require the highest availability possible. IT systems represent customer facing entities for external and internal users.

    The following list notes some concepts to consider when you implement change and release management and configuration:

    •Change windows

    The predefined time frame in which a determined CI (whether it is a service, application, or infrastructure component) can be serviced according to business needs. In this particular case, a difference must be made between production and quality and development environments to define these change windows. For example, if a change to an application requires a service outage to permanently resolve the issue, more approvals can be managed within IBM SmartCloud Control Desk. This helps to ensure awareness and to comply with audit procedures defined in your organization.

    •Blackout Periods

    These are periods in which the CI is marked untouchable. The CI must work according to stakeholder demands during these periods. For example, an ERP system has a predefined blackout period from the first until the 25th of each month. It cannot be serviced unless approved by high-level management. This period ensures the integrity of the core services that are part of the CIs. When blackout periods extend over long periods of time, change requests tend to become more elaborate. The next window of opportunity for change might not be for the next 3-4 weeks.

    •Change scheduling

    Include and consult with people who are managing the systems before any change. This discussion ensures appropriate commitment to the change. When a high risk change is programmed, hold meetings to effectively identify the necessary tasks. These meetings usually involve specific people with the necessary skills. If the change is not scheduled with the originally dedicated resources, the change might not have the success rate specified in the planning phase. To keep continuity, IBM SmartCloud Control Desk provides a detailed project management-oriented view. This view allows changes to be scheduled, taking into consideration blackout periods, change windows, people skills, and availability.

    CI baselines

    A CI baseline is an important concept for managing change to the IT infrastructure. A CI baseline provides information that is needed to make a calculated decision for a CI. The baseline shows the current approved configuration. 

    With this concept in place, you have an outline of the configurations you have in terms of attributes. If you perform a change that requires a target CI that is not aligned with the CI baseline, an unauthorized change is performed to that CI. This unauthorized change can potentially identify the level of maturity of the change management process, breeches of security, or unforeseen gaps. In any case, it is an informative tool for those managing IT systems. 

    Sometimes people do not have a clear idea of what an unauthorized change represents to the configuration of services. Even a change in a parameter can result in unexpected behavior in your infrastructure.

    CI auditing

    It is important to identify unauthorized changes before they cause problems. This can be a root cause for incidents that are created in the infrastructure. It is common to identify changes that disrupt services because an unauthorized change has been implemented in the IT environment.

    The CI auditing feature provides a method to ensure accurate authorized CIs. This allows business processes to run successfully and efficiently. A preferred practice is to immediately remediate an audit variance by updating with an actual authorized value. 

    One method to reduce outages is by browsing approved changes, attribute history, and audit results for a CI. Browse these elements to see whether there is any relation between the targets in the change and the CIs identified as inconsistent.

    An example of an audit inconsistence is shown in Figure 2-9.
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    Figure 2-9   Addressing integrity issues within a CMDB in IBM SmartCloud Control Desk

    Business impact analysis

    Inherited impacts are used in IBM SmartCloud Control Desk. They come from trends of how long CIs have taken in the past, and help determine a basis for business impact analysis. The inherited impact, which is associated to the CI, is key to setting the expectation within the change ticket as to what the risk of the change is going to be. A correct assignment of impact to CIs helps to calculate ticket priorities.

    Sometimes, a CI can have its impact changed because of other business reasons. If a trend can be identified within the CIs history, take it into account when you calculate the overall business impact. 

    IBM SmartCloud Control Desk provides this function, and the association between the CI and its impact, as a ready to use function, as seen in Figure 2-10.
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    Figure 2-10   Business impact analysis functions in IBM SmartCloud Control Desk

    Automated process workflows

    The change management process must preserve the integrity of the infrastructure. This is important to provide a consistent IT environment across the system. IBM SmartCloud Control Desk provides ready to use process workflows designs based on best practices to fast track the implementation of change management in your organization.

     

    
      
        	
          Attention: A strong change management process includes several control points. These control points are necessary to maintain the overall integrity in your IT environment. Remember that IT changes update relationships and attributes to your CIs, which can potentially hurt your organization if a change policy is not sufficient.

        
      

    

    Figure 2-11 illustrates a scenario within the change management process workflow as a predefined feature in IBM SmartCloud Control Desk.
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    Figure 2-11   An example of the ready to use workflows in IBM SmartCloud Control Desk

    Release management

    Release management is the ability to plan and oversee the successful roll-out of new, changed, and associated hardware. It includes documentation and training. IBM SmartCloud Control Desk includes role-based start centers, workflows, scheduling, and analytics for this process, as shown in Figure 2-12.
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    Figure 2-12   Proposed Release Management Process outline

    Definitive Media Library

    The ability to identify approved deployed software within the organization can help reduce support costs by allowing only approved software images to be deployed. One of the IBM SmartCloud Control Desk enhancements for change, release, and configuration management includes the Definitive Media Library. With a data repository such as the Definitive Media Library, IT can quickly identify and base work outcomes on the versions of software that are authorized by the organization.

    Application level import and export

    Customers can import and export data from any Tivoli's process automation engine based application. Functions are available that support bulk importing records, exporting a result set of records, making quick changes (within Microsoft Excel, XML, and so on), and then reimporting them into Tivoli's process automation engine.

    Unified asset, change, and configuration management

    Unified asset, change, and configuration management enables automated updates of related assets and CI data. This helps to keep asset information accurate while driving down cost of ownership. One of the ways that asset information is supported is called linkage of assets. An illustration of the linkage can be seen in Figure 2-13.
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    Figure 2-13   Unified asset, change, and configuration management

    2.2.5  IT service request, incident, and problem management

    Because the main goal of IT operations is to respond to user requests and to minimize outages, IBM SmartCloud Control Desk includes some important features and enhancements:

    •Prioritized Incidents: Make critical services available first by prioritizing incidents based on business service impact.

    •Built in searchable solutions knowledge base: Shorten time to resolved incidents through access to solutions for specific service requests.

    •Embedded remote diagnostics capability: Enable service desk agents to remotely take over workstations for problem resolution.

    •Ticket templates: Saves labor and reduces errors by pre-populating work order fields with service request information.

    •Auto pre-population and classification of tickets: Save time by pre-populating tickets through integration with compute telephony software, such as from Genesys or Cisco.

    •Chat capability: Enable service desk agents to communicate through multi-vendor alternatives for efficient and quicker request fulfillment.

    •Email listener: Efficiently process inbound emails into service requests.

    •Third-party tool integration: Provides capability to synchronize tickets through bidirectional integration with other ticket products.

    •Mobile support: Service requests can be created, viewed, and approved from mobile devices.

    CMDB and service operations convergence

    IBM SmartCloud Control Desk maximizes use of the CMDB, and obtains information from CIs and their relationships. The CMDB can populate the impact of a ticket, which affects prioritization of that ticket and aligns it to the expectations of the business.

     

    
      
        	
          Tip: Other fields such as owner, service group, or service, can be populated by the CI. This reduces the time that an operator takes to correctly assign a ticket to the corresponding owner group.

        
      

    

    By analyzing the relationships within the CI, the service desk or command center can quickly identify to which service that CI belongs. This can be used to trigger a predefined action plan that is based on the service, application, or infrastructure.

    The incident application provides a link to the CI application, enabling a single source of information across the whole organization. Also shown in Figure 2-13 on page 58 is the ability to maximize information from IT assets. This can be useful when you assign IMACs (installation, movement, additions, and changes) to IT assets. If the organization includes several sites, this single source becomes even more valuable.

     

    
      
        	
          Tip: Asset information can also be used to determine location. The location to direct the work order or request for change to is the location of the asset and the location of the affected user.

        
      

    

    User portal: Self service center

    An intuitive self service portal is key to any successful service management implementation. User self service and user customization are valuable options for an organization willing to deploy a self service culture. The following options are often available in a self service center:

    •My news: Quickly identify business announcements.

    •My requests: Identify the ticket status of your requests.

    •My assets: View and make new requests on your assets.

    Besides information that belongs to the user, the self service center application includes a view for the service catalog. This view can provide users with a more intuitive and friendly approach towards the access and ordering of services in the catalogs defined in your organization.

    The user can also report an issue or access knowledge base solutions. The frequent requests pod contains the request options that are predefined to all users and the ones that have been frequently ordered by the user.

    This application can actually be the front end for all of your regular users. Its versatility and ease of use makes requesting services easier for users. If they find that this application is easier and faster than writing an email or calling the help desk, your chances of having a successful self service culture increase.

    Most organizations strongly push for these kinds of services because they demand less workforce to deliver the same service. Call desk and onsite representative resource are limited. These resources can only handle a certain number of requests or incidents at a time. With a self service approach, your organization can self fulfill requests and resolve incidents without having to log them in the system.

     

    
      
        	
          Tip: You can configure the default application that the user will see based on the security groups that are defined for that user.

        
      

    

    Extra design features add value to the user interface. The following list notes some of those available features:

    •No need to write presentation XML by hand.

    •You can edit custom dialogs in Application Designer.

    •No need to modify library.xml for offering dialogs.

    •Offerings can store data in a MBO1 (instead of specification attributes).

    •Use of full power of MBOs for offerings, including conditional UIs.

    •Support for Cart Templates.

    An example on how the service fulfillment process uses the service catalog can be found in Figure 2-14.
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    Figure 2-14   Service catalog request fulfillment overview

    All these features can help your organization drive extra value. Some of the benefits from IBM SmartCloud Control Desk’s service catalog are noted in the following list:

    •Publish a searchable list of available services

     –	Improve service levels and employee productivity by providing a list of services available to them.

     –	Help shorten time to find services by allowing a search of catalog for available services.

    •Associate cost information to services

     –	Allows users of services to understand the cost and manage consumption of services.

    •Service entitlement

     –	Service catalog entries can be provided based on group or business unit.

    •Service definition templates

     –	Lower cost and time required for catalog development by using templates that are available for common service items.

    •Job plan templates

     –	Lowers costs by improving reuse of information every time you create a work order for similar work.

    •IT service management

     –	Typical examples: Request a cell phone or notebook, deploy a server in a data center, provision a notebook with a specific software application, request a toner for a printer

    •Cloud

     –	Typical examples: Provision a new service on the cloud, request more capacity for a new application

    •IBM Smarter Planet® solutions

     –	Typical examples: Move an office, request new employee badge with building security rights

    Runbook Workflow Library and automation action library

    Using the Runbook Workflow Library can enable the addition of functional steps within the attention of a ticket, such as an incident. To help convey a clear application of this concept, the following scenario applies Runbook Workflow Library to every day operations. Mary gets an incident assigned to her. After she takes ownership of the ticket, she determines that this is a common error that is coming from a server. Her initial procedure tells her to run a couple of commands to isolate some issues in the server. She must ping the server, collect process information from the system, and collect some logs from within the system. After she gathers that information, she passes the information to a second level of support.

    As this scenario shows, automation of otherwise manual steps can improve the overall response time of IT support. This reduces response time and mean time to repair. By having information at the correct time, decisions can be made immediately with reliable information. This process increases the success of changes and the resolution of incidents by level 1 or level 2.

    How this new feature is implemented within IBM SmartCloud Control Desk Workflow is shown in Figure 2-15.
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    Figure 2-15   Applying Runbook Workflow library to automate manual tasks

    Support tables in an offering

    A table attribute can now be associated to the offering, which provides more flexibility to the user experience. This can reduce the number of open text elements that are loaded in the offering. 

     

    
      
        	
          Tip: Guide the user through the request process. A user form that contains too many fields can create a negative effect on the user. By using limited alternatives within each field in the service offering, the user is guided through the request, which helps ensure data integrity. Additionally, an open box that allows the user to type in any further request is important. If a form must be attached for the user to fill and return, include this form within the service offering.

        
      

    

    Support for work order and change creation directly from the service catalog

    IBM SmartCloud Control Desk now provides the chance to create and associate a work order and a change directly from the service catalog. This can be useful for organizations that have a set of requests of change that are pre-approved. Those pre-approved requests can be configured for automatic execution. This framework to automate requests and work orders further aligns IT with business needs. Automating workflows reduces manual work and response time.

    Reusing the service catalog for non-IT services

    IBM SmartCloud Control Desk can also provide a platform for other non-IT catalogs. This function can also be used by lines of business to reduce their manual work and increase automation.

    2.3  Deployment models

    IBM SmartCloud Control Desk provides flexibility regarding implementation approaches. These approaches are independent and end to end solutions for your organization’s business needs.

    Take the time to consider more than one approach when you are planning for your IBM SmartCloud Control Desk implementation. Look at the situation from several angles, which might cause issues that might not have been noticed to emerge.

    Perform an assessment to determine which approach is appropriate for you. Consider which kind of scope your IBM SmartCloud Control Desk will have, and what your goals for the future are.

    2.3.1  Editions

    IBM SmartCloud Control Desk is available in the following editions:

    •Entry

    •Advanced

    •Service Provider

    For information that is not covered in this section, go to the IBM information center at the following website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/overview/c_editions.html

    Entry

    An organization that typically focuses their first level of support on resolving generic issues and forwarding out of scope tickets to other support groups might fit the Entry Edition.

    In this approach, the second-level team focuses more on the relations between CIs and assets. Usually the generic issues have few attributes that fit into small procedural documents.

    In this case, the number of IT services that are delivered within the organization are small in number or specific. Often approvals are done through email because of the limited size of the organization.

    The need for a service catalog is not a high priority. This means that the implementation of service level agreements is usually left behind or defined as simple as possible. Demand for IT support (requests, changes, incidents, problems) is handled on a first come, first serve basis or by using a simple priority determination.

    Because the IT services provided are limited, the solutions management process is contained within the knowledge of the people who manage the IT systems. The requirements to run the business do not require many detailed or specific procedures in place.

    The Entry Edition is also an appropriate approach in these scenarios:

    •A unit or specific department within your organization has streamlined processes with basic best practices and little detail is required.

    •An immediate need for a streamlined service desk with basic request fulfillment, incident, problem, and change management. 

    •An entry level organization that needs a short-term solution because it has just started to use best practices and has little knowledge of how and when it will mature.

    •A need to deploy basic asset information with streamlined processes.

    •A need for a basic call center, help desk, or a call center that redirects to other support groups.

    The IBM SmartCloud Control Desk Entry Edition, provides the following processes that are ready to be implemented within your organization:

    •Self-service center

    •Service request and incident management

    •Problem management

    •Knowledge management

    •Remote control (limited licenses)

    •Change management

    •Support for mobile usage

    Advanced

    If your organization has a strong need to deploy more processes, the Advanced Edition might be the better option. It provides some extra processes that include a service catalog, service level management, a traditional change management process, and asset and configuration management.

    Processes such as event management, business dashboards, CI discoveries, asset discoveries, endpoint inventory, and license management can be included in the Advanced Edition. Their inclusion in this approach is managed with the help of other IBM branded solutions or other vendors. 

    In this type of approach, the organization needs a strong commitment towards an overall implementation. This implementation identifies starting points and areas of improvement to define a business process that can work along ITIL best practices. In the end, this business process must be adopted by the users and the lines of business.

    This model also assumes that there is no need to distribute internal costs. It also assumes that the organization itself does not need to provide services (either internally or externally) to any other organizations or sub organizations.

    IBM SmartCloud Control Desk provides a solution to fit these needs. The Advanced Edition includes the following disciplines and applications:

    •Service level management

    •Service catalog management

    •Self service center

    •Service request and incident management

    •Problem management

    •Knowledge management

    •Remote control (limited licenses)

    •Change management

    •Release management

    •Configuration management

    •Asset lifecycle management

    •Procurement management

    •Contract management

    •Software license management

    •Support for mobile usage

    Service Provider

    If you want the capabilities of the Advanced Edition, if you feel there is a missing component regarding multi-customer environments, the Service Provider Edition is the approach for you.

    There are basically two approaches as a service provider:

    •Internal Service Provider

    An Internal Service Provider is defined as one that delivers services to either internal departments or to other organizations that belong to the same corporation. This approach uses charge back and service accounting for internal customers, but no actual revenue is generated.

    •External Service Provider

    An External Service Provider is defined as an organization that wants to provide services to third-party customers. This approach is typically used in a revenue generating model, and uses charge back for both internal and external customers.

    IBM SmartCloud Control Desk provides a flexible solution for each of these specific cases, and contains all of the functions included in the Advanced Edition. Table 2-4 has details about these solutions.

    Table 2-4   Details about internal and external versions of IBM SmartCloud Control Desk

    
      
        	
          Discipline

        
        	
          Internal service provider add-on

        
        	
          External service provider add-on

        
      

      
        	
          Charge back and service accounting for internal customers

        
        	
          Yes

        
        	
          Yes

        
      

      
        	
          Charge back and service accounting for external customers

        
        	
          No

        
        	
          Yes

        
      

    

    Extra Service Provider Edition features include management of change, requests, incidents, problems, configurations, and assets for multiple customers. You can also manage service desks, catalogs, and run audits in a multi-customer environment. Data is strictly segmented by the customer, ensuring that only authorized customers and internal users can view information about each customer. Using the multiple-customer capabilities that are provided within IBM SmartCloud Control Desk allows the following capabilities:

    •Create and manage customer records, specifying billing addresses, contacts, and other pertinent information.

    •Associate one or more authorized configuration items (CIs) with each customer.

    •Authorize people within customer organizations to view the product GUI and track the progress of the agreed upon work.

    •Set up an internal customer access list, specifying users within your organization who can view particular customer records.

    •Set up customer agreements. Each agreement defines the services that can be delivered, and the pricing of the services. The agreement specifies the pricing rules for activities that are performed under the agreement.

    •Set up billing schedules for the automated recurring billing of managed assets, asset usage, and fixed fees.

    •Create, manage, and apply response plans that ensure predictable and repeatable responses to similar work requests.

    •After a request is fulfilled, route it through one or more defined approvals before final billing.

    2.3.2  Deployment options

    To meet the needs of a wide community of customers, IBM SmartCloud Control Desk can be deployed in several ways. The deployment options are as an enterprise solution, as a virtual machine (VM) image, or through the web-based cloud infrastructure administered by IBM. 

    All three deployment options provide integrated management of traditional IT, virtual, and cloud environments. When you install as an enterprise solution, you can install any product edition. 

    The Entry and Service Provider Editions are not available in the IBM hosted deployment option. When you purchase the SmartCloud Control Desk VM image, you are also entitled to install the product as an enterprise solution. For example, you can deploy a VM image for your development or test environment and perform a traditional installation for your production environment. 

    The quick installation VM image contains the Entry Edition. After you deploy the VM image, you can run the installer to upgrade to the edition that you have purchased (SmartCloud Control Desk or IBM SmartCloud Control Desk - Service Provider Edition).

     

    
      
        	
          Tip: When you deploy the VM image, look closely at the host files for the database engine and the server itself. Errors might come up if the host files are not correctly configured. Some typical errors show as Error 500, meaning that an error related to the database has been encountered. Check your IBM WebSphere® Application Server SystemOut file, which is found in <WebSphereHome>/logs/MXServer/SystemOut.log, to verify the exact error in your system.

        
      

    

    2.4  Deployment strategies

    After you select the distribution of IBM SmartCloud Control Desk suitable for you and your deployment option, you are ready to design the infrastructure that is going to host it.

    2.4.1  Initial assessments

    No matter what edition you are deploying, or option, this initial step is crucial to correctly identify the kind of infrastructure you are going to require.

    After you identify the processes that you are going to implement, determine a sizing factor to determine the hardware capacities you are going to require to deploy the solution.

    An element that can be used with precision to calculate hardware requirements is the number of concurrent users that are going to be logged in the system at a particular time.

    Because user load is typically based on specific time frames during the day, it has an effect on the general sizing as well.

    Another aspect to consider when calculating the number of concurrent users is seasonal dates. If you have special dates where the number of users spikes, consider deploying extra temporary resources for those days to cope with the demand.

    The total number of employees in your company who have access to IBM SmartCloud Control Desk is also another factor to include when you are sizing the infrastructure. Considering a percentage of the total number of employees to be logged in at any particular moment can give you further insight to complete your sizing.

    Finally, consider the number of processes that take place in the background, such as escalations and cron tasks. Consider whether there are going to be extra integrations that might require background resources to work as expected.

    After you determine the total number of concurrent users, consider communication factors. Talking to your networking team is helpful to correctly identify which kind of bandwidth you are going to require. Specially, be sure to identify if there are multiple ways of access to the application, such as mobile, internet, and regular LAN.

    With these factors or concepts, you can now address sizing requirements, and correctly identify which platform suits you the most. 

    More considerations for the overall planning of your IBM SmartCloud Control Desk planning can be found at the IBM developerWorks® website:

    http://www.ibm.com/developerworks/wikis/display/tivoli/SmartCloud+Control+Desk+-+Overview+and+Planning

    Remember the overall tuning of the whole system. The whole system includes networking, servers, applications, databases, integrations, and so on. Tuning can affect how IBM SmartCloud Control Desk performs in your organization.

    Because IBM SmartCloud Control Desk is based on several dependencies, it is important to have personnel who support these instances. Train these personnel as much as possible in the operating systems, web servers, application servers, databases, and so on.

     

    
      
        	
          Tip: Business growth is an important element to consider when you are planning for deployment. Consider scalability factors when you select your infrastructure.

        
      

    

    2.4.2  System architecture

    The following architecture applies to most IBM SmartCloud Control Desk deployments. See Best Practices for System Performance 7.5 for more details: 

    https://www.ibm.com/developerworks/mydeveloperworks/groups/service/html/communityview?communityUuid=a9ba1efe-b731-4317-9724-a181d6155e3a#fullpageWidgetId=W5f281fe58c09_49c7_9fa4_e094f86b7e98&file=c51d5f5b-dea3-4043-a81f-d5213fc10063

     

    
      
        	
          Tip: Generally, have development and quality assurance environments separate from your production environment. Test solutions, configurations, and overall performance in a quality instance. The instance needs to be as similar as possible to your production environment if business circumstances allow you to do so.

        
      

    

    Depending on your business needs, there are two deployment options available:

    •Basic: This type of deployment refers to a single instance of IBM SmartCloud Control Desk within a single application server, having only the database engine in a separate environment. 

    •Advanced system configuration: This method of deployment allows IBM SmartCloud Control Desk to have horizontal and vertical clustering, which provides an effective method of managing user and cron task load. With this option, you can provide a cluster service within your organization.

    2.4.3  Determining suitable system hardware and software 

    Along with your business scope, concurrent number of users, and overall business usage of IBM SmartCloud Control Desk, note these considerations when you implement your environment:

    •Application performance

    •Port availability

    •Hardware topology

    •Browser

    •File systems

    •Middleware installation

    In an integrated environment where many IT components work in a collaborative manner, it is important to identify these concepts from the beginning. Doing so increases your success rate when you are deploying IBM SmartCloud Control Desk. These concepts are covered in more detail in the following section.

    For more information about the latest updates on system requirements for IBM SmartCloud Control Desk, see System Requirements for SmartCloud Control Desk version 7.5 at IBM developerWorks:

    https://www.ibm.com/developerworks/wikis/display/tivoli/SmartCloud+Control+Desk+-+Version+7.5+System+Requirements

    Application performance

    The number of concurrent users has a strong effect on the amount of resources necessary to provide the service. For optimal performance, follow these guidelines:

    •Plan one Java virtual machine (JVM) for every processor that is configured in your system. This JVM must also contain 3 GB of RAM.

    •With this JVM setup, you can manage approximately 50 concurrent users in your system. Configure as many JVMs as you need based on the number of concurrent users that was calculated in 2.4.1, “Initial assessments” on page 69.

     

    
      
        	
          Tips: The installation program sets memory to a maximum of 1.5 GB for 32-bit platforms and 4 GB of RAM for 64-bit environments.

          Remember that 32-bit architectures have limits for the amount of memory you can manage in some operating systems.

        
      

    

    Port availability

    The ports listed in System Requirements for SmartCloud Control Desk version 7.5 must be verified to ensure complete communication between the IT components.

    The ping command issued from the administrator workstation must receive response back from each server in the scope of this deployment. Make sure that this command is configured in each host.

    Hardware topology

    Both stand-alone and distributed topologies can be found in System Requirements for SmartCloud Control Desk version 7.5. Take a few moments to check out the alternatives available for your organization.

    The following are important considerations and tips for hardware topology:

    •Deploy 64-bit infrastructure when possible. 32-bit infrastructures might have limitations when managing more than 4 GB of memory in the system. For more information, see your vendor’s operating system specifications.

    •When deploying your middleware hosts, avoid installing the same components within a single physical server. Even if there are placed in different logical partitions, if the main server fails, the whole system fails as well. In this situation, consider including two physical servers with the correct amount of resources to host a highly available environment.

    •Sharing an operating system between a database and an application server might lead to memory overload.

    •When assigning IPs, defined them within the same network segment. Defining IPs this way supports high availability considerations in some application servers.

    •If your organization is going to deploy IBM SmartCloud Control Desk through the Internet, involve IT security management, network management, and the Internet service provider during the planning process. Some of the components that might be required include a digital certificate, reverse proxy, Internet access, and a public URL to access IBM SmartCloud Control Desk.

    •An email server can be used within IBM SmartCloud Control Desk to send and receive notifications. If the large numbers of notifications are sent and received, size a separate host based on the volume of notifications to manage this workload.

    Browser

    When available, use the same browser and version within your environment. Because IBM SmartCloud Control Desk requires interaction with Java runtime environment (JRE) version 1.6 from IBM or Oracle, consider this factor when upgrading Java in your desktops or notebooks.

    The version of Java required to download the JRE can be found at the following website: 

    http://www.ibm.com/developerworks/java/jdk/

    The following list are important tips for installation and compatibility:

     

    
      
        	
          Tip: Download the needed version of Java before you use IBM SmartCloud Control Desk. Also, note that new browsers and distributing might be supported. Check browser compatibility in the System Requirements for SmartCloud Control Desk version 7.5 document.

        
      

    

    File systems

    File systems are usually not present before the installation of IBM SmartCloud Control Desk. These file systems are needed to deploy the solution.

    Depending on your operating system, different file systems might be needed with different usages and sizes.

    The following list notes important considerations and information for file systems:

    •File systems need enough space and require permissions (such as read and write) to deploy images or installers. These requirements ensure their ability to properly unpack and run the installers required.

    •Unpacking tools must be available in your hosts where the installation takes place.

    •Depending on your operating system, you might require a browser to run the IBM SmartCloud Control Desk installer.

    •File system structures can be found in the System Requirements for SmartCloud Control Desk version 7.5 document, based on your supported operating system and version.

    Middleware installation

    Middleware installation requirements and supported operating systems can be found in the System Requirements for SmartCloud Control Desk version 7.5 document. Depending on your operating system and the use of already installed application servers, there might be some additional steps to consider.

     

    
      
        	
          Tip: Sometimes you are required to create specific users, depending on your deployment method and type. Make sure that the required user belongs to the correct user group, has the correct permissions, and that you know the password for this account.

        
      

    

    2.5  Deployment planning

    During deployment planning, you must correctly identify your organization’s needs. This requires that you to choose between a single server and a multi-server topology, and determine security, serviceability, and language support for your organization.

    The latest version of deployment steps can be found at the IBM information center:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_planningdeployment.html

    2.5.1  Deployment topologies

    IBM SmartCloud Control Desk works with various application servers, databases, and operating systems. Although the solution includes IBM middleware such as IBM WebSphere Application Server Network Deployment and IBM DB2®, you can also choose to implement this solution with other supported vendors. Supported vendors are noted in “Middleware installation” on page 74.

    You can use these deployment topologies:

    •Single server2: Loading all SmartCloud Control Desk components, which include middleware, the administrative workstation, and all the remaining components, into one server. 

    •Multi-server3: A split system where components can be found within different servers. This method is beneficial because it optimizes resources and decreases workload for each system. This is particularly valuable when deploying a production environment.

    For more information about deployment topologies, see the following website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_deploymentscenarios.html

     

    
      
        	
          Tip: Generally, have all servers use the same OS version and distribution. This recommendation also applies to other components if they are working in a cluster environment. Keeping OS versions and distribution the same on all servers and components can increase consistency among the systems.

        
      

    

    After you select your topology, you need to decide what to use as your administrative workstation. The administrative workstation4 is the computer system where IBM SmartCloud Control Desk is installed. Similar to the rest of the computer systems that are involved in the installation, it has hardware and software requirements.

    The following list notes important considerations about the administrative workstation:

    •The administrative workstation is where the EAR files are going to be created and later deployed into the application server. This workstation is used during the entire solution lifecycle.

    •Because the administrative workstation is where you deploy fixes to IBM SmartCloud Control Desk, periodically back up the folders containing the files needed to build the EAR files such as “<install_home>/IBM/SMP”.

    •The language packs are also installed from the administrative workstation.

    2.5.2  Deployment security planning, serviceability planning, and language support

    Security and serviceability planning and language support are also important topics to consider for every deployment. 

    IBM SmartCloud Control Desk can be configured to manage system users and their relationships in security groups. The following information is required to set up the security group process:

    •Maximo administrator user: The solution administrator user that is used for initial configuration and for adding users. The default user is maxadmin.

    •Maximo system registration user: The user that is used for the self-registration of users. The default user is maxreg.

    •Maximo system integration user: The user that is used with enterprise adapters. The default user is maxintadm.

    By default, the users are created in the database. You can log in by using the default users, or you can modify them as needed.

    When installing IBM SmartCloud Control Desk, a method for managing users and groups must be defined. Use an approach that will also work with any add-ons you might install.

    The following list provides important considerations for installation of IBM SmartCloud Control Desk and user needs:

    •A Directory Server can be integrated into IBM SmartCloud Control Desk if needed. If your organization has an internal service provider infrastructure with multiple directories, contact your local application server administrator to help with the integration of several directories.

    •Have a console or process in place for users to change their passwords for the first time if a dedicated directory server is implemented for IBM SmartCloud Control Desk.

    •Consider installing IBM SmartCloud Control Desk in English and then in other languages. This can be helpful for support and users when they require more information from your system.

    For more information about directory server security integration,5 serviceability planning,6 and language support7 on IBM SmartCloud Control Desk, see the IBM information center.

    2.5.3  Installation options

    This section addresses some of the most important factors to consider in the installation of IBM SmartCloud Control Desk. It concentrates on some important facts about organizations, sites, and data sharing. The final focus is information about the middleware installation.

    Simple or custom installation

    Early in an installation, a decision must be made to identify the installation8 that you want to use:

    •Simple: Select this option if you want to deploy all IBM SmartCloud Control Desk components within a single server, for proof of concept, demonstration, or training purposes.

    •Custom: Select this option if you want to deploy IBM SmartCloud Control Desk across several servers. This is the most common approach for production environments.

    Deferring database update and ear file deployment

    Whether you are actually installing IBM SmartCloud Control Desk, reapplying fixes, or adding more features, this option to defer database update and ear file deployment can save time. You can use this feature to delay the application of changes to the database and the EAR file. This can be useful when you must apply several fixes and only want to build and run database scripts once.

    For more information about this feature, see the database deferral and ear file update section of the IBM SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/tusc_install/c_install_defer.html

    2.5.4  Middleware

    Before you start installing IBM SmartCloud Control Desk, there are several middleware products that can either be deployed or reused.

    More information about these products and components can be found in the Middleware section in the IBM SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/install/c_ccmdb_ccmdbcmiddlewareoverview.html

    Installing program workspace

    The middleware installation program is designed to record the options you select during installation. The records are contained in a directory that is known as the workspace. The components in the workspace can then be selected and configured as a single deployed application.

    For more information about this middleware feature, see the IBM SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/install/c_ccmdb_mwiworkspace.html

    Configuration options

    This middleware feature allows you to configure servers whether you deployed middleware components from the middleware installation program or reused already deployed middleware infrastructure.

    For more information about manually or auto-configuring these components, see the Middleware configuration options section of the IBM SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/install/c_ccmdb_autoconfigvsmanual.html

    Object naming conventions

    When you install and configure middleware, in both the middleware installation program and the IBM SmartCloud Control Desk installation program, follow the standard conventions for object names. For more information about middleware object naming conventions, see the IBM SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/install/r_middleware_object_naming_conventions.html

    2.5.5  Installing SmartCloud Control Desk

    Depending on the type of deployment option that you select, the method of installation varies.

    Refer to the IBM information center to access the latest IBM SmartCloud installation procedures at the following website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/topic/com.ibm.tusc.doc/tusc_install/t_ctr_install.html

    2.6  Conclusion

    This chapter identified the key elements that make IBM SmartCloud Control Desk one of the leading IT Service Management solutions in the market.

    This chapter described the main components of the solution from common services through the main processes it can address. This prepares an organization to start defining service management processes, and to start deployment of the supporting products that provide the foundations for IBM SmartCloud Control Desk. These supporting products include directory servers, databases, and application servers.

    The next chapter addresses what tasks and initial configurations must be performed to IBM SmartCloud Control Desk. These configurations must be set in place before configuring and working on IT processes.

    

    1 MBOs (Maximo business objects) are the business objects that are used by SmartCloud Control Desk.

    2 Single server deployment topology:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_singledeployment.html

    3 Multiple server deployment topology

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_multipledeployment.html

    4 Administrative workstation requirements

    http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_maxadminsystem.html

    5 Planning for security: http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_plan_sec.html

    6 Planning for serviceability: http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_planforservicability.html

    7 Language support: http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_planforlang.html

    8 Simple or Custom installation: http://pic.dhe.ibm.com/infocenter/tivihelp/v58r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Finstall%2Fc_ccmdb_baseservices_simple_custom_option.html

  
[image: ]
[image: ]

Implementing processes in IBM SmartCloud Control Desk

    In this part, the IT service management processes supported by IBM SmartCloud Control Desk are described. Each chapter consists of an overview of a specific process and use cases on how to implement it using the product.
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IT foundations configuration

    This chapter provides information about the basic configurations necessary to work with SmartCloud Control Desk, and provides details about some of the applications used. 

    The following topics are covered in this chapter:

    •General configuration for SmartCloud Control Desk

    •IT foundations for SmartCloud Control Desk

    3.1  General configuration for SmartCloud Control Desk

    Before you start using SmartCloud Control Desk, some configuration steps are required. This chapter presents these configurations. 

    There are two ways of defining the data necessary to start using the product:

    •Create the data from scratch

    •Start with the data content available for the product

    For the examples in this book, the content pack used was the optional content pack that is included in the SmartCloud Control Desk 7.5 installer.

    3.2  IT foundations for SmartCloud Control Desk

    This section presents some of the configurations necessary to use SmartCloud Control Desk.

    3.2.1  Organization

    An organization is typically a financial entity in an enterprise in which all financial transactions are maintained in one base currency. Each organization maintains its own general ledger account, which is available to all sites that belong to that organization. Each organization can have one or more sites.

    Some items need to be configured to properly use the SmartCloud Control Desk.

    There are four information levels on SmartCloud Control Desk:

    •Enterprise

    Information available to all organizations

    •Set

    Sets can be shared between organizations, so in this case the information is available to some organizations

    •Organization

    Information available to all sites inside an organization

    •Site

    Information available only for a specific site

    The organizations are managed in SmartCloud Control Desk by using the Organizations application, which is in Administration → Organization.

    When a new organization is created, some items must be defined for it. An example is displayed in Figure 3-1.
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    Figure 3-1   Empty organization

    The administrator must define the following fields:

    •Organization

    Defines the name of the organization to be used in the system.

    •Base Currency1

    Defines the main monetary currency used. To define this, you can use the currency code application if necessary.

    •BaseCurrency2 - Optional

    Defines the secondary monetary currency used.

    •ItemSet

    Defines a set of items that are available to the organizations included in the ItemSet. Each organization is associated to one item set, but an item set can be associated with multiple organizations.

    •CompanySet

    Defines a list of companies that can be used to gather information to be used by one or more organizations.

    •Default Item Status

    Defines the initial status of the items added to this organization set. The available values are Active, Planning, and Pending.

    •Default Stock Category

    Defines the default mode of stocking items for the organization. The options are stocked (STK) or non-stocked (NS). 

    •Clearing Account

    Defines the general ledger account, which is used as the default account for this organization. This account is used for transfers between organizations.

    Besides those items, define the sites and addresses that are part of the organization. To do so, click the corresponding tab in the organization configuration window as shown in Figure 3-1 on page 85.

    There are two ways of creating an organization. The first is using the organization application, where you define each item directly on the application. The other way is by using Quick Configuration.

    Quick Configuration is an application that is designed to make it easier for users to create new organizations and the items related to the organization.

    The Quick Configuration application can be opened by clicking System Configuration → Platform Configuration → Quick Configuration.

    All changes related to organizations are made under the Org and Site Configuration tab. When you enter the quick configuration application, some sample data is already populated in the fields. Change this data according to your organization’s needs. 

    An example of the window that is used to create a new organization is displayed in Figure 3-2.
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    Figure 3-2   Quick configuration

     

    
      
        	
          Tip: When you create an organization using Quick Configuration, a new general ledger account is created with the default value GLACCT and a length value of 6 unless you already have an account in your system. 

        
      

    

    After all data is correctly defined, click Submit and the new organization is created. To check it, access the Organizations application. 

     

    
      
        	
          Tip: Accounts can be defined under Financial → Chart of Accounts.

        
      

    

    After an organization is created, it must be activated for use in the SmartCloud Control Desk. To activate an organization, select Active. This option is located under the Organizations application tab. Then, save the record. At least one site must be created for each organization.

    Another configuration option in the Organizations application allows you to define a prefix for objects created by the application, such as SR or IN. This can make it easier for users to identify objects. For example, a Service Request can be named SR1234 and an incident as IN2345. To do so, click Select Action → Autonumber Setup → System Level. In system level window, find the Autonumber name for which you want to create a prefix. In this example, the Autonumber name is SRID and INCIDENTID. Enter the prefix that you want in the associated prefix field. The records are defined as shown in Figure 3-3.
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    Figure 3-3   Autonumber configuration

    3.2.2  Work types

    Create work types for each organization that you have defined. To create work types, select an Organization and click Select Action → Work Order Options → Work Type. Then, complete the following steps:

    1.	Click New Row

    2.	Select the work order class. It can be Activity, Change, Configuration Item Work Order, Release, or Work Order.

    3.	Define a new name for the work type. Set the work type to a value that describes the type of change that is created. For example, you might set a work type as MAJOR to designate a major change.

    4.	Change the type if necessary.

    5.	In the Process flow section, define the start and complete status of the work type. Usually, those values are defined as In Progress and Complete.

    You can create as many work types as necessary for each organization.

    3.2.3  Financial configuration

    Currency codes and accounts must be created to use SmartCloud Control Desk. You can create them during the organization configuration, but they can also be managed using their applications. Each organization must have an account associated with it.

    For currency codes, click Financial → Currency Codes.

    To add a currency, complete the following steps:

    1.	Click New Row

    2.	Add the currency code and currency description and select Active. 

    To manage accounts, click Financial → Chart of Accounts.

    To create new values for Cost Center, Activity and Resource, which are the components that form the account, click Select Action → GL Component Maintenance.

    For each item, a new value can be created by selecting the item and clicking New Row.

    The accounts have a structure defined when the first account is created. This structure defines the size of each of the fields that is used in an account, cost center, activity, or resource. This can be changed by clicking Select Action → Add/Modify Account Structure. 

    Besides the General Ledger account defined for the application, other types of accounts can be defined for each organization. The following list defines the other types of definable accounts:

    •Global Rotating Suspense Account

    Use rotating suspense accounts to hold the accumulated cost of repairs for rotating equipment. 

    •Global Ticket Account

    Use the default account when a ticket for a service request is created and no other account is available. 

    •Tool Control Account

    Use the default account when a transaction involves a tool and no other account is available. 

    To define these types of account, click Select Action → Organization Default Accounts, and then select the accounts for each item as required.

    For companies that use payment, you can specify default general ledger accounts for company-related accounts. To define this type of account, click Select Action → Company-Related Account, and create a new row for each account.

    For types of accounts that are used to pay for work performed by outside vendors, external labor accounts can be defined. To define this type of account, click Select Action → External Labor Control Account, and create a new row for each account.

    3.2.4  Classifications

    Classifications are used in SmartCloud Control Desk to define groups or subgroups of similar objects so that can be found by searching for the defined attribute. For example, a building, a notebook computer, and a centrifugal pump are types of classifications. A classification can also describe an event, such as a broken window, a hard disk failure, or a request for a new email account.

    You can classify objects such as locations, assets, items, sales orders, and work orders. Classifications for work orders, tickets, and sales orders can be used as one of the matching criteria for service level agreements, response plans, and price schedules. You can search classification structures and attributes with associated values when you use any record type that can be classified.

    A classification can be defined by using a hierarchy tree. A classification can have more than one child, but only one parent. An example of the hierarchical use of classifications is displayed in Figure 3-4.
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    Figure 3-4   Classification hierarchy

    Classifications are created by using the Classifications application, which is opened by clicking Administration → Classifications.

    When a new classification is created some options must be defined as shown in Figure 3-5.
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    Figure 3-5   New classification

    The following list describes the available options:

    •Classification

    The identifier of the classification.

    •Description

    A description of the classification.

    •Classification Path

    The full path used for this classification. It contains the parent path plus the current classification.

    •Parent Classification

    Defines the parent classification of the current classification.

    •Organization

    If the new classification belongs to a specific organization, this field contains the organization. All children of this classification must have the same organization defined.

    •Site

    If the new classification belongs to a specific site, this field is set with the site. All children of this classification must have the same site defined.

    •Show in business view

    Defines whether the classification is available to be used in the topology view from the Configuration Items application.

    •Generate description

    Uses the attributes of the classification to build the description.

    •Use Classification

    Includes the classification description in the description that it is generated.

    •Use With

    Defines in which applications this classification can be used.

    •Children

    Defines the children of this classification.

    •Attributes

    Defines some characteristics of the classification, such as which processor is used if the classification is Computer.

    Create classifications according to your needs. 

     

    
      
        	
          Tip: The Use With field defines which application has access to the classification. Consider that items shared among applications (for example, service request, service catalog, and change) must have the Use With classification defined in all applications. 

        
      

    

    After the classifications are defined, associate the top-level classification to the organizations defined. To do that, select the organization in Organizations application, and click Select Action → System Settings. In the window that is displayed, a section named IT Options is displayed as shown in Figure 3-6.
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    Figure 3-6   IT Options window

    In this window, define the top-level classification for CIs, IT Assets, Software, and Self Service Asset requests. The definitions in this window are used to filter the list of classifications available for the user. They also define to which hierarchy of classifications each of the components belong.

    3.2.5  Security groups and users

    Define the roles and users for use in the SmartCloud Control Desk in the Security Groups and Users application. 

    Security groups are groups of users with the same user access for the application. Each user can be part of multiple security groups, and each security group can have multiple users.

    Within the security group application, the access for each application can be defined. For example, a service catalog designer must have access to the applications required to create catalogs, but does not require access to create new incidents.

    To add a user, you must add a person and associate that person to the user. 

    To define a user, use the Users application, which is opened by clicking Security → Users. An example of a new user is displayed in Figure 3-7.
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    Figure 3-7   New user configuration

    A new person is created if there is no person associated with the user. Each user who uses the system must have a person record created.

    Security groups can contain multiple users, and can be defined as a set of users with the same access. A new security group is defined in the Security Groups application, which is opened by clicking Security → Security Groups. Users can be added to security groups using both applications.

    For each security group, several definitions can be made. You can define the access to applications, the default application opened upon user login, the authorized sites and storerooms available, and the default start center for the user. 

    In the Applications tab, the access definitions are configured. Each application has several access types, such as Read, Insert, Save, and Delete. Each application also has signature options specific for the application that define the items the security group is allowed to access. 

    An example is displayed in Figure 3-8.
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    Figure 3-8   Service group authorization

    In this example, all the marked check boxes represent authorized actions that users are able to do within the Self Service Center application.

    The follow are extra definitions that can be made for a security group:

    •Define authorized sites

    This can be defined by using the Sites tab and selecting the authorized sites.

    •Define authorized storerooms

    This can be defined by using the Storerooms tab and selecting the authorized storerooms.

    •Define default login screen

    This can be defined using the Group tab, by selecting a value in the Default Application field.

    •Define default start center template

    This can be defined using the Group tab, by selecting a value in the Start Center Template field.

    •Insert data restrictions

    New restrictions can be defined for a specific group by using the Data Restrictions tab.

    •Change account components

    This can be defined by using the GL Components tab. Groups can be authorized to change account information if desired. 

    •Financial limits

    This can be defined by using the Limits and Tolerances tab. The group users can have a limit of how much money they can invest on their purchase or material requests.

    If LDAP is used, the groups and the users are created using LDAP. To do so, a cron task must be activated. To activate the cron task, use the Cron Task Setup application. Click System Configuration → Platform Configuration → Cron Task Setup. 

    Complete the following steps to finish this procedure:

    1.	Search for the LDAPSYNC cron task.

    2.	Activate the instance LDAPSYNC01.To activate it, select Active. 

    3.	Define the interval that this cron task uses for execution. 

    4.	Click Select Action → Reload Request. 

    If WebSphere Virtual Member Machine is used, the users are created by WebSphere. To do that, a cron task must be activated.

    Complete the following steps to activate the cron task and finish the procedure:

    1.	Go to the Cron Task Setup application and search for the VMMSYNC cron task.

    2.	Activate the instance VMMSYNC01. To activate it, select Active.

    3.	Define the interval that this cron task uses for execution. 

    4.	Click Select Action → Reload Request.

    3.2.6  Profile information

    Each user has some profile configurations that must be populated before using the SmartCloud Control Desk.

    Access the fields that must be populated by clicking Profile → Default information. Some fields might be already populated in the Users application. 

    An example of the window is shown in Figure 3-9.
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    Figure 3-9   Profile information

    The user can define the settings according to the location and role they occupy. An important field in this window is the default insert site. When the user orders a new item, it is inserted using the site defined in this dialog field.

    You can also define the default insert site by using the Users application. In this application, select the user and, in the User Settings section, define the same fields you defined in the profile information.

    3.2.7  Import content packages

    Content packages available in the ISM library can be installed in the SmartCloud Control Desk by using the ISM Content Installer application. To open the ISM Content Installer application, click System Configuration → ISM Content Installer.

    To define the list of content packages available for the product, the application uses an XML file. You can get this file from the following website: 

    http://www.ibm.com/software/brandcatalog/ismlibrary/resources/catalog?&client=ISCCD&sortBy=update_ts_desc&rc=SmartCloudControlDesk&rc=IBM_Tivoli_AssetType_ISMContentInstallerPack

    This application can be used to install packages such as the service catalog content pack. This package and a list of packages are available in the default xml, as shown in Figure 3-10.
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    Figure 3-10   ISM content installer package list

    To install the service catalog content pack, click the Download icon and select Continue. Then, accept the license agreement as shown as step 1 in Figure 3-11.
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    Figure 3-11   Accepting the license agreement

    A list of the items to be installed is displayed in the setup window as Step 2. Clear the check boxes for the data that is not necessary. An example is shown in Figure 3-12.
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    Figure 3-12   List of optional items for installation

    Click Install and the installation begins. A successful message will be displayed if the installation occurred correctly, as shown in Figure 3-13.
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    Figure 3-13   Successful installation 

    3.2.8  Changes in the navigation bar location, tabs, and fields

    There are two options for access to the SmartCloud Control Desk applications in the 7.5 version. You can use the navigation bar, which is now on the left side of the window, or the menu in the upper left corner.

    If you want to change the location of the navigation access points, use the System Properties application. Click System Configuration → Platform Configuration → System Properties.

    There are three possible changes that can be done for the location of the navigation bars. 

    The first one is to remove the navigation bar on the left side. To do that, complete these steps:

    1.	Find the property mxe.webclient.systemNavBar in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    The second change is to remove the navigation bar on the left side from a specific application. To make this change, complete these steps:

    1.	Click System Configuration → Platform Configuration → Application Designer, and find the presentation xml file related to that application. 

    2.	In the presentation tag, set systemnav=”false”. To define this change in syntax form, an example is to change the presentation tag: 

    <presentation id="abc" mboname="abc" beanclass="psdi.webclient.beans.abc" systemnav="false"> 

    An example of an application that uses this flag is the Self Service Center.

    Finally, you can relocate the menu in the upper left corner to a selectable Go To menu button at the top of the window (the position it had in prior product versions). To make that change, complete these steps:

    1.	Find the property mxe.webclient.homeButtonHeaders in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    After making this change, your menu looks as shown in Figure 3-14.
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    Figure 3-14   Go To menu

    Another option that you can changed in the SmartCloud Control Desk is to make the tabs visible in the list view of the applications as shown in Figure 3-15. The are not visible in the default option for new installations.
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    Figure 3-15   Default list view

    To change this view to how it looked in prior product versions, complete these steps:

    1.	Find the property mxe.webclient.tabBreadCrumbs in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    The application list view is displayed as shown in Figure 3-16. This is the default option for upgrades.
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    Figure 3-16   Application list view

    In SmartCloud Control Desk 7.5, the field labels are displayed above the fields, as shown in Figure 3-17. This is the default option for new installations.
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    Figure 3-17   New field label position

    It is possible to change the way fields are displayed to make it similar to prior product versions. To change this setting, complete the following steps:

    1.	Find the property mxe.webclient.verticalLabels in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    An example of the field display, with the prior version label position directly beside the field, is shown in Figure 3-18.
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    Figure 3-18   Prior label position for fields

    3.2.9  Modifying an object

    If you need to make any change on an object structure, such as adding or removing a field from the object, use the Database Configuration application. To open this application, click System Configuration → Platform Configuration → Database Configuration.

    You must use Administrator mode to apply any changes because authorized database changes are required. In Administrator mode, all users are required to log off the application.

    To change an object, select the object and then add or modify fields according to your needs.

    All pending changes are marked as To be changed in the Database Configuration application. To apply the changes, complete the following steps:

    1.	In the Database Configuration application, select Manage Admin Mode from the Action menu.

    2.	In the Turn Admin Mode ON window, modify the values in the Number of Administrative Sessions Allowed field and the Number of Minutes for User Logout field. The default value of each field is 5. If you modify these fields, click Update Properties for the parameters to take effect.

    3.	Click Turn Admin Mode ON.

    4.	In the Electronic Signature Authentication window, enter the appropriate value in the Reason for Change field.

    5.	Click OK. 

    6.	A window opens that indicates that the Admin Mode is starting. Click OK.

    7.	Throughout the configuration process, click Refresh Status to view the messages that the configuration process writes in the Status window. If you decide to cancel the configuration, click Cancel Admin Mode.

    8.	From the Select Action menu, click Apply Configuration Changes to configure the database and restore backup tables. Wait until the administration mode is turned on before you perform this step.

    9.	To turn off Admin Mode, from the Select Action menu, click the Admin Mode action, and then click Turn Admin Mode OFF.

    3.2.10  Customizing the options available on application menus

    To change the options available in the select action or toolbar menu, use the Application Designer. To open it, click System Configuration → Platform Configuration → Application Designer.

    Select the application, and, using the Select Action menu, choose one of the following options:

    •Add/Modify Signature Options

    Signature options specify privileges for using applications, menu options, and toolbar items. The signature option can be allowed or not using security groups for the selected group.

    •Add/Modify Select Action Menu

    Defines the options available in the Select Action menu for the selected application.

    •Add/Modify Toolbar Menu

    Defines the options available in the toolbar menu for the selected application.

    •Add/Modify Search Menu

    Defines the options available in the search menu for the selected application.

    When working with these menu options, you can define the position of each action when a new item is added or changed. An example of a select action menu is displayed in Figure 3-19.
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    Figure 3-19   Select action menu

    The Key Value field defines the action that this entry will runs, and the position is defined by the Position and Subposition fields.

    3.2.11  Changing applications on the navigation bar

    To change an application on the navigation bar that is used to access SmartCloud Control Desk applications, you must run a query using SQL. 

    The table that stores the applications that are displayed on the bar is named maxmenu. The order in which the fields are displayed in the bar is defined by field position. 

    Each module defined has one or more applications under it. The modules are defined in the maxmodules application.

    For example, the Service Desk module is displayed as shown in Figure 3-20.
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    Figure 3-20   Service Desk module

    The following syntax is the query that shows how these items are defined in the database:

    select position, keyvalue from maxmenu where moduleapp='SD' and elementtype='APP' order by position

    The output of the query is displayed in Table 3-1.

    Table 3-1   Query results

    
      
        	
          Position

        
        	
          Key value

        
      

      
        	
          10995

        
        	
          INCIDENT

        
      

      
        	
          10997

        
        	
          PROBLEM

        
      

      
        	
          11000

        
        	
          ACTIVITY

        
      

      
        	
          11005

        
        	
          PMCOMSR

        
      

      
        	
          11010

        
        	
          SR

        
      

      
        	
          11040

        
        	
          SOLUTION

        
      

      
        	
          11050

        
        	
          TKTEMPLATE

        
      

      
        	
          11051

        
        	
          OBJSEARCH

        
      

      
        	
          11052

        
        	
          PRIORITY

        
      

      
        	
          11054

        
        	
          PLUSPACTVT

        
      

      
        	
          11058

        
        	
          PLUSPINC

        
      

      
        	
          11062

        
        	
          PLUSPPROB

        
      

      
        	
          11066

        
        	
          PLUSPSR

        
      

      
        	
          11070

        
        	
          PLUSPSOLUTION

        
      

    

    To change the order of an application, update its position in the maxmenu table and restart your server.

    3.2.12  Reports

    Some applications have their ready for use BIRT reports defined. To run those reports, their request page must be generated the first time that the report is run or after the report is reimported into the system. 

    Request pages are created by using the Report Administration application. Open this application by clicking Administration → Reporting → Report Administrator. There are two ways to generate the request page:

    •As one specific report

    •As a list of reports

    In the list tab of the report administration application, filter the reports that must have their request pages generated. Then, click Generate Request Pages at the bottom of the window. 

    After the request page is generated, the reports are available to be run for each application. To use this function, click Select Action → Run Reports, select the report you want, and run it.

    Every time a report is reimported into the application, a new request page must be generated.

    The user might also need to customize a new report, such as creating on-demand reports, or query based reports.

    The Create Report process makes it easier for users to customize their own individual reports. They are able to design it according to their needs.

    These reports are associated with an application. The fields available for use are the fields that are defined in the main table of the application, including the relationships where the main table of the application is the parent.

    To create a report, go to the application, and click Select Action → Run Reports. Then, click Create Report.

    There are four tabs that you can use to create an on-demand report: Style, Select, Format, and Submit. These tabs are shown in Figure 3-21.
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    Figure 3-21   On-demand reports, Style tab

    The Style tab is used to select the type of report, input the title, and whether this report will be available (public) after the execution.

    The style of the report can be selected as Summary or Detail. 

    •A Summary Report is the most simple type and is often used to display a list of elements of one category. This report allows only one multiple relationship between tables.

    •A Detail Report is more complex and is often used to display data for several objects. It allows more than one multiple relationship.

     

    
      
        	
          Tip: When the report is designed without using data from relationships with the main table or the report is displayed as a list, choose a summary Report. When it uses data from relationships with the main table, choose a detail report.

        
      

    

    Select Save report and Public to make the report available for other users to run. 

    The dialog for the Select tab is displayed in Figure 3-22.

    [image: ]

    Figure 3-22   On-demand reports, Select tab

    On this tab, a list of available fields for this table and its relationships is displayed. Select the fields that you want to add to your report.

    On the Format tab, you can select which fields are used to order, group, or sort the report output.

    On the Submit tab, you select when the report will be run.

    For example, a summary report showing a list of incidents that are sorted by the ticket ID and description is displayed in Figure 3-23.
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    Figure 3-23   Summary report

    This type of report can be grouped if necessary by selecting the grouping fields in the Format tab.

    An example of a detail report is displayed in Figure 3-24.
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    Figure 3-24   Detail report

    In this detail report, the status history of the tickets is included using a relationship between the objects. Each incident record is displayed on one page.

    In detail reports, it is not possible to group the report manually because they are automatically grouped by category.

    3.2.13  Data loading using quick configuration

    You can import data using the quick configuration application. This is useful for environments without IBM Tivoli Application Dependency Discovery Manager installed, which loads data.

    To import data, the type of file used is a comma-separated value file (CSV). Assets, configuration items, person users, licenses, and locations can be added by using quick configuration data loading. By default the assets, CIs, and person users data is imported or updated by using a sequential queue. A sequential queue imports one data set at a time in the defined order, and the process stops when an error is found. This import functions in this manner because there might be dependencies on the order that the data is imported in. The locations and licenses data is imported using a continuous queue.

    Complete the following steps to import the data:

    1.	Activate cron task JMSQSEQCONSUMER.SEQQIN. 

    a.	Start the Cron Task Setup application by clicking System Configuration → Platform Configuration → Cron Task Setup. 

    b.	Search for the JMSQSEQCONSUMER cron task, and activate the instance SEQQIN. To activate it, select Active.

    c.	Define the interval for this cron task to run, and click Select Action → Reload Request. 

    2.	The configured cron task is displayed in the Reload Request window, as shown in Figure 3-25. Select SEQQIN and click OK.
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    Figure 3-25   Cron task to activate data loading

    After the data are imported, the CSV files must be created. For information about how to create CSV files, see the following website: 

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/import/r_csv_file_structure.html

    Follow these guidelines when you create a CSV file:

    •You can use a spreadsheet program such as Microsoft Excel to create your CSV file.

    •Save the CSV file in UTF-8 format.

    •Do not include more than 3000 records in a single CSV file. If you need to import more than 3000 records, use multiple files.

    •Previewing the import of large files is not recommended because it can take a considerable amount of time. Before importing a large file, preview the import of a smaller version of the file first.

    •If you recently imported data but you do not see records for the data, manually refresh the list of messages. If the import finishes and it failed for one or more records, messages for the failed records are displayed. 

    •Put records that define new users into a separate CSV file from records that update existing users. Do not mix these types of records in a single CSV file.

    •To import a CSV file that defines new users, use the Add action. To import a CSV file that contains updates to user records, use the Add/Change action.

    After the CSV files are created, go to the quick configuration application, click the Data Loading tab, and complete these steps:

    1.	Select the type of object that corresponds to the type of data you will load, such as ASSETS, CI, PERSON USER, LICENSES, or LOCATIONS.

    2.	Click Load data.

    3.	Click Browse, navigate to the CSV input file, and select it.

    4.	To deactivate the preview mode, ensure that the Import preview check box is not selected.

    5.	Click OK. Assets, CIs, and person users are placed in the sequential queue. Licenses and locations are placed in the continuous queue. If there is already a data load request processing on the same application server this request is initiated from, a message box is displayed. The message box indicates that the data load application is busy, and to restart the import after the ongoing data load operation has finished. If there are no other data import requests processing, the number of records in the CSV file is checked. An error message is returned if the number of records exceeds the maximum allowed record size in any one file. The default maximum value is 3000. If the number of records is within the allowed limit, the content of the CSV file is processed. 

    6.	While the file is being processed, review the Records Tracking table for information about the Java Message Service (JMS) messages that need to be processed. Note the following areas when reviewing this section:

     –	On the Data Loading tab, the Total pending records might be null. This occurs because the field does not update automatically. You must click Refresh to update the records.

     –	If there are no messages to be processed, the Total pending records is 0. If you submit 3000 records, the field displays any number between 0 and 3000, depending on the progress of the data loading.

     –	If you submit a new file to be loaded while there are still messages waiting to be processed, note the Total pending records field. That field shows the sum of the current backlog of messages, plus the total number of new messages to be processed in the new data load.

     –	To clear the continuous or sequential queues, click Clear continuous queue or Clear sequential queue.

    7.	Review the Failed Records table for information about problems that were encountered with the data import. You can take the following actions for messages:

     –	Edit and save a failed message. You can correct all errors in a failed message and then reprocess the message.

     –	Select and then reprocess one or more failed messages.

     –	Select and then delete one or more failed messages.

     –	Refresh the Failed Messages list.

    3.2.14  Importing and exporting data from applications

    SmartCloud Control Desk provides the functionality to import and export data from another SmartCloud Control Desk application without using an external product. This feature is useful for users to manage big data changes within the system. The user can export, change, and reimport data into the system or create data by using an xml or csv file.

    Integration framework is used to enable data import and export functions. The application that is used to make these changes is Object Structures, which is started by clicking Integration → Object Structures.

    For example, if you want to enable data import for the Classifications application, complete these steps:

    1.	Open the Object Structures application and find the definition for the object. The ID of the object structure definition is defined as MX<OBJECT_NAME>. In this example, the object to enable is Classification, so the object structure is MXCLASSIFICATION.

    2.	With the object selected, click Select Action → Duplicate object structure. Some source objects are further defined in the Source Objects section. This allows you to change the structure of the new object. For example, in the Classification object, the objects that are defined to be migrated are displayed in Figure 3-26.
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    Figure 3-26   Classification objects

    You can define the objects that you need to migrate, but the main object must be maintained in the list. For this example, only CLASSSTRUCTURE is used, so the others can be removed from the list. 

    3.	Enable the export process for the application by clicking Select Action → Add/Modify Application Export Support.

    4.	In the new window, click New Row and add the application where the export functions will be used, in this case Classifications (ASSETCAT). There are two options to be considered in this window:

     –	Default Type File

    Defines the type of the file that is used in the export process. There are two options for files to be used in a spreadsheet: XML file and flat file. To use a flat file, Support File Structure must be selected.

     –	Maximum count

    Defines the maximum number of records that can be exported in a single execution.

    In this example, the default type of file is defined as XML, and the maximum count as 100, shown in Figure 3-27.
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    Figure 3-27   Add or Modify Application Export Support window

    5.	Click OK.

    6.	For import functionality, similar steps are performed. Click Select Action → Add/Modify Application Import Support.

    7.	In the dialog, define the new object to be imported and click OK.

    8.	More changes are required for each security group that needs access to import or export data. Go to the Security Groups application, and select the security group you want.

    9.	Select the application. In this example, Classifications on the Applications tab was selected.

    10.	Two new options are created for the application: Application Export and Application Import. To make the options available for users of the selected security group, select Grant Access for the option you want to allow, as displayed in Figure 3-28.
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    Figure 3-28   New options for security group

    11.	The new configuration is completed. Log off and log in again to the system to see the changes. The application displays two new icons for export and import application data in the toolbar and the Select Action menu, as shown in Figure 3-29.
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    Figure 3-29   New icons for import and export application data

    To export data, complete the following steps: 

    1.	Filter the application if necessary, and click Application Export. 

    2.	A new window is displayed with the option to choose the object structure to be used on the export process. Select the object structure that you created earlier. The number of records filtered to be exported is displayed in the Selected to Export field. 

    An example of the window is shown in Figure 3-30.
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    Figure 3-30   Export data

    3.	Select the type of file to be created, and the Delimiter used if it is a flat file. The Delimiter default value can be defined by using the property mxe.int.flatfiledelimiter in the System Properties application. The Text Qualifier is used to wrap the text if the Delimiter character is found in one of the exported fields. If you are using an xml file, use sync as the export option.

    4.	Click OK to create the exported data. Because the file defined is an xml file, the generated file is a .xml file. This file can be opened in an xml editor. If the file chosen was a flat file, the generated output is a .dat file, which can be opened in a spreadsheet as a CSV file. 

    If you selected a CSV file, make sure that the fields are separated by commas when you open the file on a spreadsheet.

    To import a file, complete these steps: 

    1.	Click Application Import. An XML or a CSV file can be used to import data into the application. In this example, an XML file is used to add a classification to the application. To create the file, existing records can be used as an example.

    2.	Using application import dialog, select the file (XML or CSV) used to import data and the object structure to be used. Select Import Preview to see the validation results for the file that is loaded into the system. Click OK. An example of the validation results is displayed in Figure 3-31.
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    Figure 3-31   Preview results

    3.	If the validation was concluded with success, data can be imported into the application. Click Application Import again, select the file and object structure, but do not select Preview Results. Click OK. If data was imported correctly a message is displayed as shown in Figure 3-32.
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    Figure 3-32   Confirmation message

    One aspect that must be considered is how to manage autokey fields when importing data. Autokey fields are the fields where data is populated with a key defined in SmartCloud Control Desk 7.5 database. 

    Based on the file type that you are using for import, consider the following information:

    •If an XML file is used, the file should not contain the autokey fields.

    •If a flat file is used, include the field. To avoid those values actually being included in the database, a restriction is placed in the object. To configure this option, use the Database Configuration application by clicking Select Action → Restrict Attributes.

     

    
      
        	
          Tip: Define the object structure according to the data that you need to import or export.

        
      

    

    3.2.15  Searching with Lucene

    Some of the SmartCloud Control Desk applications, such as service desk and service catalog applications, use Lucene as a search engine. Lucene works with indexes, and data is filled in those indexes when a cron task is run. To use search functions properly on those applications, it is required that the Lucene cron task be activated to populate the indexes that are used during the search process.

    The cron task that is used by Lucene is named PmObjSearchCron. To activate the cron task, use the Cron Task Setup application by clicking System Configuration → Platform Configuration → Cron Task Setup. 

    Search for the PmObjSearchCron cron task, and activate the instance PmObjSearchInstance. To activate it, select Active. Next, click Select Action → Reload Request and select the interval when this cron task is run. The default option is each 24 hours, which means that the indexes from Lucene are updated once a day.

    3.2.16  Field validation

    SmartCloud Control Desk provides the feature to validate a field as a background process. The user can enter the information in a field, and proceed to the next field while the data in the first field is validated. This makes the data input faster for the user.

    If you want to disable the asynchronous field validation, use the System Properties application by clicking System Configuration → Platform Configuration → System Properties. Then, complete these steps: 

    1.	Find the property mxe.webclient.async in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    3.2.17  Query management and advanced search

    Each application in the SmartCloud Control Desk can store queries for users and run searches in the records of the user. This search process does not use Lucene.

    Searches use the Advanced Search options, and the advanced search menu is displayed above the list of items returned for the application. There are two main options:

    •More Search Field

    User can select, using the UI, which items are filtered during the search.

    •Where Clause

    An SQL where the clause is used to search fields from the main table of the application.

    The queries that are used in the search can be saved and used later by the same or another user. The options for these queries are in Save Query menu. Query options are available for each application and can be accessed in the application. They are displayed in the menu near Advanced Search.

    There are two options:

    •Save Current Query

    Allows the user to save the current query used on the application. The user can make the query public or not.

    •View/Manage Query

    Allows the user to view, access, or change a previously saved query. This is useful for reusing existing queries and to return common results, such as tickets opened or closed in a specific interval.

    3.2.18  Domains

    Domains are used as a group of available values for a specific field or application. There are several domains created for SmartCloud Control Desk. These domains can be changed or more of them created depending on your business needs. 

    To create or change a domain, click System Configuration → Platform Configuration → Domains. To add a domain, select Add a new domain and select the correct type. To change a domain, select it in the list of available domains.

    There are six types of domains available:

    •ALN

    Defines a list of alphanumeric values that can be used in the domain. The Length field defines the maximum size of each domain value, and the Data Type field defines the type for the value column. An example of ALN domains is displayed in Figure 3-33.
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    Figure 3-33   ALN domain

    •Numeric

    Defines a list of numeric values that can be used in the domain. The Length field defines the maximum size of each domain value. The Data Type field defines the type for the value column. The Scale field defines the number of decimal places for the value column. An example is displayed in Figure 3-34.
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    Figure 3-34   Numeric domain

    •NumericRange

    Defines a range of numeric values that can be used in the domain. The Length field defines the maximum size of each domain value. The Data Type field defines the type for the value column. The Scale field defines the number of decimal places for the value column. An example is shown in Figure 3-35.
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    Figure 3-35   NumericRange domain

    •Table

    The items available on this domain are obtained from an existing object in the SmartCloud Control Desk. It can be all items in the table that are related to the object, or a subset of elements of the object. To select the items available on this domain, select the new object and filter by using the List Where clause. An example of table domains is displayed in Figure 3-36.
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    Figure 3-36   Table domain

    The List Where clause used in this example is status in (select value from synonymdomain where domainid='MAXUSERSTATUS' and maxvalue='ACTIVE'). This clause filters the maxuser object with the active items. 

    •Crossover

    Defines conditions to link two different objects. Crossover domains are commonly used to get fields from one object using fields from another object as a reference. The where clause used defines the fields that are used as the link between the two objects. The crossover fields are the fields where the information is applied. An example of a crossover domain is displayed in Figure 3-37.
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    Figure 3-37   Crossover domain

    •Synonym 

    This type of domain cannot be created. It can only be changed. The user can have two synonym values for the same entry. An example of this type of domain is the status fields. For each status, multiple synonyms can be added. The Internal Value field must be the same as one of the existing entries created. This defines the value that is used internally in the application. The Value and Description fields define the values visible for the user. An example of a synonym domain is displayed in Figure 3-38.
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    Figure 3-38   Synonym domain

    This domain has two different entries with the internal value of Pending. The second column shows a value of Needs Info and Pending. The second column (list of values) can be customized according to your needs, but the interval values cannot be changed. At least one entry must be present for each of the internal values.

    After a domain is defined, it can be associated with a field. To associate a field, complete these steps:

    1.	Go to the Database Configuration application.

    2.	Select the object. 

    3.	In the Attributes tab, select the attribute to be associated with the domain.

    4.	Save the record. It is marked as To be changed.

    5.	Click Select Action → Manage Admin Mode.

    6.	In the Turn Admin Mode ON window, modify the values in the Number of Administrative Sessions Allowed field and the Number of Minutes for User Logout field. The default value of each field is 5. If you modify these fields, click Update Properties for the parameters to take effect.

    7.	Click Turn Admin Mode ON.

    8.	In the Electronic Signature Authentication window, enter the appropriate value in the Reason for Change field.

    9.	Click OK. A window opens that indicates that the Admin Mode is starting.

    10.	Click OK.

    11.	Throughout the configuration process, click Refresh Status to view the messages that the configuration process writes in the Status window. If you decide to cancel the configuration, click Cancel Admin Mode.

    12.	Click Select Action → Apply Configuration Changes to configure the database and restore backup tables. Administration mode must be turned on before you perform this step.

    13.	To turn off Admin Mode, from the Select Action menu, click the Admin Mode action, and then click Turn Admin Mode OFF.

    3.2.19  Customer configuration

    Customer functions are part of the Service Provider, and available only for Service Provider edition of SmartCloud Control Desk.

    To be able to manage assets for service providers, you must set the customer in the SmartCloud Control Desk applications. Customers are set in the Customer application, which is opened by clicking Service Provider (SP) → Customers (SP).

    Set the customer information according to your needs. Restrictions can be applied in security groups for group access to information from specific customers. Customers might need to be associated with storerooms, organizations, sites, assets, solutions, classifications, and configuration items.

    In the Customers Agreements application, which can be opened by clicking Service Provider (SP) → Customer Agreements (SP), you can define agreements with your customers.

    3.2.20  Extra configuration

    Some extra system properties are shown in Table 3-2.

    Table 3-2   Extra properties

    
      
        	
          Property

        
        	
          Description

        
        	
          Default value

        
      

      
        	
          mxe.webclient.errortooltipwaitbeforeopen

        
        	
          The number of seconds before an error tooltip is displayed when a user drags the mouse over an error icon

        
        	
          Default Value = 2. Lower numbers result in better usability, but generate more server traffic

        
      

      
        	
          mxe.webclient.asyncrendertimelimit

        
        	
          Specifies the maximum number of seconds between the responses that are sent to the user interface when processing multiple asynchronous validation requests

        
        	
          Default Value = 15. Lower numbers result in better usability, but generate more server traffic

        
      

      
        	
          mxe.webclient.asyncrequestsbeforerender

        
        	
          Specifies the maximum number of concurrent asynchronous validation requests that the user interface framework processes before rendering a response

        
        	
          Default Value = 5. Lower numbers result in better usability, but generate more server traffic

        
      

      
        	
          mxe.webclient.ClientDataValidation

        
        	
          Speeds up response without requiring a trip to server. Validates user entries against a defined data type and size in domain. Validation is done within the browser

        
        	
          If value = 1 (default), the system uses Client Data validation If value = 0, it uses Server-side validation

        
      

      
        	
          mxe.webclient. ClientEventQueue.threshold

        
        	
          The maximum number of events that can be in the client event queue before they are sent to the server. The value is set low in Control Desk so UI is more responsive

        
        	
          If value = 0, the events are sent immediately.

          If value = 1, only data type validation is used, and errors are queued.

          If value = 2 (default), when there are two events in queue, they are sent to server.

          If value is 3 or higher, events are sent when that number is reached.

        
      

      
        	
          mxe.webclient. ClientEventQueue.timeout

        
        	
          The maximum time in milliseconds the client event queue waits before being sent to the server

        
        	
          Default value = 2000

        
      

      
        	
          mxe.webclient.listtable.retainstate

        
        	
          Manual refresh of list tab on each application

        
        	
          If value = 1 (default), the filters made on list tab are maintained if the user works on other tabs. 

          If value = 0, the filters made on list tab are not kept when user works on different tabs

        
      

      
        	
          mxe.retainrecord

        
        	
          Retain the state of application tabs and child tables when editing

        
        	
          Default value = 1

        
      

      
        	
          mxe.retainrecordlimit

        
        	
          Maximum records for which the table retains state

        
        	
          Default value = 200

        
      

      
        	
          mxe.server.enableCSRFBlocking

        
        	
          Enable checks for the Cross Site security

        
        	
          Default value = 1

        
      

      
        	
          mail.smtp.host

        
        	
          Represents the name of the host that runs the SMTP server

        
        	
          Default value = None

        
      

    

    3.3  Conclusion

    In this chapter, the options and configurations that are required for running the SmartCloud Control Desk were covered. It showed how to create organizations, security groups, persons, and classifications, and how to use them in SmartCloud Control Desk.

  
[image: ]
[image: ]

IT asset management

    This chapter provides an overview of IBM SmartCloud Control Desk capabilities. to help you achieve effective management of the entire IT asset lifecycle from planning through end of life. These capacities help lower cost, mitigate license and regulatory compliance risks, and better align IT with business goals.

    The key concepts and use cases describe the extensive list of features that IBM SmartCloud Control Desk provides for IT asset management. These include inventory management, procurement management, contract management, and financial management. This chapter covers product features specific to IT and how they can help you control today’s complex environments, including software license management and different representations of your IT resources. It provides detailed descriptions of asset and CI linkage concepts, and provides typical scenarios on how to manage assets and CIs together using IBM SmartCloud Control Desk.

    This chapter includes the following sections:

    •IT asset management process overview

    •IT asset management using IBM SmartCloud Control Desk

    •Integrations

    •Reports and KPIs

    •IT asset management for service providers

    4.1  IT asset management process overview

    IBM SmartCloud Control Desk is a product that provides a wide range of functions for hardware asset management and software license management. This section provides an overview of the IT asset management features in the product.

    The discipline of IT asset management borrows the practices and processes of enterprise asset management. One of the leading software solutions for enterprise asset management is IBM Maximo Asset Management. It has been adapted and enhanced over time to support IT asset management. The IT asset management version of the Maximo Asset Management product is now included in IBM SmartCloud Control Desk and is the primary focus of this chapter.

    4.1.1  IT resources representation

    This section describes key concepts for IT assets, and clarifies the different levels of representation and interactions with other types of records.

    IT assets and items

    An IT asset is any purchased, leased, or licensed hardware device, software product, or related contract service that supports business services. IT assets include financial and legal obligations.

    An item is an orderable entity, approved by the company’s policy. It can be associated with one or more vendors.

    Figure 4-1 shows the different types of items and their relation with assets or licenses.
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    Figure 4-1   Items and assets

    •Non-Rotating Items are consumed, not serialized, tracked, or managed with the inventory application.

    •Rotating Items are not consumed, but issued as assets, serialized when issued, and tracked throughout their lifecycle with the assets application.

    •Software Items are associated with a software catalog record, issued as licenses, and tracked throughout their lifecycle with the licenses application.

    Assets and licenses

    Licenses represent the software that is purchased by an organization. Assets and licenses represent the what-you-want view of your infrastructure. In this view, you find only resources that you consciously decide to manage by your processes. The what-you-want views are sometimes referred to as authorized assets and authorized licenses, but the official terms are assets and licenses. To place existing resources under management (in the what-you want view), you purchase or create new resources.

    To allow you to control the level of information you want to manage, IBM SmartCloud Control Desk provides another representation of both hardware assets and software assets. One view represents what-you-have, and is normally populated through an import of information from your Operational Management Products, such as Tivoli Application Dependency Discovery Manager, Tivoli Asset Discovery for Distributed, Tivoli Provisioning Manager, or Tivoli Endpoint Manager. Because the what-you-have views are populated by importing information, they include everything that your tools discover in the infrastructure. The resources that are represented in the what-you-have views are referred to as deployed assets and deployed software.

    To place deployed assets under management, you promote the what-you-have view. To link and compare deployed assets and assets, reconcile the what-you-want and what-you-have views. To ensure compliance between your licenses and deployed software, run audit reports.

    Figure 4-2 depicts the organization of IT assets resources that are managed by IBM SmartCloud Control Desk.
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    Figure 4-2   IT assets representation

    Assets and configuration items

    In IBM SmartCloud Control Desk, IT resources are represented in multiple ways because you most likely want to manage different aspects of them. 

    Some IT resources must be managed because they represent financial value to your business, and you must adhere to accounting requirements, demonstrate compliance, and manage contractual obligations and claims. These resources are called assets. Typically, you decide to manage your assets when they represent a value that is greater than the cost of management, or the cost of not managing the asset properly exceeds the cost of the asset. Managing IT assets typically involves controlling aspects such as identification, core attributes, physical location, ownership, accounting, licensing, warranties, and maintenance contracts.

    However, you can also manage the technical aspects of IT resources. Technical management involves managing the configuration of your resources as well as how they relate to, and depend on one another. It also includes management of changes to the resource configurations and their relationships to maintain control over the IT infrastructure and ensure that IT services are delivered according to your (contractual) obligations. In this context, resources are mostly intangible, and represent resources such as subnets, virtual systems, IP addresses, Java Platform, Enterprise Edition server instances, and business applications. Tangible resources, such as routers, computer systems, and storage devices, are also managed from a technical point of view. Commonly, technical resources are referred to as configuration items, or CIs.

    Within your IT infrastructure, you can have millions of CIs and thousands of assets. Most of these can be discovered by tools, and imported to IBM SmartCloud Control Desk. However, chances are that you do not want to manage all of them. Keyboards are considered commodities these days, and are so inexpensive that you most likely do not worry about managing them. The same might apply to monitors. For technical resources, you can discover details such as BIOS level, and detailed Java Platform, Enterprise Edition Server configuration parameters. However, it is again not likely that you want to manage all of these.

    To control the level of information you want to manage, IBM SmartCloud Control Desk provides two representations of both assets and CIs. One view represents what-you-have, and is normally populated by importing information from your Operational Management Products, such as Tivoli Application Dependency Discovery Manager, Tivoli Asset Discovery for Distributed, Tivoli Provisioning Manager, or Tivoli Endpoint Manager. Because the what-you-have views are populated from importing information, they include everything that your tools discover in the infrastructure. The resources that are represented in the what-you-have views are referred to as deployed assets and actual CIs.

    The other representation shows the what-you-want, or plan. In these views, you find only resources that you consciously decide to manage. The what-you-want views are sometimes referred to as authorized assets and authorized CIs, but the official terms are assets and configuration items. To place existing resources under management (in the what-you want view), promote discrete resources from the what-you-have views. When you are planning for new managed resources, create the new resources in the what-you-want views directly.

    Besides helping to control the amount of information to manage, having both the what-you-have and what-you-want views enables auditing and reconciliation. By comparing the plan (what-you-want) to the actual (what-you-have), you can determine whether the actual configuration of your resources matches what you authorized in the plan (what-you-want). The organization of the resources that are managed by IBM SmartCloud Control Desk can be depicted as shown in Figure 4-3.
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    Figure 4-3   IT resources representation

    Managed resources can be created directly by the Asset or Configuration Manager if you need to start managing a resource before it manifests itself as a physical entity in your IT infrastructure. Existing resources are imported so you are aware of their existence. If you want to manage them, promote them.

    When both the managed and the unmanaged resources are represented, use the reconciliation tasks built into IBM SmartCloud Control Desk to manually link created and discovered resources. When the managed and unmanaged resources are linked, the reconciliation tasks also identify differences between what-you-have and what-you-want. This information can be used in an audit process. You can then manually or automatically reconcile the two sides through promotion. The import → reconcile → promote loop is an on-going process that must be performed regularly so the Asset and Configuration Managers maintain the accuracy of the CMDB.

    Figure 4-4 shows the reconciliation process.
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    Figure 4-4   IT resources reconciliation

    Using reconciliation and promotion, you can understand how your managed and unmanaged resources are related to one another either from an administrative or a technical perspective. However, it does not help you access administrative management information when working in the technical space, or access technical information from the administrative management space. To access the sibling information, you must link the technical and administrative resources. To provide you with the flexibility to manage assets and configuration items independently of one another, the administrative and technical resources more or less are separate from each other. To integrate the two types of management, you must link managed CIs to assets.

    The linkage from the what-you-have (unmanaged) to the what-you-want (managed) representations can also be automated. When discovered resources are imported to populate the unmanaged resources, a Globally Unique Identifier (GUID) is generated by the import tool. This GUID is built from one or more sets of attributes that uniquely identify a resource. When the same data is used to import both deployed assets and actual CIs, the same attributes are provided, and the GUIDs assigned to the two resources are identical. The GUIDs can then be used to automatically link deployed assets and actual CIs so you have immediate access to related sibling resource when working with any unmanaged resource.

    Linking the managed resources provides a different challenge. The managed resources are often created before they are discovered, and in many instances the administrative and technical resources are created independently of one another. In addition, the information needed to construct a GUID that can be used for linkage is not available at creation time. The likelihood that the Asset Manager and Configuration Manager use the exact same attribute values is minimal. Therefore, you need another mechanism for linking managed resources.

    IBM SmartCloud Control Desk allows you to link managed resources in multiple ways. If the unmanaged siblings are not known, you can either manually provide the linkage information, or you can use a new reconciliation task to compare common attributes to find the resources that share a common set of attributes. This task can use attributes such as serial number or asset tag to try to identify matching Asset-CI pairs. However, if the unmanaged resources have been imported, the new reconciliation task uses the existing information to identify the link between the two managed resources. 

    By following the Configuration Item → Actual CI → Deployed Asset → Asset chain of links (Figure 4-5), the reconciliation task can determine which CI is related to which asset. For this automated linkage to work, all four representations of a resource must be available. So there is no need to analyze the chain starting from the asset.
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    Figure 4-5   IT resources chain of links

    In addition to providing the linkage information required to manage assets and configuration items together, the new reconciliation task also allows you to create generic resources. Generic resources are system created siblings that are created when the task detects that no sibling exists for a resource. Typically, this happens when an administrator creates an asset or a CI. This facility provides a convenient way for enhancing the collaboration between the Asset and Configuration Managers. For attributes that are common to the two types of managed resources, you can also enable automate synchronization to ensure consistency across management disciplines.

    Benefits of linking assets and CIs

    Many processes and resources are often involved in the delivery of IT services. All of these tasks and resources must be orchestrated so that the service is delivered in accordance with the specified service level agreements, and with minimal disruptions. 

    The complexity of IT environments has grown so much that it is impossible to manage them using pen and paper, or even spreadsheets. This lack of control can lead to service degradation or even unplanned outages because of the application of changes that lead to unexpected consequences. Powerful IT Service Management solutions like IBM SmartCloud Control Desk must be deployed in environments to help configure, orchestrate, plan, and implement changes and updates to the IT infrastructure. Especially in highly dynamic infrastructures such as cloud-based environments, tools to manage the ever-changing configuration are a must.

    The linkage between assets and CIs as provided by IBM SmartCloud Control Desk can facilitate the management of your IT infrastructure:

    •From an incident management perspective

    The SMART interface on a hard disk in a production server automatically sends an alert to notify you of the number of bad sectors detected. This alert is the basis for an incident. The incident manager will want to know whether the disk is under warranty. If the configuration item record that represents the error prone hard disk is not linked to the asset record that represents the same hard disk, the incident manager must manually find the contract that specifies the warranty status of the hard disk. 

    However, if the link between the CI and the asset exists, the related contract is only a few clicks away. This availability not only allows the Incident Manager to be more productive, but it also increases the possibility that the correct contract is identified.

    •From an asset management perspective

    For example, consider that a hardware asset manager responsible for the central server hardware is asked to withdraw some servers from services. The current servers consume too much power, and it was decided to consolidate the load on a new server to avoid an update to the cooling system in the data center. If the assets and CIs are not linked, there is no information in the asset data that shows the asset manager that the servers are actively in use and they support a vital business service. The asset manager is therefore not prevented from issuing a work order to dispose of the servers. However, if these links are in place, the system alerts the asset manager the operational state of the asset cannot be changed while the related CI supports live applications. In this case, the asset manager must wait for the change and configuration teams to do their job before the disposal can be activated. When the workload has been moved to the new server, the configuration manager changes the operational status of the CI to decomissioned. Because this state is not protected, the asset manager can then initiate the disposal.

    •From a change management perspective

    In this example, as part of the deployment of a new application, a new server is ordered. While waiting for delivery, the change to implement the server and all the software components that are needed progresses. If there is a link between the asset and the CI that represents the new server, the implementation task can be automatically started as soon as the status of the asset changes to inactive. This change of status typically happens when the server is received, physically installed, and powered on. If the asset-CI link does not exist, the start of the implementation task cannot be automated. It therefore must wait for the asset manager to convey the news to the change manager.

    •From the configuration management perspective

    Another scenario that demonstrates the benefits of linked assets and CIs is related to the provisioning of the new server. When the change request to deploy a new server is processed, the configuration management team is asked to create and configure the necessary configuration items.

    Benefits of generic asset and CI creation

    Besides the linking of existing assets and CIs, IBM SmartCloud Control Desk also supports the creation of generic assets and CIs. If enabled, sibling resources are automatically created when either a CI or an asset is created. Enabling this facility ensures that the asset and CI that represent the same resource are available simultaneously. It therefore allows for tighter integration between the asset and configuration management disciplines.

    •From the asset management perspective

    In this example, a new server is deployed into the infrastructure. After discovery, all the configuration items, including the computersystem and operatingsystem CIs, are registered as actual configuration items. The configuration manager decides that the server must be managed, so the actual CIs are promoted to the CI space. The standard linkage takes place, so if the asset that corresponds to the new computersystem CI exists, the two are linked. However, if there is no asset record, a generic asset is created, and its specification is copied from the CI. The specification of this generic asset can now be refined by the asset manager, who turns it into a normal asset with the correct classification and administrative information. In addition, if the reconciliation between deployed assets and assets is automated, the new asset is linked to the correct deployed asset. This in turn is linked to the actual CI, and the circle is completed.

    •From the configuration management perspective

    As part of the roll-out of a new application, the asset manager creates a number of assets that represent virtual machines, and allocates the necessary software licenses to them. In this case generic CIs are created that are used by the configuration manager to provide the configuration details of the servers. Because the generic CIs are linked to the asset records, the configuration manager can easily review the asset information to determine which servers assume which role. This is possible because specific DB, Java Platform, Enterprise Edition Server, and Web Server software licenses have already been allocated to the assets.

    Benefits of assets and CIs synchronization

    When assets and CIs are linked, you can use the synchronization feature to synchronize attributes that are common to both CIs and assets. You can configure IBM SmartCloud Control Desk to ensure that attributes are synchronized as soon as they are updated. Only common attributes such as customer, organization, site, location, serial number, and custom attributes with identical names are synchronized. In most cases, these attributes are updated by the asset manager. So you usually configure the synchronization to update the CIs when changes are made to the assets.

    The synchronization feature allows for better accuracy in your registrations, productivity gains, and enables greater level of automation.

    The use cases presented later in this chapter demonstrate how to put in action these new features for asset and CI linkage, generic creation of CI, and synchronization.

    4.1.2  IT asset lifecycle

    Assets have lifecycles, and an important function of any asset management process is to track an asset throughout its lifecycle. The asset management process must not just track the asset, but it must help the business make the transition to and be prepared for the different phases of the lifecycle. 

    IBM SmartCloud Control Desk can manage hardware and software assets using the IT asset management lifecycle from planning to retirement. Managing the lifecycle with IBM SmartCloud Control Desk aligns IT with your company strategy, and provides cost savings and improved business processes. As shown in Figure 4-6 on page 150, the asset management lifecycle includes the following phases:

    •Plan

    During the planning phase, an organization formulates a budget and an associated schedule for hardware and software acquisitions. The technology refresh cycle indicates when existing assets must be replaced based on company policy. Stockrooms are used to keep and check inventory before a purchase is made. During the planning phase, corporate strategic goals must also be kept in mind.

    •Acquire

    During the acquisition phase, assets are acquired, typically through purchase or lease. Critical information about the asset must be captured for the asset management process. A purchase order (PO) approval process must be in place to expedite the control of purchasing. Asset records can be created from a PO, receipt of an asset into inventory, or directly from a vendor.

    •Deploy

    During the deployment phase, assets are assigned either to an employee, project, or business unit. The status of the asset is tracked as it moves through its lifecycle. A system that enables communication with the user facilitates a smooth deployment. Ongoing reconciliation related to the user is also important: For instance, if a user moves to a new department or leaves the company, asset records related to the deployment of assets to that user must be updated. 

    Interaction with a service desk application, as provided by IBM SmartCloud Control Desk as a unified solution, can also be critical. For instance, the requirement for a new asset to be deployed might be generated due to an event handled by the service desk. Likewise, after a deployment is agreed upon, a service request is generated for a technician to assist with or perform the deployment.

    •Manage

    The manage phase includes the tracking of the asset and its ongoing care and feeding after it is deployed. In this phase, asset reconciliation between what is discovered versus what has been purchased occurs. Installs, Moves, Adds, and Changes (IMAC) must be recorded. Integration with change management processes such as requests for change (RFCs) can be implemented. During the manage phase, asset costs are managed through processes such as software license compliance, and monitoring stock rooms and software use.

    •Retire

    During the retire phase, an asset reaches the end of its life. The asset can be disposed of, auctioned, donated, sold to employees, or returned to the vendor when obtained through lease or rental.

    The IT asset management lifecycle, as shown in Figure 4-6, is an endless loop. When an asset is retired, the planning phase begins to determine how to replace the asset, if required.
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    Figure 4-6   IT asset lifecycle

    4.1.3  Relation to other processes

    IT asset management is related to other processes:

    •It works with financial management to control the costs of assets and track their value to the organization.

    •Compliance management ensures that IT assets comply with licensing, security, and other compliance issues.

    •IT asset management works with configuration management to make sure the assets in the assets database match configuration items in the Configuration Management Database (CMDB). Assets have a strong relationship with CIs. While an asset is in operation within the IT infrastructure, it might also be considered a configuration item. Thus, an asset has a longer lifecycle than a CI.

    For information about how IT assets and CIs work together using IBM SmartCloud Control Desk, see “Assets and configuration items” on page 140.

    4.1.4  IT asset management roles

    IBM SmartCloud Control Desk facilitates many tasks that are performed by people in traditional business process roles who might intervene during IT asset management lifecycle:

    •IT Managers can see how to streamline inventory and resources across the organization.

    •Operations Managers can see asset conditions in sufficient detail to improve asset usage and performance.

    •Purchasing Managers can see costs and orders enterprise-wide for price comparisons, discounting, standardization, and order tracking.

    •Hardware Asset Managers can see lease and maintenance status, and when to plan for upgrades.

    •Software Asset Managers can see how to optimize licensing to avoid over- or under-purchasing and mitigate compliance risks.

    •Financial Managers can see the entire inventory and analyze return on assets for financial reporting.

    •Risk Managers can see asset detail to ensure regulatory compliance and mitigate risk.

    •Contract Managers can see asset-related contracts, which helps negotiate with vendors and monitor supplier performance.

    •Maintenance Managers can see job plans enabled by availability information to increase asset capacity.

    •Facilities Managers can see assets in the data center to optimize power consumption and reduce unplanned outages.

    •Service Desk technicians can see asset data to streamline service request handling and expedite incident and problem resolution.

    To facilitate your implementation, IBM SmartCloud Control Desk optional content, which is installed from the launchpad, provides security groups already configured that cover these traditional business process roles, granting them access to necessary applications. 

    Table 4-1 shows the security groups that are included in IBM SmartCloud Control Desk optional content specific to IT asset management:

    Table 4-1   Optional content security groups for IT asset management

    
      
        	
          Security group

        
        	
          Description

        
      

      
        	
          ITAMACCTSPEC

        
        	
          IT asset management Accounting Support Specialist

        
      

      
        	
          ITAMADMIN

        
        	
          IT asset management administrator

        
      

      
        	
          ITAMENDUSER

        
        	
          IT asset management user

        
      

      
        	
          ITAMFINMGR

        
        	
          IT asset management financial manager

        
      

      
        	
          ITAMHAM

        
        	
          IT asset management hardware asset manager

        
      

      
        	
          ITAMINVADMIN

        
        	
          IT asset management inventory administrator

        
      

      
        	
          ITAMRECEIVER

        
        	
          IT asset management receiver

        
      

      
        	
          ITAMSAM

        
        	
          IT asset management software asset manager

        
      

    

    4.1.5  Product capabilities

    IBM SmartCloud Control Desk pulls together all the information necessary for the full spectrum of IT asset management. Direct integration is provided to Tivoli asset discovery products to provide full software asset management. 

    For information about integrating IBM SmartCloud Control Desk with asset discovery and license management products, see 4.3, “Integrations” on page 202.

    IBM SmartCloud Control Desk provides full asset lifecycle management support. It provides support for software asset management, including full support for software license management. It also identifies underused and overused software based on allocated capacity to reduce costs from over purchasing and to reduce risk from under purchasing.

    Table 4-2 provides a list of IT asset management capabilities with IBM SmartCloud Control Desk:

    Table 4-2   IT asset management capabilities

    
      
        	
          Discipline

        
        	
          Capabilities

        
      

      
        	
          Contract management

        
        	
          •Contract terms and conditions

          •Notifications

          •Software contracts

        
      

      
        	
          Financial management

        
        	
          •Purchase and Lease cost tracking

          •Work or Service cost tracking

          •Usage accounting

          •Total cost of ownership

        
      

      
        	
          Asset management

        
        	
          •Software asset management

          •Hardware asset tracking

          •Installs, moves, adds, changes

          •Reconciliation and audit

          •Extend beyond IT (data center facilities, power, and so on)

        
      

      
        	
          Services management

        
        	
          •Support service desk with asset configuration data

          •Service impact management

        
      

      
        	
          Procurement

        
        	
          •Procure based on standards

          •Create and route purchase requests

          •Use catalogs

          •Integrate with ERP systems

        
      

      
        	
          License management

        
        	
          •Full lifecycle support

          •Multiple license types supported

          •Audit ready reports

        
      

      
        	
          Work management

        
        	
          •Work planning and scheduling

          •Skills, labor, and inventory management

          •Service plans and cost management

        
      

      
        	
          Easy configuration

        
        	
          •UI, dashboards, KPIs, reports

          •Process workflows with alerts and escalations

          •New applications

        
      

    

    IBM SmartCloud Control Desk can help you to put strong workflow processes in place, and ensure that your IT asset management procedures are supported and followed.

     

    
      
        	
          Exception: IT asset management capabilities are not included in IBM SmartCloud Control Desk Entry Edition. The following modules and included applications, related to IT asset management, are not available in the entry edition:

          •Assets

          •Purchasing

          •Contracts

          •Inventory

        
      

    

    4.2  IT asset management using IBM SmartCloud Control Desk

    This section contains use cases that demonstrate IBM SmartCloud Control Desk capabilities for IT asset management, and design consideration, configuration tips, and best practices.

    The use cases do not demonstrate the capabilities of IBM SmartCloud Control Desk for inventory management, procurement management, contracts management, or financial management in any great detail, but rather focus on specifics for managing IT:

    •Management of the software catalog

    •Software license management, including creation of a new license, allocation to a computer, and license audit report

    •Reconciliation of assets and deployed assets

    •Promotion of a deployed asset

    •Asset and CI linkage

    For more information about the extensive capabilities of IBM SmartCloud Control Desk for inventory management, procurement management, contracts management, and financial management, see IT Asset Management Processes using Tivoli Asset Manager for IT, SG24-7601.

    4.2.1  IT asset management applications

    IBM SmartCloud Control Desk applications specific to IT asset management are grouped into the following modules and submodules:

    •The assets module contains applications for Assets and Licenses that show information about managed records (what-you-want view), and extra applications such as Locations, or Meters, that are used to manage your assets.

    •The deployed assets submodule contains applications such as Computers, Network Devices, Network Printers, and Deployed Software, which show information that is imported from discovery tools (what-you-have view).

    •The conversion submodule in the administration module contains applications that make information uniform and presentable.

    •The reconciliation application facilitates the linkage of discovered information to its authorized and financial aspects. The reconciliation applications are used to perform the following functions:

     –	Define reconciliation tasks that specify how to compare information from one data set with information in another data set.

     –	View and manage the results of reconciliations.

    •The contracts module contains applications to manage contracts for labor rates, purchases, leases, warranties, and software. You can create different types of contracts and define the rules that govern each type of contract.

    •The inventory module contains applications to manage your inventory of spare parts, maximize the availability of items for upcoming work tasks, and reduce excess inventory balances and related carrying costs.

    •The purchasing module contains applications to manage the purchasing process, including obtaining requests for quotes (RFQs), purchasing the materials and services, and then receiving and invoicing them. The application also helps you maintain information about the companies from which you purchase, and to integrate legal terms and conditions into the purchasing process.

    4.2.2  Managing the software catalog

    The software catalog provides a list of all software that can be discovered and licensed in the environment. It can be made up of software definitions from the Software Knowledge Base Toolkit or software titles identified by third-party discovery adapters. The later use cases provide general information about the software catalog, detailing how it can be imported into IBM SmartCloud Control Desk. They also provide configuration considerations to manage software hierarchy and software variants.

    Software catalog overview

    You use the software catalog application to locate and review the catalog data for software bundles, products, and components. In addition to viewing details about the software, you can find related license and software deployment information, and learn about related versions, releases, and parent-child relationships.

    The software catalog is a key component in software license management. The software product that is selected for software records (software items, licenses, and deployed software) must be defined in the software catalog. Therefore, it is critical that the software catalog is as complete as possible before you begin adding software records.

     

    
      
        	
          Important: The software catalog is a key component in software license management. It is the link between software items, license records, and deployed software.

        
      

    

    The software catalog records are viewed from the Software Catalog application, which can be accessed by clicking Go To → Administration → Deployed Assets → Software Catalog.

    Because it is portable, the software catalog can be imported into the IBM SmartCloud Control Desk database. There are two methods for importing a software catalog. First, you can directly import the software catalog that is published by IBM. Alternately, you can connect to the Software Knowledge Base Toolkit and import a published catalog. In this book, the first method is demonstrated.

     

    
      
        	
          Using Tivoli Asset Discovery for Distributed: if you are using Tivoli Asset Discovery for Distributed, which requires the Software Knowledge Base Toolkit, you might want to consider the second method for importing the software catalog. This method is preferable because it populates the software catalog in IBM SmartCloud Control Desk not only with the software catalog provided by IBM, but also any other software that is discovered with Tivoli Asset Discovery.

        
      

    

    Import the IBM software catalog

    This section describes the steps to manually import the latest Software Knowledge Base file, referred as software catalog, into IBM SmartCloud Control Desk. 

    The first step is to download the latest software catalog from IBM:

    ftp://ftp.software.ibm.com/software/tivoli_support/misc/CandO/TivoliCatalog/ibm/SwKBT/

    Figure 4-7 shows the files present on the FTP server at the time of writing.
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    Figure 4-7   Downloading the latest software catalog from IBM

    The name of the file to download is IBMSoftwareCatalog_canonical_form_yyyymmdd.zip where yyyymmdd is the date code when the file was released. It is updated at the beginning of a month and contains the catalog through the end of the previous month. In this compressed file is an XML file, similarly named, that is what is needed on the IBM SmartCloud Control Desk server.

    Next, the SWCATALOGIMPORT cron task must be set up. Open the cron task setup application by clicking Go To → System Configuration → Cron Task Setup, then open the SWCATALOGIMPORT record.

    Table 4-3 shows parameters that are used by the SWCATALOGIMPORT cron task to import the canonical software catalog that was downloaded from IBM.

    Table 4-3   SWCATALOGIMPORT cron task parameters

    
      
        	
          Parameter

        
        	
          Value

        
        	
          Description

        
      

      
        	
          HOSTNAME

        
        	
          [Leave blank]

        
        	
          Required to import the software catalog from the Software Base Tool Kit.

        
      

      
        	
          PARTIALRUN

        
        	
          6

        
        	
          Option 6 performs the following tasks:

          •Transform the .xsl file in the temporary directory.

          •Load the transformed files into the database using enterprise services.

        
      

      
        	
          PORT

        
        	
          [Leave blank]

        
        	
          Required to import the software catalog from the Software Base Tool Kit.

        
      

      
        	
          REPOSITORYID

        
        	
          [Leave blank]

        
        	
          Leaving this parameter blank turns off the verification.

        
      

      
        	
          TEMPDIR

        
        	
          /data/home/

        
        	
          Working directory where the software catalog file is located.

        
      

      
        	
          TEMPFILE

        
        	
          SwKBT.xml

        
        	
          Name of the canonical software catalog file. This file was renamed to a shorter name.

        
      

    

    After the cron task parameters are set, set the interval and enable the instance. Because this file is imported once, set the interval to a small value to get the import process going, then disable the cron task instance.

    Figure 4-8 shows the SWCATALOGIMPORT cron task after these changes.
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    Figure 4-8   SWCATALOGIMPORT cron task

    After the cron task starts, you see a processor usage increase and new records being added to the Systemout.log file. The time to process the file varies on memory and processor. A few hours is typical to process the entire file.

    The cron task parses the IBM software catalog to prepare it for import. After the file is parsed, the cron task imports the individual XML files created. As the files are imported, they are removed from the working directory. A few minutes after the cron task started, you can verify that SwKBT*.xml files have started to be created in the working directory.

    Figure 4-9 shows the files created by the cron task a few minutes after it was started.
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    Figure 4-9   XML files created by SWCATALOGIMPORT cron task

    By reviewing the history of the cron task, you can verify that it is complete. The cron task is complete when the End Time of the ACTION is updated. Figure 4-10 shows SWCATALOGIMPORT completed.
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    Figure 4-10   SWCATALOGIMPORT cron task complete

    Software hierarchy

    A software hierarchy is the combination of product, version, and release (or feature) that represents an item of software in a database or knowledge base. 

    Typically, the product is the root of the hierarchy, whereas versions and releases are associated to the product as related versions. 

    To align with their licensing model, users can define a product's software hierarchy in either Software Knowledge Base Toolkit or SmartCloud Control Desk at the product, version, and release or feature level.

    Software products, versions, and releases can be imported into SmartCloud Control Desk from the Software Knowledge Base Toolkit. In the Software Catalog application, you can use the Product Hierarchy tab to view the imported software hierarchy. When an import from Software Knowledge Base Toolkit is in place, the data that is provided is made read-only in the Software Catalog. Data that is imported from most other discovery tools can be manually organized into software product hierarchies. This gives businesses that work with discovery tools the same capabilities to define hierarchical structures as those that work with Software Knowledge Base Toolkit.

    As mentioned earlier, software is often licenses at the product top level. For example, when you purchase IBM WebSphere Portal Server, the license is independent of the version or release. You might have version 6, 7, and 8 installed and all of those versions fall under the license agreement for IBM WebSphere Portal Server. When you create the license record in IBM SmartCloud Control Desk, select the top-level product for IBM WebSphere Portal Server. Because the software catalog maintains the product hierarchy, the discovered versions that are related versions of the top level are included in audit reports for the license.

    Conversion variants

    The link between software in a license and discovered software is made by finding exact matches in the software names. When you are using IBM SmartCloud Control Desk and IBM Tivoli Asset Discovery for Distributed together, this link is automatic because they are both using the same software knowledge base. The link is also automatic when using IBM Tivoli Asset Discovery for z/OS®.

    However, if you use any other discovery tool, the discovery tool might use a slightly different software name. For example, in the software catalog, a software product name might be Microsoft Office, but is discovered as MS Office. Because the name does not match, the discovered software is not counted against the license when an audit report is run. To address this issue, you can define conversion variants. 

    A conversion variant is an alias of the preferred software name. In the software catalog, you can add conversion variants to software entries. You can then use the preferred software name in the license and any discovered variants are counted against the license.

    4.2.3  Software license management use cases

    Software license management begins after the software catalog of knowledge base data is imported into the Maximo database for SmartCloud Control Desk.

    This scenario demonstrates IBM SmartCloud Control Desk capabilities for software license management:

    •Acquisition

    •Allocation

    •Discovery

    •Audit

    Software acquisition and deployment

    The acquisition and deployment workflow for new software licenses using IBM SmartCloud Control Desk is depicted in Figure 4-11.
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    Figure 4-11   Software acquisition

    For this scenario, a new purchase requisition is created for an already existing software license. The purchase requisition is approved, and a purchase order is created. The ordered software items are then received so that capacity is added to the license record.

    Software purchase requisition

    The license record for which the purchase requisition is created already exists, but more capacity is required.

    The license record is associated to a software catalog product. An orderable software item, approved by company’s policies, is defined in the item master, and is associated to the same software catalog product as the license. As explained previously, the software catalog product acts as a link between the license and the software item. Therefore, the purchase requisition (PR) created from the license is on this software item. 

    Figure 4-12 shows an example of a software item.
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    Figure 4-12   Software item

    The acquisition of this software item is initiated from the License record by selecting the Create a PR action. The software lines table is prepopulated with the software items associated to that software catalog product as shown in Figure 4-13. The quantity must be entered.
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    Figure 4-13   Creating a PR from a license

    After the purchase requisition is approved, a purchase order can be created directly from the purchase requisition record by clicking Select Action Create PO.

    To view the purchase order, click Go To → Purchasing → Purchase Orders. The default status is waiting for approval, with all fields populated as per the purchase requisition, including the PO Lines table that is populated as per the items selected in the purchase requisition, as shown in Figure 4-14.
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    Figure 4-14   Software purchase order

    Receive software licenses

    After the purchase order is approved and the software is received or downloaded from the vendor, the ordered items must be allocated to the license record. This can be done by using the Receiving application, which is opened by clicking Go To → Purchasing → Receiving.

    In the Material Receipts tab, select the ordered Items to be received from the PO. After saving, the status of the purchase order changes to COMPLETE.

     

    
      
        	
          License Required flag: The License Required flag indicates that the software must be associated with a license. This flag is automatically set for every software material receipt in these circumstances:

          •Inspection status becomes COMP

          •Line points to a software item

          •Line has not been associated to a license

        
      

    

    In this scenario, the License Required flag is not set because the receipt line item is already associated with the license from where the purchase requisition was initially created. 

    As shown in Figure 4-15, by clicking Receive Software Licenses, a window opens that provides the capability to perform the following actions:

    •Create a license record for the received software items. To do so, click Create Licenses

    •Add the received software items as extra capacity to the associated license record by clicking OK. This is the option that is selected to complete the allocation phase of this scenario.
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    Figure 4-15   Receiving software licenses

    As a result, extra capacity, in the quantity of software items ordered and received, is added to the authorized license record.

    Software license allocation

    The license application allows you to define your license entitlements by defining the scope of the licenses, and allocating the licenses to locations, computer assets, partition assets, or application users, and to general ledger accounts.

    This scenario focuses on managing the capacity of the license according to the software items purchased and how it is allocated to computers. Figure 4-16 shows the license record, its authorized capacity as per the previous procurement use case, and the computer assets to which the license is allocated.
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    Figure 4-16   Software license allocation

    Note that the Allocated Capacity field matches the number of computer assets in the Allocations table. When a new row is added to the Allocations table, the Allocated Capacity is incremented as per the capacity allocated.

     

    
      
        	
          License over allocation: You can over-allocate license capacity. However, over-allocation is not recommended unless the license is subject to capacity realignment later, based on an evaluation of capacity growth. Saving a license record with over-allocated license capacity results in a negative value in the Available Capacity field. You also receive a message warning of the over-allocation.

        
      

    

    View deployed software

    IBM SmartCloud Control Desk provides different ways to see the software discovered in your infrastructure and imported into the product. This use case demonstrates how to view deployed software from the deployed software application and from the computers application.

    Deployed software application

    You can browse deployed software by opening the deployed software application. Click Go To → Assets → Deployed Assets → Deployed software. You can then see all deployed software records as imported from your discovery tools and the computers on which the software is installed as shown in Figure 4-17.
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    Figure 4-17   Viewing deployed software

    Open the records to see detailed information about the deployed software. This information includes information about the software product as defined in the software catalog, software installation details, and details about the computers and associated authorized assets where the software is installed.

    From the deployed software application, you can also define software that is running on a specific computer as exempted from the audit reports by using the Modify Software Use Exemption action. In this scenario, the computer Mobile06 is a development computer and all software that is installed on it is excluded from license audit reports as shown in Figure 4-18.
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    Figure 4-18   Modify software use exemption

    Computers application

    The Computers application displays information about hardware and software that is installed on computers that are deployed throughout your enterprise. The data is gathered by a discovery tool and imported into the database.

    To easily find the software product used in this scenario in the output from discovery, use the advanced search feature to filter the results on computers where the software product was actually discovered, as shown in Figure 4-19.
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    Figure 4-19   Computer application advanced search for software applications

    This query returns the same Computers list as seen previously in the deployed software application. Open a computer record to see all details as discovered and imported from your discovery tools. The list of applications discovered as installed on the computer is in the Software tab, under the Applications subtab, as shown in Figure 4-20.

    [image: ]

    Figure 4-20   Software applications that are installed on a computer

    Running and analyzing the license audit report

    This use case demonstrates how to run the install based audit report, and provides guidance on how to analyze the result to ensure compliance.

    Run license install based report

    From the license application, select Run reports, then select the type of report that corresponds to the software product licensing model. This scenario is based on an Installed based license. The results of the report display the associated product from the software catalog, the total license capacity that represents the purchased or authorized capacity, the discovered capacity that represents the actual software instances deployed in the infrastructure, and the variance. Figure 4-21 shows the result of the install based audit report.
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    Figure 4-21   License install based audit report

    By clicking the number reported for discovered capacity, another report window opens that displays details of the discovered system on which the software is discovered, as shown in Figure 4-22.

    [image: ]

    Figure 4-22   Software install based deployed details

    Analyze audit report

    The license application provides information about the authorized use of a specific software product. The audit report provides information about the actual use of the same software product. With both reports, the software management team can compare data, and ensure the software product as used in compliance with the company’s policies.

    In this scenario, it is first identified that the authorized allocated capacity does not match the discovered capacity, as shown in Table 4-4.

    Table 4-4   Allocated capacity versus discovered capacity

    
      
        	
          Authorized allocated capacity (as shown in the license record)

        
        	
          Discovered capacity (as shown in the audit report)

        
      

      
        	
          6

        
        	
          4

        
      

    

    A further analysis, comparing license allocation and discovered capacity details, shows that the discrepancies represent typical issues that can be encountered:

    •The license is allocated to deployed computer asset hostname1, but it is not reported. The software product is probably not installed yet.

    •Deployed computer asset hostname2 is shown on the report, but the license is not allocated to it. The software product was probably installed on the computer without permission.

    •Deployed computer asset Mobile06 is not shown on the report because it was exempted by using the Modify software use exemption for development reasons.

    Based on the results of your analysis, IBM SmartCloud Control Desk provides the capabilities to create work orders or tickets to resolve the issues.

    4.2.4  Hardware assets management use cases

    This scenario demonstrates IBM SmartCloud Control Desk capabilities for hardware assets management.

    •View discovered assets, either virtual or physical hardware

    •Promote a deployed asset to an authorized asset

    •Reconcile deployed assets and authorized assets

    Viewing discovered assets

    The Computers application, in the Deployed Assets submodule, provides a view of the discovered data that has been imported. There are several types of deployed computer assets. The asset does not have to be a physical computer. It can also be a virtual machine (VM) or a logical partition (LPAR). The Role field identifies the type of deployed computer asset. The role that is assigned can depend on the discovery tool used to discover the system.

    Viewing discovered virtual environment

    As an example, Figure 4-23 shows the Drilldown feature of IBM SmartCloud Control Desk that provides you a practical view of a virtualized environment. The deployed computer asset is a VMWare ESX server on which 20 virtual machines are running.
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    Figure 4-23   Deployed computer asset drilldown

    By clicking any of the virtual machine in the drilldown, the asset management team can navigate to the VM deployed computer asset records and see their details.

    Viewing discovered hardware assets

    The Computers application displays information about the computer itself. This includes the computer’s software, storage devices, processors, media adapters (such as sound and video cards), communication devices (such as modems and network adapters), network settings for TCP/IP and IPX, image devices (such as printers and scanners), monitors, users, and partitions.

    The data that are displayed in this application are gathered by a discovery tool and imported into the database.

     

    
      
        	
          Note: Data that the Computers application shows varies depending on the discovery tool that is used to collect the data. An empty field indicates that the discovery tool did not collect the data or that administrators did not map the data for import into the database.

        
      

    

    Figure 4-24 shows an example of a deployed computer asset as seen from the main tab of the Computers application.
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    Figure 4-24   Deployed computer asset

    The deployed computer asset that is shown in Figure 4-24 will be promoted to an authorized asset in the next use case.

    Promoting a deployed asset

    When following the IT asset lifecycle, an authorized asset record is typically acquired and created before it is deployed. However, in some cases it is possible to have assets that were deployed without going through the correct channels or deployed before the acquisition process was in place. When you find deployed assets that do not have a matching authorized asset, you can use the promote to asset feature to create an authorized asset record. 

     

    
      
        	
          Promote to asset feature: To manage the lifecyle of an asset, it must have an authorized asset. IBM SmartCloud Control Desk provides a promote to asset feature to create authorized assets records from deployed assets that do not have a matching authorized asset.

        
      

    

    With IBM SmartCloud Control Desk, you can promote deployed assets automatically through scheduled escalations or manually through an action in the Computers application. You can define default promotion values to use for scheduled and manual promotions. You must provide default values for Site ID and asset class, or the promotion will fail. A classification must be provided so that the asset generated is classified as an IT asset.

    For this scenario, the deployed computer asset hostname1.example.com does not have a matching asset record, so the promote to asset feature is used to create one.

    First, open the deployed computer asset in the Computers application, which is opened by clicking Go To → Assets → Deployed Assets → Computers.

    The View Asset action under More Actions in the navigation bar shows whether an asset is associated with the deployed asset. Figure 4-25 shows that there is no asset for this deployed asset.
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    Figure 4-25   View Asset window

    To create an authorized asset record for this deployed computer asset, select Promote to Asset to open the Promote to Assets window. Click Apply Defaults for the promotion values, then overwrite or complement these values for the deployed asset selected, as shown in Figure 4-26.

     

    
      
        	
          Promote parent and child assets: You can use the IBM SmartCloud Desk feature to promote parent and child partitions at the same time, which can be useful for managing virtualized environments. This can be enabled by selecting Promote partitions in the Promote Asset window. In that case, the item and classification that are specified for the parent computer or parent partition is assigned to the children.
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    Figure 4-26   Promote to Assets window

    Click OK to initiate the promotion. A system message about the newly created asset record number is shown as in Figure 4-27.
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    Figure 4-27   Promotion complete

    The deployed asset Promoted field now indicates that it was promoted to an authorized asset that can be viewed by opening the View Asset window. Figure 4-28 shows the asset that was promoted in this example.
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    Figure 4-28   View promoted asset

     

    
      
        	
          Consideration: When assets are promoted from discovered information instead of creating authorized asset records through the procurement process, there is no verification that the data in the discovered records actually matches the data in procurement records. You must have a business process that reconciles procurement records with discovered data to ensure that your authorized asset data is complete and accurate.

        
      

    

    Asset reconciliation

    Asset reconciliation is an important part of asset management. Reconciliation is the process of matching sets of information, and finding and investigating the differences. It is the capability of reconciling the differences between a physical inventory of what actually exists and the database accounting system of what you believe exists. This reconciliation is important for support reasons and, perhaps, even more important for financial and compliance management.

    The reconciliation process identifies successful matches as well as discrepancies and variances between the two sets of data. You can use the results of a reconciliation to determine whether the objects deployed comply with corporate plans. You can also use the results to determine whether the changes over the lifecycle of an object are in compliance with corporate policies.

    Discrepancies can be caused by these factors, among others:

    •Incorrect data entry

    •Modified equipment

    •Retired equipment

    •Theft

    •Unauthorized use of hardware and software in the enterprise

    To define the parameters for a reconciliation, create a reconciliation task. The reconciliation task combines the elements required for the reconciliation into a specific task and schedules the task for execution. A reconciliation task consists of the following components:

    •A task filter (optional), which defines a subset of either deployed assets or assets to reconcile.

    •One or more link rules (required), which establish a relationship between the top-level IT asset and a deployed asset.

    •One or more comparison rules (optional), which identify objects or attributes of a child or parent IT asset to compare with objects or attributes of a child or parent deployed asset.

    For this scenario, the reconciliation task provided with IBM SmartCloud Control Desk ITAMHardwareReconTask is described and run.

    Link rules

    A link rule is a required component of a reconciliation task. When a reconciliation task is processed, a link rule establishes the basis for reconciliation by identifying an attribute of a partition or top-level object in one data set to match with a specific attribute of a partition or top-level asset in another data set. The attributes that are most commonly used to link authorized IT assets with deployed assets are serial numbers and asset tags.

    A link rule is defined in the Link Rules application, and associated to the reconciliation task in the Link Rules table.

    ITAMHardwareReconTask in this scenario is associated to link rule ITAMHardwareLink as shown on Figure 4-29. 
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    Figure 4-29   Hardware link rule

    This rule links an asset to a deployed asset if the serial numbers attributes match or if the ASSETTAG attributes match. If a successful link is found, the reconciliation task compares the two records based on the comparison rule defined.

    Comparison rules

    A comparison rule is an optional component of a reconciliation task. It defines how to compare objects or attributes of a child or parent object in one data set with a child or parent object in another data set. 

    For example, you can define a comparison rule that evaluates whether the amount of RAM on the authorized asset matches the RAM on the deployed asset, or if the number and speed of processors are the same on authorized and deployed assets. 

    ITAMHardwareReconTask in this scenario is associated to the link rule ITAMHardwareLink as shown on Figure 4-30.

    [image: ]

    Figure 4-30   Comparison rule

    As an example, this comparison rule is based on attributes equality comparison. It specifies that the attribute in Data Set 1 (MACHNAME) must equal the attribute in Data Set 2 (NODENAME).

    Scheduling reconciliation tasks

    After you use the reconciliation module applications to define a reconciliation task, a cron task can be set up to process it on a scheduled basis.

     

    
      
        	
          Caution: Because reconciliation tasks process data imported into the system from external sources, you must exercise caution when scheduling reconciliation tasks. The timing of deployed asset data migration must be carefully coordinated with the reconciliation process. For example, do not attempt to reconcile data about deployed objects against authorized objects if you have not yet imported the deployed object data. 

        
      

    

    The follow steps are the high-level procedure for scheduling and running your reconciliation-related cron tasks:

    1.	Set up your cron tasks for reconciliation.

    2.	Collect data about actual deployed objects by using a discovery tool.

    3.	Import collected data into the database by using Integration Composer.

    4.	Optional: If you use the Deployed Assets Administration module applications to standardize naming conventions, set up software suites, or define software usage display options, make any changes necessary in those applications.

    5.	Run the cron task that processes reconciliation tasks.

    In this scenario, the reconciliation task is scheduled to run every day. The reconciliation results are updated after each execution of the cron task.

    Reconciliation results

    After a reconciliation task is run, you can view the results and resolve discrepancies or problems that you found. For IT assets, you can view and act upon results from reconciliation tasks in the Asset Link Results and Asset Reconciliation Results applications. An inventory administrator can review the results of the reconciliation, search on failed results, and create work orders as needed to synchronize the information or correct problems. After the reconciliation failure is investigated, the administrator can mark the record as resolved.

    The Asset Link Results application lists all successfully linked assets by link rule name along with the link date and time. The linked node, or deployed asset, is displayed with the linked asset as shown in Figure 4-31.
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    Figure 4-31   Asset link result

    In this scenario, the reconciliation task found a successful match for the assets that are listed in Table 4-5. This information is used in later use cases of this book.

    Table 4-5   Asset matches

    
      
        	
          Asset

        
        	
          Deployed asset

        
      

      
        	
          PULSE2077

        
        	
          CS1

        
      

      
        	
          PULSE2078

        
        	
          CS3

        
      

      
        	
          PULSE2079

        
        	
          CS0

        
      

      
        	
          PULSE2080

        
        	
          CS4

        
      

      
        	
          PULSE2081

        
        	
          CS2

        
      

    

    You use the Asset Reconciliation Results application to view and manage result records that are produced when the system runs a reconciliation task. In this application, you can view and manage two different kinds of results:

    •Link rule failure results

    A link failure occurs when the system processes a link rule and does not find a successful one-to-one link between the object in Data Set 1 and the object in Data Set 2. Link rule failures occur when the reconciliation process finds no links or finds multiple links. If multiple links are found, click Select Action → View Multi-Link Failures on the Asset Reconciliation Result tab to view a list of links that were found.

    In this scenario, the deployed asset hostname1.example.com, which was manually promoted to asset 2077, previously created a link rule failure result. Because an authorized asset already existed with a matching serial number, the manual promotion created a duplicate on the authorized level. 

    This was resolved by deleting the asset that was created during promotion, and documented in the Asset Reconciliation Results application as shown in Figure 4-32.
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    Figure 4-32   Asset link rule failure: More than one asset links to this deployed asset

    •Comparison rule results

    The system produces comparison rule results when it processes a comparison rule. The specific comparison rule data depends on a parameter that is set in the Reconciliation Tasks application, which lets you select one of the following options for comparison results when you define a reconciliation task:

     –	All results, both successful and failed matches.

     –	Instances where the object from Data Set 1 failed to reconcile against the object from Data Set 2.

     –	Instances where the object from Data Set 1 successfully matched the object from Data Set 2.

    The reconciliation task run in this use case was defined to report all reconciliation results. In case of failure, the Asset Reconciliation task application displays information from the authorized asset and the deployed asset side by side to allow further analysis as shown in Figure 4-33.
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    Figure 4-33   Asset reconciliation failed result 

    To manage remediation in case of reconciliation failure, you can use the Asset Reconciliation Results application to create tickets. Do so if a review of the reconciliation result indicates that an action is required to address a discrepancy between an authorized IT asset and a deployed asset. You can create the following kinds of tickets:

    •Service requests

    •Incidents

    •Problems

    •Work orders

    •Changes

    •Releases

    If appropriate, you can create escalations to generate tickets automatically. To create escalations, first create an action for the escalation in the Actions application, then define the escalation in the Escalations application.

     

    
      
        	
          Caution: Use caution when you create escalations for asset reconciliation results. Large numbers of asset reconciliation results might result in many tickets or work orders.

        
      

    

    Reconciliation results are also displayed in other applications:

    •Reconciliation failure flags are displayed in these locations:

     –	Detail section of the asset application

     –	Asset lookup for work orders and contracts

    •Reconciliation results are displayed the reconciliation results section of the asset IT details tab.

    •Reconciliation differences are displayed in the view asset window of the deployed asset.

    •The linked computer asset section identifies the corresponding authorized asset in the deployed software authorized tab.

    4.2.5  Assets and configuration items linkage use cases

    The following use cases demonstrate IBM SmartCloud Control Desk capabilities in terms of assets and CIs linkage as described in “Assets and configuration items” on page 140.

    Manual linking of assets and CIs

    Before describing the automated creation of the link between assets and CIs using reconciliation tasks, this use case shows how to create the link manually. Considering the quantity of CIs and assets that compose a typical IT infrastructure, a manual creation of asset and CI link might not be feasible. However, it helps to better understand the process. Also, it can be useful if the automated creation of the link cannot be established or if unmanaged resources have not been discovered yet. When manually linking resources, you are in total control of the process. You can apply your own rules for deciding which asset is linked to which CI, eliminating the need to match attributes.

    The manual creation of the link can start either from the CI side, or from the authorized asset. In the latter case, the CI that you want to link is selected from the IT Details tab of the Assets application, as shown in Figure 4-34.
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    Figure 4-34   Manual selection of the CI to link with the asset

    To verify that a similar link has been created from the CI to the asset, navigate to the CI application. Open the Configuration Item record, and notice that the Associated Asset field is populated with the ID and name of the asset, as shown in Figure 4-35.
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    Figure 4-35   Viewing an associated asset

    From the CI application, you can use IBM SmartCloud Control Desk to see when and who performed the linkage by using the View Asset-CI Link Details action as shown in Figure 4-36. The link method, User Interface in this case, provides helpful information as to how the link was created. If the link was created automatically, you also see information in the Link Rule field that helps you identify the definitions that led to the creation of the link. This information is valuable when you are investigating why, or why not, links are created.
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    Figure 4-36   View Asset-CI link details

    The benefits of linking resources are described in “Benefits of linking assets and CIs” on page 145. When you have the link directly available in the console, you can easily navigate between CIs and assets. The linkage provides higher productivity and ease-of-use when using the console. With it, you can automate processes and prevent actions based on events and the status of the related resources.

    From the Configuration Item record, you can use IBM SmartCloud Control Desk to access information about the asset by expanding the detail menu beside associated asset: 

    •Open Drill down

    •Classification

    •Attributes

    •View Contracts

    •View Work Details

    •View Asset Details

    Automated linking of assets and CIs

    As seen previously, you can create a manual link between assets and CIs in unusual scenarios where unmanaged resources have not been discovered yet or the reconciliation task cannot establish the link. However, when you import the latest set of discovered information related to both actual CIs and deployed assets, IBM SmartCloud Control Desk automatically links assets and CIs based on the relationships between the managed and unmanaged resources, and the relationship between the unmanaged siblings.

    Asset-CI reconciliation task

    To enable and facilitate this automated linkage, IBM SmartCloud Control Desk provides a reconciliation task between asset and CI: CCILinkAssetsAndCIs.

    The reconciliation between asset and CI is defined in the Reconciliation Task application. To access this application, click Go To → Administration → Reconciliation → Reconciliation Tasks. This is the same application that was used in previous examples to establish a link between assets and deployed assets.

    The match between assets and CIs is determined by running multiple comparisons. These can use either the discovered data of deployed assets and actual CIs (in particular, a universal identifier called a DIS GUID), or by using authorized data (such as a serial number) specified in the reconciliation task’s link rules.

    The default asset-CI reconciliation task, CCILinkAssetsAndCIs, does the asset-to-CI linking. The reconciliation task runs its automated tasks in the following order:

    1.	Discovered-data matching and linking

    The asset-CI reconciliation task run a background operation to try to match authorized assets to authorized CIs by matching the universal identifier on their unmanaged deployed asset and actual CI. The universal identifier is a DIS GUID, which is imported, discovered data.

    2.	Attribute matching and linking

    The reconciliation task processes its link rules. It can use the sample link rule, CCIAssetCISerialNum, if you include it, to match authorized assets and CIs by their serial number.

    If you added your own customized link rules that use one or more other attributes to identify matches, the reconciliation task tries to find and match assets and CIs that uniquely have those attributes and their values in common.

    After processing all the link rules, successful matches are linked.

    3.	Generic asset and CI creation

    Optionally, the asset-CI reconciliation task creates any generic assets or CIs needed to link any unmatched CIs and assets from the previous steps. Creation of generic CIs is described later in this use case.

    The link rule that is used by CCILinkAssetsAndCIs reconciliation task identifies common attribute between assets and CIs. Such an attribute can be the serial number, as shown in Figure 4-37 on page 191, but any attribute unique to the resource can be used.

     

    
      
        	
          Activation: The default reconciliation that links assets and CIs is not activated by default. You must enable the task before CIs and assets are linked automatically.

        
      

    

    [image: ]

    Figure 4-37   Asset-CI link rule

    The default reconciliation task that links assets and CIs uses the CCIAssetCISerialNum that has 11 link clauses that are defined as shown in Figure 4-37. They all look alike, but the details of each clause show that each one compares the COMPUTERSYSTEM_SERIALNUMBER for a specific computer system architecture CI Classification to the SERIALNUM attribute of the asset. Because the CIs are classified according to architecture, a link clause must be provided for each classification you want to include in the analysis. When an asset and CI are linked for the first time, their common attributes are synchronized based on the settings that are specified in the organization.

    Identify linked assets

    When the linkage Reconciliation Task is active and has run at least once, you can see which assets are linked to which CIs, and which rules were used to match them up. To find the resources that have been linked to one another by a reconciliation task, you normally use the Link Results application. However, this application only provides information about the linkage between authorized and unauthorized resources, such as links between deployed assets and assets, and links between actual CIs and CIs. To see the results of the asset and CI linkage, you must instead use the reports that are provided with IBM SmartCloud Control Desk:

    •If you are in the Assets application, you can select from these options:

     –	Assets Linked to CIs

     –	Assets Linked to Generic CIs

     –	Assets with Missing Generic CIs

    •If you are in the Configuration Items application, you can select from these options:

     –	CIs Linked to Assets

     –	CIs Linked to Generic Assets

     –	CIs with Missing Generic Assets

    Figure 4-38 shows the result of the Assets Linked to CIs report initiated from the Assets application.
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    Figure 4-38   Assets Linked to CIs report

    The results of the report show which assets are linked to which CIs, when they were linked, who linked them, and why they were linked. There are three different link methods that are shown in this report:

    •Reconciliation CCIAssetCIDISGUID: This applies to assets and CIs linked automatically by the reconciliation task based on their universal identifier, a DIS GUID, which is imported, discovered data. 

    •User Interface: This applies to assets and CIs linked manually, as shown previously.

    •Reconciliation CCIAssetCISerialNum: This applies to assets and CIs linked automatically by the reconciliation task based on link rule defined.

    Creation of generic CIs

    Previous use cases have demonstrated how existing assets and CIs can be linked, either manually or automatically, to integrate the tasks that are performed by the asset management team and the configuration management team.

    However, if one of the resources does not exist. IBM SmartCloud Control Desk allows you to automatically create a CI when the asset is created, or to automatically create an asset when a CI is created. It populates the newly created record with core attributes that apply to both the asset and the CI.

    For example, when planning for the addition of a server, you manually created an asset to manage ownership, status, accounting information, and location. This asset is also used to assign software licenses. To assign the server as the target of a change, the configuration item must exist. To create it, the configuration management team needs the basic information, which happens to be recorded in the asset.

    With IBM SmartCloud Control Desk, you can configure the solution to automatically create siblings for these unlinked assets and CIs. When the Asset-CI linkage task finds an unlinked asset or CI, it can create the sibling and populate the attributes for the sibling based on information from the target unlinked asset or CI. The link between the two is created as part of this process. The newly created sibling is referred to as a generic asset or CI because it most likely is missing important details. It is the responsibility of the Asset or Configuration Manager to ensure that the generic resource is properly registered and classified. When this process is complete, the generic resource becomes a normal managed resource.

    Enabling the creation of generic resources

    Generic resources are created only for resource types for which this feature is enabled. Therefore, you use the classification of the unlinked asset or CI resource to control whether the CCILinkAssetsAndCIs task creates generic sibling resources or not. By controlling the creation of generic resources through the classifications, IBM SmartCloud Control Desk allows for fine-grained control by allowing you to enable the creation of generic resources only for certain specific types of resources.

    In this scenario, the automatic creation of a generic CI is enabled for new assets classified as IT \ COMPUTER SYSTEM. A generic CI is then created automatically and linked to the asset in these circumstances:

    1.	No matching CI can be found for the new asset

    2.	Enough information is available to create the generic CI

    Figure 4-39 shows the Classifications application configured to enable creation of generic CIs to assets classified as IT \ COMPUTER SYSTEM.
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    Figure 4-39   Enabling creation of generic CI

    In this example, a new computer system is acquired as per the hardware asset lifecycle. Upon reception and inspection of the ordered item, the serial number is entered, and a new asset record is created and classified as a computer system.

     

    
      
        	
          Important: To successfully create the generic CI, the reconciliation task requires that you provide the attributes that support at least one link rule that is associated with the task. In this example, because the link rule associated with the task uses serial number, a serial number must be entered in the asset. Otherwise, the generic CI will not be created.

        
      

    

    During the next execution of the CCILinkAssetsAndCIs reconciliation task, no matching CI is found. Therefore, because the Autocreate Generic CI option is enabled for the classification of the asset, an attempt to create a generic CI is made. 

    As a result, an autonumbered generic CI is created. Its name and description can be viewed from the asset application in IT Details. For more details, such as link method and link rule that was used to link the resources, open View Asset-CI Link details window from the Select Action menu, as shown in Figure 4-40.

    [image: ]

    Figure 4-40   View Asset-CI Link Details window

    The generic CI that was created automatically can also be seen in the Assets linked to CIs report, as shown in Figure 4-41.
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    Figure 4-41   Assets Linked to CIs report

    When IBM SmartCloud Control Desk creates generic CIs, a special classification is used. In this example, the generic CI was automatically classified as CI.GENERIC_COMPUTERSYSTEM. 

    Using these special classifications makes it easy for the configuration manager to find the generic resources. Typically, it is the configuration management team’s responsibility to rename and reclassify the generic configuration item so that it is represented correctly in the CMDB.

    Synchronizing assets and CIs

    Assets and CIs both have attributes that specify which organization they belong to, their location, their asset tag and similar administrative information. In addition, you can add your own attributes to the relevant classifications to represent your own information.

    Assets and CIs can be updated independently of each other. For example, if you issue a Move/Modify for the asset, the common attributes in the corresponding CI are not updated. However, the attributes are changed if asset-CI synchronization is enabled.

    If synchronization between assets and CIs is enabled, it is run in the following situations:

    •At the time a key attribute is updated:

     –	In the Assets, Configuration Items, or Changes application

     –	From the integration framework

     –	By promotion

    •When an asset and CI are linked:

     –	Manually, in the assets of configuration items applications

     –	From the asset-CI reconciliation task

    •When a new specification is added to an asset or a CI classification

    If an asset and CI are not linked, they are not synchronized.

     

    
      
        	
          Remember: The synchronization feature does not create attributes for the resources involved. Synchronization only ensures the consistency of values for attributes that exist in both the asset and the CI in a linked asset-CI pair. Also, the synchronization operates independently of the CCILinkAssetsAndCIs reconciliation task. Synchronization takes place whenever updates to common attributes are detected, no matter if these updates originate from the console or a background task.

        
      

    

    When the asset-CI synchronization is enabled, it ensures that the values for the attributes listed in Table 4-6 are the same for assets and CIs in linked asset-CI pairs.

    Table 4-6   Attributes that are synchronized between assets and CIs

    
      
        	
          Asset

        
        	
          CI

        
      

      
        	
          SITEID

        
        	
          ASSETLOCSITEID

        
      

      
        	
          ORGID

        
        	
          ASSETLOCORGID

        
      

      
        	
          LOCATION

        
        	
          CILOCATION

        
      

      
        	
          SERIALNUM

        
        	
          COMPUTERSYSTEM_SERIALNUMBER

        
      

      
        	
          <ASSETATTRID>

        
        	
          <CIATTRID>

        
      

    

    The last line in Table 4-6 represents equally named attributes that exist in both the CI and asset in an asset-CI pair.

    Enabling asset to CI synchronization

    The enablement of the synchronization feature is controlled at the organization level. From the organization record, select the action CI and Asset synchronization to open the CI and Asset synchronization window as shown in Figure 4-42.
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    Figure 4-42   CI and Asset Synchronization window

    From the CI and Asset synchronization window, the synchronization is enabled by selecting Synchronize information between assets and CIs that are linked. This allows key attributes and equally named attributes to be replicated between assets and CIs, in both directions, upon modification.

    To specify the direction of the copy from the asset to the CI upon creation of a link between the resources, select Copy the asset information to the linked CI. 

    The settings also enable a button in the UI that allows you to immediately synchronize already linked assets and CIs from the Organizations application. The asset-CI reconciliation task does not have to be active to use this button.

    For this scenario, the synchronization is enabled, and the direction of the copy is configured to copy attributes from the asset to the IC when a new link is created. 

     

    
      
        	
          Direction of synchronization: When a new link between an existing asset and an existing CI is established, the direction of synchronization must be configured. The attributes are either copied from the asset to the CI, or from the CI to the asset. When both resources exist and are linked, a decision must be made on whether to synchronize common attributes. Enablement of synchronization and the direction the first time assets and CIs are linked is determined on the organization level.

        
      

    

    Copying asset attributes to the CI upon creation of a new link

    In this example, CI data has been entered manually or by using a spreadsheet and is not up to date. Then, asset data begins to be discovered and promoted to authorized assets. If the serial number is specified on both the asset and CI resources, the link is created during the next execution of the reconciliation cron task, and the outdated CI data will be updated.

    For example, the location was out of date on the CI. That is, before the execution of the reconciliation task, the location of the asset does not match the location of the CI. After the reconciliation task is run, the link is created because the link rule finds a match on the serial numbers. The location of the CI is then populated as per the asset’s location because the synchronization is enabled and the copy is configured from asset to CI.

    Synchronizing information between assets and CIs

    The previous use case showed how the synchronization works when assets and CIs are linked together. Later in the lifecycle of the resources, changes are made either on the asset authorized record or on the CI authorized record. 

    When synchronization is enabled between assets and CIs, any changes that are made on key attributes or equally named attributes are replicated to the linked sibling. 

    For this example, an attribute is created on the CI with the exact same name as an attribute that exists on the asset: CUSTOM_MACHINE_TAG. This attribute is created without a value, but is automatically populated upon saving. 

    The additional attribute was created on the linked CI itself for this example, so it is not associated to any other CI. It could have been created in the classification application so it is associated to all CIs using the classification.

    After the attribute exists with the exact same name on both resources, any changes that are applied to the attribute are replicated on the linked resource. This process works in both directions.

    4.3  Integrations

    This section provides more information about the IBM tools and products that contribute to an integrated IT asset management architecture. Figure 4-43 on page 203 provides an overall view of the following components of the IBM SmartCloud Control Desk family from an IT asset management point of view:

    •IBM SmartCloud Control Desk, which provides IT asset management capabilities

    •Software Knowledge Base Toolkit, which provides software catalog customization capabilities

    •IBM Tivoli Integration Composer, which is used to import discovered data into IBM SmartCloud Control Desk

    •IBM Tivoli Asset Discovery for Distributed, which provides discovery tools that are focused on software in a distributed environment

    •IBM Tivoli Asset Discovery for z/OS, which provides a discovery tool that is focused on software in a mainframe environment
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    Figure 4-43   Discovery and Integration architecture

    The family of products and tools together provide the full software license management. The products are tightly integrated by product provided adapters, launch-in-context capabilities, and a common software catalog.

    4.3.1  IBM discovery tools for IT assets

    IT asset management has two parts. First, you must track what you have purchased. Second, you must verify what was actually deployed. Often, there is a discrepancy between the two. This difference can be caused by many factors such as users installing software or assets being removed from service without permission.

    To verify what is actually deployed, you must implement a discovery tool. This section describes the discovery process. It focuses on IBM Tivoli Asset Discovery for Distributed and IBM Tivoli Endpoint Manager because of their tight integrations with IBM SmartCloud Control Desk.

    Discovery tools run the audit operation of the IT infrastructure to harvest IT asset details such as:

    •Asset location and current configuration

    •Changes to the assets that have taken place over time

    •Software installed on the assets

    The discovery is typically scheduled, but they can also be run on demand. The discovered assets can be reviewed before importing them into IBM SmartCloud Control Desk. After the discovered assets are loaded into the product’s database, they can be compared with authorized assets and licenses by using reconciliation tasks or audit reports.

    Tivoli Asset Discovery for Distributed

    IBM Tivoli Asset Discovery for Distributed consists of agents for various platforms. These agents collect hardware and software inventory and software use data from distributed networks. These data are then placed in a database. IBM Tivoli Asset Discovery for Distributed provides inventory validation and management of bundled products. IBM Tivoli Asset Discovery for Distributed runs on the IBM Tivoli Asset Discovery Server and has a separate user interface.

    IBM Tivoli Asset Discovery for Distributed uses the same software catalog as IBM SmartCloud Control Desk. By using the same catalog, it ensures that the discovered software is using the same software product names as the licences. Therefore, the link between licences and deployed software is established with minimal work.

    If you have agreed to IBM subcapacity pricing, you must use a discovery that supports the collection of PVU data. The only tools that collect this data are IBM Tivoli Asset Discovery for Distributed and IBM License Metric Tool. These tools share the code base. Therefore, deployment steps and administration tasks are the same. IBM License Metric Tool is a tool available at no extra fee that you can use to monitor your subcapacity PVU usage. However, it only supports IBM software monitoring. IBM Tivoli Asset Discovery for Distributed is a charged product that includes the following extra functionality:

    •Discovery of non-IBM software. The IBM License Metric Tool can only scan for IBM software

    •Discovery of unmatched registry entries. IBM License Metric Tool can only discover software that is included in the software catalog. IBM Tivoli Asset Discovery for Distributed can scan the operating system registry for unknown software that is not included in the software catalog. You can view the raw discovered data to identify software that you want to monitor. You can launch the Software Knowledge Base Toolkit in context to add the missing software product and signature. Software must be added to the software catalog to be managed.

    •Use data collection. IBM Tivoli Asset Discovery for Distributed can monitor when a software product is used. To be monitored, the software product must have a signature defined in the software catalog.

    •Integration with IBM SmartCloud Control Desk. The IBM License Metric Tool data cannot be imported into IBM SmartCloud control Desk. You must upgrade to IBM Tivoli Asset Discovery for Distributed to import discovery data.

    Software data collection in IBM Tivoli Asset Discovery for Distributed is a multi-step process:

    1.	The product is added to the software catalog.

    2.	The software catalog is imported into IBM Tivoli Asset Discovery for Distributed.

    3.	The catalogBuilder tasks prepare the catalog in a format that is consumable by the agents.

    4.	The agent downloads the catalog. The catalog downloaded to the agent contains the software signatures, and is platform specific. A catalog downloaded to a Linux agent contains Linux specific signatures.

    5.	The agent runs the software scan.

    6.	The agent uploads the inventory by component.

    7.	The inventoryBuilder task transforms the inventory by component into inventory by product. Software inventory for a product is not viewable until the inventoryBuilder task has run against it.

    8.	Once a day, aggregation runs to calculate PVU and use data. By default, collected PVU data must be at least two days old to be aggregated.

    9.	Bundle management is performed to refine the associations determined by the inventoryBuilder task. Bundle management is a manual process performed by a software asset manager.

    10.	The PVU audit report is reviewed for accuracy and signed.

    11.	Discovered data is imported into IBM SmartCloud Control Desk using IBM Tivoli Integration Composer.

    There are two types of hardware scans: Capacity and full.

    •On a regular basis, the agent scans for changes in processor information. This scan is called a capacity scan. A capacity scan is required to ensure that PVU calculations are accurate. The agent can also perform a full hardware scan to gather details about the asset. By default, a capacity scan occurs every 30 minutes.

    •A full hardware scan collects information such as network adapter, monitor, video card, and printer. For a full list of hardware information that is collected, see this website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v54r1/topic/com.ibm.tad4d75.doc/com.ibm.license.mgmt.admin.doc/r_hardware_scan.html

    Full hardware scans are scheduled by using scan groups. The default frequency for hardware scan is once a month. You can change this frequency at the scan group level. However, because hardware does not change frequently, once a month is normally sufficient.

    Software scans use the software catalog to discover installed software instances. You must ensure that the agents have the latest catalog so that it can discover all software that you want to monitor. You can verify the catalog version for agents in the IBM Tivoli Asset Discovery for Distributed console.

    Software scans are also scheduled by using scan groups. The default frequency for software is once a week. You can change this frequency at the scan group level. You might consider increasing the frequency if you are planning to install new software in your environment.

    Virtualization scans are run when an agent is installed on a guest system in a virtual environment such as VMWare. To properly calculate PVU data, IBM Tivoli Asset Discovery for Distributed must have visibility into the underlying physical infrastructure. When an agent is installed in a virtual machine, it does not have access to the physical system. Therefore, it must be able to communicate with the virtual machine manager of the virtual environment to gather that data. In a VMware environment, this manager is typically the vCenter. In a Microsoft environment, this manager is the Hyper-V server. A virtualization scan occurs every 30 minutes by default. It connects to the virtual machine manager and gathers data about the processor and processor count. The scan frequency can be changed by setting the vmManagerPollingInterval server setting. 

    A use scan is only run if you enable use data collection for a software product. The use scan collects use data at different levels. The default frequency is every 5 minutes. This frequency can be changed at the agent level.

    For more information about scan management, see the following website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v54r1/topic/com.ibm.tad4d75.doc/com.ibm.license.mgmt.admin.doc/c_software_scan_management.html

    Software Knowledge Base Toolkit

    The Software Knowledge Base Toolkit has two primary components:

    •The server: The server allows you to manage the knowledge base that is used by IBM SmartCloud Control Desk and IBM Tivoli Asset Discovery for Distributed. You can import the published IBM software catalog and add entries for software that is not in the IBM catalog.

    •The raw data collector: This component is optional. It allows you to collect raw signature data from a distributed environment. This data can be used to add signatures to the knowledge base for unknown software.

    The Software Knowledge Base Toolkit allows you to build and customize a software catalog to meet the needs of your organization. You can import the IBM catalog as a starting point. You can then manage the different software definitions in the knowledge base. After you have finished with the knowledge base, you can export it as a software catalog that can be used by other products.

    After you install the Software Knowledge Base Toolkit, import the latest IBM catalog. This step ensures that you have the latest software signatures and details from IBM. If you have software in your environment that is not included in the IBM catalog, you can add that information in the toolkit. The goal is to populate the software catalog so that it supports all of the software that you want to monitor.

    After you add all of the appropriate software, publish the catalog. Publishing the catalog makes it available to products such as IBM SmartCloud Control Desk and Tivoli Asset Discovery Asset for Distributed.

    When the catalog is published, you must import it into IBM SmartCloud Control Desk and IBM Tivoli Asset Discovery for Distributed. IBM SmartCloud Control Desk imports the software catalog through a cron task, and uses it to create software records (software items and licenses). IBM Tivoli Asset Discovery for Distributed uses the catalog to discover software instances and associate software bundles.

    Tivoli Endpoint Manager for Software Use Analysis

    The IBM Tivoli Endpoint Manager for Software Use Analysis is a relatively new product in the IBM portfolio. It uses IBM Tivoli Endpoint Manager to gather asset and software inventory information. These data can be used for software license compliance monitoring. IBM Tivoli Endpoint Manager for Software Use Analysis provides the following capabilities:

    •Harvests software inventory and usage data from the endpoint inventory data available in a Tivoli Endpoint Manager

    •Identifies licensed and unlicensed software with a drill-down granularity

    •Includes an embedded software catalog for software identification

    •Has broad software identification support in an endpoint environment

    IBM Tivoli Endpoint Manager for Software Use Analysis includes similar features to IBM Tivoli Asset Discovery for Distributed. However, it is not as tightly integrated with IBM SmartCloud Control Desk because it does not use the same software catalog. This integration will be improved over time.

    IBM Tivoli Application Dependency Discovery Manager

    The strength of IBM Tivoli Application Dependency Discovery Manager is its ability to gather information about processes that are running during discovery and the relationship between those processes. With IBM Tivoli Application Dependency Discovery Manager, you can see exactly what services and applications are in use. You can also see how the applications and services are being deployed in the network.

    The IBM Tivoli Application Dependency Discovery Manager discovery process automatically determines the relationships among running applications or services. With this information, IT administrators can confirm what is running on their network. The discovery process does not operate under any assumptions about what it is supposed to find when it runs.

    Based on what it discovers, it presents the applications that are running and how they are related. This process provides an accurate picture of the computing environment. After that information is known, IBM Tivoli Application Dependency Discovery Manager can begin tacking changes to the environment over time.

    These functions make IBM Tivoli Application Dependency Discovery Manager a key part of configuration management. Although the IBM Tivoli Application Dependency Discovery Manager discovered data can be imported into the deployed assets table and used for IT asset management in IBM SmartCloud Control Desk, it is not as strong as other tools for software license management. The basic discovery methods only find software that is running. Because of that fact, it does not always discover all the software that is installed. It also does not support licenses capacities such as PVU.

     

    
      
        	
          Note: IBM Tivoli Application Dependency Discovery Manager is the supported tool for the actual configuration item discovery for IBM SmartCloud Control Desk.

        
      

    

    IBM Discovery tools comparison

    Table 4-7 provides a comparison of previously described discovery products based on business goals.

    Table 4-7   IBM Discovery products comparison

    
      
        	
          Business Goals

        
        	
          IT Discipline

        
        	
          Discovery inventory use

        
        	
          High-level capability

        
        	
          Products

        
      

      
        	
          Software audit readiness

          Reduce software license costs

          Lower total cost of ownership

        
        	
          IT and software asset management

        
        	
          Software audit readiness

        
        	
          •Provides software inventory and use

          •Provides license use to support license compliance, especially in virtualized environments

          •Hardware asset management

          •Strong in the data center environment

        
        	
          Tivoli Asset Discovery for Distributed

        
      

      
        	
          Software audit readiness

          Reduce software license costs

           

        
        	
          Software asset management

        
        	
          Software audit readiness

        
        	
          •Provides software inventory and use

          •Provides license use to support license compliance

        
        	
          Tivoli Asset Discovery for z/OS

        
      

      
        	
          Software audit readiness

          Reduce software license costs

          Lower total cost of ownership

        
        	
          IT and software asset management

        
        	
          Software audit readiness

        
        	
          •Provides software inventory and use

          •Strong in the endpoint environment

        
        	
          Tivoli Endpoint Manager Software Use Analysis

        
      

      
        	
          Provisioning physical and virtual servers from OS to applications

          Base of cloud computing

          Optimize test environments

        
        	
          Infrastructure operations management

          Provisioning management

          Server configuration management

        
        	
          Hardware configuration

        
        	
          •Provisioning

          •Software distribution

          •Patch management

          •Configuration management

        
        	
          Tivoli Provisioning Manager

        
      

      
        	
          Fill the visibility gap between infrastructure and the services provided

          Proactively assess the potential impacts of problems and changes on the infrastructure

        
        	
          Infrastructure Configuration Discovery

        
        	
          Application relationship mapping

        
        	
          •Discover what exists with agentless, credentialless capability

          •Discover relationships between applications, middleware, servers, and networks components

          •Detailed operational configuration information

        
        	
          Tivoli Application Dependency Discovery Manager

        
      

    

    Other discovery tools

    You can use various other IBM and non-IBM discovery tools to collect hardware and software data.

    Independent of the discovery tool, you must use IBM Tivoli Integration Composer to import discovered data into IBM SmartCloud Control Desk. For a list of supported adapters, see this website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/topic/com.ibm.tusc.doc/int_comp/c_ic_adapters.html

    To integrate data from other discovery tools, use the Create Data Schema feature in IBM Tivoli Integration Composer to create a data schema for the discovery tool. After you create the data schema, you can create a mapping based on the new data schema. You can then use the mapping to import data into the target database. This requires specific database skill.

    4.3.2  IBM Tivoli Integration Composer

    After IT asset data is discovered, the data must be migrated into the IBM SmartCloud Control Desk database. IBM Tivoli Integration Composer is used to import these data. After the data are imported, you can view it in the Deployed Assets module through the Computers, Network Devices, Network Printers, and Deployed Software applications.

     

    
      
        	
          Note: Tivoli Integration Composer is also used to import configuration items that are discovered by IBM Tivoli Application Dependency and Discovery manager. The imported CIs can be seen in the Actual Configuration Items application. For more information, see Chapter 5, “Configuration management” on page 227. 

        
      

    

    Enterprise can aggregate data collected by disparate asset discovery tools and integrate it into IBM SmartCloud Control Desk. This integration provides a central repository for enterprise IT asset management, reporting, and decision support.

    The following terms describe features of the IBM Tivoli Integration Composer:

    •A data schema is a structure for organizing and classifying data in a database. It defines both the data contents and the relationships. Integration composer interprets data and changes it to the format required for the target database. These changes are based on the structures that are defined in the data schemas stored in the IBM Tivoli Integration Composer repository.

    •A data source is the actual data in a database that is organized in the structure defined by a data schema.

    •In IBM Tivoli Integration Composer, data schemas organize data into classes. A class is a group of data that has the same characteristics or properties. For example, you can define a class called Computer because computers share many characteristics or properties.

    •A property is an attribute or feature that characterizes a class. The collection of properties that are assigned to a class defines the class. A class can have multiple properties. For example, objects classified as computers have the following properties: Hardware ID, Manufacturer, Model, and Serial Number.

    •An instance is a specific object that belongs to a class. For example, the class Computer is characterized by the properties Hardware ID, Manufacturer, Model, and Serial Number. In this case, a specific instance of the class, the computer HQL2310, is characterized by the properties 0399433 (Hardware ID), IBM (Manufacturer), Pentium 4 (Model), and BAR445783 (Serial Number).

    •A mapping is a set of expressions that transform data when IBM Tivoli Integration Composer imports it from an external source into a target.

    •The Expression field contains the instruction that IBM Tivoli Integration Composer uses to transform data from the source format to the target format.

    Many adapters are provided with IBM Tivoli Integration Composer. For a list of supported adapters, see this website:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/topic/com.ibm.tusc.doc/int_comp/c_ic_adapters.html

    You can also create adapters for more discovery products, or refer to the Integrated Service Management Library open source repository where extra adapters are available:

    https://www-304.ibm.com/software/brandcatalog/ismlibrary/

    The IBM Tivoli Integration Composer user interface is used for these tasks:

    •Define data sources

    •Browse the source data

    •Define data schemas

    •Create mappings to transform

    •Import data

    The command-line interface is used to start IBM Tivoli Integration Composer and run mappings.

    The IBM Tivoli Integration Composer engine processes mapping expressions that transform data and integrate it into IBM SmartCloud Control Desk database.

    IBM Tivoli Integration Composer connection methods uses a JDBC driver or an API to establish connections to the source data location and target database. The following JDBC drivers are included:

    •IBM DB2 JDBC Driver

    •Microsoft SQL Driver

    •i-net OPTA JDBC Driver

    •Oracle JDBC Thin Driver

    The IBM Tivoli Integration Composer repository contains the following data:

    •Metadata for read only data schemas that are delivered with IBM Tivoli Integration Composer. This metadata defines the structure of the data.

    •Metadata for data schemas that you create in IBM Tivoli Integration Composer

    •Data source definitions that provide data connection parameters

    •Mappings that define how to transform data instances and import them from a source to a target.

    •The time stamp of the most recent scan for top-level objects in the source data of the IBM Tivoli Integration Composer repository, if such a time stamp exists.

    If you accept the default installation patch when installing IBM Tivoli Integration Composer, the installer creates an installation directory and installs the product using the file structure that is shown in Example 4-1.

    Example 4-1   IBM Tivoli Integration Composer file structure
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    Integration Composer

    	bin

    	data

    		dataschema

    		mappings

    		properties

    			provider

    			nrs

    	etc

    	genrules

    	help	

    	lib

    	log

    	Uninstall_Integration_Composer
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    The subdirectories in Example 4-1 on page 212 have these functions:

    •etc stores files that are used by the IBM Tivoli Application Dependency Discovery Manager software development kit. Do not modify any files in this subdirectory.

    •genrules stores Java sources files that IBM Tivoli Integration Composer creates when you run a mapping. Do not modify any files in this subdirectory.

    •help stores the IBM Tivoli Integration Composer online help files. Do not modify any files in this subdirectory.

    •lib stores JDBC drivers and application programming interfaces (APIs) that IBM Tivoli Integration Composer uses. Do not modify any files in this subdirectory.

    •log stores IBM Tivoli Integration Composer log files.

    •Uninstall_Integration_Composer stores the files that remove IBM Tivoli Integration Composer from your computer. Do not modify any files in this subdirectory.

    Figure 4-44 shows the IBM Tivoli Integration Composer main menu. Adapter setup and definition of data sources, schemas, and mappings must be completed before you import the data into IBM SmartCloud Control Desk. A system administrator performs the initial setup of IBM Tivoli Integration Composer.
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    Figure 4-44   IBM Tivoli Integration Composer main menu

    The menu provides access to the following functions:

    •Define new data source: Define a data source and set the database connectivity information

    •Browse data source by structure: Navigate the data schema using a tree and associated table view. If data exists, IBM Tivoli Integration Composer displays property or instance data in the table view.

    •Delete data source: Delete a data source if it is no longer needed and if no mapping currently uses it.

    •Close data source connection: Close a data source connection if it is no longer needed in the current session.

    •Create new mapping: Associate a source data source and target data source with a mapping.

    •Open existing mapping: View or modify an existing mapping. Create mapping expressions.

    •Delete mapping: Delete a mapping if it is no longer needed.

    •Delete mapping last scan history: Delete the last scan dates for each system in the selected data source. If a mapping is modified, the last scan history must be deleted for changes to take effect.

    •Define new data schema: Define a new data schema and specify its data source connection parameters. Add classes, properties, and relationships to a data schema. Import and export data schemas.

    •Open existing data schema: View or modify an existing data schema. Export a data schema file.

    After you define the data source, schema, and mapping in the tool, run the mapping from a command line or batch file. The .bat and .sh files are in the bin directory. To update data in the IBM SmartCloud Control Desk deployed assets tables, run an existing mapping as often as needed.

    Whenever IBM Tivoli Integration Composer runs a mapping, it provides information about mapping executions, dat transactions, and errors in the fusion.log file, which is in the log directory.

    In Example 4-2, the executeMapping.bat file is used to run a mapping. The file is in the bin directory. You can modify the file with the parameters required, or the parameters can be provided when you run the file. The parameters have the following sources:

    •Mapping Name: The mapping is created within IBM Tivoli Integration Composer. If an adapter is used, import the adapter and modify the mapping expressions if needed.

    •Repository user and password: IBM SmartCloud Control Desk is used to store all the adapter, data source, and last scan information.

    •Source user and password: This user and password is for the source discovery tool database.

    •Target user and password: This IBM SmartCloud Control Desk database contains the deployed assets.

    In addition, you can set the delete last scan history flag to refresh all of the data. Otherwise, the IBM Tivoli Integration Composer process compares the last scan date that is stored in the repository against the data from the source discovery tool. It then decides whether to skip, update, or insert records.

    Example 4-2   executeMapping.bat parameters
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    REM =======================================

    REM CHECK FOR DELETE LAST SCAN HISTORY FLAG

    REM =======================================

    set DELETE=

    if not {%1} == {-delete} goto setPropFile

    set DELETE=%1

    shift

     

    REM ============================

    REM CHECK FOR PROPERTY FILE FLAG

    REM ============================

    :setPropFile

    set FLAG=

    if not {%1} == {-f} goto setMappingParams

    set FLAG=%1

    set PROPFILE="%~$PATH:2"

    if '%PROPFILE%' == '' goto error8

    if not '%PROPFILE%' == '' goto runMappingWithf

     

    :setMappingParams

    set MAPPINGNAME=%1

    set REPOSITORYUSER=%2

    set REPOSITORYPWD=%3

    set SOURCEUSER=%4

    set SOURCEPWD=%5

    set TARGETUSER=%6

    set TARGETPWD=%7

     

    REM ==============================

    REM CHECK THE COMMAND LINE OPTIONS

    REM ==============================

    if '%MAPPINGNAME%'   == '' goto error1

    if '%REPOSITORYUSER%'  == '' goto error2

    if '%REPOSITORYPWD%'  == '' goto error3

    if '%SOURCEUSER%'    == '' goto error4

    if '%SOURCEPWD%'    == '' goto error5

    if '%TARGETUSER%'    == '' goto error6

    if '%TARGETPWD%'    == '' goto error7

     

    goto runMapping

     

    REM ===========================

    REM INVOKE INTEGRATION COMPOSER

    REM ===========================
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    Naming and Reconciliation Service (NRS) is an optional content that is implemented with IBM Tivoli Integration Composer. You can use NRS to uniquely identify deployed assets and avoid duplication of asset records in your database. By default, IBM Tivoli Integration Composer is configured to use this component. NRS assigns a globally unique identifier, the NRS GUID, to a deployed asset based on defined naming rules. Each naming rule consists of one or more attributes that are required to identify the asset. For example, there is a naming rule that is based on manufacturer, model, and serial number.

    NRS provides a way to centralize asset identification across multiple products that share a IBM SmartCloud Control Desk database. 

    4.4  Reports and KPIs

    For all phases of the asset management lifecycle, the ability to create reports or otherwise view the status of various assets is important.

    IBM SmartCloud Control Desk has a powerful reporting engine that enables administrators to schedule large batch reports, which can be automatically emailed to multiple recipients. Reports can be created in multiple formats such as PDF, DHTML, and XML, and revisions of past report output can be archived.

    You can use IBM SmartCloud Control Desk‘s powerful reporting tool to define and display key performance indicators (KPIs), which are active monitoring measurements that explain what is happening in the business environment. KPIs are available through the user interface, so users can quickly see how their day-to-day activities affect the KPI performance. KPIs can be displayed graphically and are color-coded according to customized targeted values or benchmarks.

    IBM SmartCloud Control Desk includes a set of built-in reports and key performance indicators (KPIs) specific to IT asset management.

    For the list of reports that are provided with IBM SmartCloud Control Desk, see Appendix B, “SmartCloud Control Desk Reports” on page 727. 

    4.4.1  KPIs

    IBM SmartCloud Control Desk includes a set of built-in KPIs that can be used to customize your start centers. KPIs provide graphical views that enable you to track critical performance variables over time. For example, an Asset Manager Start Center displays KPI graphs that show outstanding RFCs; the deployed assets updated within the last seven days; assets disposed of in the current year; and other KPIs that provide an overview of the assets in the environment. A KPI is a process-specific item that supports a particular business process.

    Table 4-8 describes the KPIs that are available as optional content.

    Table 4-8   IT asset management KPIs

    
      
        	
          KPI

        
        	
          Contents

        
      

      
        	
          HAMKPIOAUTH

        
        	
          Deployed Asset without Authorized Asset

        
      

      
        	
          HAMKPINOAUTHPER

        
        	
          Percentage Deployed Asset without Authorized Asset

        
      

      
        	
          HAMKPINODPA

        
        	
          Authorized Asset without Deployed Asset

        
      

      
        	
          HAMKPINODPAPER

        
        	
          Percentage Authorized Asset without Deployed Asset

        
      

      
        	
          INVDPA7

        
        	
          Deployed Assets updated within last 7 days

        
      

      
        	
          ITAMNONREPORT30

        
        	
          Deployed Assets not reporting in last 30 days

        
      

      
        	
          ITAMADMINUSERS

        
        	
          ITAMADMIN Logged in Users

        
      

      
        	
          ITAMACCTSPECUSE

        
        	
          ITAMACCTSPEC Logged in Users

        
      

      
        	
          ITAMFINMGRUSERS

        
        	
          ITAMFINMGR Logged in Users

        
      

      
        	
          ITAMENDUSERS

        
        	
          ITAMENDUSER Logged in Users

        
      

      
        	
          ITAMHAMUSERS

        
        	
          ITAMHAM Logged In Users

        
      

      
        	
          ITAMINVADMINUSE

        
        	
          ITAMINVADMIN Logged in Users

        
      

      
        	
          ITAMRECEIVERUSE

        
        	
          ITAMRECEIVER Logged in Users

        
      

      
        	
          ITAMSAMUSERS

        
        	
          ITAMSAM Logged in Users

        
      

      
        	
          ITDISPOSED

        
        	
          IT Assets Disposed in Current Year

        
      

      
        	
          ITWAITDISP

        
        	
          IT Assets waiting for disposal in a location

        
      

    

    4.5  IT asset management for service providers

    As explained in 2.3.1, “Editions” on page 65, IT asset management capabilities are not included in the IBM SmartCloud Control Desk Entry Edition. The following modules and included applications, related to IT asset management, are not available in the entry edition:

    •Assets

    •Purchasing

    •Contracts

    •Inventory

    The IBM SmartCloud Control Desk Advanced Edition and Service Provider contain the full IT asset management capabilities. Within the Service Provider edition, the IT asset management applications add functional enhancements and improve usability. The following sections address these enhancements.

    4.5.1  Customers and assets

    When you create customer records, you create detailed agreement and pricing information for the customer and the services that you expect to provide. As a result, you can ensure timely and accurate billing for services. After you create a customer record, you associate the customer with assets by using the Assets application.

     

    
      
        	
          Primary customer: The Assets (SP) application, which was rewritten for the Service Provider edition, adds a new Primary Customer field. It provides the capability to associate an asset with a particular customer. Note that you can associate an asset with multiple customers, but only one is the primary.

        
      

    

    By associating customers with assets, you keep the asset records restricted to users who have permission to access the data that belongs to that customer. You associate customers with users in the Security Groups (SP) application.

    You can associate more than one customer with an asset, but one customer must be the primary customer. The primary customer can then be used to find records for the customer. When a ticket or work order for the asset is created, information about the primary customer is copied to the ticket or work order. The combination of location, asset, and customer for these objects is used to determine the best matches when a service desk agent or workflow process searches for service level agreements, price schedules, and response plans.

    The primary customer of an asset determines the classifications and the attributes of classifications that an asset can use. All assets can use global classifications and global attributes that apply to the asset. If you want to use customer-specific classifications or customer-specific attributes, the primary customer of the asset (or parent of the primary customer) must match the customer on the classification or attribute.

    By default, the first customer that you associate with an asset is the primary customer. If you associate multiple customers with an asset at one time, the first customer alphabetically becomes the primary customer.

    When you associate a customer or primary customer with an asset, child assets do not inherit the association.

    You can change the primary customer for the asset at any time. If the asset is associated with a CI, and the Synchronize option in the Organizations (SP) application is selected, any change that you make to the asset customers is also made to the customers of the associated CI. That is, the CI customer associations are synchronized with the asset customer associations.

    Adding, changing, or removing a primary customer of an asset can affect the classification and attributes of the asset when the asset is classified. For example, as a result of a change, the classification of one or more attributes might no longer be relevant to the new primary customer. The classification might include attributes that are now relevant to the new primary customer. However, classifications and attributes are never automatically removed from an asset (or added to an asset) when a customer association is changed.

    4.5.2  Asset classifications

    Within the IBM SmartCloud Control Desk for Service Provider edition, there are two types of asset classifications:

    •Global classifications: Can be added to any asset, including assets with no customer associations.

    •Customer-specific classifications: Relevant only to certain customers. An asset can use customer-specific classifications only if the primary customer of the asset (or parent of the primary customer) is associated with the classification. 

    Attributes define the characteristics of a classification. When you classify an asset, attributes of the classification are copied to the Specification tab as determined by the primary customer of the asset. There are two types of attributes:

    •Global attributes: All assets can use global attributes, including assets with no customer associations.

    •Customer-specific attributes: Relevant only to certain customers. Customer-specific attributes are copied to the Specification tab when the primary customer of the asset (or parent of the primary customer) is associated with the attribute. 

    Customer and asset matches indicate whether an attribute is appropriate for the primary customer or the parent of the primary customer. The attributes that are copied from the classification to the asset specification are global attributes and customer-specific attributes that match the primary customer of the asset or the parent of the primary customer. If there is no primary customer when you classify the asset, only global attributes are copied.

    After you add a classification to an asset, several events can occur that might cause the asset specification to be unaligned with the attributes on the classification:

    •The primary customer is changed and the classification of the asset is not associated with either the customer or its parent.

    •The primary customer is changed and one or more of the attributes on the asset specification are not associated with the customer or its parent.

    •All customers that are associated with the asset are removed so that there is no longer a primary customer, but the classification of the asset is specific to the customer. Only global classifications must be referenced to the asset.

    •All the customers that are associated with the asset are removed so that there is no longer a primary customer. There are, however, one or more attributes on the specification of the asset that are inappropriate because they are specific to the customer. The specification of the asset must reference only global attributes.

    •An attribute is entered on the specification of the asset and this attribute does not belong to the specification of the classification.

    •The definition of the classification, attributes of the classification, or the customers associated with either the classification or the attributes of the classification might have changed.

    4.5.3  Customer synchronization

    Synchronization of customers for assets and configuration items (CIs) that are linked means that the customer records on the asset and the customer records on the configuration item must match exactly. For configuration items and assets that are linked, you can specify that their primary customer and any associated customers are to be synchronized. To achieve synchronization, asset customers are copied to the configuration item and replace the configuration item customers, or configuration item customers are copied to the asset and replace the asset customers.

    The Synchronize Customers Between Assets and CIs That Are Linked option on the Asset and CI Customer Options window in the Organizations (SP) application is selected by default. The default copy direction is from the asset to the configuration item. You can change the default copy direction so that it is from the configuration item to the asset.

    When Synchronize is selected, customer synchronization can occur in multiple scenarios:

    •When you click Synchronize Assets and CIs on the Asset and CI Customer Options window.

    •When you run background processes, such as cron tasks or workflows, that associate assets with configuration items.

    •When you link an asset to a configuration item in the Configuration Items application or the Assets application.

    •When you modify the customer or customers of an asset, and the asset is linked to a configuration item.

    •When you modify the customer or customers of a configuration item, and the configuration item is linked to an asset.

    Synchronization of customers for multiple linked assets and configuration items

    When you click Synchronize Assets and CIs, the Asset and CI Customer Options window operates on customers for all configuration items and assets that are linked. An administrator typically runs the Synchronize Assets and CIs action as a one-time operation for data cleanup. The action can be used to synchronize customers for linked assets and configuration items that have customers that became out of sync before the introduction of the synchronization feature. Depending on the specified direction of copy, configuration item customers are copied to the linked assets, or asset customers are copied to the linked configuration items. The copied customers replace the existing customers.

    Background processes such as cron tasks and workflows also can associate assets with configuration items. If the Synchronize option is selected, asset and configuration item customers are synchronized based on the direction of copy that is specified in the Asset and CI Customer Options window.

    Synchronization of customers when you associate an asset with a configuration item

    You can link or associate an asset with a configuration item in the Configuration Items application or in the Assets application. If Synchronize is selected, the asset and configuration item customers are synchronized when you link the asset and the configuration item. Customer synchronization occurs based on the direction of copy that is specified on the Asset and CI Customer Options window in the Organizations (SP) application.

    Synchronization when asset or configuration item customers are modified

    You can add or modify the primary customer and any associated customers for a single asset or configuration item on the asset record or the configuration item record. You can make three types of modifications to asset or configuration item customers:

    •Add one or more customers to the asset or configuration item.

    •Change the primary customer for the asset or configuration item.

    •Remove one or more customers from the asset or configuration item.

    You also can add or remove a customer for multiple assets or configuration items from the List tab of the Assets application or the Configuration Items application.

    If Synchronize is selected in the Organizations (SP) application, any customer revisions that you make are copied to the linked record or records. If you modify customers for an asset that is linked to a configuration item, the same modifications are made to the configuration item customers. The asset primary customer and any associated customers are copied to the configuration item and replace the configuration item customers. If you modify customers for a configuration item that is linked to an asset, the configuration item customers are copied to the asset and replace the asset customers. The copy direction is from the record that you modify to the linked record. The copy direction in these scenarios is not controlled by the copy direction that is specified on the Asset and CI Customer Options window in the Organizations (SP) application.

    4.5.4  Customers, locations, and service addresses

    IBM SmartCloud Control Desk Service Provider Edition allows you to associate customers to location records. When you associate customers with locations, you can keep the location records restricted to the users who have permission to access the data of that customer.

    You can associate more than one customer with a location, but one customer must be the primary customer. When a ticket or work order is created for the location, information about the primary customer is copied to the ticket or work order. The combination of location, asset, and customer on the ticket or work order is used to determine the best matches when a service desk agent or workflow process searches for service level agreements, price schedules, and response plans.

    The primary customer of a location determines the classifications and attributes of classifications that a location can use. All locations can use global classifications and global attributes that apply to the location. When you want to use customer-specific classifications or customer-specific attributes, the primary customer of the location (or parent of the primary customer) must match the customer on the classification or attribute.

    4.5.5  Service addresses

    A service address is the address where you provide support or services to a customer. The service address can represent one or more physical locations for a customer. Service addresses contain detailed location information that helps you assign the correct resources to a location.

    When a service desk agent creates a ticket or work order for a location, the service address of the location is copied to the ticket or work order. 

    If the location does not have an associated service address, the service address of the closest ancestor in the address hierarchy is copied. An ancestor is any location that is higher in the location hierarchy than the current location. In addition to a standard street address, a service address can contain detailed and varied location information, such as the following values:

    •“300 feet behind large red outbuilding”

    •“Mile marker 584”

    •“+42°30'39.57”N -71°14'39.96”W”

    4.5.6  Charge-back costs

    On a location record in the Locations (SP) application, you can enter a customer cost center and charge back account to use with billing transactions. Customers use this information to process internal charge backs.

    Enter charge back information in the Customer Charge Account and Customer Cost Center fields on the Location tab of the Locations (SP) application. When you create a ticket or work order for this location and customer, the charge account and cost center are copied to the ticket or work order. The charge account and cost center are then added to the customer billing statement when you bill the work.

    4.6  Conclusion

    This chapter provided a view of IBM SmartCloud Control Desk features that can help you achieve effective IT asset management in today’s complex IT environments. From inventory management to asset and CI management, through software license management, IBM SmartCloud Control Desk facilitates the management of IT assets through their entire lifecycle.

    Typical use cases were provided in this chapter to demonstrate the use of IBM SmartCloud Control Desk for software license management and hardware asset management. They provided a detailed description of the assets and configuration items are managed together.

    The next chapter takes a closer look at configuration management.
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Configuration management

    This chapter focuses on best practices to populate SmartCloud Control Desk with the necessary data to manage business systems and devices within your organization. 

    Configuration management focuses on the specific part of a device’s lifecycle when it is supporting the operations of your business. In SmartCloud Control Desk, configuration management provides the following capabilities:

    •Control the configuration of logical and physical aspects of a device.

    •Define a managed state for each device.

    •Audit the consistency between a device's expected configuration and its actual configuration.

    •Determine the risk that is associated with a device if it performs poorly or is taken offline.

    This chapter includes the following sections:

    •Configuration management overview

    •Using SmartCloud Control Desk with configuration management

    •Configuration management for service providers

    5.1  Configuration management overview

    In some organizations, the configuration of key business systems and devices are stored in spreadsheets and are updated and maintained by manual processes. These processes might include lengthy, redundant, and tedious manual steps that, even with considerable effort, might not be able to keep up with day to day operations. 

    Configuration management provides tremendous value by establishing an information repository to track your IT systems. This consists of information about a server such as memory, storage, and processors. It also includes relationships that show dependencies between IT components, and can help determine which of these components are critical to maintaining your key business systems and daily operations. 

    Configuration Items (CIs) represent IT resources, and their components, that contribute to a business service. Configuration Management is required to ensure that the Configuration Management Database (CMDB) represents them accurately, controls changes to them, audits them, reports on them, and so on. The main goal is to ensure that business service that they are contributing to is always up and running (or more realistically to minimize outages and ensure that outages are planned for). The CI’s role is to provide configuration details, status and security for any updates and changes made to it to ensure correct change control. 

    SmartCloud Control Desk serves as an information repository to establish processes and controls around your key IT components.

    5.2  Using SmartCloud Control Desk with configuration management

    This section focuses on the planning and deployment steps to use configuration management function within SmartCloud Control Desk. 

    5.2.1  Actual and authorized CIs

    A key configuration management feature of SmartCloud Control Desk is the ability to audit the expected configuration of an IT device versus its actual configuration. To achieve this in SmartCloud Control Desk, you need both Configuration Items (often referred to as authorized CIs) and Actual Configuration Items. 

    A Configuration Item object in SmartCloud Control Desk is a representation of how you want a particular device to be configured. This CI can represent either a physical device such as a server, or a logical aspect of a device such as a server's operating system or IP address. Attributes and relationships are used to manage how you want a device to be configured in your environment. Configuration Items are the main object used during configuration management in SmartCloud Control Desk, and are critical to supporting other SmartCloud Control Desk processes such as change management and service management. 

    The actual CIs are read only objects and are directly imported from Tivoli Application Dependency Discovery Manager by using the Integration Composer Actual CI adapter. The attribute values and relationships in the actual CI are exactly as Tivoli Application Dependency Discovery Manager discovered them when they were brought into SmartCloud Control Desk. The main benefit of actual CIs within SmartCloud Control Desk is to provide the real configuration of a device so that it can be audited against the managed version, the Configuration Item. 

    Each of these SmartCloud Control Desk objects has its own application (Configuration Items application and Actual CIs application). They represent different configurations of the same device (the real one versus the wanted one), and can be linked together. The CI.ACTCINUM field points to the ACTCI.ACTCINUM field to form this link. This link is used during the audit process to decide which actual CI to compare with which authorized CI.

    The Actual CI application is where you view data that are imported from Tivoli Application Dependency Discovery Manager, as shown in Figure 5-1.
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    Figure 5-1   The Actual CI application

    The Configuration Item application is where you view managed data, as shown in Figure 5-2.
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    Figure 5-2   The Configuration Item application

    Figure 5-1 on page 230 and Figure 5-2 show how the actual CI and authorized CI are linked by the Actual CI Number.

    To audit the managed configuration of your devices versus their actual configuration, you need both actual CIs and authorized CIs. However, you do not need to start with both of these objects. 

    There are two approaches to populating actual and authorized CIs to support Configuration Management in SmartCloud Control Desk:

    •Load the discovered CIs into SmartCloud Control Desk as actual CIs and then apply a template onto the actual CIs to create your authorized CIs. At this point, you have both actual CIs and authorized CIs, and can perform audits between them. This approach is called starting with actual CIs.

    •Use the integration framework, Quick Config application, or Manual CI creation from the Configuration Item application to populate authorized CIs. Later, you can load discovered CIs from Tivoli Application Dependency Discovery Manager into SmartCloud Control Desk as actual CIs. Then, you can use a linking process to establish the link between authorized CIs and actual CIs. At this point, you can perform the audit between your actual and managed configuration. This approach is called starting with authorized CIs.

    5.2.2   Starting with actual CIs

    This is the main path designed flow to populate authorized CIs into SmartCloud Control Desk. The main advantage of this approach is that when the authorized CIs are created from their actual CI counterparts, the two are linked together. This allows you to begin auditing between your actual and authorized configuration immediately. It is also the easier approach. The actual CI application allows you to use a template-based function to create authorized CIs. Therefore, you do not have to deal with manually creating all the authorized CIs, their attributes, and the relationships between them. When you start with actual CIs, you bypass the process of linking an authorized CI to its corresponding actual CI. You also avoid the potential for creating duplicate CIs during the promotion process. 

    To use this approach, you must first discover your CIs. If you need to manage the configuration of your devices before they are discovered, start with authorized CIs instead. 

    The steps to start with actual CIs can be logically divided into a plan and a deploy section: 

    •Plan

    The planning section consists of these steps:

    a.	Discover your devices by using Tivoli Application Dependency Discovery Manager or a Discovery Library Adapter.

    b.	Decide what type of authorized CIs that you want to manage.

    c.	Review the ready for use classifications that define the types of Authorized Configuration Items and the attributes that can be created in SmartCloud Control Desk. Modify these classifications as needed.

    d.	Review the ready for use promotion scopes, which determine which authorized CIs and Relationships are created when using the Actual CI application's Create Authorized CI feature. Modify these promotion scopes as needed.

    e.	Review the Relationship Rules that exist between the classifications of CIs that you are managing, and modify these rules as needed.

    f.	Use the CI Type application to configure which type of devices the Tivoli Integration Composer Actual CI adapter brings into SmartCloud Control Desk as actual CIs.

    g.	Decide which CI lifecycle you want to use for your authorized CIs. 

    •Deploy

    The deploying section consists of these steps:

    h.	Run the actual CI type adapter to load actual CIs into SmartCloud Control Desk if you discovered your devices using Tivoli Application Dependency Discovery Manager. Use the IdML loader if you discovered your devices using a Discovery Library Adapter.

    i.	Run Create Authorized CIs from the Actual CI application to populate authorized CIs into SmartCloud Control Desk.

     

    
      
        	
          Promotion: You often hear this process of creating authorized CIs from actual CIs referred to as promotion. When you hear someone say, “I need to promote my CIs”, they mean that they need to run the Create Authorized CI function from the Actual CI application to populate authorized CIs.

        
      

    

    j.	Use the CIs to support configuration management functions, such as viewing, modifying, or auditing CIs.

    k.	Repeat this process regularly as Tivoli Application Dependency Discovery Manager discovers changes in your environment. 

    The next sections take a closer look at each individual step of the process.

    Step 1: Discovery

    You can use Tivoli Application Dependency Discovery Manager to discover your infrastructure, or you can discover it directly by using discovery library adapters (DLA). If you use Tivoli Application Dependency Discovery Manager, your infrastructure is imported into SmartCloud Control Desk as Actual CIs using the Tivoli Integration Composer Actual CI Adapter. Otherwise, you can use the IdML Loader to import the IdML books that are created by your Discovery Library Adapters as Actual CIs. Your Tivoli Application Dependency Discovery Manager and DLA configuration directly affect what data is available to be imported into SmartCloud Control Desk. The rest of this step covers Tivoli Application Dependency Discovery Manager settings. Refer to your DLA documentation for settings specific to that discovery product.

    Before you begin, upgrade Tivoli Application Dependency Discovery Manager to version 7.2.1, and to the latest fixpack. This ensures integrity and compatibility between the common data model contained in SmartCloud Control Desk and the one contained in Tivoli Application Dependency Discovery Manager.

    Discovery is a multilevel process that collects CI data using specialized sensors for the different components that are found in the data center. Tivoli Application Dependency Discovery Manager provides three levels of pre-built profiles. These profiles cannot be changed, but they can be cloned.

    Level one discovery

    This type of discovery scans the TCP stack to discover computer systems and network devices. This is a shallow discovery to identify host name, OS, IP interface, and FQDN (for Windows and Linux for System z®, it also discovers the MAC address). 

    Level one is credential-free and provides a basic blueprint of the environment. However, move on to level two discovery before using Tivoli Integration Composer to import Tivoli Application Dependency Discovery Manager data. 

     

    
      
        	
          Warning: The use of level one discovery is discouraged if you will be importing this Tivoli Application Dependency Discovery Manager data into SCCD because of the lack of identifying information. If the CIs are discovered later using level 2 or level 3, different naming rules will be used. This causes the Tivoli Application Dependency Discovery Manager GUID to be modified, which leads to duplicate actual CIs in the SmartCloud Control Desk database. 

        
      

    

    Level two discovery

    Level 2 sensor scanning discovers detailed information about each host configuration and does a shallow application discovery. The application discovery captures the application name, ports, and computer systems it is running on. Application dependencies can also be discovered if there is a TCP session established. This scanning requires computer system credentials, but not application credentials.

    Level three discovery

    This is a deep-dive discovery of Tivoli Application Dependency Discovery Manager data. It captures network devices, host configurations, application configurations, virtual systems, and Web Services. 

    Level 3 discovery profile is used by default if no profile is specified (the profile default setting can be changed in the Discovery Management Console.) 

    Although Tivoli Application Dependency Discovery Manager provides four discovery profiles, level 1-3 and the Utilization profile, you can create your own specific discovery profiles. 

    This flexibility allows you to specify these aspects: 

    • What you want to discover 

    • Where you want to discover it 

    • How deep you want to go

    Based on your business needs, it is likely that you will want frequent depth two discoveries, and follow up with some depth three discoveries for other components.

    Available Tivoli Application Dependency Discovery Manager sensors:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v46r1/topic/com.ibm.taddmsensors.doc_721fp3/welcome_page/welcome.html

    Tivoli Application Dependency Discovery Manager level 1 discovery overview:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v46r1/topic/com.ibm.taddm.doc_721/AdminGuide/t_cmdb_configure_l1discovery.html

    Tivoli Application Dependency Discovery Manager level 2 discovery overview:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v46r1/topic/com.ibm.taddm.doc_721/AdminGuide/t_cmdb_configure_l2discovery.html

    Tivoli Application Dependency Discovery Manager level 3 discovery overview:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v46r1/topic/com.ibm.taddm.doc_721/AdminGuide/t_cmdb_configure_l3discovery.html

    Step 2: Deciding what type of CIs to manage 

    Before bringing data from Tivoli Application Dependency Discovery Manager into SmartCloud Control Desk, decide which type of devices and which logical components of these devices that you want to manage. It is not likely that you really care to make a change request on a low-level CI such as a Network Interface Card. The more CI types that you try to manage, the more difficult it is to focus on and work with the most important components in your environment. These low-level components can show up in topology reports and audit results. While it is possible to filter them out, if you do not intend to manage a CI type, it is best to leave it out. You can always look at the actual CI or launch-in-context to Tivoli Application Dependency Discovery Manager to view lower-level details if needed

    When choosing your CI types to manage, the best place to start is with the ready for use classifications that are called the best practices. These are classifications that have CIROOT as the parent classification as shown in Figure 5-3.
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    Figure 5-3   Filter using CIROOT as the Classification Path

    Click Find to display all classifications with CIROOT as the parent classification, which all have a prefix of “CI”, as shown in Figure 5-4.
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    Figure 5-4   All CIROOT classifications

    The best practice classifications are a subset of the actual CI Classifications, which are available with the software. The Actual Classifications are often referred to as the Common Data Model (CDM). This is because they are based on the common data model that is used to form the Tivoli Application Dependency Discovery Manager CI Types. Because actual CIs represent data that are discovered in Tivoli Application Dependency Discovery Manager, it makes sense to have classifications that are based on the same data model as Tivoli Application Dependency Discovery Manager.

    Figure 5-5 shows the filter using ACTUALCIROOTCLASS as the Classification Path to view the Common Data Model classifications.
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    Figure 5-5   Filter using ACTUALCIROOTCLASS as the Classification Path

    Click Find to display all classifications with ACTUALCIROOTCLASS as the parent classification (Figure 5-6).
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    Figure 5-6   All ACTUALCIROOTCLASS classifications

    Because the best practice classifications are for Authorized Configuration Items, they only represent the CIs that you want to manage. The best practice classifications are a set of CI Classifications that are designed by SmartCloud Control Desk architects using experience and feedback as the starting point. Each best practice classification has a corresponding actual CI Classification.

    Look through the best practice classifications to decide whether there are any CI types that you never want to manage. Record the CI types that you do not need, and save them for step 4.

    Also, look at the Actual Classifications to see whether there are any CI types that you know Tivoli Application Dependency Discovery Manager has discovered and you want to manage. Again, record this information down and save it for step 4.

    As you plan for step 4 and step 6, it is important to understand what a top-level CI is. Although the Common Data Model and Tivoli Application Dependency Discovery Manager do not recognize the term top-level CI, it is important in SmartCloud Control Desk. Because CIs can be related to each other, you need a starting point for selecting a group of CIs that are all related to each other in a hierarchy. The top-level CI is the root of this hierarchy. For example, you can have a computer system, its operating system, its file system, its IP interfaces, and its IP addresses. The computer system is considered the top-level CI because that is the starting point if you were to select all of these related CIs. In this case, the computer system contains all of those other CIs. 

    In SmartCloud Control Desk, a top-level CI is any CI whose classification has the attribute toplevel set to true, as indicated with the Top Level check box in Figure 5-7.

    [image: ]

    Figure 5-7   The Top Level field determines whether a classification is designated as top level

    The following CI types are designated as top level in the best practice authorized classifications:

    •CI.AIXCOMPUTERSYSTEM

    •CI.APPSERVER

    •CI.BUSINESSAPPLICATION

    •CI.BUSINESSPROCESS

    •CI.BUSINESSSERVICE

    •CI.CITRIXSERVER

    •CI.COMPUTERSYSTEM

    •CI.DATABASESERVER

    •CI.DB2SYSTEM

    •CI.EXCHANGESERVER

    •CI.HPUXCOMPUTERSYSTEM

    •CI.IISWEBSERVICE

    •CI.IPLANETSERVER

    •CI.JBOSSSERVER

    •CI.J2EEDOMAIN

    •CI.J2EESERVER

    •CI.LDAPSERVICE

    •CI.LINUXCOMPUTERSYSTEM

    •CI.LOTUS.DOMINOSERVER

    •CI.MQQUEUEMANAGER

    •CI.MYSAPAPPSERVER

    •CI.ORACLESERVER

    •CI.SERVICE

    •CI.SOFTWAREIMAGE

    •CI.SMSSITESERVER

    •CI.SQLSERVER

    •CI.SUNCOMPUTERSYSTEM

    •CI.SYSTEMPCOMPUTERSYSTEM

    •CI.UNITARYCOMPUTERSYSTEM

    •CI.VMWARECOMPUTERSYSTEM

    •CI.WEBLOGICSERVER

    •CI.WEBSERVER

    •CI.WEBSERVICE

    •CI.WEBSPHERESERVER

    •CI.WINDOWSCOMPUTERSYSTEM

    •CI.ZSERIESCOMPUTERSYSTEM

    During this planning phase, when you are working on CI types that you want to manage, you might want to rename the best practice classifications. For example, you might decide to change CI.COMPUTERSYSTEM to CI.CS, or change the prefix to the initials of your company. Although SmartCloud Control Desk allows you this flexibility, these changes require a large amount of configuration changes. Consider this additional workload when making your decision.

    To help you take advantage of SmartCloud Control Desk immediately, ready for use configurations are provided for many functions. In many cases, these configurations are based on the best practice classifications. Unfortunately, if you modify the name of a classification, you must create a new internal ID for that classification. You must therefore reconfigure many of the ready for use best practices. The following are functions that have ready for use configuration and require extra configuration if the classification names are altered:

    •CI Summary views on the Configuration Item application. This refers to the tabs that show the related CIs and key attributes on the CI Summary Tab. Refer to the InfoCenter to learn more about configuring these views:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_simplified_ci_views.html

    •Topology Swim Lanes allow you to group your CIs into a logical order when viewing the topology of a CI. Refer to this InfoCenter link to learn more about configuring topology swim lanes:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/ticket/sd_navigatetopo.html

    •Impact Analysis has rule to configure which related CI is impacted if a CI performs poorly or is taken of line. Refer to this InfoCenter link to learn more about configuring impact analysis rules:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/change/r_iaconfig_app.html

    •Link to Actual Has Naming Rules that determine how to link actual and authorized CIs. Refer to this InfoCenter link to learn more about configuring naming rules for Link to Actuals:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_autolink_naming_rules.html

    •Create authorized CIs uses promotion scopes that are based on the best practice classifications. Refer to this InfoCenter link to learn more about using Deployer’s Workbench to configure your promotion scopes:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.dw.doc_75/dw/t_dw_create_scope.html

    Step 3: Keeping or modifying authorized attributes

    After you decide what CI types you want to manage, you must consider which attributes to keep. The attributes on the authorized CI classification are one of the ways that you scope the discovered data from Tivoli Application Dependency Discovery Manager. If an attribute is not defined on an authorized classification, its value is not brought over to the authorized side, even if that attribute was discovered. 

    The choices that you make here also affect the attributes that are created for each actual CI that Tivoli Integration Composer loads if Tivoli Integration Composer filtering is turned on. This is addressed in Step 6. 

    It is important to consider which attributes you need on your authorized CI classifications. The best practice classifications are configured with a set of attributes that are chosen by SmartCloud Control Desk architects based on experience and feedback. You can use the Classification application to modify, remove, or to add attributes as shown in Figure 5-8.

    [image: ]

    Figure 5-8   Add, remove, and modify attributes in the Classification application

    Look through the best practice classifications to decide whether there are any attributes that you never want to manage. If you decide to remove attributes, you can use the classification application or Deployers Workbench to do so. 

    Also, look at the Actual Classifications to see if there are any additional attributes that you know Tivoli Application Dependency Discovery Manager will discover and you want to manage on your authorized side. Again, you can use the classification application or Deployers Workbench to do so. 

    When you make these decisions, your choices affect many aspects of configuration management using SmartCloud Control Desk. The fewer the attributes on a CI, the easier it is to maintain your authorized CI space:

    •It makes viewing and saving a configuration item easier because there are fewer attributes to manage.

    •It also helps when you start to analyze the auditing results. The more attributes that you have, the more audit records you can see, which makes it harder for you to find the attributes that you really care about. 

    •The number of attributes you have also affects the performance of Tivoli Integration Composer, promotion, and the audit process. 

    Step 4: Configuring promotion scope and relationships

    The promotion scope is what maps an actual CI to an authorized CI during the promotion process. As mentioned earlier, promotion is the term used to define running the Create Authorized CI function to create authorized CIs out of actual CIs. This mapping is the key to deciding which type of authorized CI is created for a particular actual CI. 

    The Top Level CI classification is important to promotion because a promotion scope starts with a top level authorized CI Classification. Figure 5-9 shows an example of a promotion scope.
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    Figure 5-9   Promotion scope for CI.COMPUTERSYSTEM

    Figure 5-9 on page 245 shows the Authorized Classification on the left and the actual CI Classification on the right. CI.COMPUTERSYSTEM is a top-level CI and is the start of this promotion scope. 

    If you promote an actual CI of type SYS.COMPUTERSYSTEM, you get an authorized CI of type CI.COMPUTERSYSTEM. 

    In addition to the top-level CI type, each promotion scope also provides a template for the related CIs as well. In this case, CIs of type SYS.OPERATINGSYSTEM, NET.INTERFACE, and NET.IPADDRESS are also included in the promotion scope. If you promote a SYS.COMPUTERSYSTEM actual CI and that actual CI is related to (directly or indirectly) an actual CI of type SYS.OPERATINGSYSTEM, an authorized CI of CI.OS is created.

    One more important configuration must be in place for CI.OPERATINGSYSTEM in the example to be created during promotion. That is a relation rule. A relation rule says that a CI of Type A and CI of Type B can be related by a certain relationship. The relation rule also identifies which is the parent in the relationship. Relation rules are defined for specific classifications, so there is a set of relation rules for actual classifications and a set of relation rules for authorized classifications. Relation rules are predefined for both the CDM actual CI Classifications and the best practice authorized classifications. For more information about relation rules, see “Step 7: Reviewing the CI Lifecycle” on page 249.

    You can use either simple best practices or comprehensive best practices. The best practice that is predefined in SmartCloud Control Desk is the simple one. Both best practices include the same classifications, relation rules, and attributes. The comprehensive best practice includes extra promotion scopes so that during promotion, more authorized CIs can be created.

    If you want to load the comprehensive best practice promotion scope, use the Deployer’s Workbench. For more information, see the InfoCenter at: 

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/index.jsp?topic=%2Fcom.ibm.dw.doc_75%2Fdw%2Ft_dw_scenario_default.html 

    Now, look at the list of CI types that you do not want to manage. Use Deployer’s Workbench to remove promotion scopes of CI types that you do not want to manage. Create promotion scopes and if needed create authorized CI classifications for CI types that you need in addition to the simple best practices. 

    For more information about Deployer’s Workbench, see the InfoCenter at: 

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.dw.doc_75/dw-homepage.html

    Step 5: Reviewing the relationship rules 

    It is important to understand and review the relationship rules before you promote. You cannot actually modify a relationship rule if CIs are already related to each other using that particular rule. If you promote authorized CIs and discover that your relationship rules cause problems later on, you cannot modify the rules using the user interface unless you remove all the relationships that follow that rule. If you use the best practice classifications, you do not need to be as concerned because the ready for use relationship rules are designed to be adequate for most users. For an example of how relationship rules are used to promote related CIs, shown in Figure 5-10, see “Step 9: Running Create Authorized CIs” on page 258.

    [image: ]

    Figure 5-10   Use the Relationship application to view and modify relation rules

     

    
      
        	
          Handling virtual systems: If you have virtual systems in your environment, carefully examine the VIRTUALIZES relationship for the types of CIs you have in your infrastructure. If you want to have the virtual systems promoted when you promote the physical systems, inspect the relationship rule between the virtual system and the physical system. If the physical system is the target in the relationship, be sure that Is Target Parent is selected. 

        
      

    

    Step 6: Configuring CI Types for Tivoli Integration Composer to load

    In this step, set the CI Types that you want brought into SmartCloud Control Desk through the Tivoli Integration Composer Actual CI adapter (Figure 5-11).
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    Figure 5-11   Selecting CI types

    To activate the CI Types, use the SmartCloud Control Desk CI Type application. For more information, see the SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/topic/com.ibm.tusc.doc/int_comp/t_adapter_activating_ci_types.html

    Tivoli Application Dependency Discovery Manager CI Types have a hierarchy of subclasses. When you activate a CI Type, Tivoli Integration Composer imports all of the CIs of the CI Type you activated, plus the CIs of any subclass.

    For example, if the SYS.COMPUTERSYSTEM was set to Active, Tivoli Integration Composer brings in actual CIs that include ZseriesComputerSystem, LPAR, VirtualComputerSystem, AixUnitaryComputerSystem, LinexUnitaryComputerSystem, WindowsComputerSystem, and so on.

    Therefore, there is no need to set both the superclass ComputerSystem and the subclass WindowsComputerSystem to Active. If you want to import a subset of computer system types, set just those subclasses to Active, not the superclass. See the Common Data Model documentation to determine the subclasses. This is included in your Tivoli Application Dependency Discovery Manager installation.

    You do not need to set any non-top-level classifications to Active because Tivoli Integration Composer imports the Active top-level classification and all related Tivoli Application Dependency Discovery Manager CIs based on the Tivoli Integration Composer depth setting. For example, if Tivoli Integration Composer is run with a depth of three, the ComputerSystem CIs are imported as well as two levels of relationships. This includes the OperatingSystem, L2Interface, IpInterface, IpAddress, IPV6Network, CPU, Memory, FileSystem, and so on.

    Step 7: Reviewing the CI Lifecycle

    An authorized CI has a status field that indicates the state of its usefulness. For example, when the CI for a computer system is first created, the computer system might not be ready to be used. At some point, it is put into production. Eventually it reaches the end of its useful life and is put out of service. Having information about what state a CI is in can be useful. For example, you might want to put stricter controls around changes to a CI when it is in production. 

    The list of possible states and transitions are defined by a lifecycle are shown in Figure 5-12. 
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    Figure 5-12   CI Lifecycle

    Before you create any CIs, think about what different states you want to support, what state transitions you want to allow, and whether you want to enforce stricter controls over changes to your CIs while they are in particular states. Also, decide whether you can use the same set of states and transitions for all of your CIs, or whether they need to differ based on the CI Type. Do this before you create your CIs. You can use the CI Lifecycles application to define and work with CI Lifecycles. For more information about lifecycles, see 5.2.4, “CI lifecycles and status” on page 273.

     

    
      
        	
          Warning: If you change a lifecycle that is associated with a classification after a CI with that classification exists, the status of the existing CI is set to the default state of its new lifecycle if its existing status does not exist in the new lifecycle. This might not be an appropriate state. Analyze your existing CIs to see whether they need to have their status changed.

        
      

    

    Step 8: Importing Actual CIs into SmartCloud Control Desk

    Before SmartCloud Control Desk version 7.5.1, Tivoli Application Dependency Discovery Manager was required to discover configuration items and the Tivoli Integration Composer application was needed to import those discovered CIs as Actual CIs into the SmartCloud Control Desk database. If you wanted to load discovered CIs from a non-Tivoli Application Dependency Discovery Manager source, you first imported the data into Tivoli Application Dependency Discovery Manager. You then used Tivoli Integration Composer to load the data from Tivoli Application Dependency Discovery Manager into the SmartCloud Control Desk database. 

    Now, the ImportIDML tool provides a way to load data from non-Tivoli Application Dependency Discovery Manager discovery engines, such as Atrium or Spectrum, into the SmartCloud Control Desk database. The restriction is that the data must be specified in IdML format. The Identity Markup Language (IdML) is an Extensible Markup Language (XML) dialect that describes configuration items and their relationships according to the Common Data Model. The Common Data Model is used to describe Actual CIs in the SmartCloud Control Desk database.

    Using Tivoli Integration Composer to import Actual CIs from Tivoli Application Dependency Discovery Manager is option 1. How to use the ImportIDML tool to load non-Tivoli Application Dependency Discovery Manager data is option 2. Do not run both Tivoli Integration Composer and the ImportIDML tool at the same time! 

     

    
      
        	
          Caution: Name reconciliation is only done for computer systems. If you use both Tivoli Integration Composer and the IdML loader to import the same configuration item, and it is not a computer system, you end up with duplicate Actual CIs that represent the same configuration item. Duplicate Actual CIs can also occur if you import the same configuration item (other than computer systems) from multiple IdML sources.

        
      

    

    Option 1: Using Tivoli Integration Composer to import Actual CI data

    The Tivoli Integration Composer can import Tivoli Application Dependency Discovery Manager discovered assets and CIs as actual CIs into SmartCloud Control Desk. Tivoli Integration Composer creates and updates actual CIs based on the active classifications, the type of filtering used, and the depth settings.

    The Integration_Composer/data/properties/provider/ccmdb.properties file contains the properties that are used to specify depth and filtering. Tivoli Integration Composer supports two types of filtering: 

    ccmdb.actualci.filtering.level=0

    If this property is set to 0, Tivoli Integration Composer excludes importing Tivoli Application Dependency Discovery Manager CIs that match the CI Types set to -1 in the ccmdb.properties file.

    For example, if a ComputerSystem was set to Active for a depth of 3, Tivoli Integration Composer imports the ComputerSystem, then the related OperatingSystem, and then follow the relationship to the SoftwareComponent. If you have no need to manage software components, set that classification to -1 to allow Tivoli Integration Composer to exclude those CIs.

    If using this type of filtering, the exclude the following classifications: 

    APP.CONFIGFILE=-1 

    APP.DB.DB2.DB2DATABASECONFIGVALUE=-1

    APP.DB.DB2.DB2INSTANCECONFIGVALUE=-1 

    APP.DB.DB2.DB2SYSTEMCONFIGVALUE=-1 

    APP.PROCESSPOOL=-1 

    CORE.LOGICALCONTENT=-1 

    DEV.DISKPARTITION=-1 

    DEV.MEDIAACCESSDEVICE=-1 

    DEV.MEDIAACCESSDEVICEDEV.STORAGEVOLUME=-1

    SYS.AIXSOFTWARECOMPONENT=-1 

    SYS.DATAFILE=-1 

    SYS.SOFTWARECOMPONENT=-1

     SYS.WINDOWS.WINDOWSSERVICE=-1 

    SYS.ZOS.ZREPORTFILE=-1 

    When you exclude a CI class from being imported, the relationships between the CIs above and below it in the tree are not imported. Only relationships between CI classes that are contiguous from the top level down are included.

    If Tivoli Integration Composer was upgraded to the 7.5.x release from a prior Tivoli Integration Composer release, filter level 0 is the default filter setting. This is not the recommended filter level, but up front planning must occur before moving from this exclusion filtering model to the promotion scope filtering option.

    If you are unfamiliar with Tivoli Integration Composer filtering, see the SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_ci_type_depth.html

    The second type of filtering is:

    ccmdb.actualci.filtering.level=2

    If the filtering level is set to 2 (the preferred setting), Tivoli Integration Composer follows the Promotion Scope to determine which Tivoli Application Dependency Discovery Manager CIs to include while importing. This filtering affects not only the types of actual CIs imported, but also which attributes are imported. The result is that Tivoli Integration Composer imports only actual CIs and their attributes that you want to manage.

    This filtering is the default for environments where Tivoli Integration Composer was not previously installed.

    Using the promotion scope filtering does not ensure that Tivoli Integration Composer will import all of the CI Types listed in the promotion scope. That is because Tivoli Integration Composer will still only follow the Active classifications to the depth setting. 

    For example, a promotion scope starts at WindowsComputerSystem with a topology that includes WindowsFileSystem.You have the Tivoli Integration Composer depth set at two. Tivoli Integration Composer does not follow the relationship down to the FileSystem level because a depth of three is required to reach the WindowsFileSystem CIs.

    Another example is the relationship between IISWebService and ComputerSystem. If only ComputerSystem is set to ACTIVE, the IISWebService actual CI is not created because the RunsOn relationship between Computer System and IISWebService is only found on IISWebService. If Tivoli Integration Composer is only following the ComputerSystem instance, it never reaches the IISWebService. Instead, activate IISWebService for Tivoli Integration Composer to be able to follow the relationship to the ComputerSystem.

    For more information about promotion scope filtering, see the SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/topic/com.ibm.tusc.doc/config/c_ci_type_depth_auth_space_promotion_filtering.html

    Understanding the depth settings is one of the three critical concepts that determines what Tivoli Integration Composer will actually import. As with the filtering option, the depth setting is controlled by properties in the ccmdb.properties file. The default depth property is:

    ccmdb.classification.default.depth=3

    For the active top-level CI Types, Tivoli Integration Composer imports Tivoli Application Dependency Discovery Manager CI data up to a specified depth. The default depth setting is used unless this setting is overridden with a ccmdb.classification.depth property, for example:

    ccmdb.classification.depth.APP.APPSERVER=4

    If a top-level CI Type has a depth setting other than the default value, the subclasses are also processed with that same depth setting unless specifically overridden.

    For example, if SYS.COMPUTERSYSTEM was set to a depth 4 and SYS.WINDOWS.WINDOWSCOMPUTERSYSTEM was set to a depth 2, Tivoli Integration Composer imports all computer system type CIs at depth 4 except for Windows computer systems, which are imported using a depth of 2. This is true for Tivoli Integration Composer 7.5.0.1 Hot Fix 3 and above. Tivoli Integration Composer 7.5.0 can be upgraded to Tivoli Integration Composer 7.5.0.1 without having to upgrade SmartCloud Control Desk to 7.5.0.1.

    Option 2: Using the IdML loader to import Actual CI data

    The ImportIDML tool is used to import IdML formatted data into SmartCloud Control Desk. There are no special install options. This tool is automatically available after Tivoli Integration Composer 7.5.1 is installed. The ImportIDML tool is run from the /bin directory, under the Integration Composer root directory. The tool inserts ImportIDML as the ChangeBy value of the ACTCI table to distinguish how the CI was imported. Use the following command to run the tool:

    importIDML -f<filename> -c<prefix> -p<prefix> -s<customer>

    Provide the following input parameters;

    -c<prefix>	Optional. Used to delete Actual CIs that were created by using the ImportIDML tool and whose ACTCINUM value starts with the specified prefix. A prefix value is required. The deletion takes place immediately. This process does not use the 					CCIDELETEDACTCI table to mark the Actual CI for deletion. There will be no history trail other than the log files.

    -f<filename> 	This parameter is required unless the -c option is used. The IdML file name must be provided and, if a full path is not specified, the file must be in the directory <ITIC root>/data/idml 

    	If both the -c and -f options are provided, only the -c option is processed.    

    -p<prefix>	Optional. This prefix is used as part of the ACTCINUM value when creating CIs. 

    -s<customer>	Optional. The primary customer name to set for each Actual CI created. 

    -m<filename> 	Optional. The property file name for db connection password. The default is the executeMapping.properties file. 

    The ImportIDML tool reads the fusion.properties file to find the location of the SmartCloud Control Desk database. Properties mxe.db.url, mxe.db.usr, mxe.db.driver, and mxe.db.schemaowner are used to create the database connection.

    The database password is taken from the executeMapping.properties file (the same file that the actual CI Tivoli Integration Composer processing uses.) The ImportIDML tool first uses the value of TARGETPWD as the database password, but if that is blank, the value in REPOSITORYPWD is used. Tivoli Integration Composer and the ImportIDML tool support the passwords being encrypted. You can use the encryptExecuteMappingProperties.bat or .sh scripts to encrypt the passwords in the executeMapping.properties file.

    All error messages and debug statements are written to the <ITIC root>/log/fusion.log 

    The debug levels of ERROR, INFO, WARN, DEBUG can be used. Track IdML loader processing with the following three debug options in the <ITIC root>/data/properties/logging.properties file:

    log4j.logger.idml=INFO

    log4j.logger.idml.detail=ERROR

    log4j.logger.maximo.sql=ERROR

    The log4j.logger.idml.detail provides much lower-level details such as entry and exit logging.

    When you use the ImportIDML tool to import IdML data, it either creates Actual CIs or modifies existing ones. This tool cannot be used to delete imported Actual CIs that no longer exist in the source database. Also, this tool does not recognize the IdML extended attributes syntax. The only way that you can import extended attributes is to add them to the IdML file as normal attributes and update the SmartCloud Control Desk ASSETATTRIBUTE and CLASSSPEC tables. 

    When the tool processes an IdML file, it processes each entry in the same way, regardless of whether the entry is in a create section or a modify section. The tool uses the specified ID tag, and a prefix if one is entered, to create an ACTCINUM for the CI. The tool then queries the database for an actual CI with that ACTCINUM value. If one is found, the CI entry is processed as an update. Otherwise, a new CI is created.

     

    
      
        	
          Caution: Remembering the prefix that you use is important. If you import the same actual CI more than once but use a different prefix, the ACTCINUM values will not match, and the second import creates a new Actual CI rather than an update.

        
      

    

    After all the entries in the file are processed, the tool uses the Naming and Reconciliation Service to create a unique identifier for each newly created Actual CI that represents a computer system. This processing uses the same Naming and Reconciliation Service (NRS) APIs that Tivoli Integration Composer uses and sets the ACTCI.DISGUID to the generated GUID just as Tivoli Integration Composer Actual CI processing does.

    For each Computer System entry, if an existing Actual CI is found with the same generated DIS GUID identifier, the older Computer System is marked for deletion by adding a record to the CCIDELETEDACTCI database table. The tool assumes that the new information must replace the old record.

     

    
      
        	
          Caution: This NRS processing does not take the prefix into consideration when generating the unique identifier. Therefore, if two discovered resources exist with different prefixes, the one with the most recent create/update time stamp remains. This reconciliation processing includes the entries that are created by the Actual CI Tivoli Integration Composer adapter as well. Therefore, if both Tivoli Integration Composer and ImportIDML are used to import identical CIs, the generated DIS GUID is identical and one of the CIs will be deleted.

        
      

    

    This processing can be turned off with the following property in the fusion.properties file:

    mxe.fusion.mapping.nrs.enable=false

    The property is set to true by default, and affects both Tivoli Integration Composer and ImportIDML processing.

    The IdML specification says that the ID tag is optional, but this tag is required for importing CI data and is assumed to be unique. The ID is used, along with an optional prefix, to create the ACTCINUM attribute for the actual CI. Be sure that your IdML files have this tag specified for each actual CI. If the tool encounters a CI record without an ID, a warning message is written to the log file and the CI record is skipped. If the IdML file contains duplicate IDs, the first one is inserted and the others are treated as duplicates and the Actual CI is updated.

    If you need to create relationships between Actual CIs that were loaded with different prefixes or between an Actual CI that was loaded without a prefix (for example if it was loaded through Tivoli Integration Composer) and an Actual CI that was loaded using a prefix, specify those relationships in a separate IdML file. Then complete these steps:

    •Manually add the prefix that you used to either the source or target of the relationship in the IdML file for any Actual CIs that were loaded with a prefix.

    •Run the importIDML command with this file as input, and do not specify the prefix (-p) option.

    The createIDMLMetaCache tool

    SmartCloud Control Desk version 7.5.1 is included with version 2.10.18 of the Common Data Model. The CDM version that is used to export into the IdML input file must match. To check the version that is used to generate your IdML file, look at the top line of the IdML file. The CDMSchemaVersion parameter shows the version of the Common Data Model against which this IdML file was validated. If this schema version is newer than the version included with the SCCD release you are using, use the createIDMLMetaCache tool to update the files that are used to process through the IdML input file. 

    The createIDMLMetaCache tool is in the <ITIC root>/bin directory. It reads a CDM.xsd file, and outputs three text files into the <ITIC root>/data/idml/cdm_metadata directory: 

    •cdmdatetimes.txt

    This file contains a list of CDM names that have a datetime format that must be converted to a time stamp to be loaded.

    •cdmenumerationmap.txt

    This file contains a list of enumerations that are used to convert the alphanumeric enumerations to appropriate integer values that the product recognizes.

    •cdmnames.txt

    This file contains a list of valid CDM names that are used to recognize improper CDM names and issue warnings. If the Idml file contains CI Types that are not in this file, they are not imported. 

    If any of these files exist, the tool renames the existing file by appending the current time stamp and creates a new file. These files can be manually modified as needed.

    The createIDMLMetaCache tool accepts one parameter, which is the name of an xsd file. Specify the location of the xsd file that contains the schema that is used to generate your IdML file. If no file name is specified, the tool runs against <ITIC root>/data/idml/cdm_metadata/CDM.xsd.

    Step 9: Running Create Authorized CIs

    The Create Authorized CIs menu item in the Actual CI application is used to select actual CIs and apply a template to them that results in newly created authorized CIs. This concept of copying actual CIs to authorized CIs while including only what you are interested in managing is called promotion. The following are the key points to understand when promoting:

    •Start with Top Level

    •Promote One CI Type at a time

    •Key promotion factors 

    •Promotion example

    •Promotion strategy

    •Copying attributes

    •On-demand attributes

    Start with Top Level

    Promotion applies a template that determines whether to include related CIs, and that template needs a starting point. That starting point is a top-level CI, so you can only promote top-level CIs. For more information about top-level CI types, see “Step 2: Deciding what type of CIs to manage ” on page 235. 

    Promote One CI Type at a time

    You can promote only one top-level CI Type at a time. If you select actual CIs of more than one CI type, you receive an error message. The Create Authorized CIs window is not displayed. You need to select CIs of a single CI type. 

    Key promotion factors 

    There are three factors that contribute to creating authorized CIs during promotion. They are promotion scopes, relation rules, and the attributes defined on an authorized classification.

    The promotion scope determines which type of authorized CI is created for a particular actual CI type. It also determines which related CI types are considered when promoting a top-level CI. If you promote one top-level Actual CI, you can directly or indirectly create several authorized CIs: The top level and CIs that are related to the top level. The promotion scope is configured using the Deployer’s Workbench. For more information, see “Step 4: Configuring promotion scope and relationships” on page 245.

    Relationrules are required to promote related CIs. Missing relationrules are often the cause for expected CIs not actually being created. In respect to promotion, relationrules have four parts:

    The source CI type	The classification of the CI that is the source of the relationship.

    The target CI type	The classification of the CI that is the target of the relationship.

    The relationnum	The identifier of the type of relationship (for example, runson, virtualizes, and so on).

    IsTargetParent flag	Specifies if the source or the target is considered the parent. This determines the direction of a relationship. Often, the wrong isTargetParent flag is the reason that a CI that you expected to be promoted was not in fact promoted. The direction starts at the parent and goes down to the child. If you do not know the isTargetParent flag of the relationrule between the two classifications of CIs, you do not know whether the related CI is promoted or not. 

    The relationrule must be defined for the authorized classification. If the relationrule for the authorized classifications is missing, the related CI is not created. 

    Promotion example

    Promotion scopes and relationrules can be confusing. Consider the following example, which includes two actual CIs: CI_A and CI_B:

    •ACTCI_A

     –	The ACTCINUM (the unique identifier) is CI_A. 

     –	The classification for the CI is ACTCICLASSA. 

     –	The classification ACTCIROOT.A is designated as a top level.

    •ACTCI_B

     –	The ACTCINUM (the unique identifier) is CI_B. 

     –	The classification for the CI is ACTCICLASSB. 

     –	CI_A is related to CI_B with a “dependson” relationship. 

     –	The relationnum (the identifier for the type of relationship) is RELATION.DEPENDSON. 

     –	CI_A is the source of the relationship.

     –	CI_B is the target of the relationship.

    In this example, it takes the following to promote CI_A, a top level actual CI, and have two authorized CIs, CI_A and CI_B created and related to each other with a dependson relationship?:

    •You need a promotion scope for ACTCICLASSA. This promotion scope maps ACTCICLASSA to CICLASSA (the authorized classification). 

    •The ACTCICLASSA promotion scope includes ACTCICLASSB being mapped to CICLASSB. 

    •You need a relationrule between the authorized classifications. The source classification is CICLASSA. The target classification is CICLASSB. The relationnum is RELATION.DEPENDSON. In addition, isTargetParent is false (meaning CI_A is the parent and you are starting with CI_A and moving down to CI_B). 

    If you promote the actual CI identified as CI_A, you have two newly created authorized CIs. They are CI_A and CI_B. Notice that promotion copies the ACTCI identifier to the CI identifier. These authorized CIs are related by a dependson relationship. Also, the two new authorized CIs are linked back to the actual CIs that they were created from. 

     

    
      
        	
          Important: With promotion, if related CIs are not getting created, you almost always need to carefully consider the promotion scope and the relation rules. 

        
      

    

    Promotion strategy

    Now that you understand how the promotion scope and relation rules determines which related CIs are created, consider a promotion strategy. As an example, consider promoting Computer Systems and Business Systems. Both of these are top-level CI types and are related to each other. If you promote a business system, the relation rule considers the business system the parent, and directs its way down to the computer system. Thus, if you promote the business system, you also get the computer system that is part of the business system promotion scope. 

    The reverse is not true. If you promote the computer system, the relation rule does not specify the computer system as the parent, the relation rule does not match, and the business system is not promoted. 

    You might think that you just need to promote the business system and then you get the computer system too. This is true, but you might not get everything else that is specified in the computer system promotion scope. 

    In this case, it is best to promote the business system and also promote the computer system. By doing this, you get all of the related CIs on the business system and computer system promotion scope. Note that if you promote an actual CI that has already been promoted, it does not create another CI.

    Copying attributes

    When you check the Copy Attributes option during promotion, the value from the actual CI is copied to the authorized CI. However, an attribute of the same name must be created in the authorized CI classification of the CI that is created. Thus, if the authorized classification does not include a particular attribute, that attribute's value is not copied to the authorized side. If you choose the update promotion option when using Create Configuration Items, the attribute values from the actual side override the attribute values on the authorized side as shown in Figure 5-13 on page 262.

     

    
      
        	
          Attributes or specifications: You might hear CI attributes referred to as specifications. In SmartCloud Control Desk, both terms are used interchangeably. 
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    Figure 5-13   Creating an authorized CI

    If you want to promote an actual CI a second time without overriding attribute values, leave Update Existing CIs cleared on the Create Authorized Configuration Item window, or use Synchronize CIs in the Configuration Items application for more granular options.

     

    
      
        	
          Tip: The Configuration Item name is treated like an attribute. The actual CI name is copied to the CI name when the CI is first created. It is updated from the actual CI name on a subsequent promotion only if Update Existing CIs is selected on the Create Authorized Configuration Item window.

        
      

    

    On-demand attributes

    Before IBM Tivoli Change and Configuration Management Database 7.2.1, when promotion created a CI, all attributes that were defined on the CI's classification were created. The attribute had a blank value if copy attributes was not selected during promotion or if the attribute had no discovered value on the actual CI. 

    However, in Change and Configuration Management Database 7.2.1, a performance driven behavior change was made to the way attributes are created during promotion. An attribute is only created if Copy Attributes is checked and the attribute on the actual side had a non-blank value or if the attribute has a default value defined. Thus, since 7.2.1, CIs created by promotion often do not have every attribute that is defined by its classification. 

    There is no longer the same performance concern that prompted this change. However, the behavior remains changed and might cause usability issues. In SmartCloud Control Desk, there is a system property to return the behavior to before 7.2.1 so that the system creates every attribute that is defined on the authorized classification.

    Generally, turn on this system property, which is cci.promotion.keepallblanks. Use the System Property application to set the value to 1 to turn on the property. The default is 0. After you enable the property, you can rerun promotion or use Synchronize CIs, and any missing attributes are created as shown in Figure 5-14. 
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    Figure 5-14   Setting system properties

     

    
      
        	
          Tip: Some other system properties can also affect promotion. For more information, see the following IBM developerWorks article:

          http://www.ibm.com/developerworks/wikis/display/tivoliccmdb/System+Properties+Used+by+Actual+CI+Promotion

        
      

    

    Step 10: Starting to use CIs to support configuration management

    After using promotion to create authorized CIs, you are ready to use SmartCloud Control Desk to manage the configuration of your devices. You can view and modify your CIs, understand the risk of changing a CI, and audit the configuration of how you are managing your device versus how the device is actually configured. In SmartCloud Control Desk, the auditing function is called reconciliation. For more information about auditing actual and authorized CIs, see 5.2.5, “Reconciliation (audit) best practices” on page 277.

    Step 11: Repeating the entire process

    As you continue to practice configuration management, you can schedule Tivoli Application Dependency Discovery Manager to discover the most up-to-date information about your devices. After each discovery, rerun the Tivoli Integration Composer Actual CI adapter and promote any extra CIs that have been discovered and that you want to manage.

    Tivoli Application Dependency Discovery Manager discovery and running the Tivoli Integration Composer Actual CI adapter can be automated and scheduled on a nightly basis or at a chosen interval. The Tivoli Integration Composer Actual CI adapter runs a delta load to update the existing actuals with the most current discovered information, and import newly discovered CIs and relationships. 

    In SmartCloud Control Desk, you cannot automate promotion. You must carefully consider how you want to promote actual CIs after your initial discovery and actual CI load. If you run Create authorized CIs on actual CIs that have already been promoted, extra CIs that were discovered are created and the attributes are overridden if you chose to update existing CIs.

    Synchronize CIs in the Configuration application also allows you to rerun promotion on an authorized CI to create any other related CIs that were discovered as shown in Figure 5-15 on page 265. There are more granular options so that you can avoid overwriting your attributes. See the SmartCloud Control Desk InfoCenter for more information:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_db_sync_ci.html
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    Figure 5-15   Synchronize CIs

    Generally, use Synchronize CIs to update existing authorized CIs, and use Create Authorized CIs only for top level actual CIs that are not linked to an authorized CI yet.

    If you prefer to use Create Authorized CIs to update actual CIs that have already been promoted, clear Update Existing CIs so that your attribute values are not overridden. Then, you can update all your authorized CIs to copy values from the actual side if the authorized side is blank, but not overwrite any existing authorized value. 

    Predefined queries and extra filtering on the List tab of the Actual CI and Configuration Item application are often useful when promoting after each discovery. You might want to know which actual CIs are not promoted yet. There is a predefined query for that. However, with the Where Clause, you can create a query that lists, for example, all of the Windows servers, but shows you only the ones that do not have an authorized CI associated with them yet. If you take the time to set up some queries for all of the top-level types that you need to promote, it might make it easier to promote after each Tivoli Integration Composer load. You can filter with a query and then promote the entire set of actual CIs. A short cut is to select no rows and then click Create Authorized CI. A dialog then asks you if you want to promote all of the records that you filtered on.

    To avoid out of memory errors, SmartCloud Control Desk enforces a fetch limit for the number of records it can process at a time. The default fetch limit for business objects is 5000. However, because it is not uncommon for customers to want to promote more than 5000 actual CIs at a time, an actual CI-specific property has been defined. This system property is called mxe.db.fetchResultStopLimit.ACTCI as shown in Figure 5-16. The predefined limit is set to 50000. You cannot promote more than this number of actual CIs at a time. You might need to filter your list of actual CIs so that the resulting set contains fewer than this limit. If this is not possible, increase the fetch limit by using the System Properties application. However, your system must have sufficient resources, specifically memory, to handle the specified number of objects. A similar system property exists for CIs, called mxe.db.fetchResultStopLimit.CI.
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    Figure 5-16   Defining fetch limits

    5.2.3  Starting with authorized CIs

    Although it is easier to start with actual CIs, you might decide that you want to put your IT devices into configuration management before they are discovered. There are many reasons for this, such as:

    •You might have a spreadsheet of CIs to load, and some of these CIs are not online at the moment. You want to manage them but if they are not online, they cannot be discovered and thus you cannot start with actual CIs.

    •You might want to manage your CIs before they even arrive to your data center. Perhaps you will use a change request to bring them online.

    There are some drawbacks to this approach. It is more complicated and requires careful planning and review to ensure that your IT devices are correctly linked when the actual CIs are eventually discovered and imported.

     

    
      
        	
          Important: The biggest concern is configuring your link rules incorrectly so that after you start discovering CIs and running promotions, you introduce duplicate authorized CIs into the system. It can be challenging to correct and remove the duplicate CIs. The worst case scenario is that you have multiple CIs that represent the same device, and each one has a process artifact such as a change request or an incident associated with it. This requires a considerable amount of effort to fix. This section provides you with a best practice approach to avoid this.

        
      

    

    Here are the steps to start with authorized CIs:

    1.	Decide whether you need related CIs before discovery occurs.

    2.	Decide how to populate your authorized CIs (integration framework, Quick Config, manually).

    3.	Use your authorized CIs with many SmartCloud Control Desk functions such as change management, impact analysis, and topology.

    4.	When your devices come online, have Tivoli Application Dependency Discovery Manager discover them.

    5.	Use the CI Type application to configure which type of devices the Tivoli Integration Composer Actual CI adapter brings into SmartCloud Control Desk as actual CIs.

    6.	Run the Actual CI Type adapter to load actual CIs into SmartCloud Control Desk.

    7.	Run Link to Actuals in the CI application using preview mode to make sure that naming rules that link actual and authorized CIs are correct.

    8.	Run Link to Actuals or promote with the link to actual option turned on.

    9.	Synchronize CIs. 

    10.	Your actual CIs and authorized CIs are now linked together, and you are ready to run audits on the configuration of your devices.

    11.	Repeat this process regularly as new devices that you are already managing as authorized CIs are brought online and Tivoli Application Dependency Discovery Manager discovers them.

    Step 1: Determining whether related CIs are required

    When starting with authorized CI, only create top level authorized CIs unless you need the relationships and related CIs before discovery. This can greatly reduce the complexity of linking your authorized CIs to actual CIs later on. The reason is that top-level CIs have easy naming rules that mostly consist of attributes. Related CIs have naming rules that include other related CIs as part of the naming criteria. This is defined in the common data model that Tivoli Application Dependency Discovery Manager is based on. The more complicated a naming rule is, the more chances there are for incorrectly linking an actual and an authorized CI.

    If you can increase the likelihood that your authorized CIs can be correctly matched to an actual CI when they are brought into the system, you can minimize the risk of creating duplicate authorized CIs using the promotion process.

    Step 2: Populating authorized CIs

    There are three ways you can create authorized CIs without using actual CIs.

    •You can use the integration framework and the predefined CI object structure to define CIs, attributes, and relationships in XML or CSV format. For more information on importing CIs using the integration framework, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.mbs.doc/gp_intfrmwk/c_intfrmwk_overview.html

    •You can also use the Quick Configuration application to load CSV files to define CIs, attributes, and relationships. For more information, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.sccd.doc/import/t_importing_data_container.html

    CIs can be created manually by using the CI application. This is a good option to add one or two CIs, but it is time consuming to create a large number of CIs this way. For more information about using the Configuration application to create CIs, attributes and relationships, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.sccd.doc/config/t_create_cis.html

    Step 3: Using authorized CIs brought directly into SmartCloud Control Desk

    After the authorized CIs are created using one of these methods, you can use the CIs in many SmartCloud Control Desk functions.

    Even if you chose to create only top-level CIs, you can put them into a protected state, maintain their attributes, and associate them to other SmartCloud Control Desk process artifacts, such as a service request, an offering, or a change request.

    If you do choose to bring in the related CIs, you can also use topology and impact analysis.

    Step 4: Tivoli Application Dependency Discovery Manager discovers devices

    These same devices that you are managing can eventually be discovered by Tivoli Application Dependency Discovery Manager. For more information about Tivoli Application Dependency Discovery Manager discovery levels, see “Step 1: Discovery” on page 233.

    Step 5/Step 6: Configuring CI Types and running Tivoli Integration Composer adapter to bring actual CIs into SmartCloud Control Desk

    For information about activating CI types and using the Tivoli Integration Composer Actual CI adapter to import CIs discovered by Tivoli Application Dependency Discovery Manager into SmartCloud Control Desk as actual CIs, see “Step 5: Reviewing the relationship rules ” on page 247 and “Step 6: Configuring CI Types for Tivoli Integration Composer to load” on page 248.

    Step 7: Reviewing naming rules for linking authorized and actual CIs

    As new CIs are discovered in Tivoli Application Dependency Discovery Manager and brought into SmartCloud Control Desk as actual CIs, you must link an authorized CI to its corresponding actual CI. This match is done by using Naming Rules that are pre-populated into SmartCloud Control Desk and are defined for the best practice classifications. These predefined naming rules are based on the ones that are defined in the CDM and included with Tivoli Application Dependency Discovery Manager. The naming rules control how an authorized CI is matched to an actual CI. Similar to the CDM, SmartCloud Control Desk naming rules match attributes and relationships. For example, you can use the attribute Serial Number to match a computer system to its actual CI, or you can use an operating system's relationship to its computer system as shown in Figure 5-17. 
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    Figure 5-17   Using naming rules in the Configuration Items application

    Linking an authorized CI to the wrong actual CI can create issues within the system such as inaccurate audit results. Also, failing to find a match for an authorized CI when the corresponding actual CI exists can introduce duplicates into the system during promotion. If the actual CI is not linked to an authorized CI and the naming rules cannot find a match, a duplicate CI is created. 

    Therefore, before you attempt to link an authorized CI to an actual CI, go to the Configuration application and run Link to Actuals in preview mode first, as shown in Figure 5-18. Preview mode allows you to see how the naming rules configured in your system will link authorized and actual CIs without linking them. You can receive an email summary of what authorized and actual CIs are linked. To review, take a sample of authorized CIs from each classification and verify that they find the correct corresponding actual CI if it is available. 
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    Figure 5-18   Running Link to Actual CIs in preview mode

    After you review the preview email, modify the naming rules as needed and rerun Link to Actuals in preview mode to test your naming rule updates. You can also choose to leave out CIs that are not linking correctly. 

     

    
      
        	
          Warning: If you modify the authorized CI classifications from the best practices, you must update the naming rules with the correct classstructureids (internal ID for a CI Type)

        
      

    

    For more information about running Link to Actuals in preview mode, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/t_create_cis.html

    For more information about SmartCloud Control Desk naming rules and how to modify them using object structures and the integration framework, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/t_import_naming_rules.html

    For background information about the Common Data Model naming rules, see the Common Data Model documentation that is included with Tivoli Application Dependency Discovery Manager.

    Step 8: Linking authorized CIs to actual CIs

    After you are confident that your naming rules are configured correctly, you have two choices to link authorized and actual CIs. You can either use the Link to Actuals function in the Configuration Items application, or you can run Create Authorized CIs (promotion) from the Actual CI application using the Check For Existing CIs option. 

    Both of these options use the SmartCloud Control Desk naming rules to try to match actual CIs and authorized CIs. 

    Using promotion can be convenient because you can choose a set of actual CIs and promote them. If the naming rules match an authorized CI, the authorized and actual CIs are linked. However, promotion only attempts to link the actual CIs that you select. It does not attempt to link any of the related actual CIs that it processes unless the Naming Rule for the selected actual CI type uses a relationship. If you have created related CIs that you need to link, use the Link to Actual CIs action from the Configuration Items application.

    Using the Link to Actuals action from the Configuration Items application has some additional benefits. You can choose to get an email summary of the authorized and actual CIs that were linked and which naming rule was used in each case. You can also choose to link multiple CI Types at the same time. 

    For more information about using Link to Actuals, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_linkauthtoactual_overview.html

    For more information about promoting actual CIs with the Check for Existing CIs option, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/config/c_prevention_duplicate_cis.html

    Step 9: Synchronizing CIs

    After you link an authorized CI to its corresponding actual CI, you can use the Synchronize CI function in the Configuration Item application to populate the CI with the discovered data. If you only created the top level authorized CI, you can bring over all of the related CIs now. Even if you created some related CIs manually, Synchronize CIs can bring over more related CIs. 

    Synchronize CIs follows the same logic as promotion does, and uses the promotion scope, relation rules, and classifications in the same way. You get the same results if you run Synchronize CI on the authorized CI or Create Authorized CIs on the actual CI. However, Synchronize CI has more granular options and can be run from the authorized CIs. Also, with Synchronize CIs, you can select CIs of different CI types at the same time, which provides more flexibility over Create Authorized CIs. 

    Step 10: Auditing authorized CIs

    After you link authorized CIs to actual CIs, you are ready to use SmartCloud Control Desk to audit the configuration of how you are managing your device versus how the device is actually configured. In SmartCloud Control Desk, the auditing function is called reconciliation. For more information about auditing actual and authorized CIs, see 5.2.5, “Reconciliation (audit) best practices” on page 277. 

    Step 11: Repeating the entire process if needed

    In SmartCloud Control Desk, you cannot automate promotion or linking using naming rules. You must consider how you want to promote actual CIs after your initial discovery and actual CI load. If you start with authorized CIs, you can use promotion with the check for duplicates option to link an authorized CI to the actual CI before promoting. However, if you manually created or imported related authorized CIs, use the Link to Actuals function before promoting because this tries to link the related CIs as well.

    For more information about how to repeat the process as new CIs are created and Tivoli Application Dependency Discovery Manager continues to discover new data, see “Step 11: Repeating the entire process” on page 264. 

    5.2.4   CI lifecycles and status

    Configuration Items have a status field that defines what operational state it is in. The set of valid states is defined by a CI lifecycle. The classification of the CI determines what its CI lifecycle is.

    The CI Lifecycles application can be used to manage CI lifecycles. Using this application, you can define the set of states that are associated with the lifecycle and the valid transitions between them. You can associate a list of authorized CI classifications with a lifecycle. Each classification can only be associated with a single lifecycle. One lifecycle can be designated as the default lifecycle. This means that it is used as the lifecycle on any CIs whose classification is not specified elsewhere. 

    A lifecycle must include a default state. The default state is assigned to any new CIs that use this lifecycle. When an unclassified CI is classified, its status is initialized to the default state defined for its lifecycle. 

    States can be protected or unprotected. A CI must be associated with an approved Change Request to change into or out of a protected state. A Configuration Item in a protected state requires a Change Request to be modified. This includes changes that are made by update promotion. Defining a state as protected provides tighter control over changes that are made to the CI while it is in that state. 

    SmartCloud Control Desk contains two predefined lifecycles, Default and ITIL, as shown in Figure 5-19. 
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    Figure 5-19   The predefined lifecycle states that are available

    As its name implies, the Default lifecycle is designated as the default lifecycle. It consists of three states: NOT READY, OPERATING, and DECOMMISIONED. None of these states are protected. The NOT READY status is the default status and is used when a CI is not yet in operation. During its useful life, a CI is typically in the OPERATING status. The DECOMMISSIONED status is used when the CI is no longer in use. Many business rules prevent CIs from being deleted. Instead, change the CIs to the DECOMMISSIONED status when they are no longer being used. Some special business rules apply to CIs in the DECOMMISSIONED status. For example, some of the Select Value filters used within SmartCloud Control Desk filter out CIs that are DECOMMISSIONED.

    The default lifecycle is sufficient most of the time. However, you might want to see more granular states on your CIs, or provide tighter control over changes to your CIs at certain times. The ITIL lifecycle that is also included as a predefined lifecycle contains 10 states, some of which are protected. You might want to use this lifecycle as-is, or modify it to meet your needs. In its predefined state, no classifications are associated with this lifecycle, so the Default lifecycle is used for all CIs.

    When you change the status of a CI, its lifecycle determines the states that it can change to. If the current or new state is protected, you must specify the Change Number for a change work order that is approved or in progress and whose targets include the CI. In addition, when you change the status of a CI, SmartCloud Control Desk changes the status of all its child CIs.

    A contained child CI is a CI that is related to the selected CI where the relationship rule that governs the relationship meets certain criteria. To determine whether a related CI will have its status changed, find the relationship name, the classification of the Source CI, and the classification of the Target CI on the relationship. Go to the Relationships application and filter on the Relationship name. In the Relationship Rules table, locate the rule where the Source Classification matches the class of the Source CI and the Target Classification matches the class of the Target CI. If the Containment flag is not set, the child CI will not automatically have its status changed. If the Containment flag is set, look at the Is Target Parent flag. If the CI selected to have its status changed is the Source Class and Is Target Parent is not set, the child will have its status changed as well. If the CI selected to have its status changed is the Target Class and the Is Target Parent flag is set, the child will have its status changed. 

     

    
      
        	
          Tip: The child's status change is subject to all of the same business rules as the parent. It must be a valid status change for the child CI's status to be modified. The status change on the parent fails if the status change on any of the child CIs fails.

        
      

    

    5.2.5  Reconciliation (audit) best practices

    To audit an authorized CI against the discovered data in SmartCloud Control Desk, use the reconciliation cron task. To audit all of the top-level CIs, the related CIs, the attributes, and the relationships between CIs, use the Full CI Recon option when setting up your reconciliation task. Full CI reconciliation uses the relationrules to follow relationships for authorized CIs and compare each CI to the actual CI it has been linked to. For more information about full CI comparison rules, see the SmartCloud Control Desk InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.mbs.doc/gp_recon/c_full_ci_comparison.html

    Depending on the volume of actual and authorized CIs, reconciliation can require intensive processing on your processor and memory. With extra large data sets, there are ways to break up reconciliation into multiple tasks so that you can stagger the processing of certain CI types. You can use a task filter and specify the CI Type to run reconciliation against using the classstructureid filter. See the SmartCloud Control Desk InfoCenter for information about how to add a task filter:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.mbs.doc/rcntskfltr/t_crt_task_filters.html

    By creating multiple reconciliation tasks, each with a classstructureid task filter, you can avoid processing all CI types at the same time.

    When setting a classstructureid filter with the UI, you are only filtering the authorized classifications that are processed. However, you can also apply a task filter to the actual side. When reconciliation runs, it tries to link each authorized CI to all of the actual CIs. If there is a large volume of actual CIs, you can specify which actual CIs are considered. For example, if you set up a task filter to only process CI.WINDOWSCOMPUTERSYSTEMS, you can probably set the actual CI filter to only include SYS.WINDOWSCOMPUTERSYSTEM CIs. 

    To specify an actual CI filter, create a system property that identifies the classifications of the actual CIs that are included during the comparison. During the reconciliation, only actual CIs with the specified classifications are brought into memory and used for comparison. Filters are specified by reconciliation task, so each task can use a different filter. 

    The actual CI filter is configured by using the System Properties application by adding a system property. For the Property Name, specify recon.actualci.filter.<yourReconTaskName>. In place of <yourReconTaskName>, substitute the name of the reconciliation task this filter is to be used with. For the Global Value, specify a comma-separated list of the classstructureids for the actual CI classifications that are included in the comparison. For example, if your reconciliation task is comparing authorized Windows computer systems, you might want to limit your actual CI data sets to the actual CI classifications for Windows computer systems. To determine the classstructureid value for a classification hierarchy path, use the CI Types application. You do not need to restart your server for these settings to take effect, but you must refresh the property by using Live Refresh as shown in Figure 5-20.
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    Figure 5-20   Define a reconciliation filter

    Using task filters is very useful when you are running reconciliation on large amounts of CI and actual CI data.

    5.2.6  Impact analysis

    You can use the Configuration Item application to analyze the effect that a change will have on related Configuration Items. The CI Topology tab shows the hierarchy of related Configuration Items. If you click the Show Impacted check box, you can see which of its related CIs will be impacted if the current Configuration Item is changed.

    Figure 5-21 shows the Detail View of a Linux Computer System with Show Impacted selected. The yellow fill color and triangle icons indicate the related Configuration Items that will be affected by a change to the Linux Computer System. The two Configuration Items that are not shaded in yellow and do not have the triangle icon will not be affected.
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    Figure 5-21   Impact analysis for a Linux Computer System

    5.2.7  Baselines

    So far, this chapter has focused on using actual and authorized CIs to maintain a managed state of CIs and notify you through auditing if the configuration of your devices veers from that state. However, you might change your system and find that the managed configuration you chose is causing issues. To troubleshoot this problem, it is useful to know what your configuration was like at a point when your configuration was running smoothly. You can make this comparison using CI Baselines.

    You can use baselines to take a snapshot of your authorized CI space at a particular point in time as shown in Figure 5-22. You typically do this when you have a configuration that you know is good and working as planned. As you move forward and make configuration changes to your authorized space, you have this baseline to refer to. Using the baseline application, you can compare your baseline to the actual CI space. This gives you some insight into what is different from the time when things were operating correctly. 
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    Figure 5-22   Capturing an active CI baseline

    Baselines contain a set of member CIs. The more members that you have in a baseline, the longer it takes to run a comparison.Therefore, avoid including too many members in a baseline. For example, including all of the CIs owned by your sales division might be a bad idea. Instead, you can create a baseline to capture each business system that you use, such as one baseline for the CIs that comprise your payroll system, and one for the CIs that make up your conference room reservation system.

    When you compare a baseline to your actual CI space, it compares the attribute values and relationships that existed for its member CIs at the time you activated your baseline as shown in Figure 5-23. It compares the historical value of the CI to the current value of the actual CI to which it is linked. The resulting window shows discrepancies in attributes, relationships, and also whether the actual CI has been deleted. By including all of the CIs that make up the system, you can detect anything that has changed in that system. For example, you can see whether memory has been removed, or software has been updated, which can narrow down the scope of your troubleshooting when something is not working.

    [image: ]

    Figure 5-23   Use Compare with Actual CIs to see baseline comparison results

    When creating your baseline, generally start with all of the top-level CIs (for example computer systems) that are used by the business system. The CI Baselines application provides a way to select CIs for a baseline by choosing from all available CIs. Click Select CIs from the All Available CIs window to apply filters to search for CIs that meet your criteria. After you specify the search criteria, click Refine and select one or more of the resulting CIs to add to the baseline. The results table contains a filter as well, and you can use that to provide more filtering, such as limiting the results to those that are Top-Level.

    After you add your top-level CIs to the baseline, you can add related CIs. If a top-level is used solely for the business system, you probably want to add related CIs that were created when it was first promoted. The Select CIs menu has an option to select From Child CIs of Selected Top-Level Member CI. Select each of your top-level member CIs (for example, computer systems) in turn, and then choose this option from the menu. The system then displays an informational message that this process might take a few minutes. The resulting window shows you all of the CIs that were created by using the promotion of the selected top-level CI. You can select some or all of these to add to the baseline. Select whichever ones are used by your business system or that you feel you want to compare if a problem occurs. If the top level is used solely for the business system, you probably want to add all of them. It is safer to have a few too many members in a baseline than to omit some that you might need later on.

    After you add all of the CIs that are used to implement the system, and you know that your business system is working correctly, activate the baseline. This effectively takes a picture of the member CIs as they currently exist. If you update any of the CIs in your system, for example if you add more memory, another processor, or different software, create a new version of the baseline. Add or remove any member CIs to reflect what is being used by your system. When you know that the system is working correctly, activate this new version of the baseline. 

    If a problem is detected with the business system, you can run a baseline comparison using the version of the baseline that represents its most recent good configuration. This compares all of the CIs used by your business system, and help you to quickly see any discrepancies.

    5.2.8  Data cleansing and reconciliation

    This section highlights the functions in the areas of data cleansing and name reconciliation for assets and configuration items. It includes a conceptual description that defines data cleansing and reconciliation, and highlights the business value that is associated with these functions.

    Following the conceptual discussion, this section delves into the details of the following data cleansing and reconciliation functions that have been added to SmartCloud Control Desk V7.5.1:

    •Detecting duplicates when computer systems are saved or updated.

    •Remediating duplicate asset and configuration item computer system data already in your environment.

    •Reports for identifying duplicates.

    •Improvements to various linking processes that take advantage of the data cleansing and reconciliation functions.

    It also provides details about the configuration for these functions. If you are using best practice data models for assets and configuration items, this configuration is optional. If you are using other models or have customized the best practice models, this is important information.

    Another section provides some troubleshooting guidance for common issues that you might face when you implement the data cleansing and reconciliation functions.

    Data cleansing overview

    In SmartCloud Control Desk, data about assets and configuration items (both discovered and authorized) can be brought into SmartCloud Control Desk from other data sources by using IBM Tivoli Integration Composer adapters or the Maximo Integration Framework.

    In some cases, the source product that discovers the asset or configuration item formats the attribute information about the object in slightly different ways. For example, consider how the Tivoli Application Dependency Discovery Manager and Tivoli Asset Discovery for Distributed source products format the serial number attribute for virtual machines. 

    Note the serial number format in Figure 5-24 on page 284 as it is passed into SmartCloud Control Desk from Tivoli Application Dependency Discovery Manager and Tivoli Asset Discovery for Distributed. Serial number is an example of an important naming attribute for a computer system. Naming attributes are attributes that uniquely identify a resource. A naming rule combines one or more naming attributes such that the unique combination of those attributes uniquely identifies the asset or configuration item.

    Because naming attribute values are used to determine uniqueness of assets and configuration items, slight variances in the format of those naming attributes for the same computer system (coming from different discovery sources) can result in multiple, duplicate representations of the same computer system. 

    Data cleansing provides a solution to these duplicate issues. It is the process whereby naming attribute values are normalized by using a set of data transformation rules. 

    In Figure 5-24, note that, after the process of data cleansing, the serial number attribute values for the same computer system (coming into SmartCloud Control Desk from Tivoli Application Dependency Discovery Manager and Tivoli Asset Discovery for Distributed), have been normalized. The leading “Vmware-” literal and the underscores inserted into the serial number by Tivoli Application Dependency Discovery Manager are removed. As a result, only a single instance of that computer is brought into the SmartCloud Control Desk, avoiding the issues of duplicate data in the system. 
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    Figure 5-24   Overview of data cleansing process

    Name reconciliation overview

    Name reconciliation is a technology that computes unique identifiers (referred to as integration identifiers) using the cleansed naming attributes and naming rules. Figure 5-25 shows an overview of the reconciliation processing. 
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    Figure 5-25   Name reconciliation overview

    Multiple discovery sources might know different naming attributes associated with the same computer system. For example, one tool might only have visibility to the IP address for a computer. Another tool might have access to the IP address and to the manufacturer, model, and serial number for a computer. Name reconciliation uses these overlapping naming attributes and naming rules and assigns unique identifiers. Computer systems with the same unique identifiers (also referred to as data integration service GUIDs or integration identifiers) are considered to be the same computer. Therefore, these unique identifiers are ideal for identifying duplicate computer systems already in your database and for ensuring that new duplicates never enter your environment.

    The naming reconciliation function in SmartCloud Control Desk is handled by an internal component, the naming and reconciliation service. As illustrated in Figure 5-25, the input to the naming and reconciliation service is a class type and a set of naming attributes for the resource. The naming and reconciliation service uses this input along with a set of naming rules to compute the unique identifiers and to manage the different aliases by which a single resource is known in different discovery sources. In this fashion, the naming and reconciliation service can be viewed as a “black box” that handles the internal details associated with uniquely identifying resources. 

    Although the naming and reconciliation service supports any of the class types defined in the common data model, data cleansing and reconciliation is only currently supported in SmartCloud Control Desk for computer system class types.

    Importance of duplicate detection

    The presence of duplicates in the SmartCloud Control Desk environment creates challenges. This section illustrate a scenario whereby the presence of duplicate computer systems introduces confusion when associating a change to the affected computer system. Without data cleansing and name reconciliation, a user might import three different representations of the same computer system. The impact analysis and scheduling of the change can have dramatically different results based on which of the three duplicates is selected. This results in user confusion and potentially failed implementation of the change, as depicted in Figure 5-26.
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    Figure 5-26   Potential impacts of duplicates on change management

    Previous releases of SmartCloud Control Desk had gaps in this area of data cleansing and reconciliation. These gaps and the associated customer challenges are highlighted in Table 5-1.

    Table 5-1   Gaps and challenges

    
      
        	
          Gap

        
        	
          Challenges

        
      

      
        	
          Data cleansing and reconciliation is not consistently performed when assets and configuration items enter the system through the UI or integration framework.

        
        	
          •Customers can create duplicates assets and configuration items (with the same naming attributes), which reduces integrity of the configuration management database.

          •Customer confusion about what instance of a duplicate asset or configuration item needs to be referenced in changes or tickets. 

          •No help given to the customer in identifying existing duplicates so they can clean up their database.

        
      

      
        	
          Uncleansed and unreconciled IT assets and configuration items already exist in the system and must be remediated.

        
      

      
        	
          Existing processes such as link-to-actuals and reconciliation correctly function only with cleansed data.

        
        	
          •Incorrect or missing links between assets and configuration items.

          •Incorrect or missing links between deployed assets and authorized assets.

          •Incorrect or missing links between actual configuration items and authorized configuration items.

        
      

    

    Data cleansing and reconciliation enhancements

    To address the gaps and customer challenges detailed in Table 5-1, several data cleansing and reconciliation enhancements are incorporated into SmartCloud Control Desk.

    In SmartCloud Control Desk 7.5.0, data cleansing and reconciliation was incorporated into IBM Tivoli Integration Composer:

    •IBM Tivoli Integration Composer reconciles actual configuration item computer systems and deployed assets during import with data integration service/naming and reconciliation service. It stores data integration service integration identifiers on those objects.

    •A new data cleansing service is embedded in IBM Tivoli Integration Composer engine with configurable cleansing rules. This cleansing service normalizes naming attributes of computer systems before they are reconciled.

    SmartCloud Control Desk 7.5.1 adds extra enhancements in this area:

    •A shared naming and reconciliation service-based reconciliation and cleansing service (function extracted out from V7.5.0 of IBM Tivoli Integration Composer engine) is now used across IBM Tivoli Integration Composer, the Maximo business object layer for assets and configuration items, and a new cleansing and reconciliation tool.

    •Data cleansing and reconciliation are extended to support authorized IT asset computer systems and authorized configuration item computer systems.

    •Updates to the authorized IT asset and authorized configuration item Maximo business object layer have been made to store data integration service integration identifiers and to perform cleansing and reconciliation whenever a computer system is saved or updated.

    •Provides a new data cleansing and reconciliation tool to remediate/cleanse/reconcile existing computer systems already in the system by storing data integration service integration identifiers on all computer systems.

    •Ready for use reports to identify duplicates based on data integration service integration identifiers (now stored in deployed assets, actual configuration item computer systems, and authorized IT asset and configuration item computer systems).

    •Updates to linking processes that depend on cleansed naming attribute to use data integration service integration identifiers when linking assets to configuration items, and when linking authorized configuration items to actual configuration items.

    Architecture overview of data cleansing and reconciliation

    Figure 5-27 illustrates the component architecture for the data cleansing and reconciliation enhancements in SmartCloud Control Desk. 

    [image: ]

    Figure 5-27   Data cleansing and reconciliation architecture

    •A common rules-based data cleansing service is shared between the IBM Tivoli Integration Composer and SmartCloud Control Desk Maximo components. This service normalizes naming attributes using a set of data transformation rules. 

    •Another common component, the naming and reconciliation service, computes unique identifiers for computer system assets and configuration items. The naming and reconciliation service is also shared and is used within IBM Tivoli Integration Composer and the SmartCloud Control Desk applications that run in Maximo.

    •The IBM Tivoli Integration Composer engine uses the data cleansing service and naming and reconciliation service to cleanse and reconcile any computer systems imported into SmartCloud Control Desk using IBM Tivoli Integration Composer. These include actual configuration item computer systems and deployed assets. 

    •The unique naming and reconciliation service-generated integration identifiers are now stored on deployed assets, actual configuration item computer systems, authorized IT asset computer systems, and authorized configuration item computer systems. Storing these unique identifiers on SmartCloud Control Desk objects provides improved detection of duplicates and more accurate linkages to be established between these items:

     –	Authorized IT asset computer systems and configuration item computer systems

     –	Deployed asset computer systems and authorized asset computer systems

     –	Deployed asset computer systems and actual configuration item computer systems

     –	Actual configuration item computer systems and authorized configuration item computer systems

    •On the Maximo application side, the asset and configuration item Maximo business object layers are updated to cleanse data, perform reconciliation, and detect duplicates anytime that an authorized asset computer system or authorized configuration item computer system is created or updated.

    •A new cron task, named the cleansing and reconciliation tool, can cleanse data and generate unique identifiers for assets and configuration item computer systems that have already been created in SmartCloud Control Desk. This tool helps remediate existing duplicates in your system.

    •Finally, we a set of ready for use reports is provided that can be used to identify duplicate computer systems.

    Data cleansing service

    The data cleansing service is a common component that normalizes the values of naming attributes using a configurable set of cleansing rules. The data cleansing service is started to cleanse data anytime a computer system is created or updated in SmartCloud Control Desk. This includes computer systems with these characteristics:

    •Created by IBM Tivoli Integration Composer from discovery sources.

    •Created or modified by users using the asset and configuration item applications.

    •Created or modified using the Maximo Integration Framework.

    The data cleansing service is illustrated in Figure 5-28.
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    Figure 5-28   Data cleansing service in SmartCloud Control Desk

    1.	The data cleansing service is given input in the form of “dirty” naming attribute values. In the example, the serial number, manufacturer, and model attributes are presented to the service.

    2.	The data cleansing service provides a simple application programming interface that allows IBM Tivoli Integration Composer and SmartCloud Control Desk to initiate the cleansing function.

    3.	For each naming attribute, a set of data transformation rules can be defined. The data cleansing service looks up the rules and runs the rules for the particular attribute.

    4.	The rules are defined in an XML file that you can modify based on your specific data sources. A rule set is included with SmartCloud Control Desk.

    5.	The output from data transformation is returned in the form of a collection of normalized naming attribute values. These values are used in the reconciliation processing that is performed by the naming and reconciliation service.

    Using integration identifiers to detect duplicates and improve linkages

    The terms integration identifier, naming and reconciliation service GUID, and data integration service GUID all refer to the unique identifier generated by the naming and reconciliation service component. An integration identifier is computed for each computer system in SmartCloud Control Desk based on the collection of naming attributes that are associated with the computer system. These integration identifiers are used for two important purposes in SmartCloud Control Desk 7.5.1 as illustrated in Figure 5-29. 
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    Figure 5-29   Integration identifiers are stored on computer system assets and configuration items

    •Perform duplicate detection

    The integration identifiers support the detection of duplicates. For example, two configuration items with the same integration identifier are duplicates of each other. SmartCloud Control Desk provides standard reports that use these integration identifiers to help clean up duplicate data already in the system. When new computer systems are imported or created in SmartCloud Control Desk, generate the integration identifier for the new computer system and try to find an existing computer system with that identifier. In this way, SmartCloud Control Desk is able to detect duplicates before they enter the system.

    •Improve linkages between objects

    The integration identifiers also allow you to link assets and configuration item computer systems more accurately. For example, an IT asset computer system and authorized configuration item computer system that share an integration identifier represent the same computer system. Use these integration identifiers in the process that links authorized assets and authorized configuration items, and in the process that links actual configuration items and authorized configuration items.

    Cleansing and reconciliation tool

    Because previous releases of SmartCloud Control Desk lacked data cleansing, reconciliation, and detection of duplicate computer systems, customers might already have duplicate data in the system. A new tool in SmartCloud Control Desk V7.5.1, named the cleansing and reconciliation tool, is provided to help cleanse existing computer systems and generate integration identifiers so that duplicate computer systems can be identified and remediated.

    This tool processes computer systems (authorized configuration item, actual configuration item, deployed assets, and IT assets). It cleanses naming attributes and generates data integration service integration identifiers for each computer system. It then stores the data integration service integration identifier in the object in the database.

    There are two main scenarios in which you would use the tool:

    •When upgrading, to reconcile and clean objects that are already in the system. 

    Reconciliation was introduced only for actual configuration item computer systems and deployed assets in V7.5. Existing authorized IT assets and authorized configuration items must be “fixed up.” They do not have data integration service integration identifiers already computed. The tool remediates data that were imported or created in the system before the reconciliation and cleansing functions were incorporated into SmartCloud Control Desk.

    •Cleansing or naming rules are changed. 

    Data integration service integration identifiers are computed from the values of naming attributes and from naming rules that reference those naming attributes. When cleansing rules or naming rules are modified, the data integration service integration identifiers must be reprocessed for correct linking and for identification of duplicate objects.

    The tool runs as a cron task in the MXServer. Tool input parameters are delivered as cron task parameters. The cron task name for the cleansing and reconciliation cron task is CCIGuidLoader. It is shown in Figure 5-30.
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    Figure 5-30   CCIGuidLoader cron task

    Cleansing and reconciliation cron task parameters

    The new cron task supports four parameters. These are illustrated in Figure 5-31. 
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    Figure 5-31   Cleansing and reconciliation tool parameters

    The cron task parameters are detailed in Table 5-2.

    Table 5-2   Summary of cleansing and reconciliation tool parameters

    
      
        	
          Parameter

        
        	
          Value

        
        	
          Notes

        
      

      
        	
           

           

           

           

           

           

           

           

           

           

           

           

           

          Action

        
        	
           

           

           

           

           

           

          load

        
        	
          Cleanse naming attributes, and compute and load data integration service integration identifiers for any objects that do not currently have data integration service integration identifiers loaded. Output includes summary results: Count of objects processed, count of objects assigned data integration service integration identifiers, and count of objects that did not satisfy any naming rules.

        
      

      
        	
           

           

           

           

           

           

           

           

          reload

        
        	
          Cleanse naming attributes and compute and load data integration service integration identifiers for all targeted objects even if those objects currently have data integration service integration identifiers loaded. Output includes summary results: Count of objects processed, count of objects assigned data integration service integration identifiers, count of objects whose data integration service integration identifiers were replaced, and count of objects that did not satisfy any naming rules.

        
      

      
        	
          ObjectList

        
        	
          All or a list of comma-separated values from CI, actci, deployedasset, or asset.

        
        	
          Specify the type of object that is to be processed by the specified action parameter. Optional. Default value is all.

        
      

      
        	
          WhereClause

        
        	
          SQL where clause.

        
        	
          Used to filter the set of target objects that are processed. Optional. No default. If not specified, all objects of the types that are specified by ObjectList are processed.

        
      

      
        	
          TimeLimit

        
        	
          Number of minutes that tool runs.

        
        	
          This argument can be used to limit the run time of the tool. For example, when processing many objects within a set maintenance window. Optional. Default is no time limit.

        
      

    

    Key tool messages

    When the cleansing and reconciliation tool is run, it generates messages in the MXServer log. There are two classes of messages that are issued:

    •Summary messages

    These are a block of messages that are issued for each type of object that is processed by the tool: ACTCI, CI, ASSET, DEPLOYEDASSET. These messages summarize the results of the cleansing and reconciliation that is run for each type of Maximo business object. Included are messages that identify:

     –	How many objects of that type were processed?

     –	How many objects were assigned an integration identifier?

     –	How many objects were assigned a different or the same integration identifier during recleansing?

     –	How many objects were unable to be assigned an integration identifier because those objects have insufficient/missing naming attributes? 

    A sample listing of the summary messages is shown in Example 5-1.

    Example 5-1   Summary message sample
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    CTGCC1228I - CCIGuidLoaderCronTask Summary for Type CI: 94 objects processed.  

    CTGCC1229I - CCIGuidLoaderCronTask Summary for Type CI: 92 objects assigned a Guid that previously had no Guid.     

    CTGCC1230I - CCIGuidLoaderCronTask Summary for Type CI: 0 objects were assigned a different Guid.  

    CTGCC1231I - CCIGuidLoaderCronTask Summary for Type CI: 0 objects were assigned the same Guid that the object previously contained.                             

    CTGCC1232I - CCIGuidLoaderCronTask Summary for Type CI: 2 objects were not assigned a Guid because those objects did not satisfy any naming rule.
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    •Instance messages

    For each object that is processed by the cleansing and reconciliation tool, a message is issued that identifies the result of the process for that object. These messages are summarized in Table 5-3.

    Table 5-3   Instance messages

    
      
        	
          Message purpose

        
        	
          Sample message

        
      

      
        	
          Identifies objects that were reconciled that previously had no integration identifier. This message indicates that the object has a usable set of naming attributes and is well-formed.

        
        	
          CTGCC1234I - Reconciled CI object with key KEYSTONE.IBM.COM_: Previously had no GUID and was assigned new GUID 42A7B1B4C630386A9021E50BE68C882C.

        
      

      
        	
          Highlights objects that do not have sufficient naming attributes. Investigate these objects further because you should only allow objects into the system if they have enough identifying attributes to satisfy at least one naming rule.

        
        	
          CTGCC1237W - Reconciled CI object with key KEYSTONE.IBM.COM~: Object was not assigned a GUID because the attributes on the object did not satisfy any naming rule.

        
      

      
        	
          Highlights objects which integration identifiers did not change as part of recleansing.

        
        	
          CTGCC1236I - Reconciled CI object with key KEYSTONE.IBM.COM: No changes made to the previously assigned GUID 42A7B1B4C630386A9021E50BE68C882C for the object.

        
      

      
        	
          Highlights objects whose integration identifiers changed as part of recleansing. This is the case if the cleansing or naming rules were changed.

        
        	
          CTGCC1235I - Reconciled CI object with key SOMECINUM: Previous GUID “old GUID” was replaced with a different GUID “new GUID”.

        
      

    

    Duplicate detection when asset and configuration item computer systems are saved

    The SmartCloud Control Desk IT Asset and Configuration Items applications have been updated in SmartCloud Control Desk V7.5.1 to use the cleansing and reconciliations functions to run duplicate detection. Whenever an asset or configuration item computer system is initially saved or when any of its naming attributes are modified, SmartCloud Control Desk V7.5.1 performs these tasks:

    •Cleanse the naming attributes of the object being saved.

    •Generate a data integration service integration identifier for the object using the naming and reconciliation service component.

    •Check to determine whether there is already an asset or configuration item computer system with that same data integration service integration identifier before saving the asset or configuration item.

    The intent is to not permit duplicate computer systems to ever enter into the system. The duplicate detection logic is run whether the computer system is saved or updated by using the IT Asset and Configuration Item application user interfaces or by using the Maximo Integration Framework. 

    Error messages are issued if the user attempts to save an asset or configuration item computer system with an identical integration identifier as an existing asset or configuration item computer system.

    Improvements to linking processes

    Because the integration identifiers that are assigned to computer systems represents unique identification for computer systems, they are ideal for use in the linking processes in SmartCloud Control Desk. These processes tie together authorized IT assets and authorized configuration items, and tie together actual configuration items and authorized configuration items. 

    Improving linking process for actual and authorized configuration items

    The link-to-actuals processing in SmartCloud Control Desk can associate authorized configuration items with their counterpart actual configuration items. This linking process is useful if a customer seeds their authorized configuration item space before importing the discovered configuration item space into SmartCloud Control Desk.

    In SmartCloud Control Desk V7.5.1, an enhancement to the cleansing and reconciliation support has been incorporated. With this enhancement, the link-to-actuals processing logic first attempts to link an authorized configuration item to an actual configuration item using the integration identifier available on both actual and authorized configuration item computer systems.

    There are two compelling advantages to using the integration identifier to link actual and authorized configuration item computer systems:

    •The accuracy of links between authorized and actual configuration items is improved by using the integration identifier because this unique identifier is generated from cleansed naming attributes.

    •The performance of linking authorized and actual configuration items is improved by eliminating costly comparison of multiple attributes and specs, and navigation of relationships.

    Figure 5-32 illustrates how the link-to-actuals processing in SmartCloud Control Desk V7.5.1 is improved by using the integration identifiers.
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    Figure 5-32   Using integration identifier when linking actual and authorized configuration items

    Improving linking process for authorized IT assets and authorized configuration items

    The asset and configuration item linking function that was introduced in V7.5 uses the reconciliation engine and link rules. An improvement to this process in V7.5.1 adds a reconciliation link rule that can link authorized IT assets and authorized configuration item computer systems using the integration identifier. 

    As in the link-to-actuals process, the incorporation of integration identifiers (generated from cleansed data) allows improvements to the accuracy and performance when linking authorized IT asset computer systems and authorized configuration item computer systems.

    Reports for identifying duplicate computer systems

    If you are upgrading to SmartCloud Control Desk V7.5.1 from earlier versions of SmartCloud Control Desk or IBM Tivoli Change and Configuration Management Database, you might already have duplicate computer systems in your environment. Earlier versions allowed the creation of IT asset and configuration item computer systems if the unique primary key rule was satisfied for those objects (for example, ASSETNUM for assets and CINUM for authorized configuration items). These duplicates can have been imported from discovery sources and promoted, can have been created using the IT asset and configuration item user interface applications, or can have been imported using the Maximo Integration Framework. 

    SmartCloud Control Desk V7.5.1 provides ready for use reports that group, by integration identifier, duplicate IT assets, deployed assets, actual configuration items, and authorized configuration items. A separate report is provided for each Maximo business object type. These reports identify duplicate objects to be cleaned up after an upgrade to SmartCloud Control Desk 7.5.1, or when cleansing and attribute mapping rules are modified and objects are re-cleansed and re-reconciled.

    The new reports are standard Business Intelligence and Reporting Tools reports, and are run using the standard Maximo report administration applications. 

    Figure 5-33 illustrates conceptually a scenario where three duplicates of the same computer system authorized configuration item are created in the system. Note the minor variations of the naming attributes that are normalized using data cleansing. 
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    Figure 5-33   Duplicate computer system configuration items

    After data cleansing, all naming attributes for the three configuration items are identical. During reconciliation processing, those three configuration items are assigned the same integration identifier. The standard reports can help you identify these duplicates.

    Report scenarios

    There are two primary scenarios in which you use the new reports for identifying duplicates.

    After you upgrade to SmartCloud Control Desk V7.5.1, you want to determine whether you have duplicate computer systems already in the database.

    You might also need to modify the data cleansing rules or the mapping rules that the cleansing and reconciliation functions depend on. Whenever you modify the rules, test those modifications by using the new reports to ensure that your changes had the wanted effect, and whether any new duplicates were surfaced for remediation.

    In either of these scenarios, you must run the cleansing and reconciliation tool before you run the reports. The reports visually present the groupings of integration identifiers that are assigned by the tool.

    Manual remediation

    The reports help identify duplicates in your system, but you must manually clean up any duplicates by using existing interfaces and functions in SmartCloud Control Desk. Drill down into the duplicate computer systems to determine which one is the appropriate one to keep (by examining related records, for example).

    Details about the new standard reports in SmartCloud Control Desk V7.5.1 are provided in Table 5-4.

    Table 5-4   Standard reports as shipped

    
      
        	
          Report

        
        	
          APP

        
        	
          Columns

        
        	
          Grouped by

        
        	
          Report parameters

        
      

      
        	
          ci_duplicates.

          rptdesign

        
        	
          CI

        
        	
          •CINUM

          •CLASSIFICATIONID

        
        	
           

           

           

          CCIDISGUID

        
        	
           

           

          To filter, can optionally specify StartDate and EndDate to process a range of objects based on CHANGEDATE

        
      

      
        	
          actci_duplicates.

          rptdesign

        
        	
          ACTCI

        
        	
          •ACTCINUM

          •CLASSIFICATIONID

        
      

      
        	
          asset_duplicates.

          rptdesign

        
        	
          ASSET

        
        	
          •ASSETNUM

          •SITEID

          •CLASSIFICATIONID

        
      

      
        	
          deployedasset_

          duplicates.

          rptdesign

        
        	
          DPLD ASSET

        
        	
          •NODENAME

          •ASSETCLASS

        
        	
          TLOAMNRSGUID

        
      

    

    Sample report listing

    Figure 5-34 illustrates a sample report listing. In this example, the duplicate authorized configuration items report is shown. There are two sets of duplicates shown here. The report is grouped by the integration identifier. 
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    Figure 5-34   Sample duplicate authorized configuration item report listing

    Configuring the data cleansing and reconciliation functions

    Three types of configuration are associated with the new data cleansing and reconciliation functions introduced in SmartCloud Control Desk V7.5.1.

    •Several new Maximo system properties allow you to define the policies that govern whether cleansing and reconciliation is enabled and how detected duplicates are handled.

    •Data cleansing rules identify the data transformation rules that are used to normalize naming attribute values.

    •Common data model mapping identifies which asset and configuration item classifications are to be cleansed and reconciled, and map the data in those classifications into common data model naming attributes.

    Maximo system properties

    The following list identifies the new properties that can be used to configure the data cleansing and reconciliation functions. These properties are fully documented in the product information center.

    cci.dis.enable 	Specifies whether the data cleansing and reconciliation functions are enabled or disabled.

    cci.dis.dupe.policy.ui 	Specifies whether the system allows the user to save duplicates from the user interface applications (for example, the authorized configuration item application)

    cci.dis.dupe.policy.background 	Specifies whether the system allows background processes and tasks or programs using the Maximo Integration Framework to save duplicates.

    cci.dis.poolsize 	Specifies the size of the thread pool that is internally used to start the naming and reconciliation service component when performing name reconciliation.

    On a fresh install of SmartCloud Control Desk V7.5.1, the defaults are set up to run data cleansing and reconciliation, and to not permit the saving of duplicate computer systems through either the UI or through background processes. On an upgrade, you must explicitly enable the new functions. No data cleansing or reconciliation is run and duplicates are permitted to be saved.

    These properties do not support “Live Refresh”. For changes made to these properties to take effect, the MXServer must be restarted.

    Naming attribute cleansing rules

    Naming attribute cleansing rules identify the common data model naming attributes and the data normalization rules that are applied when those naming attributes are cleansed. The rules are used by both the IBM Tivoli Integration Composer engine and by the SmartCloud Control Desk components that run in Maximo. 

    In SmartCloud Control Desk, the file is loaded out of the MAXIMO.EAR, and is on the Administrative Workstation at:

    <SmartCloud Control Desk_HOME_DIR>\maximo\applications\maximo\properties\SmartCloud Control Desk\cleansingRules.xml

    In IBM Tivoli Integration Composer, the file is on the IBM Tivoli Integration Composer Server at: 

    <ITIC_HOME_DIR>\data\properties\nrs\cleansingRules.xml

    Standard cleansing rules are tailored to normalize naming attributes for data sources that are imported using IBM Tivoli Integration Composer from Tivoli Application Dependency Discovery Manager and Tivoli Asset Discovery for Distributed into the actual configuration item and deployed asset space. If you bring in data from other sources using other IBM Tivoli Integration Composer adapters or the Maximo Integration Framework, you might need to configure the standard default rules.

    If you modify this file, be sure to use the XSD to validate the changes that you make. The XSD is at the same location as the XML file, and is named cleansingRules.xsd.

    If you customize the file on SmartCloud Control Desk, you must run a rebuild and redeployment of the MAXIMO.EAR for your changes to be picked up at run time.

    This file is shared between IBM Tivoli Integration Composer and SmartCloud Control Desk, but it is not synchronized. You must ensure that any changes made to the IBM Tivoli Integration Composer instance of the file are made in the SmartCloud Control Desk version as well. 

    The format of the file is fully documented in the SmartCloud Control Desk Information Center.

    Figure 5-35 illustrates the structure of this configuration file. 
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    Figure 5-35   Naming attribute cleansing rules

    Common data model mapping

    Common data model mapping identifies which asset and configuration item classifications are to be cleansed and reconciled, and maps the data in those classifications into common data model naming attributes. This file is only applicable to SmartCloud Control Desk, not to IBM Tivoli Integration Composer.

    In SmartCloud Control Desk, the file is loaded out of the MAXIMO.EAR and is on the Administrative Workstation at:

    <SmartCloud Control Desk_HOME_DIR>\maximo\applications\maximo\properties\SmartCloud Control Desk\CDMMapping.xml

    Common data model mapping rules are aligned with the best practices authorized configuration item and asset classes. For the authorized configuration item data model, these classes are included in the Deployer's Workbench best practices, or automatically loaded during a fresh install of SmartCloud Control Desk V7.5. For authorized IT assets, these classes are included with the IT asset management content process manager product. If you are using these classes for authorized IT assets and authorized configuration items, no changes are required to this common data model configuration file.

    If you have changed the best practices models or if you are using your own model classes, you must configure this mapping to take advantage of the data cleansing and reconciliation functions that have been added to SmartCloud Control Desk in V7.5.1.

    If you modify this file, be sure to use the XSD to validate the changes that you make. The XSD is at the same location of the XML file and is named CDMMapping.xsd.

    If you customize the file on SmartCloud Control Desk, run a rebuild and redeployment of the MAXIMO.EAR for your changes to be picked up at run time.

    The format of the file is fully documented in the product information center.

    Figure 5-36 highlights the questions that the common data model mapping answers. 
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    Figure 5-36   Information provided by the common data model mapping configuration file

    The common data model mapping file is structured into two main partitions.

    The first partition identifies, for each type of Maximo business object, the classifications that are considered to be computer system classifications for that business object. See Figure 5-37 for an example of the standard definitions. 
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    Figure 5-37   Specifying computer system classifications in common data model mapping

    The second partition identifies, for each naming attribute, how to load that attribute from the various types of Maximo business objects. See Figure 5-38 for an example of the standard definitions. 
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    Figure 5-38   Specifying Maximo business object attributes associated with naming attributes

    Troubleshooting

    This section provides troubleshooting information for the data cleansing and reconciliation functions added to SmartCloud Control Desk in V7.5.1.

    Enable and set to DEBUG level the Asset Management and pmpcci loggers using the Loggers application in Maximo.

    The log files to examine on the MXServer (under WebSphere) are SystemOut.log, SystemErr.log, and trace.out. A large quantity of debug output is generated. Be sure that you configure logs to have a large capacity so that the traces do not wrap.

    On the SmartCloud Control Desk server, the naming and reconciliation service is an important component that is used within the system. Use the WebSphere Application Server administrative console to set the trace for naming and reconciliation service as shown in Figure 5-39.

    [image: ]

    Figure 5-39   Setting the naming and reconciliation service and data integration service loggers in the administrative console

    Important trace points 

    This section describes some important trace points that are useful when debugging data cleansing and reconciliation issues:

    •What cleansed naming attributes were sent to naming and reconciliation service? 

    This trace point identifies the set of naming attributes and their values after they are cleansed. These represent the naming attribute values from which the naming and reconciliation service component computes the integration identifier (Example 5-2 on page 312).

    Example 5-2   Trace point sample
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    [1/18/13 15:31:32:187 EST] 000000ee SystemOut     O 18 Jan 2013 15:31:32:187 [DEBUG] [MXServer] [] class psdi.tamit.app.common.DISService registerByCdm 

    NOTE About to register to CDM with Map:

       {  Manufacturer=IBM, 

          ClassType=ComputerSystem, 

          PrimaryMACAddress=00016C858054, 

          Signature=9.26.70.41(00016C858054), 

          Model=8212, 

          SerialNumber=LKYR970 }
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    •No naming rule Satisfied Scenario. 

    This trace point indicates that no naming rule was satisfied and no integration identifier was generated. Each naming rule is listed with an indication of the missing attributes for each naming rule as shown in Example 5-3.

    Example 5-3   Trace point sample
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    [1/18/13 15:31:35:171 EST] 000000ef SystemOut     O 18 Jan 2013 15:31:35:171 

        [INFO] [MXServer] [] class psdi.tamit.app.common.DISService registerByCdm 

        INFO NrsNameException trying to register with NRS. 

        com.ibm.tivoli.namereconciliation.common.NrsApiException: 1002. 

        Insufficient identifying attributes were provided to construct a 

        valid name based on the naming rule.  

           NamingRule=sys/CDMComputerSystem_CSSignature, 

              MissingAttributes=Signature;              

           NamingRule=sys/CDMComputerSystem_CSProduct,

              MissingAttributes=Manufacturer+Model+SerialNumber;

           NamingRule=sys/CDMComputerSystem_CSUUID, 

              MissingAttributes=SystemBoardUUID;

           NamingRule=sys/CDMComputerSystem_PrimaryMACAddress, 

              MissingAttributes=PrimaryMACAddress;
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    •Before and After Values When An Attribute is Cleansed. 

    This trace point is issued whenever the cleansing process results in a change to a naming attribute value. In this example, the <UpperCase/> rule on the model naming attribute converts the model attribute value to all uppercase. The example is shown in Example 5-4.

    Example 5-4   Trace point sample
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    [1/18/13 15:31:36:093 EST] 000000ef SystemOut     O 18 Jan 2013 15:31:36:093 [DEBUG] [MXServer] [] NRS naming attribute Model got transformed from [model2] to [MODEL2]
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    Information Center topics

    The online SmartCloud Control Desk Information Center provides more details associated with the new data cleansing reconciliation functions. Click the following link to go to the section depicted in Figure 5-40:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.sccd.doc/int_comp/c_intro_nrs.html
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    Figure 5-40   Data cleansing and reconciliation topics in the online product Information Center

    5.3   Configuration management for service providers

    SmartCloud Control Desk allows configuration management for multiple customers in a single instance deployment. With this function, one or more customers can be associated with a CI or an actual CI. These customer associations can be used to keep the CI and actual CI records restricted to users who have permission to access the data that belongs to that customer. You can associate customers with users in the Security Groups (SP) application. 

    All of the customers on a CI or actual CI are used to determine who can access the data. One of the customers must be designated as the primary customer. The primary customer of a CI or actual CI determines the classifications and attributes of classifications that the CI or actual CI can use. All CIs and actual CIs can use global classifications and global attributes that apply to its classification. When you use customer-specific classification or customer-specific attributes, the primary customer (or parent of the primary customer) on the CI or actual CI must match the customer on the classification or attribute. 

    If you change the primary customer on a CI after it is classified, the current classification or attributes might not be appropriate for the new primary customer. SmartCloud Control Desk displays an informational message if this happens. Be sure to reevaluate the classification and attributes that are defined for the CI.

    5.3.1  Assigning customers to actual CIs

    When actual CIs are imported through Tivoli Integration Composer, they are not associated with any customer. Until they are associated with customers, they are visible to any users who have access to data that have no assigned customers. For this reason, assign customers to your actual CIs as soon as possible. You can assign customers to actual CIs manually, by using the Actual CI application, or by using a cron task. The cron task makes it easier to assign customers to large numbers of actual CIs. For more information about assigning customers to actual CIs, see:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v51r1/topic/com.ibm.tusc.doc/config/c_actci_intro.html

    Tivoli Application Dependency Discovery Manager has a location tag that can be used to identify which customer an actual CI belongs to in a multi-customer environment. Dynamic location tagging is especially helpful. For more information about location tagging in Tivoli Application Dependency Discovery Manager, see: 

    http://pic.dhe.ibm.com/infocenter/tivihelp/v46r1/topic/com.ibm.taddm.doc_721fp3/AdminGuide/r_cmdb_loc_tagging.html

    You can use this capability to tag all of the discovered CIs belonging to a particular customer with the same location tag. 

    Integration Composer can then filter the CIs so that only the CIs with the specified location tag values are imported. For more information about this capability, see: 

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/int_comp/c_location_tag_filtering.html

     

     

    
      
        	
          Top-level filtering: This Integration Composer filtering only happens at the top level. It assumes that all of the related actual CIs belong to the same customer, and imports related actual CIs to the configured depth.

        
      

    

    This location tag becomes an attribute on the actual CI when it is imported through Integration Composer. If you used the Integration Composer CI Types adapter to load the Common data model classifications, the name of the attribute is MODELOBJECT_LOCATIONTAG for all classifications. However, if the Common Data Model classifications were loaded when SmartCloud Control Desk was installed, the name of the attribute depends on the type of actual CI. If you plan to use the MODELOBJECT_LOCATIONTAG on the actual CI customer mapping cron task to identify and associate actual CIs with customers, use this attribute in the Customer Mapping XML as shown in Example 5-5.

    Example 5-5   Customer mapping XML
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    <?xml version="1.0" encoding="UTF-8" ?>

    	< actcicustmap completionEmailTo="you@your.address"

    	completionEmailSubject="optional subject"

    	preview="true"

    	requireItic="true"

    >

    <!-- this is the section for customer ACCOUNT1 -->

    <customer name="ACCOUNT1"

    	completionEmailTo="you@your.address"

    	completionEmailSubject="optional email subject for ACCOUNT1 "

    >

    <!-- starting with actual CIs whose MODELOBJECT_LOCATIONTAG equals CustomerA-->

    <AND>

    	<attribute name="MODELOBJECT_LOCATIONTAG" type="alnvalue">

    	<equals value="CustomerA" />

    	</attribute>

    </AND>

    </customer>

    <!-- END OF ACCOUNT1 customer definition -->
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    To omit any traversal of relationships in the Mapping Control XML, see Example 5-6.

    Example 5-6   Mapping Control XML
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    <?xml version="1.0" encoding="UTF-8" ?> 

    	<relationsToFollowRules> 

    	<relationsToFollowRule 

    	fromClassification="*" 

    	includeAllRelatedAsContainment="false" 

    	includeAllRelatedByRelation="" > 

    	</relationsToFollowRule> 

    	</relationsToFollowRules>
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    This precisely associates customers with all of the actual CIs that have a particular MODELOBJECT_LOCATIONTAG attribute and are not already associated with any customers. It performs better than using relationships to traverse related actual CIs. 

    If you want to use the MODELOBJECT_LOCATIONTAG, but your CDM classifications were created during product installation, you can still run the Integration Composer CI Types adapter to create the MODELOBJECT_LOCATIONTAG attributes on your CDM classifications and remove the class-specific ones. If you must have MODELOBJECT_LOCATIONTAG attributes on your authorized classifications, you need to add them. 

    Another option is to assign customers starting with top-level classifications that you care about, and have the cron task assign the same customers to related actual CIs. As an example, you can use the cron task to assign customers to all of your computer system types, and any related actual CIs. The location tag for all classifications of computer systems is called COMPUTERSYSTEM_LOCATIONTAG, so you can use Customer Mapping XML similar to the one shown in Example 5-7.

    Example 5-7   Customer mapping XML
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    	<AND>

    	<attribute name="COMPUTERSYSTEM_LOCATIONTAG" type="alnvalue"> 

    	<equals value="CustomerA" />

    	</attribute>

    	</AND>
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    To traverse all of the relationships, use a Mapping Control XML similar to the one shown in Example 5-8.

    Example 5-8   Mapping Control XML
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    <?xml version="1.0" encoding="UTF-8" ?> 

    	<relationsToFollowRules> 

    	<relationsToFollowRule 

    	fromClassification="*" 

    	includeAllRelatedAsContainment="true" 

    	includeAllRelatedByRelation="*" > 

    	</relationsToFollowRule> 

    	</relationsToFollowRules> 
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    That particular Mapping Control XML associates the customer with all of the related actual CIs, some of which might be owned by another customer. For example, you have a physical computer system that you, the service provider, own that contains virtual computer systems that you supply to different customers. You do not want to use that exact XML because it assigns all of the virtual computer systems to the same customer as the hosting computer system. In that case, consider using the stopClassifications tag on the cron task XML so that it stops at the classifications of your virtual systems. You can then associate those by using a separate mapping. 

    Always preview your results (preview=”true”) before actually assigning customers using the actual CI customer mapping cron task.

    Associating customers with CIs and actual CIs has implications on promotion, reconciliation, and baselines. 

    5.3.2  Service Provider considerations for promotion 

    When you promote an actual CI, any customers that are associated with that actual CI are copied to the CI that is created. The primary customer on the actual CI is designated as the primary customer on the CI. Therefore, associate customers with your actual CIs before you promote them. If the CI already exists (that is, if you are updating an existing CI), the customers on the CI are not updated. 

    Before a new CI is created by promotion, SmartCloud Control Desk verifies that the authorized classification in the promotion scope is appropriate for the primary customer on the actual CI being promoted. If it is not appropriate, no CI is created for that actual CI. If it is appropriate, the CI is created and classified. Only attributes that are appropriate for the primary customer on the CI are created. You can use this behavior to manage different types of CIs and attributes for different customers.

    To make it easier to assign customers to actual CIs, promotion propagates the set of customers from the top level actual CI that is being promoted to any related actual CIs that it processes that do not already have any associated customers. If you assign customers to your top level actual CIs and then promote them, those customers are associated with all of the child actual CIs in the promotion scope. They are also associated with any authorized CIs that get created by promotion.

    This is the default behavior, but the system can be configured to omit this processing. The MAXVAR named CCIACTCICOPYCUST controls this action. By default it is set to 1, which enables the copy. If you want to turn it off, use SQL to update the MAXVAR to 0. The following SQL is an example that you can use to update the MAXVAR to disable the copy:

    update maxvars set varvalue='0' where varname='CCIACTCICOPYCUST'

    5.3.3  Service Provider considerations for reconciliation

    In a Service Provider environment where you manage large numbers of configuration items for multiple customers, you must limit the configuration items targeted on a reconciliation task to a single customer for performance and security reasons. A customer field has been added to reconciliation tasks, task filters, link rules, and comparison rules to allow you to do this. 

    A customer who is associated with any task filters, link rules, or comparison rules that you apply to the reconciliation task must match the customer that you are setting up the reconciliation task for. If you specify a customer, you can only select task filters, link rules, or comparison rules that are associated with that customer. If you do not specify a customer, you can only select task filters, link rules, and comparison rules are not associated with a customer.

    When the reconciliation task runs, the records in data set 1 and data set 2 are limited to those that are associated with the specified customer. They are limited to those that are not associated with any customer, if no customer is specified.

    5.3.4  Service Provider considerations for baselines

    No customers are associated with baselines. However, because baselines consist of configuration items, and configuration items can be associated with customers, baselines have different behavior in a multi-customer environment. 

    When you create a baseline, you can only add CIs that you have access to. If you access a baseline that contains CIs that you do not have access to, those member CIs are hidden from you. A help text lets you know that some member CIs are hidden.

    If you create a new version of an existing baseline that contains member CIs that you do not have access to, the inaccessible members are copied to the new version. However, they remain hidden from your view. 

    If you create a new baseline from an existing baseline that contains member CIs that you do not have access to, the new baseline will not contain the CIs that you cannot access. 

    When you run a comparison, only those member CIs that you have access to are compared. The comparison results will indicate that some members were not compared. Also, the member CI are not compared if you do not have access to its linked actual CI. The results indicate this condition.

    It is a best practice for all CIs in a baseline to be associated with the same customer.
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Service catalog management

    This chapter describes the use of the Service Catalog applications with IBM SmartCloud Control Desk, the customizations, and the options that can be used when you create a catalog. 

    This chapter includes the following sections:

    •Service catalog management overview

    •Service catalog management using IBM SmartCloud Control Desk

    •Offering design

    •Catalog design

    •Enterprise App Store scenario

    •Restricting access to Catalogs and Offerings

    •Approving a request

    6.1  Service catalog management overview

    Since the emergence of concepts connecting business with IT, most notably with the publication of the first ITIL books in 1989, using IT as a strategic enabler has gained strength. This trend has been a natural consequence of the increasing presence of technology in the execution of various organizations’ strategic objectives.

    CEOs are inevitably asking CIOs and their IT services departments to help achieve their companies’ strategic goals. This trend follows a maturity path that originated with the technological approach of reducing costs and automating tasks into an approach in which IT is part of both strategic planning and execution.

    Some initiatives to increase the involvement of IT have failed. A common reason for this failure can be summarized as a misunderstanding by or an inability of some IT environments to deliver value from the clients’ point of view. Moreover, the search for value is so deeply attached to service provisioning that services are even defined around the value concept.

    A service can be defined as an offering, function, or activity that is delivered to an internal or external customer that might contribute revenue or complete a required task for an organization. Its output is created by using an organization's human, intellectual, financial, and physical assets.

    Value is achieved when the expert delivers a service that is a necessary and an acknowledged part of the client’s business goals. Defining and managing the necessary services to achieve specific business outcomes is a fundamental objective for any IT department that wants to be recognized as a business enabler, not solely as a simple technological function of the organization.

    The use of service catalog is defined as an ITIL process since ITIL V3. The goal of the service catalog is to help an organization by creating a list of services available for its internal or external users. 

    6.1.1  Capabilities

    To manage the use of the Service catalog process, SmartCloud Control Desk provides a complete end-to-end set of functions. These functions allow the definition of different types of requests for services, a way to locate those services, and a structured process that manages the delivery of these services. It provides cost savings through the streamlining, automation, and quality improvement of service delivery. Service Catalog can also be used to support management decisions about improving effectiveness of services and their delivery through assessment of service consumption patterns and the cost of fulfillment.

    The SmartCloud Control Desk Service Catalog provides the following capabilities:

    •Service request management integration

    •Definition of services and service providers

    •Management of service definitions

    •Shopping and browsing for services

    •Service entitlement

    •Service approval

    •Service provider integration and management

    •Service requisition notification and status monitoring

    •Service requisition data logging and analysis

    Organizations can choose to use all or some of these capabilities

    6.1.2  Roles

    The roles for service catalog management are defined in Table 6-1.

    Table 6-1   Service catalog management roles

    
      
        	
          Role

        
        	
          Responsibility

        
      

      
        	
          Service Catalog Administrator

        
        	
          The Service Catalog Administrator supports the Service Catalog Manager by managing records, tracking action items, and providing process-related reports.

        
      

      
        	
          Service Catalog Designer

        
        	
          The Service Catalog Designer implements the content and design of the Service Catalog. 

        
      

      
        	
          Service Catalog Manager

        
        	
          The Service Catalog Manager oversees the day-to-day execution of Service Catalog Management.

        
      

      
        	
          Self Service User

        
        	
          Users of service catalog, responsible for ordering offerings.

        
      

    

    6.2  Service catalog management using IBM SmartCloud Control Desk

    An overview of the service catalog is shown in Figure 6-1 on page 325. It summarizes the three main actions of SmartCloud Control Desk Service Catalog:

    •Create the catalog and make it available for the users, which are provided by the applications’ Catalog and Offerings.

    •Request offerings and track their fulfillment in the Self Service Center. In addition to requesting offerings, users can also get self-help, make requests against assets they are user or custodian of, and make requests of the Service Desk. The original applications, Offering Catalog, Shopping Cart, Cart Templates, and View Catalog Requests can also be used to request Offerings and track the requests.

    •Fulfillment of service requests, which are provided in several applications, such as Service Request and Work Order.
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    Figure 6-1   Service catalog usage in IBM SmartCloud Control Desk

    6.2.1  Applications

    The main applications that are used in the Service Catalog of IBM SmartCloud Control Desk are described in Table 6-2.

    Table 6-2   Application overview

    
      
        	
          Application

        
        	
          Description

        
      

      
        	
          Self Service Center

        
        	
          An integrated application where the service request user can browse available offerings, create and track service requests, make requests for their assets, and find solutions to issues they might have.

        
      

      
        	
          Catalogs

        
        	
          The catalogs, which can contain one or more offerings, are defined in this application. Catalogs are used by the Self Service Center and Offering Catalog applications.

        
      

      
        	
          Offerings

        
        	
          In this application, service designers create offerings. Creating an Offering entails defining the approval and fulfillment processes, specifications, and presentation.

        
      

    

    The security group of self service users can be configured to take the user directly to the Self Service Center instead of the traditional start center. This provides a better user experience and often saves the user from extra navigation.

     

    
      
        	
          Guideline: Self service users should use the Self Service Center instead of the older applications that are listed in Table 6-3 on page 327. The Self Service Center provides a better user experience and allows users to perform all operations from a single application. 

        
      

    

    Table 6-3 lists the older applications for Service Catalog for Self Service Users requesting services from the Service Catalog.

    Table 6-3   Older application overview

    
      
        	
          Application

        
        	
          Description

        
      

      
        	
          Offering Catalog

        
        	
          In this application, the Service Request User can see the available offerings and add offerings to its shopping cart.

        
      

      
        	
          Shopping Cart

        
        	
          In this application, the Service Request User can manage its offerings and submit the shopping cart.

        
      

      
        	
          View Catalog Request

        
        	
          The View Catalog Requests application allows users to view specific information about submitted requests, including service request details.

        
      

      
        	
          Cart Templates

        
        	
          Cart templates can combine several offerings that are usually ordered together. This list of offerings can be saved as a single cart template.

          The Cart Templates application allows you to view the list of offerings in a cart template, manage your cart templates, create a copy of a cart template for another user, add a selected cart template to the shopping cart, and delete a cart template. 

        
      

    

    6.3  Offering design

    Offerings are objects that are defined in SmartCloud Control Desk that encompass all the details of a service that can be requested by self service users. Offerings can be both IT specific (for example, provisioning a virtual machine) and non-IT specific (for example, onboarding a new employee).

    The following sections provide information about creating Offerings for a Service Catalog. Creating Offerings can be broken down into three main topics that include specifying high level Offering information, fulfillment, and attributes and presentation.

    The service catalog designer user is responsible for creating Offerings and managing their lifecycle. To create and manage offerings, use the Offerings application, which is opened by clicking Service Request Manager Catalog → Offerings.

    When a new offering is created, there are some common fields for all types of offerings. The main fields are described in Table 6-4.

    Table 6-4   Common fields in Offerings

    
      
        	
          Field

        
        	
          Description

        
      

      
        	
          Offering

        
        	
          Required field that is used as an identifier for the offering. This value is unique within the item set.

        
      

      
        	
          Item Set

        
        	
          Identifies the item set for the Offering. Item sets can be used to segregate data. This value is read only and is derived from the Organization. 

        
      

      
        	
          Offering description

        
        	
          Required field that provides a brief description or title of the Offering. The description field is used as the primary title shown to users browsing the Service Catalog by using the Self Service Center or Offering Catalog.

        
      

      
        	
          Long description

        
        	
          Provides more details for the Offering. Rich text can be used when you define the long description to include links, graphics, font changes, and lists. A portion of the long description is shown to users as they navigate. It is shown in full in the Offering dialog. 

        
      

      
        	
          Offering Type

        
        	
          Defines the type and fulfillment process of the Offering.

          There are three types of offerings available for use: Descriptive, Action, and Service Request.

           

          For more information about the Offering types, see 6.3.1, “Offering types” on page 332.

        
      

      
        	
          Attachments

        
        	
          Used to provide more information or forms to a user. To add an attachment, click the attachment icon and select Add New Attachment.

        
      

      
        	
          Image

        
        	
          Identifies the image associated with the Offering. It can be changed by clicking Select Action → Add/Modify Image

        
      

      
        	
          Service Group

        
        	
          Service group is a method for grouping similar Offerings based on the service offered. For example, you might have an IT Service Group that has services for user IDs and passwords, network support, and so on.

        
      

      
        	
          Service

        
        	
          Defines the service offered within the service group, and is used to group similar Offerings based on the service offered.

        
      

      
        	
          Classification

        
        	
          Classification is a required field. When the type is defined as Action or Service Request, the classification is copied to the resulting Service Request. Any specification attributes that are defined on the Classification are also copied to the Offering.

           

          The classification is used as the default Offering Catalog Taxonomy, and is the path self service users navigate to find an Offering in the catalog.

        
      

      
        	
          Classification Description

        
        	
          The description of the offering classification is the text that is shown to users as they are navigating the Classification when browsing the available Offerings.

        
      

      
        	
          Fulfillment Time

        
        	
          A static value that is used to indicate approximate fulfillment time on an Offering dialog. If a value is present, the information is automatically shown on the default dialogs.

        
      

      
        	
          Unit of Measure

        
        	
          Used with fulfillment time to indicate approximate time to fulfill a request for an Offering.

        
      

      
        	
          Status

        
        	
          The status represents the current state of the Offering in its lifecycle.

           

          The status is initially set to the default item status defined on the organization. This value must be planning or pending. The primary Offering details can be edited only if the status is planning or pending. Otherwise, they are read only.

           

          After an Offering is ready for users to begin requesting it, the status must be made active.

           

          Offerings that are no longer required in the system transition to Pending Obsolescence, then finally to Obsolete.

        
      

      
        	
          Shipping Info Required

        
        	
          Mark this field when the service defined by this offering requires a shipping address. For example, if the new offering created is used to deliver an item to a customer, this field must be marked.

           

          When an Offering request is submitted that requires shipping information, the user is prompted with an extra dialog to provide the shipping details.

        
      

      
        	
          Display Initially

        
        	
          This field does not affect requests generated from the Self Service Center.

           

          Mark this field if you want the offering to be displayed in the initial query when the user enters the Offering Catalog. This option only applies when the user enters the Offering Catalog application for the first time. This flag is ignored for any subsequent accesses to the application. Mark this field for the most important offerings available on your system.

        
      

      
        	
          Offering Uses Quantity

        
        	
          Mark this field if the user can order more than one of this service at one time. If this offering is used to order a product, this field can be marked depending on the availability of the product. If this offering is used to offer a service, do not mark this field. 

           

          Without configuration, this flag applies only to Offerings that use the default dialog.

        
      

      
        	
          Keywords

        
        	
          Keywords can be added to an Offering to increase searchability for users. Meaningful keywords increase the likelihood of users finding the Offering they intend to request.

        
      

      
        	
          Service Desk Offering

        
        	
          This field determines how the user navigates to the Offering. Checking this box indicates that this Offering is used to solve Service Desk requests such as resetting a password. Offerings that are marked as Service Desk Offerings are found by following the Report an Issue link in the Self Service Center navigator.

           

          If this field is cleared, users can navigate to this Offering under the Request a New Service link in the Self Service Center navigator.

        
      

      
        	
          Frequent Request

        
        	
          Mark this field if the you want to provide a fast path for finding this Offering in the Self Service Center. Users can navigate to all Offerings marked as Frequent Request by clicking Frequent Requests → Systemwide Frequent Requests. 

           

          This field does not apply to the Offering Catalog.

        
      

      
        	
          Allow Comments and Ratings

        
        	
          This check box is used primarily by the default dialogs to enable or disable the ability of users to add or view comments and ratings for Offerings. If the box is checked, users are able to add or view comments and ratings.

        
      

    

    Figure 6-2 shows a sample Offering definition.

    [image: ]

    Figure 6-2   Sample Offering definition

    Follow these guidelines when you define an Offering:

    •Use Service Desk Offerings for common requests for service desk users, such as resetting a password. Using Service Desk Offerings with a ticket template provides a mechanism for quick ticket routing.

    •The classification of the Offering is used as the default taxonomy that self service users use when browsing for offerings. The taxonomy that is used when adding the Offering to a catalog can be changed, allowing the designer to use a different classification path for user browsing. In addition, using a different taxonomy across catalogs allows the user to navigate to the same offering in multiple ways.

    •When you define the classifications used for the Offering Catalog Taxonomy, keep in mind that the description for each node is shown in the breadcrumb as the user navigates down the tree. If the description of each node has the full hierarchy in the description, the data will look like they are repeated.

    6.3.1  Offering types

    Of the three types of Offerings, Service Request is most commonly used as it provides the greatest flexibility for request tracking, approvals, and fulfillment automation. This section covers the guidelines for Descriptive and Action Offerings. Service Request Offerings are introduced and covered in greater detail throughout the chapter.

    Descriptive Offering

    Use this type of offering to provide the self service user with general information that can include links to services offered outside of SmartCloud Control Desk. A description of the action that the user must take is typically described in this offering. A service request is not generated for these types of Offerings.

    An example of this type of offering is providing the user with a link to more information, such as resetting their IBM developerWorks password.

    Action Offering

    Use this type of offering when the organization wants to integrate the new offering with an external service, URL, or application. In this type of offering, Launch in Context or a workflow must be used to define the access to the integrated service or application.

    Use Launch in Context if the action is to access an external URL.

    Use workflows for stand-alone executable actions that do not require approvals or when a work order is not created.

    It is possible to access SmartCloud Control Desk using both Launch in Context and workflows, depending on the organization’s needs.

    When the user selects Action as the type, the Action Offering Information section is displayed. This allows the service designer to select whether it is Launch in Context or a Workflow.

    There are two specific fields for this type of offering. The fields are described in Table 6-5.

    Table 6-5   Action Offering fields

    
      
        	
          Field

        
        	
          Description

        
      

      
        	
          Action type

        
        	
          Type of action that is used on the offering, which can be Workflow or Launch in Context.

        
      

      
        	
          Launch in Context/Workflow

        
        	
          Workflow/Launch in Context used for the action offering to specify the workflow or Launch in Context to be run when the Offering is requested.

        
      

    

    Figure 6-3 shows the configuration for Action Offerings.
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    Figure 6-3   Action Offering Information window

    To create a new Workflow, use the Workflow Designer application, which can be opened by clicking System Configuration → Platform Configuration → Workflow Designer.

    To create a new Launch in context option, use the Launch in context application, which can be opened by clicking System Configuration → Platform Configuration → Launch In Context.

    Action offerings can pass information, including attribute information, to a started service. When an action offering is run, a catalog request and service request are automatically opened and closed for accountability purposes.

    Action offerings cannot be added to a cart.

    Service Request Offering

    Service Request is the most commonly used type of Offering. It is governed by process workflows, some of which can be defined on a per Offering basis. SmartCloud Control Desk provides a set of best practice workflows that can be used or modified based on the needs of the environment. The process workflows and default approval workflows are configured at an Organization level.

    All workflows used with Offerings must be enabled, active, and set to object SR. To view, modify or create a new workflow, use the Workflow Designer application, which can be opened by clicking System Configuration → Platform Configuration → Workflow Designer.

    Providing the configuration and input parameters for the process workflows is covered in subsequent sections.

    The following sections note the primary best practice process workflows that are provided in SmartCloud Control Desk.

    Initiate WorkFlow on Catalog Request submission

    This is the default workflow used when a new catalog request is submitted and the workflow type is default. It is the primary workflow that governs the entire fulfillment process, and calls the approval workflows followed by the workflow to set up the fulfillment processing.

    Figure 6-4 shows the most recent ready for use workflow, PMSC_SR4, that controls the request processing. Note that there are two sub processes: One for managing the approval process and another for managing the fulfillment options. 
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    Figure 6-4   PMSC_SR4 workflow

    Figure 6-5 illustrates the APP_WF sub process, PMSC_SR4A, which is responsible for completing the approval process. 
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    Figure 6-5   Workflow approval

    The approval workflow runs the following actions:

    1.	Checks whether the offering requires the approval of a line manager.

    2.	Checks whether a line manager workflow has been specified on the Offering. If it does not exist, the default line manager approval workflow is started.

    3.	Wait for the approval of the line manager. If the line manager approves the request, the status is set to APPLM. If the line manager rejects the request, the status is set to RESOLVED and the workflow stops.

    4.	Checks whether the offering requires the approval of a fulfillment manager.

    5.	Checks if a fulfillment manager workflow has been specified on the Offering. If it does not exist, the default fulfillment manager approval workflow is started.

    6.	Wait for the approval of the fulfillment manager. If the fulfillment manager approves the request, the status is set to APPR and the approval workflow stops. If the fulfillment manager rejects the request, the status is set to RESOLVED and the workflow stops.

     

    
      
        	
          Tip: Note the use of the @ symbol in the approval workflow nodes. The use of this symbol is explained in greater detail in 6.3.3, “Fulfillment” on page 342.

        
      

    

    If the status is set to APPR, the sub process OPTION_WF is started to complete the fulfillment processing.

    The fulfillment workflow runs the following actions:

    1.	Applies a ticket template to the Service Request (Action: PMSC_APPLY_TT) 

    A conditional node checks to see whether a ticket template is specified on the offering associated with the service request. If a ticket template exists, the action applies it automatically. When the ticket template includes a job plan, an activity work order is created, and a job plan is applied. The activity work order is displayed on the Service Request Activities tab.

    2.	Create a standard work order (Action: PMSC_CREATE_WO) 

    A conditional node checks to see whether the Create Standard Work Order flag is specified on the offering associated with the service request. If the flag is enabled, a standard work order is created. If there is a job plan specified on the offering, it is applied to the work order.

    3.	Create a change work order (Action: PMSC_CREATE_CH_WO) 

    A conditional node checks to see whether the Create Change Work Order flag is specified on the offering associated with the service request. If the flag is enabled, a change work order is created.

    4.	Copy the SR specification to the work order (Action: PMSC_SR_COPYSPEC) 

    A conditional node checks to see whether the Copy SR Specification to Work Order flag is specified on the offering associated with the service request. If the flag is enabled, the custom action copies the service request specification data (TICKETSPEC) to the work order specification (WORKORDERSPEC).

    5.	Copy the SR attributes to the work order (Action: PMSC_SR_COPY_WO) 

    A conditional node checks to see whether the Copy SR Attributes to Work Order flag is specified on the offering associated with the service request. If the flag is enabled, the custom action uses the TICKET2WO crossover domain to copy service request attributes to the work order.

    6.	Copy the SR attributes to the work order and tasks (Action: PMSC_SR_COPY2TASKS) 

    A conditional node checks to see whether the Copy SR Attributes to Work Order and Tasks flag is specified on the offering associated with the service request. If the flag is enabled, the custom action uses the TICKET2TASKS crossover domain to copy service request attributes to the work order and associated tasks.

    7.	Invoke a workflow on the change work order (Action: PMSC_INVOKE_CH_WF) 

    A conditional node checks to see whether the Create Change Work Order flag is specified on the offering associated with the service request. If the flag is enabled, the custom action starts a workflow on the change work order that was previously created. To specify a workflow to start, update the Parameter/Attribute field for this action.

    8.	Invoke a workflow on the change work order (Action: PMSC_INVOKE_WO_WF) 

    A conditional node checks to see whether a workflow is defined to be started after the Work Order is created. If the flag is enabled, the custom action starts a workflow on the work order that was previously created. To specify a workflow to start, update the Parameter/Attribute field for this action. 

    Figure 6-6 illustrates the OPTION_WF sub process PMSC_SR4B, which is responsible for completing all of the fulfillment actions. 
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    Figure 6-6   PMSC_SR4B workflow

    Initiate WorkFlow for Service Request Line Manager Approval

    This is the default workflow that is used when a catalog request is submitted and a Service Request Line manager is required. This workflow seeks one level of approval from the supervisor listed on the requester’s person record.

    Figure 6-7 illustrates the default line manager approval workflow, PMSC_LMD1. 
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    Figure 6-7   PMSC_LMD1 workflow

    Initiate WorkFlow for Service Request Fulfillment Manager Approval

    This is the default workflow that is used when a catalog request is submitted and a Service Request Fulfillment manager is required. 

    Figure 6-8 illustrates the default fulfillment manager approval workflow, PMSC_FMD1. 
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    Figure 6-8   PMSC_FMD1 workflow

    Initiate Apply Response Plan WorkFlow on Catalog Request submission

    This is the default workflow that is used when the catalog request submitted was defined using a Response Plan as the workflow type. This workflow starts the response plan engine that is used to find the best matching response plan.

    Figure 6-9 illustrates the default response plan workflow, PMSC_SR2. 
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    Figure 6-9   PMSC_SR2 workflow

    To change or add a response plan, use the Response Plans application, which can be opened by clicking Service Level → Response Plans.

    Using response plans allows for a way of dynamically fulfilling a request based on user input. Response plans can be ranked and defined with criteria to match incoming requests. However, take caution with this approach in that the permutations can grow quickly. 

    Check supervisor prior to cart submission

    This checks whether the user who is requesting the service has a supervisor defined in the Users application

    To view the set of workflows for an Organization, navigate to the Organizations application. Select your organization and click Select Action → Service Catalog Options → Workflow options for service catalog.

    The default workflows provided are shown in Figure 6-10. 
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    Figure 6-10   Default workflows

    6.3.2  Approvals

    When the Offering is defined as a Service Request, the designer is able to configure the approvals that are needed when the Offering is requested. The default process workflow provides for both a line manager approval and a fulfillment manager approval. The workflows that are used in these processes were described previously.

    There might be instances where no approval is needed by either the line manager or fulfillment manager. Examples can include simple automated processes such as a password reset.

    Conversely, there might be a need for multiple levels of management approval for a user request. Examples can include large capital requests.

    The Offerings application provides a simple method to configure the approval processes that are needed. When an Offering is created, the approvals are set to preapproved. The service designer can then choose to use the default workflow from the requester’s organization, or specify a custom approval workflow for the Offering.

    The fields that are used when configuring approvals are found in the Table 6-6.

    Table 6-6   Fields to configure approvals

    
      
        	
          Field

        
        	
          Description

        
      

      
        	
          Line manager approval - Preapproved

        
        	
          When this field is enabled, the default workflow automatically approves the service request. The service request status is set to APPLM, which indicates that the line manager has approved the request.

        
      

      
        	
          Line manager approval - Default Workflow

        
        	
          Indicates that the workflow used for line manager approval processing is specified under the Service Catalog Workflow Options for the organization and site.

        
      

      
        	
          Line manager approval - Workflow

        
        	
          Specifies the workflow that is used during the line manager approval process. This workflow overrides the value specified under the Service Catalog Workflow Options for the organization and site. The specified workflow must set the service request status to APPLM if the approval is granted, or RESOLVED if the approval is denied.

        
      

      
        	
          Fulfillment manager approval - Preapproved

        
        	
          When this field is enabled, the default workflow automatically approves the service request. The service request status is set to APPFM indicating that the fulfillment manager has approved the request, or RESOLVED if the approval is denied. 

        
      

      
        	
          Fulfillment manager approval - Default Workflow

        
        	
          Indicates that the workflow used for fulfillment manager approval processing is specified under the Service Catalog Workflow Options for the organization and site.

        
      

      
        	
          Fulfillment manager approval - Workflow

        
        	
          Specifies the workflow that is used in the fulfillment manager approval process. This workflow overrides the value specified under the Service Catalog Workflow Options for the organization and site. The workflow that is specified must set the service request status to APPFM or RESOLVED. 

        
      

    

    An approval workflow configuration illustrating a custom line manager approval and a preapproved fulfillment manager approval is shown in Figure 6-11. 
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    Figure 6-11   Example approval workflow

    Identifying approval tasks in custom approval workflows

    Many workflows include task nodes that are used to require an individual to approve or disapprove the requested work.

    When you create a task node for an approval task, begin the title of the task node with the @ symbol. This convention enables the node to be recognized as an approval task. If the workflow is applied to a service request, identifying the approval tasks enables the requester to view the current pending approval for the service request. The requester can also view approvals that have been completed.

    Some workflows include automatic approvals that are not recorded in the database, and therefore do not appear in the list of approvals for the service request. If you are designing a workflow and it contains automatic approvals, and you want the automatic approvals to appear in the list of approvals for the service request, create an action group that includes the automatic approval task and insert a new action type named AUTO_ASSIGN_ACCEPT after the automatic approval. Otherwise, the approval is not recorded, but the workflow proceeds. After you add this action type, the approval task appears as having been performed by the Maximo administrative user in the Self Service Center.

    For an example of an action group that includes the AUTO_ASSIGN_ACCEPT action type, see the PMSC_SR3A workflow.

    The product currently displays approvals only in the Self Service Center. You can use the AUTO_ASSIGN_ACCEPT action type in any type of workflow that includes automatic approvals if you want to record them in the database so the approval can be viewed in reports or (after modifying it) the user interface.

    6.3.3  Fulfillment

    The next step in defining an Offering is to configure the fulfillment details. SmartCloud Control Desk is flexible in that it allows both manual and fully automated fulfillment of requests. Depending on the requirements in the system, activity, standard, or change work orders can be created and related back to the original service request.

    After the approval is complete, the fulfillment workflow completes the fulfillment actions based on the configuration. 

    Table 6-7 lists the allowable configuration options when you are defining Offering fulfillment.

    Table 6-7   Fields to configure fulfillment

    
      
        	
          Field

        
        	
          Description

        
      

      
        	
          Ticket template

        
        	
          Allows you to identify the ticket template to apply to the service request. The ticket template is applied after approval processing is complete. When a job plan is specified on the ticket template, an activity work order is created. 

        
      

      
        	
          Standard work order workflow

        
        	
          Allows you to specify a workflow that gets initiated after the workflow is created. This can be important for initiating automated processes. 

        
      

      
        	
          Create standard work order

        
        	
          Allows you to create a standard work order for the service request.

        
      

      
        	
          Create change work order

        
        	
          Allows you to create a change work order for the service request. 

        
      

      
        	
          Job plan

        
        	
          Allows you to specify a job plan that is applied when the standard work order field is enabled.

        
      

      
        	
          Copy SR specification to work order

        
        	
          This option copies the service request specification data (TICKETSPEC) to the work order specification (WORKORDERSPEC).

        
      

      
        	
          Copy SR attributes to work order

        
        	
          This option uses the TICKET2WO crossover domain to copy service request attributes to the work order.

        
      

      
        	
          Copy SR attributes to work order and tasks

        
        	
          This option uses the TICKET2TASKS crossover domain to copy service request attributes to the work order and associated tasks.

        
      

    

    Figure 6-12 illustrates the options with configuration for an Offering that creates a standard work order, applies a job plan, then starts a workflow for the work order. 
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    Figure 6-12   Options for a standard work order

    Follow these guidelines when configuring fulfillment:

    •Create a standard work order and specify a job plan in the Offering instead of adding the job plan to the ticket template to create an activity work order.

    •A ticket template can be used to specify an owner or an owner group to quickly route new requests.

    •To reduce the amount of space used in the database, the copy options provide the flexibility to copy data only to the objects that require it.

    •When using a ticket template, be careful not to specify a classification in the template. The classification overwrites the value from the Offering and likely will remove any specification data that has been entered by the user.

     

    6.3.4  Scripting

    When required, you can validate attributes, offerings, and shopping carts by using Jython or JavaScript validation scripts (other scripting types are also supported). Those scripts must be defined in the Automation Scripts application, which you can open by clicking System Configuration → Platform Configuration → Automation Scripts.

    There are four types of script validation for the Service Catalog, add to cart, submit cart, and attribute validation. These script types are described in the next sections. In addition, a script can be used to prepopulate data in an Offering dialog. All sample scripts are written in Jython with a log level of ERROR. Only scripts that have a status of Active can be associated with an Offering.

    Figure 6-13 illustrates an Offering configured with a prepopulation and submit cart script. 
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    Figure 6-13   Script configuration for an Offering

    For more information about validation scripts, see the following documentation at IBM developerWorks:

    https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Service%20Request%20Manager/page/Jython%20Scripts

    Submit cart script

    IBM SmartCloud Control Desk allows an organization to add validation as a part of the shopping carts for its users. Cart validation can be useful when validating data across multiple Offerings, starting a process to complete a request, or setting values on the Service Request at the time of submission.

    Submit Cart Scripts can be defined on a per offering basis or for an Organization that runs every time that a cart is submitted. To define a global submit cart script, use the Organization application. Select your organization and click Select Action → Service Catalog Options → Submit cart script for service catalog. Then, select the script you want as shown in Figure 6-14.
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    Figure 6-14   Submit cart script

    Submit cart scripts can be added to individual Offerings and are defined on the Offering tab in the Offering application.

    For example, if you have an offering to build a new server with middleware, one of the options is to install a new database to the server. Selecting this option might require that a second offering of adding a database to a server be added. A cart validation script can be added to validate that both Offerings are present in the cart before submitting the cart.

    This example is included in the content available with SmartCloud Control Desk. The first offering is named PMSC_2021A, and the attribute name that defines whether a database is installed is named INSTDB. The second offering (adding a database to the server) is named PMSC_2007A.

    The script checks that offering PMSC_2021A is on the cart, and if it is, checks whether INSTDB attribute is checked. With these conditions, the second offering PMSC_2007A must be on the shopping cart too, or an error message is displayed.

    The script that is used in this example is shown in Example 6-1.

    Example 6-1   Cart validation script
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    rc = 1

    errmsg = ''

     

    foundPMSC_2021A = False

    foundPMSC_2007A = False

     

    numItems = len(itemsInCart)

     

    for i in range(numItems):

     item = itemsInCart[i]

     if item != None:

      itemnum = item.getString("PMSCITEMNUM")

      if itemnum == 'PMSC_2021A':

       attrs = itemAttributes[i]

       dbyesno = attrs.getValue("INSTDB")

       if dbyesno == '1':

       foundPMSC_2021A = True

      elif itemnum == 'PMSC_2007A':

       foundPMSC_2007A = True

     

    if foundPMSC_2021A == True and foundPMSC_2007A == False:

      rc = 0

      errmsg = 'If Build New Server with Middleware is in the cart and the Install DB attribute is 1, then the Add Database To Server offering must also be included in the cart'

     

    print rc

    print errmsg
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    A second example of a submit cart script is a request to deploy a new virtual machine as shown in Example 6-2.

    Example 6-2   Cart validation script - 2
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    from java.lang import Runtime

    from java.lang import Process

     

    hostname = offeringAttributes.getString("ALNVALUE1")

     

    ipaddress = offeringAttributes.getString("ALNVALUE2")

     

    sr = offeringAttributes.getMboSet("SR").getMbo(0)

     

    ticketid = sr.getString("TICKETID")

     

    ticketuid = sr.getString("TICKETUID")

     

    process2 = Runtime.getRuntime().exec("/opt/IBM/scripts/automation/staf-deploy-vm.sh" + " " + hostname + " " + ipaddress + " " + ticketid + " " + ticketuid)

     

    print 1
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    Add to cart script

    This type of script is used when validation must be done as an offering is added to the cart. A typical scenario is to validate all the data that has been input by a user as the user adds the Offering to the cart. For example, a script can be used to validate that a start date occurs before a requested end date.

    Add to cart scripts are defined on the Offering tab in the Offering application.

    An example script to solve this issue is displayed in Example 6-3. The attributes PMSCSTARTDATE and PMSCENDDATE are used as the start and end date in the offering.

    Example 6-3   Add to cart script
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    # Check that end date comes after start date and add the data to the long description on the sr

     

    from java.text import SimpleDateFormat

    from java.lang import StringBuffer

    from psdi.mbo import MboConstants

     

    fmt = SimpleDateFormat('MM/d/yy')

     

    rc = 1

    errmsg = ''

    startdatestr = offeringAttributes.getValue("PMSCSTARTDATE");

    #startdatestr="12/1/10"

     

    enddatestr = offeringAttributes.getValue("PMSCENDDATE");

    #enddatestr = "11/1/10" 

     

    if len(startdatestr) > 0 and len(enddatestr) > 0: 

     startdate = fmt.parse(startdatestr)

     enddate = fmt.parse(enddatestr)

     if enddate.before(startdate):

      rc =0

      errmsg = 'The Start Date must occur before the End Date'

     

    print rc

    print errmsg
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    Attribute validation

    Scripts can be associated with specific attributes to validate data that are entered by the user, or to populate data in other fields upon a data change. To associate a script with a specific attribute, set the validation script for the attribute on the Specifications and Presentations tab of the Offering.

    These validation scripts are started as the user enters data and tabs or moves out of a field.

    The first sample script illustrates validating an IP address that has been entered as shown in Example 6-4.

    Example 6-4   User input validation script
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    errmsg = ''

    rc = 1

    ipList = newValue.split('.')

    if len(ipList) == 4:

     for i in ipList:

      try:

       i = int(i)

      except:

       rc = 0

       errmsg = i, ' is not a valid number. IP Addresses must contain valid numbers'

       break

      if i > 255:

       rc = 0

       errmsg = i, ' is greater than 255. Valid IP Addresses are between 0 and 255.'

       break

    else:

     rc = 0

     errmsg = 'IP Addresses must be in the form nn.nn.nn.nn'

    print rc

    print errmsg
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    The second example (Example 6-5) illustrates setting a default database directory (DBDIR) and administrator (DBADMIN) if they currently do not have values when the add database to server box is selected.

    Example 6-5   Data update script
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    if (newValue == '1'):

     dbdir = offeringAttributes.getValue("DBDIR")

     dbadmin = offeringAttributes.getValue("DBADMIN")

     if len(dbdir) == 0:

      offeringAttributes.setNewValue("DBDIR", "c:/ibm/db2")

     if len(dbadmin) == 0:

      offeringAttributes.setNewValue("DBADMIN", "db2admin")

    print 1
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    6.3.5  Presentation and specification attributes

    Offering dialogs are the self service user’s view of an Offering. They use the dialogs to view the details, complete any required information, and submit requests for the Offering.

    When an offering is created, there are two options for creating a dialog: Default and custom. This choice is defined by using the Specifications tab in the Offering application. Custom dialogs are required to be used when a Custom MBO is used, attributes require special handling such as sigoptions for conditional UI, or the dialog requires a special layout such as a wizard.

     

    
      
        	
          Tip: Use the default dialogs whenever possible to simplify the Offering creation process.

        
      

    

    Beginning with SmartCloud Control Desk 7.5.0.0, Offering dialogs were moved to the PMSCOFFER application, and can be edited by using the Application Designer application. Although dialogs can still be stored in library.xml, moving them to the PMSCOFFER application removes the need for service designers to write XML and modify a system library file.

    To aid in dialog creation, a new action to clone an existing dialog has been added. This action allows a service designer to use an existing dialog as a template. A sample dialog in addition to dialogs for the sample content has been included for this purpose.

    The Specifications and Presentations tab in the Offering application includes a Preview Dialog button that shows the currently configured dialog.

     

    
      
        	
          Note: The preview of the dialog is shown in a read only mode. Any elements that have sigoptions added are not shown.

        
      

    

    Specification attributes

    In most cases, Offerings are defined with a set of specification attributes. When an Offering is classified, any attributes that are attached to the classification are automatically added to the Offering. Attributes cannot be dynamically added without being predefined in either the Classification application or in the Offering application by using the Add / Modify Attribute action. After specification attributes are defined in the system, they can be added to an Offering. Unneeded attributes can be deleted from the Offering.

    The Offerings application contains two views of an attribute. The first is the attribute details, including type and description. The second view shows presentation information for the attribute. This is covered in detail in the following sections.

    Default dialogs

    Use a default dialog when the user is presented with zero or a simple list of specification attributes. To use a default dialog, the Presentation Type field on the Specifications and Presentation tab must be set to the default dialog. When this is done, some additional configuration options are available. These options are shown in Table 6-8.

    Table 6-8   Configuration options for default dialogs

    
      
        	
          Configuration option

        
        	
          Usage

        
      

      
        	
          Display User Attachments Link

        
        	
          Select this option when the user needs to add more attachments. This can be useful in cases where a user must attach a form, image, or similar data.

        
      

      
        	
          Display Add to Cart and Order Now Buttons

        
        	
          There are instances where the Service Designer might not want to allow the self service user to add the Offering to a cart. When the box is checked, the user can submit the request immediately or add the Offering to the cart. If the box is cleared, the user can only submit the request.

        
      

      
        	
          Display Asset Field

        
        	
          This displays the asset field from the Service Request on the dialog. This is useful in cases where the Offering is requested for a specific asset. An example is deploying software to a target asset.

        
      

      
        	
          Display Price

        
        	
          This optionally hides pricing information from an individual Offering.

        
      

    

    Figure 6-15 illustrates the default dialog configuration options. 
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    Figure 6-15   Default dialog configuration options

    After the high-level dialog options are configured, the next step is to add, remove, or modify the specification attributes. A default set might have been added when the Offering was classified.

    Multiple configuration options are available with a default dialog to control how the attribute is presented. Table 6-9 lists the presentation details for a specification attribute in a default dialog. 

    Table 6-9   Presentation details for a specification attribute in a default dialog

    
      
        	
          Configuration option

        
        	
          Usage

        
      

      
        	
          Sequence

        
        	
          This determines the order that the attributes are displayed in the dialog.

        
      

      
        	
          Mandatory

        
        	
          The user is required to enter a value for this attribute.

        
      

      
        	
          Hidden

        
        	
          This attribute is not shown on the dialog. This is useful when data must be passed to approvers or the fulfillment process.

        
      

      
        	
          Read Only

        
        	
          The attribute is not able to be edited by the user. This allows the user to view data but not make any changes.

        
      

      
        	
          Checkbox

        
        	
          The user input method is a check box.

        
      

      
        	
          Calendar

        
        	
          This is used to allow the user to enter a date. 

        
      

      
        	
          Multiline

        
        	
          This shows multiple lines of text for user input. The maximum length is defined by the specification attribute, which has a system-wide default of 255 characters.

        
      

      
        	
          Exclude From Template

        
        	
          Mark this if the attribute should not be included in a cart template. Use this for passwords, serial numbers, and similar data.

        
      

      
        	
          Validation Script

        
        	
          This is the attribute-specific validation script.

        
      

      
        	
          Attribute Help

        
        	
          Provides some simple text when the user hovers over the label of the specification attribute.

        
      

    

     

    
      
        	
          Remember: The sequence numbers of the attributes do not automatically update. Use increments of 10 to make updates to the sequencing easier. 

        
      

    

    Figure 6-16 illustrates the default dialog attribute presentation configuration options. 
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    Figure 6-16   Default dialog attribute presentation configuration options

    Five default dialogs are provided with the product. The dialog that is used depends on the configuration details of the Offering, as shown in Table 6-10.

    Table 6-10   Configuration details for Offerings

    
      
        	
          Dialog ID

        
        	
          Offering Type

        
        	
          Service Desk?

        
        	
          Number of Attributes

        
        	
          Remarks

        
      

      
        	
          defaultDialogCr

        
        	
          Action / Service Request

        
        	
          N

        
        	
          >= 1

        
        	
          This dialog is used for non-service desk Offerings that contain attributes. 

        
      

      
        	
          defaultDialogNoAttributesCR

        
        	
          Action / Service Request

        
        	
          N

        
        	
          0

        
        	
          This dialog is used for non-service desk Offerings that have no attributes.

        
      

      
        	
          defaultDialogCRSD

        
        	
          Action / Service Request

        
        	
          Y

        
        	
          >= 1

        
        	
          This dialog is used for service desk Offerings that contain attributes.

        
      

      
        	
          defaultDialogNoAttributesCRsd

        
        	
          Action / Service Request

        
        	
          Y

        
        	
          0

        
        	
          This dialog is used for service desk Offerings that have no attributes

        
      

      
        	
          descriptiveDialogCR

        
        	
          Descriptive

        
        	
          N/A

        
        	
          N/A

        
        	
          This dialog is used for all descriptive Offerings.

        
      

    

     

    
      
        	
          Note: Dialogs for Service Desk Offerings contain reported priority and summery fields that can be filled in by the user and are not found on the non Service Desk Offerings. 

        
      

    

    Custom dialogs

    Use a custom dialog when custom MBOs are required, complex layouts such as a wizard, or attributes must have sigoptions for specific behavior. To use a custom dialog, the Presentation Type field on the Specifications and Presentation tab must be set to custom dialog. When this is done, some extra configuration options are available as shown in Table 6-11.

    Table 6-11   Extra configuration options

    
      
        	
          Configuration option

        
        	
          Usage

        
      

      
        	
          Custom Dialog Name

        
        	
          This is the ID of the custom dialog to be used. A lookup allows the service designer to see the available dialogs that can be selected. This is a mandatory field.

        
      

      
        	
          Display Add to Cart and Order Now Buttons

        
        	
          There are instances where the Service Designer might not want to allow the self service user to add the Offering to a cart. When the box is checked, the user can submit the request immediately or add the Offering to the cart. If the box is cleared, the user can only submit the request.

           

          Note: This option is not used unless the same sigoptions from the default dialog are migrated to the custom dialog. The buttons can be configured directly on the dialog.

        
      

      
        	
          Display User Attachments Link

        
        	
          Select this option when the user needs to add extra attachments. This can be useful in cases where a user must attach a form, image, or similar data.

           

          Note: This option is not used unless the same sigoptions from the default dialog are migrated to the custom dialog. The attachments link can be configured directly on the dialog.

        
      

      
        	
          Display Price

        
        	
          This hides pricing information from an individual Offering where showing the estimated price is not needed.

           

          Note: This option is not used unless the same sigoptions from the default dialog are migrated to the custom dialog. Display of price information can be configured directly on the dialog.

        
      

    

    Figure 6-17 illustrates the default dialog configuration options. 

    [image: ]

    Figure 6-17   Default dialog configuration options

    After the high-level dialog options are configured, the next step is to add, remove, or modify the specification attributes. A default set might be added when the Offering is classified.

    A small set of configuration options are available with a custom dialog. Table 6-12 lists the presentation details for a specification attribute in a default dialog.

    Table 6-12   Presentation details for a specification attribute in a default dialog

    
      
        	
          Configuration option

        
        	
          Usage

        
      

      
        	
          PMSCCRSPEC Column

        
        	
          This is the name of the attribute in the PMSCCRSPEC table that the specification attribute must map to in the dialog. These values must be used when you define the dialog to ensure that the values entered by the self service user match the correct attribute.

        
      

      
        	
          Exclude From Template

        
        	
          Mark this if the attribute should not be included in a cart template. Exclude passwords, serial numbers, and similar data.

        
      

      
        	
          Validation Script

        
        	
          This is the attribute-specific validation script.

        
      

    

    Figure 6-18 illustrates the custom dialog attribute presentation configuration options. 

    [image: ]

    Figure 6-18   Custom attributes for custom dialogs

     

    
      
        	
          Important: Pay special attention to the PMSCCRSPEC mapping shown in the attribute section. This is needed to ensure the correct mapping of data as they are created from the offering to the service request.

        
      

    

    Creating a custom presentation bean

    When a custom dialog is created, it is also possible to create a new custom presentation bean to be used with the dialog. A presentation bean is the Java class that is used to define the actions available for the created presentation dialog.

    The new bean that is created must extend com.ibm.ism.pmsc.webclient.beans.shoppingcr.PmScInputSpecBean, which is the class used in the default presentation dialog. Extending ensures all actions available for the default presentation offering are present in the new offering.

    The following list notes some actions that can be done by using a custom presentation bean:

    •Pre-populate attribute fields using application data or external data

    It is necessary to change the initialize method inside the new customPresentationBean class to fill the data you want to be pre-populated. The method that is used to do this population is named setValue.

    •Extend current button functionality

    There are five predefined buttons in the PmScInputSpecBean class available for all default and custom presentation dialogs. The buttons are described in Table 6-13.

    Table 6-13   Buttons available for presentation dialogs

    
      
        	
          Action

        
        	
          Method signature

        
        	
          Function

        
      

      
        	
          Add to cart

        
        	
          int opencrdr() throws MXException, RemoteException 

        
        	
          Insert the offering in the Shopping Cart and starts the Shopping Cart application

        
      

      
        	
          Execute/Launch

        
        	
          int execute() throws MXException, RemoteException

        
        	
          Used for Action Offerings only, execute the workflow or the Launch in Context action

        
      

      
        	
          Cancel

        
        	
          int cancelClicked() throws MXException, RemoteException

        
        	
          Cleans up records that were created when offering was selected and closes dialog.

        
      

      
        	
          Add to favorites

        
        	
          void addtofav() throws MXException, RemoteException

        
        	
          Adds the selected offering to the Favorite Offerings list.

        
      

      
        	
          OK

        
        	
          int okClicked() throws MXException, RemoteException

        
        	
          Update the values that were changed for the Offering. Not available for the Offering Catalog application. 

        
      

    

    The Service Designer user can extend the functionality of any of these buttons by overriding the methods in the custom presentation dialog.

    •Add new button function

    You can add buttons to the custom presentation bean. To do so, the Service Designer user must create a new method to handle the new function.

    An example of a custom presentation dialog bean is shown in Example 6-6.

    Example 6-6   Custom presentation bean
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    package com.ibm.ism.pmsc.webclient.beans.shoppingcr;

     

    import java.rmi.RemoteException;

     

    import psdi.mbo.MboConstants;

    import psdi.util.MXException;

     

    // New class must extend PmScInputSpecBean

    public class MyCustomPresentationBean extends PmScInputSpecBean {

     

    //Change initialize method to have pre populated attributes

    protected void initialize() throws MXException, RemoteException

    {

    	// This calls the initialize method on the PmScInputSpecBean class, 

    	// it is required

    	super.initialize();

    	// This calls setValue method and set John Doe to field defined as 

    	// aln1 on the presentation

    	this.setValue("aln1", "John Doe", MboConstants.NOACCESSCHECK);

    	this.setValue("num2", "12345", MboConstants.NOACCESSCHECK);

    	moveTo(0);

    }

     

    // Override one of the existing methods. On this example, the method 

    //that will be overriden is execute

    int execute() throws MXException, RemoteException

    {

    	System.out.println("Executing service");

    	// Calls the execute event from PmScInputSpecBean.

    	super.execute();

    	// Add here the required extra code required to add a new 

    	// functionality for the class

    	return EVENT_HANDLED;

    }

     

    //Creates a new button functionality, in this case named email

    int email() throws MXException, RemoteException

    {

    	// Add here the required code for the new functionality

     return EVENT_HANDLED;

    } 

    	

    }
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    6.3.6  Custom MBOs

    There are many use cases in which users must add multiple entries when requesting a service. Examples can include adding software to a newly requested system, requesting access to a building, or requesting that ports be opened in a firewall. 

    There are also cases where the standard ALN, NUMERIC, and TABLE specification attributes do not adequately address the types or amount of data that must be collected in an Offering dialog.

    Support for Custom MBOs has been added to address these use cases. Maximo business objects (MBOs) are the business objects used by SmartCloud Control Desk. By using Custom MBOs, service designers can create offering dialogs that contain a table control. The table control can be used to collect information about the offering in a tabular format. This format allows users to request services with multiple similar resources in a single request form.

    This format minimizes the number of distinct items that the requester must order, while providing the ability to use resource information for dynamic requests and assignment workflows. 

    To generate this offering, the service designer must create a custom MBO to handle the information provided in the offering by using the database configuration application. 

    When you create a custom MBO, the new object must include the required attribute TICKETID so that it can be associated with the service request’ generated by the user. The custom MBO must also have a specific class (com.ibm.ism.pmsc.custommbo.PmScComplexItemSet).

    An offering can have more than one custom MBO associated with it, but each custom MBO must be unique in that offering. Similarly, custom MBOs can be shared across multiple offerings.

    Creating a custom MBO 

    To create an MBO in the database, use the Database Configuration application, you can open by clicking System Configuration → Database Configuration.

    Complete the following steps to create the new object:

    1.	In the Database Configuration application, click the New Object icon.

    2.	Type a name in the Object field and a description of the object in the Description field. The Entity field shows the value that you typed in the Object field and becomes the name of the table in the database.

    3.	Change the value in the Class field to the following syntax:

    com.ibm.ism.pmsc.offering.PmScComplexItemSet

    4.	Select Main Object and Persistent as shown in the building access example in Figure 6-19.
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    Figure 6-19   New MBO: Object tab

    5.	Click the Attributes tab and add the attributes that are required for the tabular data object. The attribute TICKETID must also be added because it is the required attribute used to relate the data in the custom MBO to the service request. Set Same as Object to TICKET and Same as Attribute to TICKETID. Figure 6-20 shows the configuration for the TICKET attribute. 
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    Figure 6-20   Configuration for the TICKET attribute

    6.	Specify any indexes that are needed for this object in the Indexes tab. This step is optional.

    7.	Click Save Object.

    Some attributes are automatically created. In this example, the MBO does not use long descriptions or an HASLD attribute, so these attributes are marked to be deleted in the Status column. All other attributes are marked to be added to the database.

    If the object is ready to be inserted into the database, you can use the following steps to insert it:

    1.	In the Database Configuration application, select Manage Admin Mode from the Action menu. To select Manage Admin Mode, you must not select any records.

    2.	Click Turn Admin Mode ON.

    3.	Click OK. A window opens that indicates that the Admin Mode is starting.

    4.	Click OK. Refresh the status and the following message is displayed if the admin mode was turned on successfully: 

    BMXAA4002I - Administration mode is on for this server

    5.	Click the Apply Configuration Changes action to configure the database and restore backup tables. 

    6.	Refresh the status to check the progress. The following message is displayed when the configuration finishes: 

    BMXAA6820I - ConfigDB completed without errors

    7.	To turn off Admin Mode, click the Admin Mode action, and then click Turn Admin Mode OFF. The following message is displayed if the admin mode was turned off successfully: 

    BMXAA4003I - Administration mode is off for this server

    If the new object no longer has To be added as the status, the database configuration was run successfully.

    Next, a relationship between SR and the new object must be created. The parent of the relationship must be SR, so the relationship must be created in the SR object. This configuration is required to use the new MBO in the service catalog.

    To create the relationship for the new object and SR object, complete these steps:

    1.	Click New Row.

    2.	Fill the Relationship field with the name of the custom MBO created.

    3.	Fill the Child Object field with the name of the custom MBO created.

    4.	Fill the whereClause field with ticketid=:ticketid. This is the link between SR and the new object created.

    5.	Save the object.

    An example of this new relationship is displayed in Figure 6-21.
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    Figure 6-21   New relationship

    Using a Custom MBO inside an Offering

    After the object is created, it can be used when creating an Offering. To use a custom MBO with an Offering, add a row and find the new MBO based on the relationship name that was created previously. You can optionally specify a minimum and maximum number of rows that can be added.

    If Table Data is selected, this Custom MBO is used to gather multiple lines of data as in the building access or software examples. If it is left cleared, only a single instance of the Custom MBO is used with the Offering request to use specific data types or a custom data model outside of the standard specification attributes.

    As with the specification attributes, you can configure which data is used when this object is used as part of an Offering that is included in a Cart Template. If specific attributes must be excluded from a cart template, an Object Structure must be created. The following example permits all data to be added to a template.

    Figure 6-22 shows how a custom MBO can be added to an Offering. 
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    Figure 6-22   Custom MBO

    Custom MBOs can only be used when a custom dialog is used. To reference the new object, a data source must be used in the dialog. The building access dialogs provide an example of how this can be done.

     

    
      
        	
          Hint and tip: Data from Custom MBOs is not stored as part of a Service Request or Work Order. To view the data entered by the user, click Show Offering Dialog in the Service Request or Work Order applications.

        
      

    

    Dialog considerations

    At this point, create the custom dialog to be used with the custom MBO. It can be created according to the needs of each offering.

    To create a new dialog, you can use the Application Designer. Complete these steps:

    1.	Click Go to → System Configuration → Platform Configuration → Application Designer.

    2.	Find and load the application PMSCOFFER.

    3.	The easiest way to start a new custom dialog is to clone an existing dialog. Two examples using a custom MBO are BuildingAccess (uses a multi-line table) and BuildingAccessNoTable (uses the custom attributes, but not in a multi-line table).

    4.	Edit the dialog using the Edit Dialogs option.

    5.	When you are finished making the dialog changes, save the dialog. Remember to find the datasrc that uses the relationship to PMSCBLDACCESS and update it to use the relationship you created to the custom MBO.

    6.3.7  Price and cost

    Services offered through the Service Catalog often have associated prices to reflect actual costs that are based on the parts and labor needed to fulfill that service. In many cases, the prices are billed directly to the user or to the user’s department. 

    Prior releases had limited support for displaying the price of a service to a user. In those releases, displaying pricing information required extra configuration in the system.

    With the most recent release of IBM SmartCloud Control Desk, Service Catalog uses the Price Books application from Service Provider to maintain and display estimated price information. Price Books allows both a one time and a recurring price to be defined for each individual Offering. For example, if a user is requesting a mobile phone, the Offering can display a one time price for the device hardware and the activation fee, and a monthly recurring price for the voice and data plans.

    When a user requests an Offering, both the one time and recurring unit prices are stored on the Service Request. If that Offering is configured to allow a quantity to be specified, the total unit and recurring prices are also stored on the Service Request. 

    The prices that are associated with an Offering must only be used to convey estimated pricing. The actual price that is billed is based on the actual costs of parts and labor, taking into account any discounts from customer agreements.

     

    
      
        	
          Note: To fully support billing for services using IBM SmartCloud Control Desk, the Service Provider Managed or Internal editions must be used. The standard edition can only display the estimated price to a user.

        
      

    

    Pricing configuration

    Pricing for Service Catalog Offerings can be configured both globally and on a per Offering basis. The global configuration setting for displaying price enables or disables pricing for Offerings throughout the entire system, including Offering design, self service, and service fulfillment. The global setting takes precedence over the per Offering configuration setting. If the global setting for pricing is enabled, the service designer is able to configure individual Offerings to display pricing information.

    For systems that have not been upgraded, pricing is enabled globally by default while systems that have been upgraded have pricing globally disabled to maintain system continuity after upgrade. To enable or disable pricing on a global level, a system property, pmsc.catalog.displayprice, is used. A value of 0 disables the display of pricing information, and a value of 1 enables display. Figure 6-23 illustrates the global pricing configuration. 
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    Figure 6-23   Global pricing configuration

    If the global setting to display pricing is enabled, individual Offerings can then be configured to display or not display pricing information. To enable the display of pricing information, select Display Price in the Offering application. Figure 6-24 illustrates the Offering level pricing configuration. 
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    Figure 6-24   Offering level pricing configuration

     

    
      
        	
          Note: This setting is only available if the Offering is using a default dialog. Offerings that use custom dialogs can be configured to display pricing information if needed directly in the dialog.

        
      

    

    In most cases, the catalog contains a mixture of services that have costs associated with them. For these cases, globally enable displaying pricing information, configure display on each Offering. To be consistent, you might want to always show a price for each service, but show a value of 0 where no costs are associated.

    Defining a Price Book

    A Price Book contains all of the pricing information for use with Service Catalog. The type of Price Book must be defined with a type of OFFERING. Price Books contain a list of all the Offerings that are configured to display pricing information. 

    Price Books are also associated with an Organization. The currency that is defined for that Organization is then used for the Price Book. A single Offering can be displayed in multiple currencies by adding it to separate Price Books that have distinct Organizations and currencies.

    Price information is displayed only for Price Books that are APPROVED, the default Price Book, and Price Books that have not expired or reached their end date. There can only be a single Price Book that meets these criteria per Organization.

    Figure 6-25 shows the primary information that is defined for a Price Book. 
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    Figure 6-25   Price Book tab

     

    
      
        	
          Note: The List Price value is not currently used by Service Catalog Offerings.

          When making a revision of a Price Book, the effective date can only be the next calendar day or later. Make sure that prices are accurate before approving the Price Book.

        
      

    

    The price history and different prices for multiple currencies of an Offering is visible in the Offering application. The Price and Cost tab shows all of the Price Books the current Offering is part of. If the Offering is associated with a Job Plan, the costs that are associated with labor and materials can also be seen. 

    Figure 6-26 shows the Price and Cost tab for an Offering. 
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    Figure 6-26   Price and Cost tab for an Offering

    6.3.8  Ratings and user comments

    As commonly found on many Internet shopping sites, users in IBM SmartCloud Control Desk are able to rate and make comments on individual Service Catalog Offerings. In the Offerings application, a service designer or administrator is able to view all of the comments and ratings that have been made by users. 

    If any comments and rankings are determined to be invalid, inappropriate, or no longer apply, they can be marked inactive by checking the box in the table. Marking a comment and ranking inactive removes it from the average rating calculation. In addition, records marked as inactive are not visible by users in the Offering dialog. 

    An example of ratings and comments that are provided by users as shown in the Offerings application can be seen in Figure 6-27.
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    Figure 6-27   Comments and Ratings window

    There are at least two ways to use the user comments and ratings. The first allows users to provide specific feedback to the service designers on individual Offerings. The feedback can include how the Offering was fulfilled, the ease of filling out the Offering dialog to make the request, and suggestions for adding or removing options. The service designer can use this information to make adjustments and updates to the Offering. In this case, old feedback can be marked inactive so that the rating is based on comments for the updated Offering.

    The other approach allows users to share feedback with the broader user community on how satisfied they were with the Offering. This paradigm is commonly used for internet shopping sites.

    Allowing users to provide comments and ratings can be configured on a per Offering basis. To allow users to provide comments and ratings, select Allow Comments and Ratings on the main Offerings tab. This check box enables the tab and button on the default dialog. For custom dialogs, this check box has no effect unless the appropriate sigoptions and conditions are configured for that dialog.

    6.3.9  Adding Offerings to a Catalog

    Offerings can be added to a Catalog directly from the Offering application. To add the current Offering to one or more Catalogs, use the Add Offering to Catalog action. The resulting dialog lists all the Catalogs that this Offering is not currently part of. You can use this window to check the Catalogs this Offering should be included in. In addition, the taxonomy can also be modified from the dialog.

    Figure 6-28 illustrates a user adding the Offering to multiple catalogs using a different taxonomy for each Catalog. 
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    Figure 6-28   Add to Catalogs window

    Offerings can be added to a Catalog from the Offering application at any time. However, if you want to modify the taxonomy, the Offering must have a status of planning or pending.

    The classification of the offering is used as the default taxonomy self service users use when browsing for offerings. The taxonomy that is used when adding the offering to a catalog can be changed, allowing the designer to use a different classification path for user browsing. In addition, using a different taxonomy across catalogs allows the user to navigate to the same offering in multiple ways.

    When defining the classifications used for the Offering Catalog Taxonomy, remember that the description for each node is shown in the breadcrumb as the user navigates down the tree. If the description of each node has the full hierarchy in the description, it can seem as though data is repeated.

    The result of the action is illustrated in Figure 6-29. To remove an Offering from a Catalog, the delete icon can be used. 
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    Figure 6-29   Catalog list

    6.4  Catalog design

    Catalogs are used as container objects for one or more Offerings, and can be used to authorize groups to different sets of Offerings. In addition, multiple Catalogs can be used to provide users with different navigation paths when distinct taxonomies are used.

    With the introduction of the Self Service Center, the notion of separate Catalogs was hidden from the user. They simply see a single collection of Offerings regardless of Catalog. In the Offering Catalog applications, users are able to browse by specific Catalog.

    The service catalog designer user is responsible for creating the new catalogs. To create and manage catalogs, the application that is used is Catalog, which you can open by clicking Service Catalog → Catalogs.

    In the first tab, enter the catalog name and the description for the catalog. In the second tab, add the required offerings for this catalog. To add offerings to the new catalog, click Add Offerings and select the offerings to be included. Only offerings with Active status can be requested by self service users.

    An example of a Catalog with five Offerings is shown in Figure 6-30. 
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    Figure 6-30   Offering tab

    If you prefer to add multiple offerings, you can click Select Action → Add Multiple Offerings. Offerings that are currently not part of the Catalog can be selected and added.

    After all the offerings that you need are added to the catalog, change the status to Active and the catalog will be available for users.

     

    
      
        	
          Hint and tip: The classification of the offering is used as the default taxonomy self service users use when browsing for offerings. The taxonomy that is used when adding the offering to a catalog can be changed, allowing you to use a different classification path for user browsing. In addition, using a different taxonomy across catalogs allows the user to navigate to the same offering in multiple ways.

        
      

    

    6.5  Enterprise App Store scenario

    The sample content for SmartCloud Control Desk contains a sample Offering, TEMDEPLOY. This was created to integrate with Tivoli Endpoint Manager to deploy a software package to an asset specified by a user. After the environment is configured for the integration, the Offering can be duplicated to create more Offerings that enable automated software deployment of other software. The collection of these Offerings can be used to build an Enterprise App Store where self service users can browse the catalogs of available applications and request to have them automatically deployed to their asset. For an example of what an Enterprise App Store might look like to a self service user, see “Enterprise Application Store” on page 541.

    The TEMDEPLOY Offering takes advantage of some of the new fulfillment features in SmartCloud Control Desk. The Offering was defined to create a standard work order, apply a job plan to that work order, and start a workflow to change the status to initiate the job plan actions. The Job Plan contains a single action that runs a workflow, SCCDTEMDEP, which does the integration with Tivoli Endpoint Manager after conducting a check for an available license. If the software deployment succeeds, the license count is decremented. Figure 6-31 illustrates the workflow that is used to run the software deployment. 
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    Figure 6-31   Tivoli Endpoint Manager workflow

    In this workflow, Jython scripts are called to handle the integration with Tivoli Endpoint Manager. Other scripting languages such as JavaScript can also be used.

    6.6  Restricting access to Catalogs and Offerings

    You can restrict the access of groups to specific catalogs or offerings by using the Security Groups application. All security configurations are done using the Service Catalog tab in the Security Groups application.

    By default, groups that access the self service applications are authorized to view all Catalogs and Offerings that are active. Groups with access to the service design applications are authorized to view all Catalogs and Offerings. 

    To manage security, the Service Catalog tab contains two check boxes that have similar purposes. They both create data restrictions to restrict access to Offerings and Catalogs. The first check box restricts access in the self service applications such as the Self Service Center and the Offering Catalog. The second check box restricts access to those objects in all applications. When one of the check boxes is checked, a set of data restrictions is created. 

    Table 6-14 shows the data restrictions that are created when the self service restrictions check box is checked.

    Table 6-14   Data restrictions for the Offering Catalog and the Self Service Center

    
      
        	
          Application

        
        	
          Type

        
        	
          Object

        
        	
          Condition

        
      

      
        	
          PMSCOFFCAT

        
        	
          Qualified

        
        	
          PMSCCATALOG

        
        	
          PMSCCATQSTAT

        
      

      
        	
          PMSCOFFCAT

        
        	
          Hidden

        
        	
          PMSCCATALOG

        
        	
          PMSCCATHSTAT

        
      

      
        	
          SRMSSCTR

        
        	
          Qualified

        
        	
          PMSCCATALOG

        
        	
          PMSCCATQSTAT

        
      

      
        	
          SRMSSCTR

        
        	
          Hidden

        
        	
          PMSCCATALOG

        
        	
          PMSCCATHSTAT

        
      

      
        	
          PMSCOFFCAT

        
        	
          Qualified

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFQSTAT

        
      

      
        	
          PMSCOFFCAT

        
        	
          Hidden

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFHSTAT

        
      

      
        	
          PMSCCRDET

        
        	
          Qualified

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFQSTAT

        
      

      
        	
          PMSCCRDET

        
        	
          Hidden

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFHSTAT

        
      

      
        	
          SRMSSCTR

        
        	
          Qualified

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFQSTAT

        
      

      
        	
          SRMSSCTR

        
        	
          Hidden

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFHSTAT

        
      

    

    Table 6-15 shows the Data Restrictions that are created when the global restrictions check box is checked.

    Table 6-15   Global data restrictions

    
      
        	
          Application

        
        	
          Type

        
        	
          Object

        
        	
          Condition

        
      

      
        	
          All

        
        	
          Qualified

        
        	
          PMSCCATALOG

        
        	
          PMSCCATQSTAT

        
      

      
        	
          All

        
        	
          Hidden

        
        	
          PMSCCATALOG

        
        	
          PMSCCATHSTAT

        
      

      
        	
          All

        
        	
          Qualified

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFQSTAT

        
      

      
        	
          All

        
        	
          Hidden

        
        	
          PMSCOFFERING

        
        	
          PMSCOFFHSTAT

        
      

    

    After the data restrictions are created, the users in that group do not have any access to Offerings or Catalogs. The next step is to grant access to a Catalog. Granting a group access to a Catalog also implicitly grants access to all Offerings in that Catalog. This is done by adding a row in the table of Authorized Catalogs.

    There might be instances where the group should not have access to one or more Offerings that have been implicitly granted by accessing a Catalog. Individual Offerings can be explicitly restricted by adding a row to the Restricted Offerings table. 

    Explicitly revoking access to an Offering takes precedence over implicitly granting access to the Offering by using Catalog authorization.

    Figure 6-32 shows a group that has been configured to have access to only a single Catalog in the self service applications. One of the Offerings in that Catalog has been restricted. 
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    Figure 6-32   Security restrictions for service catalog

    6.7  Approving a request

    An Offering can be configured to require approval from a line manager. In many cases, line managers are a class of self service users who also have approval responsibilities. With this in mind, an application (VIEWAPPRSR) was developed to make approvals by a line manager easier. It provides a simple view of the user’s request. Unlike managing traditional workflow assignments, this application also allows the user to navigate to other waiting assignments without going back to the start center and accessing the inbox assignments portlet.

    The default approval workflow, PMSC_LMD1, has been configured to use the VIEWAPPRSR application. The fulfillment manager approval workflow, PMSC_FMD1, has not been configured with this application. Instead, it uses the full SR application view. This was done to show how the roles between the line manager and fulfillment manager can be separated. 

    To approve a request, the line manager simply has to click Take Action, and then approve or reject the request. The line manager can also view the same dialog that the user used to request the Offering by clicking Show Offering. 

    Figure 6-33 illustrates the approval application for Fred, Bob’s line manager. 
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    Figure 6-33   Approval action

    6.8  Conclusion

    This chapter addressed the use of the Service Catalog in the IBM SmartCloud Control Desk. Information that included how to customize an Offering, order services, and fulfill those requests, was provided to help organizations build service catalogs that best fit their needs.
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Service level management

    This chapter describes how IBM SmartCloud Control Desk supports the service level management process. It provides key concepts of the process, and describes its use with the product, including typical use cases and configuration considerations.

    The following sections are included in this chapter:

    •Service level management process overview

    •Service level management using IBM SmartCloud Control Desk

    7.1  Service level management process overview

    Service level management process is part of the service design lifecycle as per ITIL. Service level management deals with the design of new or modified services for introduction into a production environment.

    The goal of the service level management process is to ensure that an agreed level of IT service is provided for all IT services.

    Service level management represents the IT service provider to the customer, and the customer to the IT service provider. There is regular bidirectional contact, whereby levels of services are discussed. Table 7-1 provides a discussion example between a customer and service provider. This table also notes the agreement reached based on both parties’ objectives and the amount of money the customer is willing to spend.

    Table 7-1   Example discussion for service level agreement 

    
      
        	
          When the customer wants it

        
        	
          How long the service desk wants to provide it

        
        	
          How much the customer is willing to spend

        
        	
          Time that customer and service desk agree on

        
      

      
        	
          Immediately

        
        	
          1 month

        
        	
          $

        
        	
          1 week

        
      

      
        	
          Immediately

        
        	
          1 month

        
        	
          $$

        
        	
          1 day

        
      

      
        	
          Immediately

        
        	
          1 month

        
        	
          $$$

        
        	
          2 hours

        
      

      
        	
          Immediately

        
        	
          1 month

        
        	
          $$$$

        
        	
          30 minutes

        
      

    

    In a perfect world, all customer contacts with the service desk would be resolved instantly. In the real world, service desks are busy, support staffs are overworked, and things always take longer than expected. The agreements between the two parties are a compromise between the level of service customers require and the level that the service desk (IT and technical support) can provide, based on resources available and overall costs.

    The following list notes the objectives of service level management:

    •Defining, documenting, agreeing, monitoring, measuring, reporting, and running a review of the service level.

    •Delivering and improving the relation and communication with the business and clients.

    •Ensuring that specific and measurable targets are being developed.

    •Monitoring and improving customer satisfaction with the quality of service that is being delivered.

    •Ensuring that IT and the customers have a clear and unambiguous expectation of the level of service to be delivered.

    •Ensuring that proactive measures to improve levels of service delivered are implemented wherever the costs are justified.

    7.1.1  Benefits

    Service level management provides a consistent interface to the business for all service-related issues. It provides the business with the agreed service targets and the required information to ensure that those targets are met. If targets are missed, service level management provides feedback on the cause of the breach and details of the actions being taken to prevent the breach from occurring again.

    The service level management process entails planning, coordinating, drafting, agreeing, monitoring, and reporting about service level agreements (SLAs). Service level management also covers the ongoing review of service achievements to ensure that the required and cost-justifiable service quality is maintained and improved. 

    7.1.2  Definitions

    A service level agreement is a written agreement between the service desk (service provider) and its customers. It documents the levels of service that are provided to the customer. An SLA is best described as a collection of commitments and expectations for both sides. It records the commitments and expectations, but not the means or details of execution.

    A service provider is the organization that supplies services to one or more internal or external customers. You can think of it as a service desk that answers the requests and issues of its users.

    A service is a set of tasks that is provided by a service provider that fulfills one or more of the customer’s needs.

    A commitment is a specific responsibility that the service provider must meet to fulfill the SLAt with the customer. A commitment describes a measurable and quantifiable aspect of a service.

    7.1.3  Product capabilities

    The following are some of the IBM SmartCloud Control Desk capabilities specific to service level management that are demonstrated in later use cases:

    •Definition of service level agreements criteria to condition the application of an SLA based on the conditions such as classifications, priority, locations, assets, and configuration items (CIs).

    •Definition of service level agreement targets with predefined types of commitments:

     –	Contact: Identifies when interactions begin with the requester.

     –	Response: The service desk must start working on a ticket or work order within a set amount of time.

     –	Resolve: The service desk must resolve the request within a set amount of time.

     –	Other: Other commitments between the service desk and the customer, such as reliability, availability, or downtime.

    •Definition of escalation points, such as actions or notifications, related to agreed commitments to ensure that critical tasks are delivered on time.

    •Application of service level agreements either manually by an agent, or automatically by workflow or escalation.

    •Application and calculation of service level agreements based on calendars and shifts that are defined for the organization, location, people, or assets.

    •Service level agreement hold status to avoid unnecessary penalties for violating SLAs when something occurs beyond the control of IT staff.

    •Monitoring and reporting of SLA compliance through the means of key performance indicators or reports.

    For a list of reports that are provided with the product see Appendix B, “SmartCloud Control Desk Reports” on page 727. KPIs for service level management, available as part of the optional content, are listed in Table 7-2.

    Table 7-2   Service level management KPIs

    
      
        	
          KPI

        
        	
          Content

        
      

      
        	
          INCSLAPERCENTP1

        
        	
          SLA Compliance - Priority 1 incidents

        
      

      
        	
          INCSLAPERCENTP2

        
        	
          SLA Compliance - Priority 2 incidents

        
      

      
        	
          INCSLAPERCENTP3

        
        	
          SLA Compliance - Priority 3 incidents

        
      

      
        	
          INCSLAPERCENTP4

        
        	
          SLA Compliance - Priority 4 incidents

        
      

      
        	
          INCSLAPERCENT

        
        	
          SLA Compliance - All incidents

        
      

    

    7.2  Service level management using IBM SmartCloud Control Desk

    This section describes how IBM SmartCloud Control Desk facilitates management of service level agreements in typical situations. The following are the areas that are covered: 

    •Configuring SLA options for an organization with use cases

    •Creating a service level agreement

    •Applying the service level agreement to an incident

    •Enabling the SLA hold feature 

    •Considering calendars in the calculation of the service level targets

    7.2.1  Organization SLA options

    Options for service level agreements are set from the Organization application, by using the SLA options action as shown in Figure 7-1 on page 386. Other than Allow SLA Hold to be Applied on SLAs, you set these options separately for each site.
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    Figure 7-1   SLA options window

    Select Allow SLA Hold to be Applied on SLAs. This is a global setting that applies to all sites. If you select this check box, you can specify that tickets associated with an SLA can be placed in an SLA Hold status. When tickets are in an SLA Hold status, the ticket is not escalated, and the time that the ticket is in the SLA Hold status is added to the target date and time. Tickets can be placed in an SLA Hold status when the service desk analyst is waiting for a response from the individual who submitted the ticket for example. 

    From the SLA Options window, select the site to which you want the settings to apply, then set the options as you want. Table 7-3 describes the available options.

    Table 7-3   SLA options descriptions

    
      
        	
          Option

        
        	
          Description

        
      

      
        	
          Allow application of one SLA?

        
        	
          Select this option to have one matching service level agreement apply to a record. The matching service level agreement with the highest ranking value is applied to the record. The highest ranking is 1 and the lowest ranking is 99999.

        
      

      
        	
          Allow Application of Multiple SLAs?

        
        	
          Select this option to have all matching service level agreements applied to a record. 

        
      

      
        	
          Apply multiple SLAs based on ranking?

        
        	
          Optional: If you allow the application of multiple service level agreements, select this option to have the service level agreement with the highest ranking update the target dates on the record.

        
      

      
        	
          Apply multiple SLAs based on commitment stringency?

        
        	
          Optional: If you allow the application of multiple SLAs, selecting this option examines all the matching SLAs. The most stringent contract target, response target, and resolution target are selected from among their respective groups. These targets can come from three different SLAs, such as:

           

          •SLA001   Contact 30 Min, Response 4 Hours, Resolution 16 Hours.

          •SLA002   Contact 45 Min, Response 2 Hours, Resolution 24 Hours

          •SLA003   Contact 60 Min, Response 90 Minutes, Resolution 3 Hours

           

          Assuming that all three of these SLAs matched the ticket, the contract target is calculated using SLA001, the response target date using SLA002, and the resolution target date using SLA003.

           

          Regardless of which target dates are copied to the ticket, performance against all of the target is measured by using KPIs, and all of the escalations from all matching SLA are run.

        
      

      
        	
          Use calendar for calculating escalation point condition?

        
        	
          Select this option to specify that, for the selected site, calendars are used if the escalation originated from a service level agreement. 

        
      

      
        	
          Disable calendar for calculating escalation point condition?

        
        	
          Select this option to specify that, for the selected site, calendars are not used if the escalation originated from a service level agreement.

        
      

    

    7.2.2  Create a service level agreement

    A service level agreement record is created in the Service Level Agreements (SP) application. To locate this option, click Go to → Service Level → Service Level Agreements (SP).

    An SLA is associated with a specific type of ticket or work order. In this example, the SLA created applies to incidents.

    Conditions

    The SLA is applicable to records with values that match criteria in the SLA. The less specific the SLA, the more records to which it is potentially applicable. For example, if there is no customer associated with an SLA, the SLA can be matched to a ticket for any customer.

     

    
      
        	
          Note: The SLA is applied to a ticket or work order if all the conditions are met.

        
      

    

    This example uses service level agreements that apply to incidents that are provided with IBM SmartCloud Control Desk optional content, as shown in Table 7-4.

    Table 7-4   Service Level agreements used in the example

    
      
        	
          SLA number

        
        	
          Description

        
        	
          Condition

        
      

      
        	
          SRM1002

        
        	
          P1 Incident - Respond in 30 minutes, Resolve in 2 hrs

        
        	
          Internal Priority = 1

        
      

      
        	
          SRM1003

        
        	
          P2 Incident - Respond in 2 hrs, Resolve in 4 hrs

        
        	
          Internal Priority = 2

        
      

      
        	
          SRM1005

        
        	
          P3 Incident - Respond in 9 hrs, Resolve in 18 hrs

        
        	
          Internal Priority = 3

        
      

      
        	
          SRM1006

        
        	
          P4 Incident - Respond in 18 hrs, Resolve in 36 hrs

        
        	
          Internal Priority = 4

        
      

    

    The conditions for an SLA are defined in the Conditions tab, as shown in Figure 7-2. 
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    Figure 7-2   SLA Priority 1 incident conditions

    The priority for the ticket is set with Internal Priority field. In this case, the SLA is applied only if the internal priority equals 1.

    The following list notes the other condition criteria available from this tab:

    •Classification: This restricts the SLA to a specific ticket classification.

    •Services: This restricts the SLA to a list of services or service groups.

    •Conditions: This restricts the SLA to extra conditions by using operators such as EQUALS, GREATER, or LESSOREQUAL.

    •Additional SLA Criteria: This restricts the SLA based on your own SQL conditions.

    Furthermore, conditions can be set in different tabs to restrict the application of the SLA to certain types of resources:

    •Locations

    •Assets

    •Configuration Items

    Commitments

    An SLA describes one or more commitments. The following list covers the commitment types that are predefined in IBM SmartCloud Control Desk:

    •CONTACT: When an SLA is applied that includes a contact commitment, the contact commitment date populates the Target Contact date field of the record.

    •RESPONSE: When an SLA is applied that includes a response commitment, the response commitment date populates the Target Start date field of the record. 

    •RESOLUTION: When an SLA is applied that includes a resolution commitment, the resolution commitment date populates the Target Finish date field of the record.

    •OTHER: Other type of commitments made between the service desk and the customer. Some examples are reliability, availability, and downtime.

    Excluding the commitment type OTHER, only one of each commitment type can be added to an SLA.

    The commitments are defined in the Service Level Agreement tab, as shown in Figure 7-3.
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    Figure 7-3   SLA priority 1 commitments

    Figure 7-4 provides another view of the commitment points defined for this service level agreement. This view represents the timeline from the creation of the ticket to the point where the commitment is not met.
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    Figure 7-4   SLA priority 1 commitments

    Escalation points

    For each commitment, you can establish escalation actions or notifications that occur if the commitment is not met. An escalation process can monitor all activities, send notifications, and perform other activities to ensure that commitments are met.

    The primary goal of escalations is to ensure that critical tasks are delivered on time.

    In this example, a new escalation point is created. The incident is assigned to the incident manager if the incident remains in a state of no response. This reassignment happens 5 minutes before the agreed response commitment time is missed.

    To define a new escalation, click the define escalation icon from the associated commitment line, as shown in Figure 7-5.
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    Figure 7-5   Define escalation icon

    The escalation tab opens and a new escalation point is created. For this example, the escalation is configured in the following ways:

    •The escalation point is autonumbered, and the elapsed time attribute is set to responsedate by default because the escalation was created from the response commitment. To trigger the action 5 minutes before the agreed response date, the elapsed time interval is set to -25 minutes. A positive number indicates a time period in the past. A negative number indicates a time period in the future.

    •The action to be triggered, when the elapsed time interval is reached, is set to PMINC_ASGN_INCMGR. This setting gives ownership of the incident to the incident manager group.

    •The schedule of the escalation cron task is set to 1 minute instead of the 1 hour default. 

    Figure 7-6 shows the escalation that is configured for this example.
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    Figure 7-6   Escalation associated with response commitment

    Figure 7-7 provides a graphical representation of the timeline, the date that is associated with the commitment point, and the escalation point set to 5 minutes before the response date.
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    Figure 7-7   Escalation 5 minutes before response date

    Associate a KPI to an SLA

    A key performance indicator is often referred to as a KPI. From the KPIs tab of the Service Level Agreements application, you manage key performance indicators that are associated with a service level agreement. A key performance indicator is a metric that tracks critical performance variables over time. In this case, you track the performance of a service desk organization and its compliance with service level agreements.

    In the Service Level Agreements application, you use the KPIs tab to create and associate key performance indicators with service level agreements. Figure 7-8 shows the SLA compliance KPI associated with the example SLA that applies to priority 1 incidents.
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    Figure 7-8   KPI associated to SLA for priority 1 incidents

    To ensure that you are aware of the response times for the incidents created in your organization, create a key performance indicator for this service level agreement. You also make the key performance indicator accessible to the appropriate managers. Using the key performance indicator, you can take necessary proactive measures to avoid the financial penalties that are associated with noncompliance.

    To view the graphs for key performance indicators, use either the KPI Manager application or add the key performance indicator portlets to a start center. Figure 7-9 shows the KPI as it is displayed in the Incident manager start center.
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    Figure 7-9   View SLA compliance from Start Center

    7.2.3  Applying a service level agreement

    To apply an SLA means to associate an SLA with a record to facilitate tracking of compliance with service level agreements. When an SLA is applied to a record, the record can be tracked as part of an SLA monitoring process.

    The types of records to which service level agreements can be applied include tickets (service requests) and work-based records (work orders). Before you can apply an SLA to a record, the record must have a site defined.

    An SLA can be applied in several ways:

    •The system can apply an SLA automatically through a workflow, automation script, escalation process, or through another SLA.

    •An agent can use the Apply an SLA action. With this method, the system chooses and applies the most appropriate SLA or SLAs to the record.

    •An agent can use the Select an SLA or Deselect an SLA action to view and select an SLA to apply to a ticket record.

    Applying an SLA manually

    This use case describes how to manually apply an SLA to a ticket record.

    Apply SLA action

    One way to manually apply an SLA is to use the Apply SLA action available from the Select Action menu. When you use Apply SLA, the system finds and applies one or more SLAs, if any, that match the selected record. A message in the navigation bar indicates the result of the action. The following list describes two of those cases:

    •If SLAs exist that match this record, a confirmation message indicates that an SLA has been applied. If there are no applicable SLAs, the message indicates that there are no SLAs to apply to this record.

    •If you try to apply an SLA to a record that already has an SLA applied to it, the system displays a warning message asking if you want to override the existing SLA.

     

    
      
        	
          Note: The system applies the SLA only to the record, not to its activities.

        
      

    

    In the example, an incident was reported as priority 1 by a user complaining about their email service not working. The service desk agent confirmed the priority by setting the impact and urgency as critical. The internal priority is then set to 1 by the system based on the priority matrix defined. 

    From the Select Action menu, the agent manually applies the SLA. The incident, having an internal priority that equals 1, matches the condition that is defined in the SLA, and the system applies it.

    A short message is displayed in the top navigation bar indicating the SLA was applied. SLA Applied is now selected as shown in Figure 7-10.
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    Figure 7-10   SLA applied on priority 1 incident

    Also, the target dates are populated as per the commitments defined in the SLA, as shown in Figure 7-11.
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    Figure 7-11   Incident priority 1 target dates

    Select/Deselect SLAs action

    Another option to apply an SLA manually from the record is to use the Select/Deselect SLAs window. It can be opened from the Select Action menu. This action also provides the ability to remove an SLA already applied.

    When the Select/Deselect SLAs dialog opens, it lists only SLAs applied to the current record. In this example, a SLA applied previously is listed (Figure 7-12).
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    Figure 7-12   Select/Deselect SLAs dialog

    The SLA options for this site were configured so that only one SLA can be applied. Therefore, from the dialog, an agent must first remove the already applied SLA before another one can be selected.

    After the SLA is removed, the agent can decide to continue without an SLA applied, or to add a row and select another SLA. To create a row, click New Row, then select Value from the detail menu of the SLA field. The select SLA dialog opens, providing two filters. The default filter is Show Filtered SLAs. It displays only SLAs that have conditions that match the current record. But if the agent selects Show All SLAs, all SLAs applying to incidents are displayed. Show All SLAs operates regardless of the conditions such as internal priority as shown in Figure 7-13.
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    Figure 7-13   Show All SLAs window

    In this example, the agent decides to apply the SLA for priority 2 incidents, even though the current incident has a defined internal priority of 1. Thus, the Select/Deselect SLAs option gives the agent the ability to bypass conditions defined on the SLA record and apply a specific SLA. After the new SLA is applied, the target dates are updated as per the new commitments, which is shown in Figure 7-14.
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    Figure 7-14   Updated target dates

    Applying an SLA through workflow

    This use case describes the creation of a simple workflow process that automatically applies the SLA to an incident. In this example, the workflow process created is used independently, but it can be inserted into an end to end workflow as a subprocess.

    The workflow process is created by using the Workflow Designer application. Click System Configuration → Platform Configuration → Workflow Designer. It is set for use with an incident object.

    The workflow process consists of a condition node only, with two connectors:

    •The condition node SLAAPPLIED verifies whether an SLA is already applied to the incident record. The expression that is used by the condition node is:

    :slaapplied = '1'

    •If the condition is successful, that means an SLA is already applied to the incident record. The process then follows the positive connector that goes to the stop node.

    •If the condition is unsuccessful, that means no SLA is applied to the incident. The process then follows the negative connector that runs the action INC_APPLYSLA before going to the stop node.

    Figure 7-15 shows the process view of the workflow, and the two connectors in the actions table.
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    Figure 7-15   Workflow to apply SLA

    Figure 7-16 shows the details of the INC_APPLYSLA action.
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    Figure 7-16   INC_APPLYSLA action

    As a result, when an incident is routed into this workflow, the most appropriate SLA is applied without the intervention of the agent. The following list notes what in the incident record is also updated automatically as though the SLA was applied manually:

    •SLA Applied is selected

    •Target dates are populated as per the commitments defined in the SLA

    7.2.4  Service level agreement calendars

    There are two types of calendars on a service level agreement:

    •Applies-to-calendar

    The applies-to-calendar fields specify the organization, calendar, and shift for records to which you intend to apply the SLA. If you add values to these fields, the values are used as part of the matching logic when SLAs are selected for tickets and work orders. The default matching logic is that the report date on the ticket or work order is compared to the work periods in the specified shift. However, the user can specify that a different date is used for that condition.

    •Calculation calendar

    The calculation calendar fields specify the organization, calendar, and shift to be used when the target contact, start date, or finish date in the ticket or work order are calculated. The commitment values on the SLA are added to the ticket or work order reported date. The target work dates in the ticket or work order are populated with the calculated value. If these fields are empty, the values from the Applies To calendar are used to set the target work dates.

     

    
      
        	
          Neither calendar is required: If you do not complete the calendar information, the calendar is not considered when the service level agreement is applied to another record or when calculating work dates. If you do use calendars, the SLA can be applied and target work dates can be calculated based on calendar information.

        
      

    

    In this example, the SLA is configured so that the target values are calculated as per the calendar ORG01. ORG01 specifies that the organization is open from Monday to Friday, from 9:00am to 5:00pm. The DAILY shift that is described in Table 7-5 is applied to organization’s calendar.

    Table 7-5   DAILY shift configuration

    
      
        	
          Shift name

        
        	
          Description

        
        	
          Start Day

        
        	
          Days in pattern

        
      

      
        	
          DAILY

        
        	
          Daily business hours

        
        	
          MONDAY

        
        	
          7

        
      

    

    The DAILY shift uses the pattern that is shown in Table 7-6.

    Table 7-6   DAILY shift pattern configuration

    
      
        	
          Pattern day

        
        	
          Start Time

        
        	
          End Time

        
        	
          Work Hours

        
      

      
        	
          001 (Monday)

        
        	
          09:00

        
        	
          17:00

        
        	
          08:00

        
      

      
        	
          002 (Tuesday)

        
        	
          09:00

        
        	
          17:00

        
        	
          08:00

        
      

      
        	
          003 (Wednesday)

        
        	
          09:00

        
        	
          17:00

        
        	
          08:00

        
      

      
        	
          004 (Thursday)

        
        	
          09:00

        
        	
          17:00

        
        	
          08:00

        
      

      
        	
          005 (Friday)

        
        	
          09:00

        
        	
          17:00

        
        	
          08:00

        
      

      
        	
          006 (Saturday)

        
        	
          00:00

        
        	
          00:00

        
        	
          00:00

        
      

      
        	
          006 (Sunday)

        
        	
          00:00

        
        	
          00:00

        
        	
          00:00

        
      

    

    The SLAs for Incidents priority 1, 2, 3, and 4 used in previous use cases must be modified to take the organization’s calendar into consideration when calculating target dates as per the commitments. SLAs should not set target dates outside of the organization’s working hours.

    For each SLA record, use the main tab of the Service Level Agreement application to set the organization’s calendar and shift in the applies-to calendar section, as shown in Figure 7-17.
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    Figure 7-17   Calculation calendar

     

    
      
        	
          Note: If the applies-to calendar is not defined in the SLA, the SLA can be applied at any time, regardless of the organization’s calendar.

        
      

    

    The examples that follow give several scenarios to further explain how calendars, incident priority, and SLAs interconnect and work together. In addition, a non-working time is defined on the calendar: November 9 is defined as a national holiday.

    A new priority 1 incident is reported at 05:30 pm on Wednesday, November 7, and the corresponding SLA is automatically applied by the workflow. The response commitment time is 30 minutes. The resolution commitment is 2 hours. The target start is set to 09:30 am on Thursday, and the finish date is set to 11:00 am on Thursday. Because the incident was reported outside of working hours, the calculation takes as reference the start time of the following day, as shown in Figure 7-18.
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    Figure 7-18   Priority 1 incident target dates with calendar

    A new priority 3 incident is reported at 05:59 pm on Wednesday, November 7, and the corresponding SLA is automatically applied by the workflow. The response commitment time is 9 hours. The resolution commitment is 18 hours. The target start is set to 10:00 am on the next Monday, and the finish date is set to 11:00 am on the next Tuesday. Because the incident was reported outside of working hours, the calculation takes as reference the start time of the following day. Furthermore, because Friday, November 9 is defined as a holiday, and the organization is closed for the week-end, the target dates are delayed to the next week. 

    The completed computation is shown in Figure 7-19.
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    Figure 7-19   Priority 3 incident target dates with calendar

    You can specify a sequence for determining which calendar to use for the service level agreement. For example, you might specify that when the target values are calculated on an incident, the first consideration is the person who reported the ticket. If that person has a calendar and shift, the work periods for that calendar and shift are used to calculate the target values. However, if that person does not have a calendar and shift, the asset on the incident is considered next. In this example, select Person Calendar in the First Choice field, and Asset Calendar in the Second Choice field, as shown in Figure 7-20.
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    Figure 7-20   Selection of calculation calendars

    When you apply a service level agreement to a ticket or work order, the calendar that is used to calculate the target values is selected in the following order:

    1.	The calendar in the First Choice field is used, if it exists.

    2.	Otherwise, the calendar in the Second Choice field is used, if it exists.

    3.	Otherwise, the calendar in the Third Choice field is used, if it exists.

    4.	If none of the first, second, or third choice calendars exists, then the calculation calendar is used, if it exists.

    5.	Otherwise, the applies-to calendar is used.

    6.	If neither the calculation calendar or the applies-to calendar is found, the target is calculated without using a calendar.

    7.2.5  Service level agreement hold 

    The IBM SmartCloud Control Desk provides a service level agreement hold feature. It allows the SLA clock to be paused when something occurs beyond the control of IT staff, avoiding unnecessary penalties for violating SLAs.

    For instance, a ticket can be placed in SLA Hold status when the service desk agent is waiting for a response from the individual who submitted the ticket. When a ticket is in SLA Hold status, it is not escalated and no actions or notifications associated with the service level agreement are started.

    Figure 7-21 provides a graphical representation of the adjusted commitment when you use the IBM ControlDesk SLA hold feature.
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    Figure 7-21   Adjustments of commitments with SLA hold

    Enabling the SLA hold feature

    You enable the SLA Hold status for a service level agreement in the Service Level Agreements application. 

    The SLA Hold feature must also be activated in the Organizations application. Select Allow SLA Hold to be Applied on SLAs in the SLA Options window to activate the SLA Hold feature, as described in 7.2.1, “Organization SLA options” on page 385. When the SLA Hold feature is activated, you can enable the SLA Hold status to be used on tickets that are associated with a service level agreement. When you select Enable SLA Hold on the Service Level Agreement tab in the Service Level Agreements application, the SLA Hold status is enabled for that SLA.

    SLA hold feature use case

    In this example, a new incident was reported by user Bob, who is complaining about the payroll system being out of service. Jane, the service desk agent, is assigned to the ticket. Upon application of the SLA to the incident, the service level agreement indicates that a resolution is required within two hours. Because the SLA Hold feature was enabled in the SLA definition, the system automatically selects SLA Hold Enabled on the incident, as shown in Figure 7-22.
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    Figure 7-22   SLA Hold Enabled is selected by the system

    Jane, the service desk agent, cannot reproduce or confirm the issue. To her, the payroll system is functioning as expected. The resolution time has been running for 15 minutes. She calls Bob to get more information. Because Bob is in a meeting, Jane leaves a message asking him to contact the service desk. As she is waiting for the user, Jane changes the status of the ticket to SLA Hold, as shown in Figure 7-23.
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    Figure 7-23   Change status to SLA Hold

     

    
      
        	
          SLA Hold status: The SLA Hold status is available for selection only if SLA Hold was enabled on the applied service level agreement. Although the ticket has a status of SLA Hold, no escalations are triggered.

        
      

    

    The ticket remains in this status until Bob returns the call. During this time, the ticket is not escalated, and the remaining time during which Jane must resolve the issue is not affected. When Bob returns the call and Jane receives the information that she needs, the status of the ticket is changed to In Progress. The clock starts again.

    When the ticket leaves the status SLA Hold, the system repopulates some fields. The system populates adjusted dates in the SLA Hold section based on the target dates and the accumulated hold time, as seen in Figure 7-24.
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    Figure 7-24   SLA Hold section

    At any time, either while the ticket is on hold or after it has been resumed, the time spent in SLA Hold status can be seen from the View History dialog. This dialog is available from the Select Action menu, as shown in Figure 7-25.
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    Figure 7-25   View History of the incident

    SLA Hold in Key Performance Indicators

    The predefined key performance indicators for SLA compliance for incidents, as used in previous use cases, do not consider the SLA Hold feature. This use case describes how to modify a query so that the information reported is accurate.

    By default, these KPIs look at the number of incidents for which the commitments were missed, divided by the total number of incidents of the same priority. The result is given in the form of a percentage. For example, the query of the KPI associated with incidents with Priority 1 SLA is shown in Example 7-1. It shows that the actual dates compared with the target dates.

    Example 7-1   Default KPI for compliance on Priority 1 incidents 
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    select 

    ((select count(*) from incident where actualstart < targetstart and actualfinish < targetfinish and status in ('RESOLVED','COMP','CLOSED') and internalpriority=1)*1.0)

    / 

    ((select count(*) from incident where targetstart is not null and targetfinish is not null and status in ('RESOLVED','COMP','CLOSED') and internalpriority=1 )*1.0)

    * 100 

    from dummy_table
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    Consider the adjusted dates for those incidents where SLA hold feature was used during resolution. The query must be modified so that it counts and considers the following formula:

    (number of breached priority 1 incidents where sla hold was not used, plus number of breached priority 1 incidents where sla hold was used) divided by (total number of priority 1 incidents)

    The modified query is shown on Example 7-2.

    Example 7-2   Modified KPI for compliance on Priority 1 incidents, with SLA hold
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    select

    ((select count(*) from incident where actualstart < targetstart and actualfinish < targetfinish and status in ('RESOLVED','COMP','CLOSED') and internalpriority=1 and adjustedtargetresponsetime is null and adjustedtargetresolutiontime is null)

    + 

    (select count(*) from incident where actualstart < adjustedtargetresponsetime and actualfinish < adjustedtargetresolutiontime and status in ('RESOLVED','COMP','CLOSED') and internalpriority=1)*1.0)

    / 

    ((select count(*) from incident where targetstart is not null and targetfinish is not null and status in ('RESOLVED','COMP','CLOSED') and internalpriority=1 )*1.0)

    * 100 from dummy_table
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    7.3  Conclusion

    This chapter addressed key concepts of a service level management process and how IBM SmartCloud Control Desk facilitates the definition and reporting of service level agreements.

    It detailed the configuration options that allow you to adjust the definition of your SLAs with the business requirements. Those business requirements include attributes such as calendars consideration, automated actions, notifications through escalations, conditions on the service level agreements, and application to tickets or work orders.

    It also demonstrated associating predefined key performance indicators with your SLAs. This association allows you to measure and report on compliance with agreed levels of service, and eventually improve your customers’ satisfaction.
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Service Operations

    This chapter provides information about the use and configuration of IBM SmartCloud Control Desk for Service Desk, for Request Fulfillment, and Incident and Problem management as they relate to the Service Operation phase of IT Service Management.

    This chapter includes the following sections:

    •Service operation overview

    •Service Operation using IBM SmartCloud Control Desk

    •Configuring IBM SmartCloud Control Desk

    •Performing remote diagnostics using IBM SmartCloud Control Desk

    8.1  Service operation overview

    Service Operation in the context of IT Service Management is concerned with the business-as-usual delivery and support of services. The Service Desk is a key function of Service Operation. It provides a point of communication to the users and a point of coordination for several IT groups and processes. 

    This section provides an overview of the following systems:

    •Service desk

    •Request Fulfillment

    •Incident management

    •Incident management process flow

    •IBM SmartCloud Control Desk capabilities

    Service Operation in ITIL terms also consists of Event Management, Access Management, and other functions and activities. These are only covered briefly where they are relevant to IBM SmartCloud Control Desk.

    All Service Operation functions, processes, and activities are designed to deliver a specified and agreed on level of service. For more information about service level management using IBM SmartCloud Control Desk, see Chapter 7, “Service level management” on page 381.

    8.1.1  Service desk

    The service desk is the primary point of contact for users when there is a service disruption, for service requests, and for some categories of request for change. For this reason, a good service desk can often compensate for deficiencies elsewhere in the IT organization. However, a poor service desk can give a poor impression of an IT organization.

    A service desk can deal with various events from users, typically made by using telephone calls, email, or a self-service web interface and walk-up kiosks among others. This is now extending to video calls and instant messaging. For more information about self-service, see Chapter 9, “Self-service” on page 531. Figure 8-1 on page 411 shows how information gets to the service desk and where it goes when it leaves the service desk. Outputs can be in the form of actions, alerts, email communications, and reports.

     

    
      
        	
          Note: In IBM SmartCloud Control Desk, a user’s interaction with the service desk is captured in a service request ticket. The ticket contains a request for some sort of service that is either fulfilled by the request fulfilment or incident management process.
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    Figure 8-1   Service desk interactions

    As shown in Figure 8-1, IBM SmartCloud Control Desk also allows you to configure automated tooling to assist the service desk agent create service requests tickets. This includes the creating tickets from these sources:

    •Email through a POP3 or IMAP mailbox listener

    •CTI (Computer Telephony Integration) and IVR (Integrated Voice Recognition) tools

    The primary aim of the service desk is to restore normal service to the users as quickly as possible. This can involve fixing a technical fault, fulfilling a service request, or answering a query. Specific responsibilities can include:

    •Logging all relevant service request and incident details

    •Allocating categorization and prioritization codes

    •Providing first-line investigation and diagnosis

    •Resolving service requests and incidents where able

    •Escalating service requests and incidents that they cannot resolve 

    •Closing all resolved incidents, requests, and other calls

    •Conducting customer/user satisfaction surveys

    •Communication with users: Keeping them informed of incident progress, notifying them of impending changes or agreed outages, and so on

    8.1.2  Request Fulfillment

    Service Request in ITIL terms is a generic description for many varying types of demands that are placed upon the IT Department by the users. Request Fulfillment is the processes of dealing with service requests from the users. The process and activities that are needed to fulfil a request vary depending on exactly what is being requested. Some service requests are handled by the request fulfillment process itself, whereas others are routed to other process for fulfillment as show in Figure 8-2.
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    Figure 8-2   Request fulfillment process overview

    Broadly, service requests can be for the following categories of services:

    •Request to fix a fault. This is an unplanned event that is handled by using the incident management process. For more information, see 8.1.3, “Incident management” on page 414.

    •Small changes. These are typically characterized by being repeatable, high frequency, low risk, and low cost. For example, a request to change a password, or a request to relocate a computer desktop. More complex changes must be handled by using the change management process. For more information, see Chapter 11, “Change management” on page 593.

    •Procurement requests. To allow the user to request assets and consumables. These requests typically follow an approval process, and lead to the issue of an item from store or a purchase order.

    •A request for information. To assist with general information, complaints, or comments.

    Best practice request fulfillment involves providing users with quick and effective access to standardized services. This depends on your organization having agreed on and published a list of standard services, and defined the associated approval and fulfillment procedures.

    With IBM SmartCloud Control Desk, this system enables you to perform these tasks:

    •Create request models for fulfilling requests in a consistent and known manner by using ticket templates and job plans to break down the set of activities that must be performed.

    •Define and publish a fulfillment catalog for self-service access of standardized services that can use request models. You can define the workflows and approvals, fulfillment groups involved, target time scales, and escalation paths.

    Request Fulfilment effectively reduces the effort that is involved in requesting and receiving access to existing or new services, reducing the cost of providing these services.

    Request Fulfillment roles

    The main roles that are involved with request fulfillment provided by the optional content are described in Table 8-1. These roles are typically synonymous with the service desk analyst and service desk manager, respectively.

    Table 8-1   Request fulfillment roles

    
      
        	
          Role

        
        	
          Description

        
      

      
        	
          Request Analyst

        
        	
          These users are the primary contact for customers, functioning as a hub between the customer organization and the IT organization. The request analyst typically creates incident tickets and coordinates their resolution.

        
      

      
        	
          Request Manager

        
        	
          These users are responsible for the quality and integrity of the user contact management process. They interface with other process managers.

        
      

    

     

    
      
        	
          Note: The IBM SmartCloud Control Desk optional content package also provides a User Contact Administrator group. This is NOT a process role. It is an administrative group that has access to all applications. You can decide whether you want to use it.

        
      

    

    Request Fulfillment process flow

    The following steps are involved in the Request Fulfillment process flow:

    •Receive and Approve Service request

    The service request is received and assessed. If the service request is accepted, the service desk analyst opens a service request ticket. The ticket contains all relevant information so that it can be tracked, monitored, and communicated. Otherwise, the contact is rejected and this decision and the reasons are communicated to the requester.

    •Fulfill or Route Service Request activity

    The service request is either fulfilled by the service desk analyst or routed to another process to be fulfilled.

    •Close Service Request

    After the service request is completed, the agent updates and closes the service request ticket.

    8.1.3  Incident management

    Incident management is the process of restoring normal service operation as quickly as possible to minimize an incident’s adverse impact on business operations. In ITIL terms, an incident is any unplanned interruption or reduction in quality of an IT Service. This includes the failure of a configuration item that has not yet impacted service.

    Incidents are typically recorded through these process:

    •The Service Desk, when disruptive events are reported to them by users or by technical staff.

    •Technical staff, when they notice disruptive events during normal operation.

    •An interface to an event management system. Note that not all events are incidents. Some events are informational or indicators of normal operation.

    Best practice incident management involves immediate service restoration using standard processes of investigation, diagnosis, resolution, and recovery. 

    For this purpose, IBM SmartCloud Control Desk allows you to perform these tasks:

    •Define incident models, which are a way of pre-defining the steps that must be taken to handle a particular type of incident in an agreed way. This ensures that standard incidents are handled in a predefined path and within predefined time scales.

    •Match similar tickets, and search known errors, solutions, and historical incidents and problems to help you identify past problems, which can result in faster resolution.

    •Define automation scripts to help collect information about the incident being experienced, by running workflows to help analyze and resolve the incident.

    •Use integrated configuration management information to help diagnose the impact of an incident, potential problems, and users affected.

    It is also part of incident management to identify whether an incident is likely to recur, and decide whether any preventive action is necessary to avoid this. With Problem Management, raise a Problem record in all such cases so that preventive action is initiated.

    Incident management roles

    The main roles that are involved with incident management are provided by the optional content and described in Table 8-2.

    Table 8-2   Incident management roles

    
      
        	
          Role

        
        	
          Description

        
      

      
        	
          Incident Analyst

        
        	
          The Incident Analyst, in most instances the 2nd line (or higher) support professional, is a subject matter expert of one or more competency domains. This role is responsible for quickly providing a good analysis of an incident or a solution to it to restore the disturbed service. 

        
      

      
        	
          Incident Manager

        
        	
          The Incident Manager is responsible for the quality and integrity of the Incident Management process. This rile is the interface to the other process managers.

        
      

      
        	
          Incident Owner

        
        	
          An Incident Owner is responsible for an individual incident. The Incident Owner oversees the handling of the incident, bringing in analysts and specialists as needed to handle the incident. The Incident Owner is responsible for seeing that analysts and specialists bring the incident to a close. 

        
      

    

     

    
      
        	
          Note: The IBM SmartCloud Control Desk optional content package also provides an Incident Administrator group. This is NOT a process role. It is an administrative group that has access to all applications. You must decide whether you want to use it.

        
      

    

    Incident management process flow

    Figure 8-3 shows the activities that are involved in the incident management process.
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    Figure 8-3   Incident management process overview

    •Identify and log incident

    This step involves detecting or acknowledging incidents from other activities, recording details about the incident, notifying and alerting support groups, and other processes where applicable.

    •Classify incident and provide initial support

    This step involves determining the impact, urgency, and priority of the incident. It also involves performing initial diagnosis by correlating it with problems, known errors, other incidents, and related configuration details.

    •Investigate and diagnose incident

    This step involves assessing the data that are associated with the incident to identify appropriate responses and actions.

    •Resolve incident and recover service

    This step involves performing the necessary actions to resolve the incident and restore service by using an existing solution work-around or, alternatively, raising a request for change.

    •Close incident

    This step involves reviewing the resolved incident for completion of documentation that includes cause, resolution, outcome, and effort expended, and reviewing the original classification correctness. The accuracy of these data is important for metrics reporting.

    8.1.4  Automatic incident assignment

    Prompt resolution of high-priority or blocking incidents is vital to an organization’s success. The automatic incident assignment feature can significantly reduce initial response time and total resolution time for incidents in high-volume environments, and in situations where owner selection is a complicated or time-consuming process.

    Automatic incident assignment is the process by which incidents are automatically and repeatedly assigned to person groups and person group members until they are claimed and addressed. A typical scenario is as follows:

    1.	Communication from a user prompts a service desk agent to create an incident.

    2.	After recording pertinent information in the incident, the service desk agent assigns an initial owner group and sets a value that indicates that it should be enrolled in the automatic assignment process.

    3.	An escalation, running at a set interval, processes the incident. If the incident remains unclaimed, it is assigned to the next owner in the specified sequence order.

    This process continues until the incident is claimed or it reaches the end of the person group sequence.

     

    
      
        	
          Requeue an incident: An agent can requeue an incident that they are working on at any time by changing the incident status back to queued (QUEUED).

        
      

    

    Typically, different organizations have different requirements for automatic assignment, so automatic incident assignment is as flexible as possible while maintaining a simple administrative and user experience. 

    The following sections introduce automatic incident assignment configuration guidelines by presenting an abridged version of the configuration process. For a more detailed description of the configuration process, see the product documentation.

    Automatic incident assignment enrollment

    To enroll an incident in the automatic assignment process, the automatic incident assignment feature must be enabled and the incident must match a set of predefined criteria.

    Enabling the automatic incident assignment feature

    To enable automatic incident assignment, complete the following steps:

    1.	Set the pmcom.ticket.simultaneous.ownerandownergroup system property to 1 (one). This property is set to 1 by default in a new installation.

    a.	Open the System Properties application as shown in Figure 8-4 by clicking Go To → System Configuration → Platform Configuration → System Properties.

    b.	Filter the Global Properties by property name by using the value pmcom.ticket.simultaneous.ownerandownergroup.

    c.	Set Global Value to 1 (one).

    d.	Save the record by clicking the save icon.

    e.	Click Live Refresh in the Common Actions navigator window, or select Live Refresh from the Select Action menu. 
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    Figure 8-4   Setting the system property for automatic incident assignment

    2.	Make the ONCALLASSIGN escalation active:

    a.	Open the Escalations application by clicking Go To → System Configuration → Platform Configuration → Escalations.

    b.	Search for the ONCALLASSIGN escalation and click it.

    c.	Click Activate/Deactive Escalation in the More Actions navigator window as shown in Figure 8-5, or select Activate/Deactive Escalation from the Select Action menu.
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    Figure 8-5   Activating escalation

    Enabling Automatic Incident Assignment for each incident

    To enroll incidents in automatic assignment, complete these steps for each incident that will be automatically assigned:

    1.	Enable Automatic Assignment for the incident:

    a.	Open the Incidents application by clicking Go To → Service Desk → Incidents.

    b.	Search for the incident that you want to enroll in Automatic Incident Assignment and open it.

    c.	Select Automatic Assignment in the Incident Details section as shown in Figure 8-6. A ticket template can be used to set the Automatic Assignment value.
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    Figure 8-6   Enabling automatic assignment

    2.	Assign an initial owner group to the incident:

    a.	Open the Incidents application by clicking Go To → Service Desk → Incidents.

    b.	Search for the incident that you want to enroll and click it.

    c.	Click Select Owner in the Common Actions navigator pane (or select Select Owner from the Select Action menu) as shown in Figure 8-7.
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    Figure 8-7   Assigning the initial owner group

    d.	Click the Person Groups tab.

    e.	Select the initial owner group that you want.

    3.	Change the incident to the queued state (QUEUED):

    a.	Open the Incidents application by clicking Go To → Service Desk → Incidents.

    b.	Search for the incident that you want to enroll and click it.

    c.	Click Change Status in the Common Actions navigator pane (or select Change Status from the Select Action menu).

    d.	Click New Status → Queued, as shown in Figure 8-8. Note that the incident status is also changed to Queued when an initial person group is assigned (step #2). 
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    Figure 8-8   Queuing the incident

     

    
      
        	
          Reminder: Automatic incident assignment only considers person group team members that are available according to their primary calendar and shift or the Modify Availability table. Both can be configured through the People application. 

        
      

    

    Escalation

    The primary automatic assignment mechanism is a combination of an escalation (defined in the Escalations application) and an action script that is written in Jython:

    Escalation: 	ONCALLASSIGN

    Action: 	ONCALLASSIGN

    The escalation defines the execution period (schedule) and the incident match criteria that are used to determine whether an incident is reassigned.

     

    
      
        	
          Reminder: The ONCALLASSIGN escalation is INACTIVE by default. It must be enabled to use the automatic incident assignment feature.

        
      

    

    The assignment hierarchy and extra automatic assignment parameters are defined at the person group level. 

    The Automatic Assignment escalation is configured to run every 10 minutes by default. This is the absolute minimum amount of time between incident assignments. Be sure to consider this when you add new values to the Assignment Frequency domain.

    Person groups

    The automatic assignment hierarchy (or sequence of people and groups to whom an incident is automatically assigned) is defined by using the Person Groups application.

    There are essentially two sequences of potential incident owners: The sequence of people in each person group and the sequence of person groups. 

    Automatic incident assignment iterates through each member of a person group or through the sequence of person groups according to the value of the Automatic Assignment Method field on the person group.

    For most ready for use methods, automatic incident assignment assigns the incident to each member of the person group before moving the incident to the next person group in the person group sequence.

     

    
      
        	
          Eligibility for team members: Alternate person group team members are only eligible for automatic incident assignment if their primary person group team member is unavailable according to the Modified Availability table.

        
      

    

    The person group sequence is defined by setting Next Person Group in the Person Group application, as shown in Figure 8-9.
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    Figure 8-9   Next Person Group

    The assignment method algorithm is defined by setting the Automatic Assignment Method as shown in Figure 8-10.
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    Figure 8-10   Configuring the Automatic Assignment Method

    You can further customize the automatic assignment interval by changing the How many minutes to wait before re-assigning attribute, as shown in Figure 8-11.
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    Figure 8-11   Configuring the re-assignment wait period

    This attribute only accepts values from the ONCALLASSIGNFREQ domain, which is configured to allow 15 minute, 30 minute, and 60 minute intervals by default, as shown in Figure 8-12.
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    Figure 8-12   ONCALLASSIGNFREQ domain values

    You must edit the ONCALLASSIGNFREQ domain by using the Domains application to add or update these values. To open the Domains application, click Go to → System Configuration → Platform Configuration → Domains.

    Person availability

    Group member availability is defined in the People application. You can assign a primary calendar and shift to a person and modify their availability by using the Modify Person Availability action. 

     

    
      
        	
          Time zones: Within the scope of automatic incident assignment, all work periods that are associated with a person (shifts, shift breaks, modified availability periods) are considered to be in the person's time zone. For example, if a person working in the US Central time zone (CST6EDT) is marked as unavailable from 7am to 10am in the Modify Availability table, they are considered unavailable from 8am to 11am in the US Eastern time zone (EST5EDT).

        
      

    

    The automatic assignment script uses the process that is shown in Figure 8-13 to determine availability.
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    Figure 8-13   Availability logic

    Person group guidelines

    Incidents are not reassigned to the first group after they reach the last group in the person group sequence by default. Therefore, be sure to place an active, closely watched person group in last group position.

    If your business requirements demand that an incident must be reassigned to the initial person group in the person group sequence, edit the noMoreAssignments method in the ONCALLASSIGN Automation Script.

    Use the How many minutes to wait before re-assigning attribute to adjust the precision of the incident reassignment interval. A combination of the escalation schedule and the person group reassignment interval determines the total incident reassignment period. Therefore, consider this and adjust it according to your business requirements.

    Assignment methods

    Assignment methods are essentially load balancing mechanisms that can be used to tailor the performance characteristic of a person group to your business requirements. The automatic incident assignment implementation supports the following assignment methods:

    •Set as Owner Group

    Assigns an incident to the person group only. This method does not assign the incident to individual group members, giving them the opportunity to voluntarily take ownership. It is appropriate for large person groups where the re-assignment time (escalation period and re-assign wait time) makes assigning an incident to individual group members prohibitively expensive or for a supervisory/administrative person group.

    •Set Owner by Rotation

    Assigns an incident to a person group member based on sequence number (starting with the lowest sequence number), but chooses a different initial person for each new incident. 

    This method prevents the same person (the first person in the group) from being the first recipient of multiple escalated incidents, spreading the burden of initial incident assignment across the entire group. This method is appropriate for the initial person group in environments with a high rate of incoming incidents.

    •Set Owner by Sequence

    Assigns an incident to a person group member based on sequence number (starting with the lowest sequence number).

    This is the default assignment method, and is typically employed by an administrator who wants strict control over incident assignment order. For example, they might have constructed their groups in order of increasing expertise or experience, ensuring that only incidents that cannot be addressed by a junior member of the team are assigned to senior members.

    •Set Owner by Workload

    Assigns an incident to a person group member based on their current active workload, as measured by the number of active incidents that are assigned to them. This method queries the database to determine ticket count.

    An incident is considered active if it is in one of the following states:

    In Progress (INPROG)

    Queued (QUEUED)

    This can be changed by modifying the binding value for the activeTicketStatus automation script variable for the ONCALLASSIGN automation script.

    a.	Open the Automation Scripts application by clicking Go To → System Configuration → Platform Configuration → Automation Scripts.

    b.	Search for ONCALLASSIGN and open the record.

    c.	Click the Variables tab and search for activeTicketStatus as shown in Figure 8-14.
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    Figure 8-14   Configuring active incident status values

    There is more information about script parameters in the next section.

    Assignment script

    The automatic assignment action script (ONCALLASSIGN) is written in Jython, a language that employs Python syntax with support for instantiating and using Java objects.

    The automatic assignment script is a highly configurable extension point that allows you to customize the assignment process through changes to script variable values or, if necessary, modification of the assignment script itself.

    Script variables

    There are three automation script variables that can be used to customize the automatic assignment process. To view the script variables, complete these steps:

    1.	Open the Automation Scripts application by clicking Go To → System Configuration → Platform Configuration → Automation Scripts.

    2.	Search for ONCALLASSIGN and open the record.

    3.	Click the Variables tab and search for activeTicketStatus:

     –	activeTicketStatus	

    This variable controls the status values that the automatic assignment script considers ACTIVE when counting total active incidents for the Set Owner by Workload assignment method.

    The default value is INPRG,QUEUED, which means that the assignment script counts all incidents that are queued or in-progress when calculating the total number of active incidents assigned to a person group team member.

     –	endOfShiftBuffer

    This variable allows you to prevent an incident from being assigned to a person group team member who is at the end of their shift. It effectively introduces a block of time at the end of the shift when incidents are not assigned to that person group team member.

    This variable is best used in environments with complex or time-consuming incidents, or where shift close-out consists of extra activities (paperwork or other administrative overhead) that prevent a person group team member from effectively resolving incidents.

     –	useModAvailRecordWorkTime

    Setting the value of this variable to 1 (one) indicates that the Modify Availability table is used to determine group member availability if a primary calendar is not defined on the person record.

    Set the value of this variable to 1 (one) if your organization does not use calendars to define available time.

    Script organization

    The main purpose of the automation script is to determine an incident's current owner, and assign the next owner according to the algorithm defined on the current person group. The script is well-documented and designed to be modular and easily extensible.

    Assignment script guidelines

    The Automatic Assignment script is run for every incident that matches the escalation criteria, so avoid adding complex/time-consuming logic.

    Adding an assignment algorithm

    As a example, add an assignment algorithm that assigns an incident to the members of a person group in alphabetical order:

    •Add a value to the Automatic Assignment Method domain.

    This example uses the Content Loader ImportObject utility to add the domain value to the ONCALLASSIGNMETHOD ALN Domain:

    a.	Save the XML markup shown in Example 8-1 to a file and note its location.

    Example 8-1   XML markup for ALNDOMAIN
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    <?xml version="1.0" encoding="UTF-8"?>

    <objectExport>

      <object keyColumn="DOMAINID,VALUE,SITEID,ORGID"

        name="ALNDOMAIN" tableName="ALNDOMAIN">

        <column dataType="java.lang.String" name="DOMAINID">

          <value>ONCALLASSIGNMETHOD</value>

        </column>

        <column dataType="java.lang.String" name="VALUE">

          <value>Set Owner by Alphabet</value>

        </column>

        <column dataType="java.lang.String" name="DESCRIPTION">

          <value>Iterate through person group members in alphabetical order</value>

        </column>

        <column dataType="java.lang.Long" name="ALNDOMAINID">

          <columnOverride>

            <sequence mode="nextval" name="ALNDOMAINSEQ"/>

          </columnOverride>

        </column>

        <column dataType="java.lang.String" name="VALUEID">

          <value>ONCALL_ALPHABET</value>

        </column>

      </object>

    </objectExport>
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    b.	Open a command line and navigate to the SmartCloud Control Desk installation directory (typically C:\IBM\SMP\maximo\ or /opt/IBM/SMP/maximo).

    c.	Navigate to the tools/maximo/internal subdirectory.

    d.	Run the following command, replacing <PATH TO XML FILE> with the fully qualified file name of the file that was saved in Step #1:

    On Microsoft Windows:

    ImportObject.bat -input=<PATH TO XML FILE>

    On Linux or AIX:

    ./ImportObject.sh -input=<PATH TO XML FILE>

    •Update the Automatic Assignment Script to implement the new assignment method:

    a.	Click System Configuration → Platform Configuration → Automation Scripts.

    b.	Search for the ONCALLASSIGN script.

    c.	Add a method named getNextPersonByAlphabet.

    Python/Jython methods are defined as follows:

    def MethodName(parameter 1, parameter 2):

     method_body line 1

     method_body line 2

    White space is important in Python/Jython, so the method body must be indented relative to the method signature or preamble. The full method is contained in Example 8-2.

    Example 8-2   ONCALLASSIGN new Alphabet Assignment method
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    def getNextPersonByAlphabet(pgtMboSet, currentPerson): 

        nextPerson = None    

        pgtMbo = None

        count = pgtMboSet.count()

        i = 0; 

     

        # Sort by personid in alphabet order

        pgtMboSet.setOrderBy("respparty asc");

        pgtMboSet.reset();

     

        for i in range(count):

            pgtMbo = pgtMboSet.getMbo(i)         

            if (currentPerson == None):           

                break

            else:

                person = pgtMbo.getString("RESPPARTY")

                if (person == currentPerson):

                    if (i + 1) < count:

                        pgtMbo = pgtMboSet.getMbo(i + 1)

                    else:

                        pgtMbo = None

                    break

     

        if (pgtMbo != None):

            nextPerson = pgtMbo.getString("RESPPARTY")

     

        print ticketid + ": getNextPersonByAlphabet: nextPerson = " , nextPerson

        return nextPerson, pgtMbo
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    d.	Call the new method from the getNextPersonFromMemberList method.

    This method contains a switch that calls Jython methods depending on the Automatic Assignment Method for the person group:

     if (onCallMethod != None and onCallMethod == 'ONCALL_ROTATION'):

         # call rotation method here

    elif (onCallMethod != None and onCallMethod == 'ONCALL_ALPHABET'): 

        # call alphabet method here

    The full method is contained in Example 8-3.

    Example 8-3   ONCALLASSIGN updated getNextPersonFromMemberList method to call the new Alphabet assignment method
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    def getNextPersonFromMemberList(pgtMboSet, currentPerson, personGroup, isPrimary, firstRotationAssnPerson):

     

        onCallMethod = getOnCallAssignMethod(personGroup)

        

        if (onCallMethod != None and onCallMethod == 'ONCALL_ROTATION'):            

            return getNextPersonByRotation(pgtMboSet, currentPerson, personGroup, isPrimary,

    firstRotationAssnPerson)

        elif (onCallMethod != None and onCallMethod == 'ONCALL_ALPHABET'): 

            return getNextPersonByAlphabet(pgtMboSet, currentPerson)

        

        # Workload algorithm is handled directly by the main routine

          

        # default to sequence    

        return getNextPersonBySequence(pgtMboSet, currentPerson)
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    e.	Save the script

    8.1.5  Problem Management

    In ITIL terms, a problem is the underlying error in the infrastructure that is the cause of one or more incidents. Problem management is the process of diagnosing the root cause of the error and arranging for a correction. Furthermore, it seeks to prevent a recurrence of incidents that are related to these errors. 

    Problem Management is closely related to Incident management and benefits from using the same tools with similar categorization, impact, and priority coding systems. This ensures effective communication when dealing with related incidents and problems.

    Problem management is also responsible for ensuring that the resolution of a problem is implemented through the appropriate control procedures, especially Change Management and Release Management.

    Effective problem management requires being able to quickly and accurately turn an unknown error into a known error with a documented root cause and work around. The information about problems, their workaround, and resolutions are important inputs to knowledge management, and helps to reduce the number and impact of incidents over time. 

    Problem management is also proactive when involving analyzing trends to recommend service improvement opportunities.

    IBM SmartCloud Control Desks assist in effective problem management in these ways: 

    •Allowing capture of root cause in a failure hierarchy and a workaround in a solution, against a problem record.

    •Allowing you to mark problem records as known errors, effectively providing a searchable known error database for your organization.

    •Allows the creation of changes from identified problems and ties appropriate incidents to these problems.

    •Providing integration with CMDB and topology views to assist root cause diagnosis.

    •Providing built-in, real-time dashboards, giving insight into all levels of service desk operations. This allows any support staff, manager, or executive to monitor role-based KPIs in an intuitive, graphical display.

    •Providing dashboards with actionable information that can identify potential problem areas, enabling IT to take appropriate corrective actions in most cases before critical services are adversely affected. 

    Problem management roles

    The main roles that are involved with problem management are provided by the optional content, and described in Table 8-3.

    Table 8-3   Problem management roles

    
      
        	
          Role

        
        	
          Description

        
      

      
        	
          Problem Analyst

        
        	
          Problem Analyst group. These users are subject matter experts in one or more areas. The Problem Analyst discovers incident trends, identifies problems, and determines the root cause of problems.	

        
      

      
        	
          Problem Manager

        
        	
          Problem Manager group. These users are responsible for the quality and integrity of the problem management process. The Problem Manager interfaces with other process managers and serves as the focal point for escalation.

        
      

      
        	
          Problem Owner

        
        	
          Problem Owner group. These users oversee the handling of a problem, bringing in analysts and specialists as needed. The Problem Owner is responsible for bringing the problem to closure.	

        
      

    

     

    
      
        	
          Note: The IBM SmartCloud Control Desk optional content package also provides a Problem Administrator group. This is NOT a process role. It is an administrative group that has access to all applications. You must decide whether you want to use it.

        
      

    

    Problem management process flow

    Figure 8-15 shows the activities that are involved in the incident management process.
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    Figure 8-15   Problem management process flow

    •Detect and log problem

    Either automated or manual, this activity ensures that monitoring, analysis, and notification mechanisms are implemented to detect problems. When detected, problems are linked to associated incidents. Problems can be detected from these sources:

     –	Incidents

     –	Notification from suppliers

     –	Feedback from service desk or technical support groups (ideally this process results in an incident report)

     –	Pro-active approaches such as trend analysis

    •Categorize and prioritize problem

    This activity ensures that problems are classified to enable appropriate analysis and resolution. It takes into account the severity of problems that might be encountered, and the potential impact to business goals.

    •Investigate and diagnose problem

    This includes activities for root cause analysis, creating workarounds where possible, and recording a known error. This activity must ensure that workarounds are in place and effective, and that sufficient analysis and diagnosis are done to complete the root cause analysis.

     –	Workarounds are a temporary way of overcoming difficulties without addressing the root cause of the problem. When workarounds are found, the problem record needs to remain open, and details of the workaround must be documented.

     –	On completion of problem diagnosis, a known error record must be raised and placed and marked as a known error, so that as further incidents or problems arise, they can be more easily identified

    •Resolve problem

    This activity ensures the resolution of known errors (that is, problems for which the root cause is fully understood). This includes these steps:

     –	The search for a solution

     –	The implementation planning of resolution actions to eliminate known errors (for example, by initiating a request for change or project proposal)

     –	Tracking the successful implementation of the change to the infrastructure.

    •Close and review problem

    This activity includes closing problems, ensuring known error records have been updated, and performing reviews for major problems. Each problem record is checked for completeness so that other processes have the appropriate information available, for example, updates to incident management. For each major problem, conduct a review and incorporate the results into communication, training, and reviewing the affected service.

    8.1.6  IBM SmartCloud Control Desk capabilities

    This section summarizes the capabilities that IBM SmartCloud Control Desk provides for Service Operation:

    •Separate applications for recording service requests, incidents, and problems. These are separate record types, but are a form of ticket.

    •The ticket applications are closely related and share many features that include:

     –	The ability to define relationships between tickets, link them together for information purposes, and view the linkages and details in the appropriate applications.

     –	The ability to directly report on and view integrated CMDB and Asset information.

     –	Integrated logging of communication channels that includes email, work logs, and instant messaging.

    •Multi-level classification and failure reporting of incidents and problems.

    •Basic entry dialogs for faster creation of new incidents and service requests.

    •Automation scripts to help collect information about the incident (this capability is not available with the entry edition).

    •Common service desk applications to support request fulfillment, incident, and problem resolution:

     –	Ticket Templates application for modeling common high-volume tickets.

     –	Priority Matrix application for prioritizing tickets based on your impact and urgency mapping.

     –	Service Level Agreements application for defining automated actions and notification for time-based service commitments.

     –	Response Plans application for automating predictable and repeatable responses to tickets.

     –	Solutions application for predefining responses to commonly asked questions or problems.

     –	Global Search application for searching across Service Requests, Incidents, Problems, and Solutions.

    •Common Tivoli's process automation engine for automation of process workflow and condition-based escalation.

    •Integration with event management products and third-party incident management products.

    •Integration with Interactive Voice Response (IVR) and Computer Telephony Integration (CTI) technologies.

    •Integrated remote diagnostics tools.

    8.2  Service Operation using IBM SmartCloud Control Desk

    This section presents an integrated scenario and examples to demonstrate some key features in the use of IBM SmartCloud Control Desk for service operation. Examples are based on the optional contents package.

    The optional contents package provides workflows for handling service requests, incidents, and problems. These are useful for demonstrating service operation using IBM SmartCloud Control Desk. In many real-life deployments, however, workflows are not used because they can increase the number of clicks that are required by Service Desk agents to administer tickets. The agents can still complete many of the activities in the examples without being guided by a workflow.

    The examples do not show any operation following service level commitments. See Chapter 7, “Service level management” on page 381 to see how this can be applied.

    Furthermore, the scenarios assume that labor tracking is not being used. If your organization wants to use labor tracking, your analysts must use the start and stop labor clocks when they begin and end their work on a particular ticket.

    8.2.1  Logging a service request example

    User Bob is having an issue when trying to access a business application. He can get a resolution to the issue by using self-service or calling the company’s in-house service desk. The result of these scenarios is a service request record that captures his issue.

    Self-service

    This example shows Bob using self-service to try to address his issue. For more information about the Self-service center and other self-service applications in IBM SmartCloud Control Desk, see Chapter 9, “Self-service” on page 531.

    1.	Bob logs in to IBM SmartCloud Control Desk and is taken to the Self-service center.

    2.	He notices that there is some news available about a system outage. Bob clicks the news item under recent Recent Activity to see whether it is related to his issue as shown in Figure 8-16. The news is not related to his business application, so he clicks Close to close the dialog.
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    Figure 8-16   Checking for news and announcements using self-service center

    3.	Bob then searches to see whether there are any known solutions to this problem that he can address himself quickly. He clicks Search for Solutions under the navigation bar and is presented with a key word search dialog as shown in Figure 8-17. Bob enters words that are related to his issue, access error, into the dialog and clicks Search.
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    Figure 8-17   Self-service center search for solutions

    Figure 8-18 shows the returned search results. Alternatively, Bob can type the search words directly into the navigation bar. However, this returns quick inserts and catalog items as well as solutions.
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    Figure 8-18   Self-service center solution search results

    4.	The first solution from the search results in Figure 8-18 best matches Bob’s issue. Note that it has five stars, which indicates that users who have used the solution have given it a high average ranking. Bob clicks the solution and is presented with its details as shown in Figure 8-19 on page 442.

     

    
      
        	
          Tip: The average solution ranking is calculated every 24 hours at midnight by a cron task. To make this run more frequently, alter the PmRankingSolutionCron cron task from the Cron Task Setup application.
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    Figure 8-19   Example solution dialog

    Bob follows the instructions in the resolution and checks the host file on his notebook. The IP address is already in his host file, so the solution does not help. He clicks No - Create a Service Request to request further assistance.

    The solution that Bob has viewed is added to the solution tracking section or the Service Request. This provides a history of solutions the user has tried when creating a service request as seen in Figure 8-20.
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    Figure 8-20   Self service solution tracking

    5.	The Report an Issue dialog is displayed. Bob completes the details of his issue. Because he urgently needs access to the application, he changes the priority to 1 and selects his notebook ITAM1004 from the Affected Asset field as shown in Figure 8-21. 
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    Figure 8-21   Report an Issue dialog

    From the Attachments tab, Bob clicks Screen Capturer, which starts a tool to allow him to capture and attach a screen capture of this error as shown in Figure 8-22.
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    Figure 8-22   Report an Issue dialog: Attachments tab

    6.	Bob clicks Submit Now, and a service request is created. An acknowledgement with a system generated ticket number of 1091 is presented as shown in Figure 8-23.
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    Figure 8-23   Service Request ticket acknowledgement

    The generated service request ticket is shown in Figure 8-24.
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    Figure 8-24   Service request ticket

    The Source field is automatically set to SELFSERVICE. The Created By, Reported By, and Affected Person all identify Bob. Furthermore, because the service request was created by viewing a solution, the ticket inherits the classification from the solution.

    A service desk analyst picks up the new ticket. The analyst validates it for completeness, reviews its categorization, and prioritizes it before fulfilling the request. This process is detailed in the next scenario.

    From Live Chat

    Users can initiate chat sessions with a Service Desk Agent. If a user does not choose an existing request, a new Service Request is generated. For more information about a user chatting with a service desk agent, see 9.2.8, “Chatting with an agent” on page 555.

    Calling the service desk

    This example shows one of the traditional ways to ask for help: Bob calls a telephone number and speaks to a service desk analyst. 

    In this scenario, Service Desk analyst Scott receives Bob’s call. After he validates Bob’s identity and entitlement, he creates a service request ticket on Bob’s behalf. 

    As a service desk analyst, Scott is already logged in and working in IBM SmartCloud Control Desk. Depending on where Scott is in the system, there are a couple of ways for Scott to create a service request.

    From the Start Center

    To create a service request from the Start Center, complete these steps:

    1.	Click New SR Full from the Quick Insert portlet as seen in Figure 8-25.
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    Figure 8-25   Quick insert from Service Desk start center

    This immediately takes Scott to the service request application with a new empty record created and ready for entry.

     

    
      
        	
          Tip: Your service desk can save valuable clicks by creating quick inserts from the start center for frequently requested tickets such as password resets. Create a ticket template to model the activities of the request and link this to a quick insert. Your analyst can then create the ticket, pre-populate it with model information and be taken to the entry window for the ticket with one click.

        
      

    

    2.	Scott then proceeds to record the service request as shown in Figure 8-26:

     –	He sets the source to PHONECALL to indicate that the request was initiated by a phone call.

     –	He enters Bob in the reported by field and presses tab. This automatically brings Bob’s contact details into the record and also defaults the affected person information. The Created By field is automatically set for him.
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    Figure 8-26   Service request entry window

    3.	Scott clicks the Apply Service Request Template action from the common actions as shown in Figure 8-26. This brings up a dialog of service request ticket templates. If an applicable model for the request exists, it can be selected to populate the ticket.

    4.	There are no applicable service request templates for this issue. Therefore, Scott continues to record the details of the service request including the summary details, the reported priority for the request given by Bob, and the site from which the record is being reported.

    5.	Scott proceeds classify the request. He brings up the classification drill-down from the detail menu of the Classification Path field and drills down to the value 210701: Oracle Financials Issue as shown in Figure 8-27.
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    Figure 8-27   Classification drill-down

    6.	Scott prioritizes the request based on the details that he has now recorded. The priority fields can be seen in Figure 8-28 on page 449.

     –	Indicated Priority. You can place associate indicated priorities to your classification structure to help your analyst with the prioritization process. This crosses over from the selected classification if it is set.

     –	Reported Priority. This is the priority that is given by the reported by person.

     –	Impact. This is used to indicate the scale of effect the ticket has on the business.

     –	Urgency. This is used to indicate the speed in which a ticket must be resolved before there is significant impact on the business.

     –	Internal Priority. This is a calculated field that is based on impact and urgency. Set up the calculation matrix to reflect your business processes. The Priority Matrix application (click Go To → Service Desk → Priority Matrix) allows you to set your internal priority calculations.
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    Figure 8-28   Ticket priority fields

    From the Service Request application

    As a service desk analyst, Scott is probably already working in the service request application. He does not need to return to the start center to start creating Bob’s ticket. To create the ticket from the Service Request application, complete these steps:

    1.	Scott can either click New Service Request on the navigation toolbar or use the keyboard shortcut CTRL+ALT+I as shown in Figure 8-29.
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    Figure 8-29   Inserting a new service request

    2.	A new service request dialog is displayed as shown in Figure 8-30. This is a simple entry dialog that allows Scott to quickly capture the initial details of the call. Scott can also select a ticket template from the Common Requests field to immediately create the service request.
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    Figure 8-30   New Service Request dialog

    3.	On clicking Submit Now, a service request is created and Scott is taken to the full Service Request entry window where he continues to classify and prioritize the request as shown previously.

    8.2.2  Quickly determining important details of a service request, incident, and problem

    The Service Request, Incident, and Problem applications have been redesigned to include a new header. The updated header allows the user to quickly understand primary details of a ticket including its name, description, status, owner / owner group, and priority. A progress map is used to give a pictorial view of the ticket’s status, and previous and future transition states. Figure 8-31 shows an example header from an incident.
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    Figure 8-31   Incident header

     

    
      
        	
          Looking different: For a service request, the progress map will differ for requests generated from the service catalog to include the approval steps.

        
      

    

    Icons in the header provide more details. The first icon indicates whether there is a known service bulletin that is associated with the ticket. To view the service bulletin details, click the icon. Table 8-4 shows the two icons related to service bulletins.

    Table 8-4   Service bulletin icons
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          There is no Service Bulletin related to the ticket.
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          There is a Service Bulletin related to the ticket. To view the details of the bulletin, click the icon.

        
      

    

    The second icon indicates if the ticket is, is related to, or is not currently related to a global ticket. Clicking the icon allows the user to associate the ticket to a global incident. Table 8-5 shows the icons related to Global Tickets.

    Table 8-5   Global ticket icons
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          This ticket is not a global ticket and is not related to a global ticket. To change this information, click the icon.
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          This ticket is a global ticket. To change this information, click the icon.
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          This ticket is related to a global ticket. To change this information, click the icon.

        
      

    

    8.2.3  Fulfilling and routing the service request

    Scott now continues to fulfill the logged service request. The scenario is continued with self service ticket 1091 that was created in 8.2.1, “Logging a service request example” on page 440.

    Using workflows

    You can use workflows to help guide your users through a process or procedure. This example shows Scott using the SR_V3 workflow included in the optional content packages:

    1.	With the service request ticket open. Scott selects the route workflow button from the navigation bar and proceeds to start the ticket in the SR_V3 workflow. This workflow guides the user through the request fulfillment process as shown in Figure 8-32 on page 453.
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    Figure 8-32   Starting the request in the fulfillment workflow

     

    
      
        	
          Tip: You can create toolbar buttons to start a specific workflow to save clicks and make it easier to find the correct workflow. For more information, see 8.3.5, “Creating a workflow go button” on page 509.

        
      

    

    2.	On starting the workflow, Scott is presented with dialog shown in Figure 8-35 on page 455. Because he will be working on this ticket, he selects Take Ownership and clicks OK. The status of the record changes to QUEUED as shown in Figure 8-33.
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    Figure 8-33   Taking ownership of the request

    3.	Scott continues to allow the workflow to guide him. He clicks the route workflow button and the system automatically searches for solutions that match the classification. He is presented with a solution similar to Figure 8-19 on page 442. If there is more than one matching solution, a list is displayed.

    4.	He clicks Use Solution from the solution dialog, and the solution is copied into the service request in the Solution Details tab as shown in Figure 8-34. 
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    Figure 8-34   Solution copied into service request

    5.	Scott uses the integrated remote diagnostics tools to check Bob’s host file. For more information, see 8.4, “Performing remote diagnostics using IBM SmartCloud Control Desk” on page 520. The solution does not fix Bob’s problem because his host file already contains the required entry.

    6.	Scott selects his next workflow actions from a series of guiding dialogs. He selects the options that a solution was found, but that the request was not fulfilled by the suggested solution.

    7.	Because this is an incident, Scott chooses to create an incident from the radio button options and enters a memo to describe his actions as shown in Figure 8-35.
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    Figure 8-35   Creating an incident from a service request using the fulfillment workflow

    He is presented with an acknowledgement that the incident was created as shown in Figure 8-36.
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    Figure 8-36   Incident creation acknowledgement

    The follow-up relationship is created with the ticket as shown in Figure 8-37.
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    Figure 8-37   Related records

    8.	From the detail menu of the related record 1047, Scott navigates to the incident. He assigns the incident to an appropriate resolver group, SRMAPPL, by clicking Select Owner from the toolbar (Figure 8-38).
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    Figure 8-38   Assigning an owner group to a ticket

    Using Response Plans

    You can also use response plans to help your staff be more efficient and consistent. Response plans help ensure that similar work is performed in a repeatable and consistent way. When you apply a response plan to a ticket, the system finds a plan that matches the attributes of that ticket. This section shows the creation of simple response plan that automates some of the actions from the previous example.

    
      
        	
          Note: Response plans can be associated with all ticket application (Service Request, Incidents, and Problems) and also work orders and changes. For more information about setting up response plans, see the InfoCenter at:

          http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.tusc.doc/mods_apps/c_ctr_tusc_app_respplans.html

        
      

    

    To create the simple response plan, complete these steps:

    1.	Click Go To → Service Level → Response Plans.

    2.	Click New Response Plan on the navigation toolbar. A new response is created in DRAFT status as shown in Figure 8-39. Complete the basic details:

     –	Description: Responding to Oracle financial outages

     –	Ranking: 1

    If multiple response plans apply to the same ticket, the response plan with the highest ranking is selected. 

     –	Applies To: SR

    This is the type of object that this response plan applies to. In this case, it is a service request.
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    Figure 8-39   Creating a response plan

    3.	Complete the Response section as shown in Figure 8-40. The response section contains information that must be brought into the matching record. The grayed out fields relating to Job Plans and Work Groups are only applicable for work order response plans. For this example, enter the following information:

     –	Assign Owner Group: SRMAPPL

    This sets the owner group on the matching SR record.

     –	Apply Solution: SPOC1295

    This copies the solution into the matching SR record.
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    Figure 8-40   Responses

    4.	Next, define the matching conditions for the response plan in the Conditions tab. The response plan can consider various criteria that include specific locations, assets, and configuration items (specified by using the appropriate tab). It matches only if all conditions match. For this example, the match condition is based on classification and internal priority as shown in Figure 8-41 on page 459. Set the following information:

     –	Classification: 21 \ 2107 \ 210701

     –	Internal Priority: LESSOREQUAL 2

    This picks up values of 2 or 1
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    Figure 8-41   Response plan conditions

    5.	Define the automated response actions for the response plan. These can be any Tivoli's process automation engine actions or action groups that you define by using the Go To → System Configuration → Platform Configuration → Actions application. The example in Figure 8-42 on page 460 uses some predefined actions added by using the new row button:

     –	SR APPLYSLA: This runs the action to find and apply matching SLAs

     –	SR CREATEINCIDENT: This action creates a follow-up incident for the SR

     –	SR INPROG: This sets the status of the service request to in progress

    You can also generate automated notifications as a response. A common scenario is to create a response plan to notify a service restoration manager for critical priority incidents.
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    Figure 8-42   Configuring response actions

    6.	Before the response plan can be used, the status must be changed to ACTIVE. Do this by clicking the change status button in the navigation toolbar.

    To show the application of the active response plan. complete these steps:

    1.	Locate the service request 1091. Duplicate the ticket by clicking Select Action → Duplicate Service Request. 

    2.	From the duplicated ticket, click Select Action → Apply Response Plan. An error message is displayed if there are no matching response plans. Figure 8-43 shows the message when the example response plan is applied to the duplicate ticket.
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    Figure 8-43   Response plan application message

     

    
      
        	
          Tip: It is a good practice to have response plans applied automatically for efficiency. This can be done by calling predefined actions from workflows, escalation, or automation scripting. Figure 8-44 shows an example of an action that can be used.

        
      

    

    [image: ]

    Figure 8-44   Example apply response plan action

    8.2.4  Investigating and diagnosing an incident

    The scenario is continued from using the incident that was created from service request that was created by service desk analyst Scott. Nancy is a second line support analyst who is a member of the SRMAPPL group.

    1.	When Nancy logs in to the system, she can see the incident 1047 in the Group Work Queue portlet, which shows tickets assigned to the workgroups she is a member of from the Incident Analyst start center (Figure 8-45).
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    Figure 8-45   Incident Analyst start center

    2.	Nancy clicks the row for incident 1047 and is taken directly to the incident record. She reviews the incident information and validates that the priority and classification that have been given to the incident. She then begins to work on the incident by changing the status of the ticket to INPROG (in progress) and starts the workflow in the INC_V4 workflow process.

    3.	On starting the workflow, Nancy is prompted with options to assist her in diagnosis of the incident as shown in Figure 8-46. She chooses to search for duplicate tickets.
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    Figure 8-46   Starting the workflow for incident

    4.	This presents Nancy with the Show Similar Tickets dialog. Service Requests, Incidents, and Problems that have the same classification are shown (Figure 8-47). From this dialog, Nancy can inspect the records individually by navigating to the record by using the detail menu. Nancy finds that incident 1060 and service request 1113 are similar tickets and might be duplicates. She selects these and clicks Relate Records to relate them to the current ticket.
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    Figure 8-47   Searching for similar tickets

     

    
      
        	
          Tip: The criteria for similar tickets is defined by the SIMILARTICKETS relationship on the TICKET object. By default, it matches classifications. You can refine or expand this criteria by modifying this relationship definition by using the Go To → System Configuration → Platform Configuration → Database Configuration application.

        
      

    

    5.	As there are related records, Nancy is asked by the workflow if she wants to make the incident a global incident as shown in Figure 8-48.
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    Figure 8-48   Creating a global ticket

    A global record is a ticket that is a root cause of other issues or that affects many users. After you mark a record as global (Figure 8-49 on page 466), you can relate multiple tickets to it and then manage all tickets using the global record:

     –	When you open a global record, and select Show Similar Tickets in the toolbar, you can view all tickets that are related to the global record. You also can select tickets and relate them to the global ticket.

     –	A record can be a global ticket or related to a global ticket, but not both.

     –	You can view the work and communication logs for all related records from the global record.

     –	If you change the status of a global record, the statuses of all globally related tickets change accordingly.

     –	Records that are created as follow-up records from the global record cannot be related to it as a global record.

     –	You cannot manage follow-up records from the global record.

     –	You cannot relate any record to a global record that is archived as a history record.

     –	You cannot designate a record as global if it is already related to a global record or it is a history record.

     –	You can remove the global flag from a global record that has tickets related to it. However, you must first remove the value in the Related to Global ID field for each ticket that is related to the global record. You can do so by using the Related Records tab of the global record.
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    Figure 8-49   Global issues section in the main ticket tab

    6.	Nancy routes the workflow. She can now reassign the ticket to another group or individual if the incident is not in her area of responsibilities. She chooses to take ownership of this incident and continue with incident resolution as shown in Figure 8-50.
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    Figure 8-50   Taking ownership of an incident

    8.2.5  Resolving and closing the incident, and logging a problem

    Technical support analyst Nancy is part of the applications support group and has chosen to work with resolving the incident. This scenario continues with incident 1047 to show the use of automated workflows, which can be used to help incident resolution, and then the close out and logging of a follow on problem.

    To resolve and close an incident, complete these steps:

    1.	Nancy wants to checks to see whether the application server is running. She decides to use an automation workflow to ping the application server. From the incident, Nancy clicks the automation tab and sees the available workflows as shown in Figure 8-51.
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    Figure 8-51   Available automation workflows for incident management

    2.	Nancy clicks the workflow button for Ping Server - Interactive. The workflow starts by creating a specification attribute for the server IP address for ping as shown in Figure 8-52.
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    Figure 8-52   Ping automation workflow adds new specification attribute

    3.	Nancy clicks the route workflow button and is prompted for the destination ping server. She can either choose to ping a CI or a specified IP address. For this example, she picks the IP address option as seen in Figure 8-53.
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    Figure 8-53   Specifying target for ping automated workflow 1

    Figure 8-54 shows the dialog that prompts Nancy to enter an IP address.
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    Figure 8-54   Specifying target for ping automated workflow 2

    4.	Nancy enters the IP address into the specification attribute and routes the workflow. If the ping is successful, she receives a success message as shown in Figure 8-55.
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    Figure 8-55   Automated ping success 1

    The results are logged in the worklog of the ticket as shown in Figure 8-56.
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    Figure 8-56   Automated ping success 2

     

    
      
        	
          Tip: To make new automation workflows available, create the workflows beginning with RBA. For more information about changing this, see 8.3.7, “Changing available Automation workflows for incident resolution” on page 512.

        
      

    

    5.	For this scenario, assume that the ping test failed. By checking the configuration management information, Nancy is able to identify that there is a secondary application server for this application. She identifies that the secondary server is working, and that a workaround for this issue might be to route the user’s host file to the secondary application server address.

    6.	Nancy routes the workflow and chooses to create a new workaround or fix as shown in Figure 8-57. 
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    Figure 8-57   Actions to resolve the incident

    7.	This takes her to the solution details tab where she can enter the workaround into the system. The information is in a format consistent with a solution (symptom, cause, resolution) as shown in Figure 8-58 on page 471. 

     

    
      
        	
          Note: A cron task PmAdhocSolutionCron creates solution records from the solution information entered into ticket. By default, this task runs at midnight every 24 hours, but this setting is configurable.
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    Figure 8-58   Creating a work around the solution

    8.	When Nancy routes the workflow again, she is taken through a series of dialogs to guide her to resolution and closure of the incident.

    First, she is given the option of sending a communication to the requestor letting them know of the work around or creating a change request if a change if required to resolve the incident as shown in Figure 8-59.
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    Figure 8-59   Resolving the incident 1

    Depending whether she has received confirmation from the user of the resolved issue, Nancy can either indicate that the service has recovered, or she can pause the workflow to wait for the confirmation as shown in Figure 8-60. On confirmation, the status of the incident moves to RESOLVED.
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    Figure 8-60   Resolving the incident 2

    9.	Nancy is now ready to close the incident. When she routes the workflow, she is asked to vary the incident details for closure or create a problem if required as shown in Figure 8-61.
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    Figure 8-61   Prompt to create problem for incident

    10.	After validating the incident is ready for closure. Nancy is prompted to create a communication to the user to notify them of the incident closure as shown in Figure 8-62. Upon completing this step, the ticket moves to a CLOSED status. Closing the incident also automatically closes the originating service requests (if they are not already closed manually).
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    Figure 8-62   Prompt to complete send closure communication

    8.2.6  Managing a problem

    The features of the problem application are similar to that of the service request and incident applications shown in the scenario and examples. Rather than walking through a whole scenario, for brevity, the key features are highlighted.

    The ITIL aligned problem management workflow PRB_V3 guides the user through different strategies to work through the problem. Figure 8-63 shows the prompt to select a strategy. 
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    Figure 8-63   Starting the problem management workflow PRB_V3

    Figure 8-64 shows the dialog where you select the strategy.
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    Figure 8-64   Problem management strategies

    After working through the strategies and identifying the root cause of the problem, document it in the failure reporting tab as shown in Figure 8-65. 
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    Figure 8-65   Capturing the root cause with failure reporting

    This failure hierarchy is managed by using the Go To → Assets → Failure Codes application. The hierarchy can contain four levels to drill down on the root cause:

    •Failure Class

    •Problem

    •Cause

    •Remedy

    After you capture the root cause, mark the problem as a known error. This is done by selecting Is Known Error on the problem record on the main tab as shown in Figure 8-66. 
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    Figure 8-66   Is Known Error flag on Problem record

    Doing so allows the known errors to be seen to the other ticketing applications by using the Show Known Error function as shown in Figure 8-67. Access this function by using the Select Action menu within the ticket applications Incident, Problem, and Service Request.
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    Figure 8-67   Show known error dialog

    The workflow also guides the user to create a change request if it is required to fix the problem, and provides a service improvement so the user can close out the problem as shown in Figure 8-68.

    [image: ]

    Figure 8-68   Creating a change order for service improvement

    The closure of a problem record does not close the originating incident or service request record. This is because incidents typically operate under a service level and a workaround for resolution must be provided as soon as possible. In most cases, the workaround is needed before the problem is fully investigated.

    8.2.7  Resolving tickets with solutions

    Solutions are used to document responses to common issues or questions. Solutions can be reserved for use by service desk agents resolving tickets, or they can be made available to users seeking self-help. Solution records are administered in the Solutions application. To open the solutions application, click Go To → Service Desk → Solutions. 

    Making solutions available to users helps users to resolve many issues on their own, therefore reducing incoming volume to the help desk. To make a solution accessible to the Self Service Center, select Include this solution in the Self Service Center as shown in Figure 8-69.
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    Figure 8-69   Solution definition

    When the Self Service Center is configured to allow users to browse solutions, the navigation path is built by using the classification. It displays the class description at each node. Users can also search for solutions by using the navigator toolbar or the Search Solutions dialog when that option has been configured.

     

    
      
        	
          Improve your search: To increase the search hit results, add keywords (separated by commas) to the solution. This differs from previous releases where keywords had to be specifically defined and added to a table.

        
      

    

    Using solutions to resolve tickets

    Agents can use solutions as they attempt to resolve a ticket. In SmartCloud Control Desk, agents can search for solutions to try to resolve a service request or incident. Agents are now able to use a status indicator, solution status, to illustrate that a solution is under evaluation as shown in Figure 8-70.
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    Figure 8-70   Documenting solution status as CONSIDER

    If the solution resolves the user’s issue, the agent can change the solution status on the ticket to Solution Successful and resolve the ticket. If the solution fails, the agent must change the solution status to Solution Failed. Setting the status of the solution to failed on the ticket moves the solution to the Failed Solutions table as shown in Figure 8-71.
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    Figure 8-71   Documenting solution status as FAIL

     

    
      
        	
          Solution effectiveness: Using the Solution Status allows an agent to indicate that a solution is under evaluation, has failed, or has resolved the ticket. This is used to calculate an effectiveness as defined in the next section.

        
      

    

    Solution effectiveness

    Solutions are only effective if they are able to resolve a user’s issue or answer questions that users might have. Having ineffective solutions in the knowledge base can cause users to abandon self help, resulting in increased numbers of tickets or calls to the help desk.

    Solutions in SmartCloud Control Desk now have a calculated effectiveness score. This score is based on the number of times that the solution was successful, divided by total number of times the solution has been attempted. The effectiveness score is shown on the main solution page. In addition, the full details of the solution effectiveness including all requests that this solution has been used with can be seen by using the View Effectiveness Details action. Figure 8-72 illustrates the effectiveness details.
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    Figure 8-72   Solution effectiveness

     

    
      
        	
          Guideline: It is useful to define a threshold where solutions are deemed not effective and must be improved. For example, solutions with an effectiveness rating of 75% or below and have been used more than 10 times need to be reevaluated.

        
      

    

    Solution tracking

    As users browse solutions in the Self Service Center, a history is kept of solutions that are viewed by users before either resolving their issue or opening a request. This allows the knowledge base administrators to have insights into what the user has viewed or searched as another mechanism to improve finding solutions. This information can be viewed in the Solution Details tab of the Service Request application as seen in Figure 8-73.

    [image: ]

    Figure 8-73   Solutions viewed by users

    8.2.8  Quickly resolving service requests and incidents by using service bulletins

    Service bulletins are targeted messages that are displayed to users who are modifying or creating tickets. Messages are immediately displayed to the user as data is updated in the ticket based on criteria defined in the bulletin. Service bulletins can drastically reduce the amount of time it takes to resolve a ticket by quickly presenting the user information about current outages, known global issues, or for cases where support is not provided.

    For example, if a user calls the help desk with a network issue, the agent can create a ticket on the user’s behalf. As the agent classifies the ticket to report a network issue, a service bulletin can alert the agent to a known outage based on a global issue. The agent can quickly view the details of the bulletin and potentially close the new ticket, relating it to a known global issue.

    As a best practice approach, create and maintain service bulletins along with the lifecycle of global incidents.

    Defining a service bulletin

    Service bulletins are an extension of bulletin messages, and are defined by using the Bulletin Board application. New messages can be defined to be only a bulletin board message, only a service bulletin message, or both. Figure 8-74 shows the types of messages.
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    Figure 8-74   Types of messages

    After the message is identified as a service bulletin, define the attributes to match a bulletin to the ticket. The following are the allowable attributes to be specified:

    •Configuration Item

    •Asset

    •Classification

    •Location

    •Customer

    Attributes are specified in one or more rows on the Service Bulletin tab. Figure 8-75 shows a bulletin that has been configured to match any ticket that is classified with the SDANETWORKS classification.
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    Figure 8-75   Service Bulletin for SDANETWORKS classification

    If multiple attributes are defined on the same row, they are evaluated as a logical AND. For example, if a location of DENVER was added as a location in Figure 8-75 on page 483, the bulletin applies to a service request or incident that is classified as SDANETWORKS and has a location of DENVER.

    If multiple rows exist for a service bulletin, the conditions are evaluated as a logical OR. For example, if the first row specifies an asset of EMAIL_SERVER_1 and the second row specifies an asset of EMAIL_SERVER_2, the bulletin applies to a service request or incident that has an asset of EMAIL_SERVER1 or EMAIL_SERVER_2.

     

    
      
        	
          Classifications and locations support hierarchies: If you specify a classification or location, all children of that classification or location also meet the service bulletin criteria.

        
      

    

    Triggering a message in a ticket

    If the data that a user is entering or updating on a ticket matches the criteria defined for an active service bulletin, they are alerted with a dialog indicating that a service bulletin exists. The short description of the service bulletin is displayed along with an indicator that extra details can be provided. In Figure 8-76, the user is alerted that a service bulletin exists after the Classification SDANETWORK is added to the incident.
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    Figure 8-76   Existing service bulletin alert

     

    
      
        	
          TipMultiple service bulletins: If multiple service bulletins are triggered from entering the most recent value, all newly applicable bulletins are displayed in the dialog.

        
      

    

    Extra details

    A user can view the extra details of the service bulletin by clicking the bulletin icon in the application header. Figure 8-77 shows the extra details that are provided by a bulletin message.
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    Figure 8-77   Extra bulletin message details

     

    
      
        	
          Multiple service bulletins: If multiple service bulletins apply, the full details from all applicable bulletins are displayed when you open the dialog. 

        
      

    

    8.2.9  Using configuration information for diagnosis

    Configuration Management is an important input to Incident and Problem management, and can provide information to assist in these tasks:

    •Identifying faulty equipment and root cause of failure

    •Assessing the impact of an incident and problems and their potential resolutions

    •Assessing the potential affected users

    •Identifying the correct support group

    IBM SmartCloud Control Desk has a full integration configuration management capability. For configuration management guidelines, see Chapter 5, “Configuration management” on page 227. In this scenario, the incident analyst Nancy was able to identify a workaround for the incident by identifying a secondary server. 

    During the scenario, it was identified that the reported incident was on the BILLING business application, and this must be reported against the Configuration Item field of the incident as shown in Figure 8-78.
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    Figure 8-78   Viewing CI topology from ticket

    From here, Nancy can see the CI topology of the BILLING application as shown in Figure 8-79. She can quickly identify that there are two WebLogic application servers, and test connectivity to either one to provide the workaround to direct the user to the secondary application server.
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    Figure 8-79   CI topology of the billing system

    Furthermore, you can drill down into the specific failing component by right clicking to see its topology to help identify root cause.

    8.2.10  KPIs and reporting

    Table 8-6 shows the Service Request KPIs that can be used for Service Operation installed with the optional content packages.

    Table 8-6   Service Request KPIs

    
      
        	
          KPI Name

        
        	
          KPI Description

        
      

      
        	
          PMSRLATEWO

        
        	
          Number of late work orders or work orders at risk of being late from all open service requests. See the PMSRLATE query description for definitions of “late” and “at risk of being late.”

        
      

      
        	
          PMSRAVGTI

        
        	
          Average process time per service request in hours.

        
      

      
        	
          PMSROPEN

        
        	
          Service requests that are currently in progress.

        
      

      
        	
          PMSRWAPP

        
        	
          Open service requests that have work orders that are waiting for approval.

        
      

      
        	
          PMSRURG

        
        	
          Open service requests marked Urgent Priority (internally).

        
      

      
        	
          PMSRHIGH

        
        	
          Open service requests marked High Priority (internally).

        
      

    

    Table 8-7 shows the Incident Management Request KPIs.

    Table 8-7   Incident Management KPIs

    
      
        	
          KPI Name

        
        	
          KPI Description

        
      

      
        	
          PMINCLATEA

        
        	
          Number of late activities or activities at risk of being late from all open incidents. See the PMINCLATE query description for definitions of “late” and “at risk of being late.”

        
      

      
        	
          PMINCAVGTI

        
        	
          Average process time per incident in hours.

        
      

      
        	
          PMINCOPEN

        
        	
          Incidents that are currently open.

        
      

      
        	
          PMINCWAPP

        
        	
          Open incidents that have activities that are waiting for approval.

        
      

      
        	
          PMINCURG

        
        	
          Open incidents marked Urgent Priority (internally).

        
      

      
        	
          PMINCHIGH

        
        	
          Open incidents marked High Priority (internally).

        
      

    

    Table 8-8 shows the Problem Management Request KPIs.

    Table 8-8   Problem Management KPIs

    
      
        	
          KPI Name

        
        	
          KPI Description

        
      

      
        	
          PMPRBLATEA

        
        	
          Number of late activities or activities at risk of being late from all open problems. See the PMPRBLATE query description for definitions of “late” and “at risk of being late.”

        
      

      
        	
          PMPRBAVGTI

        
        	
          Average process time per problem in hours.

        
      

      
        	
          PMPRBOPEN

        
        	
          Problems that are currently in progress.

        
      

      
        	
          PMPRBWAPP

        
        	
          Open problems that have activities that are waiting for approval.

        
      

      
        	
          PMPRBURG

        
        	
          Open problems marked Urgent Priority (internally).

        
      

      
        	
          PMPRBHIGH

        
        	
          Open problems marked High Priority (internally).

        
      

    

    For a list of available reports, see Appendix A, “Troubleshooting” on page 715.

    8.3  Configuring IBM SmartCloud Control Desk

    This section presents some examples of configuring IBM SmartCloud Control Desk to match your organizational requirements for service operation. You need administrative rights to perform most of these actions. The concepts that are shown here are applicable to all Tivoli's process automation engine applications.

    For more information about configuring IBM SmartCloud Control Desk, see the InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp

    8.3.1  Setting Indicated Priority from the Configuration Item

    Some organizations prefer to set an indicated priority that is based on the business impact of the configuration item that the ticket is reported against. This requires a different configuration of crossover domains. The domain that is used for that by default is CICROSSASSETLOC. A new domain must be created to address this change. To do that, complete the following steps:

    1.	Click Go To → System Configuration → Platform Configuration → Domains.

    2.	Create a crossover domain. This crossover domain is similar to CICROSSASSETLOC, with a new field for the priority. Create the crossover with the following fields defined in crossover domain section:

     –	Object: CI

     –	Validation where clause: cinum =:cinum

     –	Error message group: ci

     –	Error message key: NotValidCI

    Also, define the following crossover fields:

     –	AssetLocOrgID

     •	SourceField: ASSETLOCORGID

     •	DestinationField: ORGID

     •	No Overwrite: Yes

     •	Sequence: 10

     –	AssetLocSiteID

     •	SourceField: ASSETLOCSITEID

     •	DestinationField: SITEID

     •	No Overwrite: Yes

     •	Sequence: 20

     –	AssetNum

     •	SourceField: ASSETNUM

     •	DestinationField: ASSETNUM

     •	No Overwrite: Yes

     •	Sequence: 30

     –	Location

     •	SourceField: LOCATION

     •	DestinationField: LOCATION

     •	No Overwrite: Yes

     •	Sequence: 40

     –	PMCCIIMPACT

     •	SourceField: PMCCIIMPACT

     •	DestinationField: INDICATEDPRIORITY

     •	No Overwrite: Yes

     •	Sequence: 50

    The crossover fields are displayed as shown in Figure 8-80.
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    Figure 8-80   Crossing over configuration item business impact to ticket priority

    3.	Locate the domain TSDCLSSTRUCT2TK and delete the row for INDICATEDPRIORITY to deactivate the crossover from classification. 

    4.	The domain created must be changed in the Database Configuration application. To do that, go to Database Configuration and find the object TICKET. The field domain from attribute CINUM must be changed to the created domain. Repeat this step for objects SR, PROBLEM, and INCIDENT.

    5.	After that, the changes must be applied to the database. To do that, select Manage Admin Mode from the action menu.

    6.	In the Turn Admin Mode ON window, modify the values in the Number of Administrative Sessions Allowed field and the Number of Minutes for User Logout field. The default value of each field is 5. If you modify these fields, click Update Properties for the parameters to take effect.

    7.	Click Turn Admin Mode ON.

    8.	In the Electronic Signature Authentication window, enter the appropriate value in the Reason for Change field and click OK. 

    9.	A window opens that indicates that the Admin Mode is starting. Click OK.

    10.	Throughout the configuration process, click Refresh Status to view the messages that the configuration process writes in the Status window. If you decide to cancel the configuration, click Cancel Admin Mode.

    11.	From the Select Action menu, click Apply Configuration Changes to configure the database and restore backup tables. Wait until administration mode is turned on before you perform this step.

    12.	To turn off Admin Mode, from the Select Action menu, click Admin Mode → Turn Admin Mode OFF.

     

    
      
        	
          Tip: You might want to keep both crossovers to get indicated priorities from either source. You must adjust the No Overwrite flag to get it working the way that you want.

        
      

    

    8.3.2  Configuring ticket templates

    Ticket templates are used to populate values from the template into fields on a ticket to save time and increase efficiency. You create and manage templates by using the Ticket Templates application that you can open by clicking Service Desk → Ticket Templates. Templates are useful for providing a classification and specification attributes, owner, owner group, and any activities that are required to resolve the ticket.

    For other users to apply a ticket template, the template must be in an ACTIVE status, and the template class must match the ticket class. In addition, you can specify a site on a ticket template when you create it. The template is then included in the list of available templates for organizations that are associated with that site, or for templates that are not site or organization specific.

    Ticket templates are also used to support self service, service catalog, and live chat. These special use cases are covered in the following sections.

    Ticket templates for self service

    Ticket templates can be used as quick inserts and enabled in the Self Service Center. When enabled for the Self Service Center, some extra options are used to control where the template appears when navigating, and how the dialog is rendered. The dialog configuration allows a single dialog to be used with some flexibility in deciding whether to display some common fields.

    Table 8-9 shows the configuration fields that can be used when you configure a ticket template for use in the Self Service Center.

    Table 8-9   Ticket template configuration fields

    
      
        	
          Field

        
        	
          Description

        
      

      
        	
          Self Service Access

        
        	
          When selected, this field is used to denote ticket templates that appear in the Self Service Center for users to create a ticket with prefilled information. The remaining fields in this table can be configured only when this check box is selected.

        
      

      
        	
          Service Desk Template

        
        	
          This field determines how the user navigates to the template. Checking this box indicates that this template is used to solve service desk requests such as resetting a password. Templates that are marked as Service Desk Templates are found by following the Report an Issue link in the Self Service Center navigator.

           

          If this field is cleared, users can navigate to this template under the Request a New Service link in the Self Service Center navigator.

        
      

      
        	
          Show Assets

        
        	
          This displays the asset field from the service request on the dialog. This is useful in cases where the template applies to a specific asset. An example is a notebook that cannot boot.

        
      

      
        	
          Show Attachments

        
        	
          Select this option when the user must add extra attachments. This can be useful in cases where a user must attach a form, image, or similar data.

        
      

      
        	
          Show Screen Capture

        
        	
          This option enables the screen capture applet to be displayed on the Report an Issue dialog. This allows the user to take a screen capture and add it as an attachment to the request.

        
      

      
        	
          Frequent Request

        
        	
          Mark this field if the service designer wants to provide a fast path for finding this template in the Self Service Center. Users can navigate to all templates marked as Frequent Request by clicking Frequent Requests → Systemwide Frequent Requests. 

        
      

      
        	
          Image

        
        	
          Identifies the image that is associated with the template. The image is used to represent the template when navigating in the Self Service Center. It can be changed by clicking Select Action → Add/Modify Image.

        
      

    

    Complete these steps to create a ticket template for use in the Self Service Center:

    1.	Click Go To → Service Desk → Ticket Templates.

    2.	Add a template or locate an existing template. You must set the Class field to SR because only service request templates can be used in the Self Service Center.

    3.	Ensure that Catalog Offering, Service Request and Quick Inserts is selected under the This Template Will Be Used In heading.

    4.	Select Self Service Access. This check box is visible only after selecting the appropriate ticket class and template use option in step 3. Selecting this box brings up a new section called Self Service Center under the Details.

    5.	Optionally, configure the extra options defined in Table 8-9 on page 492.

    Figure 8-81 illustrates a ticket template that has been configured to be used in the Self Service center for reporting an issue about a network problem. The user can specify the asset that is having the issue, take a screen capture of any error messages, and add any attachments about the system configuration.
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    Figure 8-81   Creating a ticket template

    Figure 8-82 illustrates the resulting dialog. Note the existence of the Asset field in the dialog and the default information that has been added.
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    Figure 8-82   Report an issue

    Figure 8-83 shows the additional configuration options for attachments and screen capture in the dialog on the Attachments tab.
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    Figure 8-83   Report an issue: Attachments

     

    
      
        	
          Guideline: Use ticket templates instead of offerings when the following are true:

          •Complex fulfillment and approval processes are not needed

          •Custom dialogs and data collection are not required

          •Multiple navigation paths are not needed

          •A cart is not needed

          Because the dialogs differ slightly, some deployments use offerings and associate a template with the offering to provide some consistency.

        
      

    

     

    Ticket templates for service catalog

    Ticket templates might have been created for the fulfillment of service catalog offerings. In many cases, these templates are not as useful for service desk agents who are responding to tickets. For these cases, configure the template to be used with the catalog offering only. This removes the template from the list of those that can be applied to a service request by an agent.

    Templates that are configured to be used with offerings only cannot be used in the Self Service Center. Figure 8-84 illustrates a template that has been configured for service catalog and following the other best practices.
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    Figure 8-84   Ticket template for service catalog only

    Specifying a classification on the template that is used with an offering overwrites the classification that was part of the offering. This might remove data that were entered by a user to the specification attributes.

    When a work order is needed to fulfill a service catalog request, do not specify a job plan on the ticket template that results in an activity work order. Instead, configure the offering to create a standard work order and specify a job plan on the offering.

    Ticket templates for live chat

    Ticket templates can be configured to be used as chat topics with the live chat feature of SmartCloud Control Desk. Detailed information can be found in the next section.

    8.3.3  Configuring live chat

    The ability to chat directly with the help desk for support is becoming more prevalent across Internet sites. The chat feature allows a user to quickly get help without having to pick up a phone and in the context of where they are working. In addition, the help desk staff might be able to respond to multiple users at a single time, increasing their efficiency and productivity.

    The live chat feature provides a mechanism for user to agent communication, where previous instant messaging integrations provided a way for agent to user communication.

    Configuring chat topics

    Chat topics allow organizations to determine how best to route incoming requests and to provide default information about a new service request. SmartCloud Control Desk can be configured to route all incoming requests to a single group or to route requests based on subject matter to specialized groups. 

    Chat topics are based on specially configured ticket templates. When the user initiates a chat request, a service request is created. All of the properties of the ticket template are applied to the newly created request in the same way as applying a template to a ticket. To use a ticket template for a chat topic, it must be configured to be used with a service request, and be used only for a chat topic. The owner group of the chat topic is required and is the person group responsible for responding to the request. The person group is known as a chat queue, and is covered later in this section. 

    Figure 8-85 illustrates a ticket template configured as a chat topic. This template has a classification specified that is applied to the service request.
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    Figure 8-85   Configured chat topic

    Without configuration, a single chat topic is provided and can be used to route all incoming requests to a single group. The single chat topic is intended to provide a mechanism for a user to initiate a chat without needing to specify the purpose of the chat. This is useful when a generalized support staff handles all requests.

    There are many cases where a single chat topic does not fit the needs of the organization. In addition to request routing, allowing the user to specify the reason for the chat allows some additional data and information to be added to the newly created service request automatically without manual actions by the responder. For example, the user can provide a default classification of the request along with specification attributes.

     

    
      
        	
          Using specification attributes: Specification attributes can be used for the agent to collect some required information from the user as part of the chat session.

        
      

    

    A single chat topic can be configured by specifying the name of the topic in the system property, sccd.livechat.singlechattopictemplate. The topic is configured to be CHAT_TOPIC. If the property has no value, all active chat topics are used. For an example of a user being prompted to select a chat topic, see 9.2.8, “Chatting with an agent” on page 555. The system property can be modified by using the System Configuration → Platform Configuration → System Properties application.

    Configuring chat queues

    Chat queues are specially configured person groups whose members are responsible for handling incoming chat requests. To configure a new chat queue, a person group must be created using the person group application. The application opened by clicking Administration → Resources → Person Groups. 

    After members have been added to the group, a chat queue tab that has been added to the application needs to be configured. Both Is Chat Queue and Available to Chat must be selected to denote this group is a chat queue and to make this group available to handle incoming requests. 

    Figure 8-86 illustrates a chat queue that has been configured and is available to respond to incoming chat requests. Note that the main summary tab of the group shows the total number of active / pending requests, the availability of the agents in the group, and number of requests currently being handled by each agent.
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    Figure 8-86   Active chat queue

     

    
      
        	
          Escalate: For instances where chat topics are only available during certain scheduled hours, an escalation can be created to manage the availability of a Chat Queue by enabling / disabling the Available to Chat field.

        
      

    

    The chat queue tab on the person group application shows more information about all of the activities of this chat group. This information is contained on the extra tabs.

    Figure 8-87 illustrates the In Progress Chats tab, which shows the active chats, the corresponding service requests, and descriptions.
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    Figure 8-87   In Progress Chats tab

    The Waiting Chats tab shows the chats that are waiting for an agent response as shown in Figure 8-88.
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    Figure 8-88   Waiting Chats tab

    Lastly, the Chat Topics tab shows all of the chat topics (ticket templates) that specify this chat queue (person group) as the owner group on the topic as shown in Figure 8-89. Some of these topics might not be active.
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    Figure 8-89   Chat Topics tab

    Agent view

    An extra icon in the toolbar indicates incoming chat requests for chat agents. As users request to chat with an agent, the icon changes and flashes with the number of pending requests. To accept a chat request, the agent clicks the flashing icon. Figure 8-90 illustrates the menu bar of an agent. The top part of the image shows the menu bar with no pending requests, whereas the bottom part of the image illustrates a pending chat request.
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    Figure 8-90   Agent view with and without a pending chat request

    The agent view of the chat window contains a link to the service request that the user selected or that was created. This link allows the agent to quickly access the service request and see any previous history or details of the request. This is especially useful when the user chats about an existing request. Figure 8-91 illustrates the agent view of a chat window.
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    Figure 8-91   Chat with an agent

     

    
      
        	
          Watch out: If the agent accesses and modifies the service request, they must save their changes before closing the chat window. Otherwise, any unsaved changes are lost. Closing the chat windows triggers an event to save the chat history to the service request.

        
      

    

    Chat history

    When a chat session is completed and the agent closes the chat window, a history of the chat is saved to the communication log of the service request. If a user is chatting about an existing request, an agent can go and view any previous chat history by looking at the request. Figure 8-92 illustrates the chat history in the communication log of a service request.
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    Figure 8-92   Chat history

    8.3.4  Modifying and disabling the new service request, and new incident and new change dialogs

    In the Changes, Incidents, and Service Requests applications, a dialog enables users to quickly enter basic information when creating a change, incident, or service request, and submitting the new record. 

    Disabling or enabling the dialog

    You can configure your environment to display this dialog for each application using the system properties shown in Table 8-10. Click Go To → System Configuration → Platform Configuration → System Properties.

    Table 8-10   New dialog properties

    
      
        	
          Dialog

        
        	
          Property

        
      

      
        	
          New Service Request

        
        	
          pmsrv.servicerequest.usecreatedialog	

        
      

      
        	
          New Incident

        
        	
          pminc.incident.usecreatedialog	

        
      

      
        	
          New Change

        
        	
          pmchg.change.usecreatedialog	

        
      

    

    Adding fields to the dialogs

    You can add fields to the dialog if information can be identified up front. This example shows adding the Source field to the Service Request application. To do so, complete these steps:

    1.	Click Go To → System Configuration → Platform Configuration → Application Designer.

    2.	Locate the SR application.

    3.	Click Edit Dialogs in the toolbar.

    4.	Look for the dialog with control ID CRSREX_create_simple_sr and label Create New Service Request. Click it and a window opens.

    5.	Open the Control Palette from the toolbar and drag a text box under the email field in the dialog as shown in Figure 8-93.
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    Figure 8-93   Adding a text box to the New Service Request dialog

    6.	Open the Control Properties for the text box and set the following settings as shown in Figure 8-94:

     –	Label: Source

     –	Attribute: EXTERNALSYSTEM

     –	Lookup: VALUELIST
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    Figure 8-94   Text properties for new source field

    7.	Save the record. Figure 8-95 shows the resultant dialog with a selectable source field.
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    Figure 8-95   Modified new service request dialog

    8.3.5  Creating a workflow go button

    To allow help users to start the correct workflow quickly, create a toolbar button that directly starts the ticket into a predefined workflow. This example shows creating a button to start the service request fulfillment workflow SR_V3: Service Request Management:

    1.	Click Go To → System Configuration → Platform Configuration → Workflow Designer.

    2.	Filter the list window for Object =SR, and select any of these workflows.

    3.	Click Select Action → Edit Workflow GO buttons. This opens a a dialog similar to Figure 8-96.
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    Figure 8-96   Workflow go button dialog

    4.	Enter the following information and click OK:

     –	Process Name: SR_V3

     –	Description: Start SR_v3 workflow

     –	Toolbar Icon: nav_icon_submit.gif

     –	Active Icon: nav_icon_submit.gif

    When you open the Service Request application, you see a button in the navigation bar that launches the record into the SR_V3 workflow as shown in Figure 8-97.
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    Figure 8-97   New start SR workflow button

    8.3.6  Setting color alerts 

    To help analyst and other technical support staff identify high priority tickets quickly, it is possible to highlight them using color. To do so, complete these steps:

    1.	As a system administrator, locate the start center that you want to modify

    2.	Click the edit (pencil) icon on the result set portlet that you want to modify.

    3.	This opens the result set setup as shown in Figure 8-98 on page 512. Click the Display Options tab.

     –	Set the condition attribute to INTERNALPRIORITY.

     –	Click Add Color Alert in the Color Parameters table. Enter the following settings:

     •	Expression: Equal To

     •	Expression Value: 1

     •	Color: Red1 

     –	Click Add Color Alert in the Color Parameters table. Enter the following settings:

     •	Expression: Equal To

     •	Expression Value: 2

     •	Color: Dark Orange
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    Figure 8-98   Setting color alerting for start center result sets

    4.	Click Save. The resulting window is shown in Figure 8-99.
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    Figure 8-99   Result set portlet with color alerting

    8.3.7  Changing available Automation workflows for incident resolution

    The workflows that are displayed in the Automation tab of the incident application are filtered from all available workflows. By default, it lists incident workflows with names beginning with RBA. You can add automation workflows by creating workflows starting with RBA, or you can change the filter in the application.

    To change this filter, complete these steps:

    1.	Click Go To → System Configuration → Platform Configuration → Application Designer.

    2.	Locate the Incident application and export the application XML by clicking Export Application Definition on the toolbar as seen in Figure 8-100. Save the XML file to a location on your local computer.
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    Figure 8-100   Exporting the incident application XML

    3.	Create a backup of the exported XML file, then edit the XML using a text editor. Find the text id="inc_workflows". This brings you to the table definition that displays the available automation workflows. See Example 8-4.

    Example 8-4   Automation workflow filter in incident application
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    <table beanclass="com.ibm.ism.tsd.pminc.webclient.beans.RBAIncidentWFProcessBean" id="inc_workflows" inputmode="readonly" label="Workflows" mboname="WFPROCESS" whereclause="objectname='INCIDENT' and active=1 and PROCESSNAME like 'RBA%'">

    									<tablebody displayrowsperpage="20" filterable="true" filterexpanded="false" id="wfresults_showlist_tablebody1">

    										<tablecol dataattribute="description" id="wfresults_showlist_tablebody_33"/>

    										<tablecol dataattribute="processname" id="wfresults_showlist_tablebody_31"/>

    										<tablecol dataattribute="processrev" id="wfresults_showlist_tablebody_32"/>

    										<tablecol filterable="false" id="wfresults_col_route_2" mxevent="ROUTEWF" mxevent_desc="Start Workflow" mxevent_icon="nav_icon_route.gif" sortable="false" type="event"/>

    									</tablebody>

    								</table>
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    4.	Change the whereclause to the filter you want. For example, you might want to change the filter to display workflows based on their classification, in this case the classification RBA_IT_MGT as shown in Example 8-5.

    Example 8-5   Automated workflows by classification
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    whereclause="objectname='INCIDENT' and active=1 and classtructureid = 'RBA_IT_MGT'
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    5.	Save the XML file and import it back by clicking Import Application Definition on the toolbar of the Application Designer.

    8.3.8  Using automations scripts for field validations

    A new feature in IBM SmartCloud Control Desk is the ability to use launch points and scripting to customize the product without requiring system downtime and Java coding. Scripting allows you to accomplish these tasks:

    •Create Scripts with Object launchpoint

    •Create Scripts with Attribute launchpoint

    •Create Scripts with Action launchpoint

    •Create scripts with custom condition launchpoint

    Figure 8-101 gives a high-level overview of how scripting works.
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    Figure 8-101   How scripting works

    This is a simple example that shows the creation of an attribute launchpoint on the incident object to validate the affected by field. Assume that your requirement is to prevent incidents from being reported for more than a year in the future. Configure the launchpoint by using a script as follows:

    1.	Add an error message that will be used for the validation error message. To do this, click Go To → System Configuration → Platform Configuration → Database Configuration.

    2.	Click Select Action → Messages. The Messages window is displayed as shown in Figure 8-102.
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    Figure 8-102   Add new error message for validation

    3.	Click Go To → System Configuration → Platform Configuration → Automation Scripts.

    4.	Click Select Action → Create → Script with Attribute launchpoint. This starts a wizard that takes you through creating the script. 

    At the first window, as shown in Figure 8-103, enter the following information:

     –	Launchpoint: INAFFECTDATE

     –	Description: Validate the affected by date for incident

     –	Object: INCIDENT

     –	Attribute: AFFECTEDBY

     –	Select New to create a script, then click Next.
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    Figure 8-103   Create script with attribute launchpoint 1

    on the next window, Figure 8-104 on page 518, provide a name for the script and some variables that you will be using in the script:

     –	Script: TKVALIDATEAFFECTEDBY

     –	Description: Validate ticket affected date

     –	Add a variable affecteddate

     •	Variable Type: IN

     •	Launchpoint binding value: affecteddate

     –	Add a variable reportdate

     •	Variable Type: IN

     •	Launchpoint binding value: reportdate

    Click Next.
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    Figure 8-104   Create script with attribute launchpoint 2

    5.	Now you must enter the script as shown in Example 8-6. This example imports some Java utility classes for calculating the date. You can also use Jython or JavaScript functions to achieve the same results. 

    Example 8-6   Sample validation script
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    from psdi.util import MXApplicationException

    from java.util import Calendar

    from java.util import Date

     

    cal=Calendar.getInstance()

    cal.setTime(report)

    cal.add(Calendar.YEAR, +1)

    limit = cal.getTime()

     

    if affecteddate > limit:

    	errorgroup = 'TICKET'

    	errorkey = 'AFFECTEDDATE'
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    6.	Change the status of the script to ACTIVE.

    7.	You can add the same validation to other ticket objects by repeating step two and specifying another object such as SR or PROBLEM.

    8.	The result is that when you try to set the affected date more than 1 year in advance of the reported date, you get an error indicated by a red cross as shown in Figure 8-105.

    [image: ]

    Figure 8-105   Sample field validation error

     

    
      
        	
          Tip: For more information about automation scripting, see the IBM SmartCloud Control Desk InfoCenter at:

          http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/topic/com.ibm.mbs.doc/autoscript/c_overview.html

        
      

    

    8.4  Performing remote diagnostics using IBM SmartCloud Control Desk

    Tivoli Remote Diagnostics is an integrated feature of SmartCloud Control Desk that is based on the IBM Tivoli Remote Control version 5.1 product. If Remote Diagnostics is enabled, you can take control of a remote system identified in the Asset or Configuration Item field on a ticket record. You can then run commands and applications on that system, transfer files, and perform other tasks. Your session is automatically recorded. If enabled by an administrator, the recorded session is automatically uploaded and added as an attachment to the ticket record.

    The following example was performed on two computers running Microsoft Window 7 and Mozilla Firefox 3.6 in the same local area network.

    1.	The user’s computer must have the remote diagnostic installed. This can be installed by clicking the Download Remote Diagnostics Agent link as shown in Figure 8-22 on page 444. The link is also available from other self-service applications such as Create Service Request and View Service Request.

    2.	Figure 8-106 shows the installation process for the remote diagnostic agent. 
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    Figure 8-106   Installing the remote diagnostic agent

    3.	When asked for the server address, shown in Figure 8-107, enter the host name of your IBM SmartCloud Control Desk server and click Next.
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    Figure 8-107   Installing the remote diagnostic agent: Server address

    4.	When prompted for the remote control port, shown in Figure 8-108, in most cases you leave the detected port and click Next. If this does not work, you might need to reinstall the agent using a different port. Also, check that the port is allowed through your desktop firewall.
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    Figure 8-108   Installing the remote diagnostic agent: Remote control port

    5.	When prompted for the peer to peer mode, as shown in Figure 8-109, select Regardless of server status and click Next. 
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    Figure 8-109   Installing the remote diagnostic agent: Peer to peer mode

    Follow the instructions to complete the installation. A round icon appears in your task tray after the agent is installed.

    6.	The service desk agent can now initiate the remote session from the menu of the asset field or configuration item field as shown in Figure 8-110.
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    Figure 8-110   Initiating remote diagnostics

     

    
      
        	
          Note: Ensure that the record is saved with the Asset or CI information before starting Remote Diagnostics. If the record is not saved, an error occurs when the session recording is uploaded to the ticket.

        
      

    

    7.	A Remote Diagnostics window opens, prompting the service desk agent for the server address and port. The agent must enter the IP address of the user’s computer and the remote control port that was entered when installing the remote diagnostic agent as shown in Figure 8-111.
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    Figure 8-111   Connecting to the user’s system

    8.	The service desk agent is then prompted to log in to the user’s system. Use an admin account if this exists, or the user must provide their login details. See Figure 8-112.
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    Figure 8-112   Authenticating to the user’s system

    9.	The user receives a prompt that notifies them of the support session. To initiate the session, the user must click Accept as shown in Figure 8-113.
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    Figure 8-113   Use notification of remote session request

    10.	After the session is accepted, the Service Desk analyst can able to see the user’s desktop as shown in Figure 8-114. Some actions that the analyst can perform are on the top toolbar:

     –	Listing system information of the client computer

     –	Initiating a chat session
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    Figure 8-114   Example of a remote diagnostics session

    8.5  Conclusion

    This chapter explained the ITIL concepts of service operations, the service desk, request fulfillment, incident management, and problem management. 

    It has shown a through and integrated scenario used in examples of how your operation staff can use IBM SmartCloud Control Desk to fulfill requests faster and more efficiently.

    It has also shown some simple examples of configurations that can be done to better align and optimize IBM SmartCloud Control Desk to your organization’s operational requirements.
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Self-service

    This chapter describes the benefits of self-service, and provides information about using and configuring the Self Service Center in IBM SmartCloud Control Desk.

    This chapter includes the following sections:

    •Self-service overview

    •Self-service using IBM SmartCloud Control Desk

    •Administering the Self Service Center

    •Configuring the Self Service Center

    9.1  Self-service overview

    A service desk is designed to act as the central point of contact between the user and IT operations. However, much has changed in recent years as the service desk has developed into a fully functioning business application that not only supports users, but also handles requests from the business itself. The combination of the Internet with smartphones, tablets, and other consumer electronic devices has created a more IT-savvy user with expectations having their needs addressed immediately.

    9.1.1  Benefits

    Making available a self-service interface helps to create a more satisfied user by allowing them to perform these tasks:

    •Self-provision, and address their consumer needs immediately.

    •Self-heal, if the user experiences an issue that has been previously addressed. That issue can be referenced in a knowledge base, and the user can resolve the issue by following the documented steps.

    •Stay updated and informed on the status of their requests and issues.

    This approach can reduce the volume of calls coming into the service desk and in addition, allows the service desk to be more productive and focus their time on working on issues that affect the business. 

    9.1.2  IBM SmartCloud Control Desk capabilities

    There are a number of applications provided by IBM SmartCloud Control Desk, which provide self-service capabilities to users.

    •Self Service Center is a single application that comes pre-configured to allow self-service users to submit service requests, report issues, request services from the service catalog, view solutions, view their assets, view news, and access their recent service requests.

    Using the Self Service Center is considered best practice as it combines all of the self-service operations and service catalog functions into a single interface.

     

     

    
      
        	
          Best practice: Self Service User groups can be configured to go directly to the Self Service Center after logging in.

        
      

    

    In addition, individual applications are available for Self Service Users to perform all of the self service functions available in the Self Service Center.

    •The Create Service Request and View Service Requests applications provide simplified interfaces with minimal information for creating a service request record and viewing records that are submitted by the user.

    •The Search Solutions application provides an easy way to search for helpful answers. Using the Search Solutions application, you can search for potential solutions before submitting a service request. You can select and view details of any solution and its related attachments, such as documents or web pages.

    •The Offering Catalog, Shopping Cart, View Catalog Requests, and Cart Templates applications allow the user to request and track requests from the Service Catalog. 

    •The Self-service Global Search application provides users the ability to search across applications for records that contain specified text. You can search for one or more of the following record types at the same time: Solution, service request, offering, and catalog request.

    The Self Service Center can be configured to allow users to perform the tasks that the business supports. The other option is to use a combination of these self-service applications. 

    9.2  Self-service using IBM SmartCloud Control Desk

    The Self Service Center combines the functions of the individual self-service applications and differs from other Tivoli's process automation engine applications. 

    9.2.1  Introduction to the Self Service Center

    The Self Service Center provides a single application where the user can perform most of their self service tasks. These include reporting issues, requesting services from the service catalog, browsing solutions in the knowledge base, tracking previous requests, and viewing important information.

    To open the Self Service Center, click Go To → Self Service → Self Service Center. The Self Service Center has five primary components as can be seen in Figure 9-1.
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    Figure 9-1   The Self Service Center

    The left side of the interface is known as the navigator. From here, the users can browse the knowledge base, request new services, report issues, and run searches. The right side of the interface contains a set of pods. Pods are small portlets where the user can view information and initiate some requests. The links in the navigator and some pod functions are configurable. The entire interface is covered in greater detail in the subsequent sections. 

    The toolbar on the navigator has a set of icons that are used throughout the user session. The icon on the far left is the home button. The home button takes the user back to the starting point as shown in Figure 9-1. This can be useful to get back to a known starting point after navigating the user interface.

    There is a large text box where the user is able to enter search terms. When the search is run, the resulting list displays all of the available solutions, offerings, and ticket templates that match the user search criteria.

     

    
      
        	
          Hint and tip: The search results use a best match rating. If the user enters multiple keywords, the objects that match the most keywords are displayed at the top of the search results.

        
      

    

    The icon at the far right of the toolbar expands the navigator and hides all of the pods. This can be useful when browsing at low screen resolutions or where viewing more information about the navigator is helpful. The remaining icons for reporting an issue, view shopping cart, and cart templates are covered in subsequent sections.

    Figure 9-2 shows the navigator toolbar in detail. 
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    Figure 9-2   Navigator toolbar

    9.2.2  Browsing solutions

    The Self Service Center allows users to browse solutions in the knowledge base to get self-help in lieu of opening a ticket or calling the help desk. Only solutions that are marked for Self Service are available to users because some solutions are only suitable for service desk agents.

     

    
      
        	
          Best practice: Use the Browse Solutions capability that was introduced in SmartCloud Control Desk 7.5.1.0. In previous releases, users were required to enter search terms into a dialog to retrieve a list of solutions. Using the Browse Solutions feature to find solutions in the knowledge base provides a more consistent experience throughout the application.

        
      

    

    To find a solution, the user can browse the solution hierarchy. The hierarchy is generated from the classifications of the solutions. The left tree navigation allows the user to quickly browse the solution hierarchy as shown in Figure 9-3. 
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    Figure 9-3   Browsing for solutions

     

    
      
        	
          Hint and tip: Image icons can now be added to a classification. These images are used in place of the default folder icon when browsing to provide more meaningful information to a user.

        
      

    

    After the user finds a potential solution to their issue, they can click the solution to view the details. The user is able to see the symptoms that the solution intends to resolve to determine if they match the issue they are having. They are also able to view details of the root cause and any steps to get a resolution. If there are any attached documents, the user can access the attachment tab.

    From the top of the dialog, there are buttons for the user to email or print the solution. To close the dialog, the user responds to the question of whether the solution helped resolve the issue by clicking one of the three buttons at the bottom of the dialog.

    If the user selects that the solution helped their issue by clicking Yes, the dialog closes and a service request is created and automatically closed. If they click No - Create a Service Request, a create service request dialog is opened that allows the user to create a request. The dialog is prepopulated with some information from the solution. The last button, No - Return to Solution Search, allows the user to view another solution or adjust the search terms to retrieve a new list.

     

    
      
        	
          Tip: In the service request application, all solutions that the user has browsed are displayed in the solution tracking section. This allows the knowledge base team to judge the effectiveness of the solutions in the knowledge base.

        
      

    

    Figure 9-4 illustrates the View Solution dialog. 
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    Figure 9-4   View Solution dialog

    The user is able to share their experiences with other users by rating the solution using the Rate this solution button. This gives users an indication if the solution has worked, or some additional tips and tricks when trying to resolve a problem they are having.

    9.2.3  Requesting Services from the Service Catalog

    The Self Service Center allows users to browse the Service Catalog by clicking Request a New Service in the navigator. From here, users are able to browse the Offerings they are authorized to see. The navigation path is built based on the classifications of the Offerings. Unlike the Offering Catalog application, the user is unaware that they might be browsing multiple Catalogs. Ticket Templates (also called Quick Inserts) that are not marked for Service Desk use are also found here. However, it is not common for Ticket Templates to be used in this manner. Figure 9-5 shows the user browsing for an Offering or Ticket Template. 
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    Figure 9-5   Browsing for an Offering or Ticket Template

    After the user finds the Offering they are looking for, they can click the Offering to open the window. The dialog provides the user with information configured for the Offering. These include the date of last update, comments and rating, estimated fulfillment time, attachments, long description, estimated price, and extra details. The date of last update gives the user an indication of any updates to the Offering that were made to address user comments. 

    Figure 9-6 illustrates a dialog for requesting a new notebook. 

    [image: ]

    Figure 9-6   Ordering a new notebook dialog

    Depending on how the Offering was configured, the user can complete the required information, then add the Offering to the Cart. If the user wants to submit the request immediately, they can click Order Now. In cases where the service designer has configured the Offering so that it cannot be added to the cart, the user is presented a Submit Request button to request the Offering. 

    Figure 9-7 illustrates Offerings in the cart. 
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    Figure 9-7   Self Service Shopping Cart

     

    
      
        	
          Note: If the user chooses to keep an Offering in the cart long enough for the price defined in the price book to change, the user is presented with an error dialog indicating a new price and is shown the updated price of the Offering.

        
      

    

    Users requesting Offerings from the Service Catalog can be able to view and provide comments and ratings for an Offering. If the Offering is configured to use this function, the overall rating for the Offering is displayed at the top of the Offering dialog. The user also sees a tab that shows previous users’ comments and ratings for the Offering that are active. Comments that are inactive are not displayed on the Offering dialog. Comments can be used to provide other users information about the Offering including ordering tips and tricks, comments on fulfillment, and usefulness of the Offering. Conversely, the comments can be used to provide feedback to the service designers on ways to improve the Offering. 

    Figure 9-8 shows an example of what user comments might look like. 
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    Figure 9-8   Comments and Ratings for Offerings

    Enterprise Application Store 

    The notion of an app store continues to become more prevalent for smartphones, televisions, and set top boxes. The latest version of SmartCloud Control Desk includes an example Offering that uses Tivoli Endpoint Manager to automate software deployment. The Offering can be replicated to create an Enterprise Application Store where users can request software to be deployed to their target asset. The software can include required applications, productivity software, utilities, and any variety of software. For more information about the sample Offering, see 6.5, “Enterprise App Store scenario” on page 374. 

    Figure 9-9 illustrates what an Enterprise App Store might look like for a self service user. 
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    Figure 9-9   An Enterprise App Store example

    9.2.4  Managing and using cart templates

    A cart template serves two primary functions. First, it allows a self service user to save a set of Offerings that are ordered together frequently. For example, a template can be created for onboarding a new employee that consists of office, badge, system IDs, phone, and workstation requests. Second, cart templates differ from favorites in that data that are entered by the user are retained. Templates are useful in this case because some dialogs can require a large amount of data to be entered that is the same from request to request.

    A cart template can be created using either the Self Service Center or Shopping Cart applications. This section focuses on using the Self Service Center because it is the best approach.

    In this case, the first thing to do is to create the cart template. Select the offerings that you want to be included in the cart template and add them to the same shopping cart, as shown in Figure 9-10. 
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    Figure 9-10   Shopping cart for new employees

    Click Create Template to create the new cart template, or Update template to update an existing cart template. When creating a template, select the Offerings to be included in the template and provide a template name. The dialog to create a template can be seen in Figure 9-11.
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    Figure 9-11   Creating a cart template

    If you are updating a template, select the template to be updated and then the offerings to be included in the existing cart template. The previous template is overwritten.

     

    
      
        	
          Tip: All of the data that are entered into the Offering dialog are saved as part of the template. The service designer can restrict some fields from being saved.

        
      

    

    To view the existing templates, click the cart templates icon in the toolbar of the navigator. The templates are listed as illustrated in Figure 9-12.
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    Figure 9-12   View existing templates

    The user is able to delete a template from the dialog. Clicking a template shows the details as illustrated in Figure 9-13.
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    Figure 9-13   Template details

    Users can perform two actions with cart templates. The first action is to use the template by adding it to the cart. To add a template to the cart, open the shopping cart by clicking the cart icon. From the shopping cart, click Add Template to Cart. From the dialog, select the template that you want to add and the users that this request is for. Figure 9-14 illustrates the Add Template to Cart dialog. 
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    Figure 9-14   Add a template to a cart

    After the users are selected, click OK and the cart template is added to the submitter’s cart. In cases where required fields are excluded from the cart template, the user is alerted that information is missing. 

    The Offering with the red mark shown in Figure 9-15 is missing required information that has been excluded from the template. In this case, it was the user’s name and serial number because these change from request to request. 
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    Figure 9-15   Missing information in shopping cart

    The other operation is to create a copy of the template for one or more users. After the copy is created, the additional users are able to see and use that template. Any changes to the original template are not propagated to the copies. To create a copy of a template, click the cart template icon in the navigator toolbar and click Create Copy.

     

    
      
        	
          Guideline: Creating a copy of a template is a function that in most cases is restricted to a small set of users.

        
      

    

    9.2.5  Reporting issues

    The Self Service Center provides multiple methods for users to report issues. Reporting an issue based on a solution was covered in a previous section, and issues against a user’s assets is covered later in this chapter. The two other methods for reporting issues are using the Create Request button in the toolbar and the Report an Issue link in the navigator.

    The navigator toolbar contains a button to create a new Service Request. When this button is used, an empty Report an Issue dialog is opened with only the Reported For information field completed. Because there is no context of the issue, the user is responsible for entering all of the details. Figure 9-16 illustrates the basic Report an Issue dialog. 
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    Figure 9-16   Report an Issue dialog

     

    
      
        	
          Hint and tip: Some deployments disable the Create Service Request icon in the navigator toolbar to force users to search the knowledge base or find a quick insert. This is done to reduce the number of overall tickets or improperly classified tickets, which can increase resolution time.

        
      

    

    The most commonly used method for reporting an issue is browsing the Ticket Templates (also called Quick Inserts) and Offerings that are marked for Service Desk use. The hierarchy that the user browses is based on the classification of the object. Ticket templates that have no classification can be found at the root of the tree. Offerings are required to have a classification. The appearance of the navigation tree is the same as Requesting a New Service.

    Use ticket templates where the broader fulfillment options are not needed. They are useful for gathering some information about the user and assigning an owner or owner group for the ticket. Use offerings where more fulfillment or workflow options can be specified, custom dialogs are needed, or to provide a consistent look and feel across all dialogs. As with all Offerings, a ticket template can also be associated with the Offering to provide some initial routing for the ticket.

    Figure 9-17 illustrates reporting an issue using a Ticket Template. There are some additional specification attributes and classification pre-populated on the request.
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    Figure 9-17   Reporting an issue using a Ticket Template

    Figure 9-18 shows a sample Service Desk Offering. The user can optionally specify a priority and some additional details directly in the dialog. This is one difference between Offerings that are not marked for Service Desk use. 
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    Figure 9-18   Sample Service Desk offering

    9.2.6  Frequent requests

    The final link on the navigator, Frequent Requests, allows the user to access their frequent requests. The user can use three types of frequent requests. 

    First, the user is able to add Offerings to their frequent requests by clicking Add to Favorites on the Offering dialog. These favorites are accessed when the user first enters the Frequent Requests link.

     

    
      
        	
          Note: Favorites differ from cart templates in that the data entered by the user are not retained.

        
      

    

    Next, there is a folder named My Frequent Requests. Objects that the user has requested most frequently based on the number of requests are displayed in this folder. This allows the user to quickly navigate to Offerings or Quick Inserts that have a history of being requested.

    Lastly, the folder named System Wide Frequent Requests contains Offerings and Quick Inserts that an administrator has configured to be displayed in the favorites. This provides another easy way to access objects that are predicted to be frequently requested.

    Figure 9-19 illustrates the user first accessing Frequent Requests where two Offerings are marked as being requested frequently. 
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    Figure 9-19   Frequent requests

    9.2.7  Tracking requests

    The My Requests pod displays the five most recent service requests created for, or affected by, the logged-in user, and the status of the logged-in user's service requests. Figure 9-20 shows a sample My Requests pod. 
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    Figure 9-20   My Requests dialog

    You can click Show All My Requests to open a sortable dialog of all service requests for the user as shown in Figure 9-21. Users are able to sort or search for previous requests. The fields that are shown in the dialog are configurable. 
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    Figure 9-21   Show All My Requests dialog

    The user can click a request from the My Requests Pod or from the Show All My Requests dialog to view the details of the request. The dialog has been updated in the most recent release to show pricing information, a progress map that shows the future transitions of the request, and any pending or completed approvals. If the request was generated from an Offering, the user is able to rate the Offering and view the original dialog. 

    Figure 9-22 illustrates a service request that was recently opened and is waiting on line manager approval. 
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    Figure 9-22   View Service Request dialog

     

    
      
        	
          Guideline: The best practice is for users to work with Service Requests without the need to know when an Incident is to be used. However, there might be some business cases where users are required to view Incidents. An Incidents pod can be configured on the Self Service Center to allow users to view and track their Incidents. Currently, users cannot create an Incident from the Self Service Center.

        
      

    

    9.2.8  Chatting with an agent

    In many Internet applications, the ability to chat with a live agent is becoming more pervasive. The ability to chat provides the user with quick resolution to issues or simple questions they might have. In addition, agents have the potential to be more productive as they can handle multiple chat requests simultaneously versus a single phone call.

    A new pod has been created that provides the user the ability to view some extra information about the Service Desk. The message in this pod can be configured to provide information such as support hours, phone numbers to call, or other information. In addition, the pod can be enabled to show a Chat Now button that allows the user to initiate a chat session with an agent. Figure 9-23 illustrates the new Contact Us pod with the chat feature enabled. 
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    Figure 9-23   Contact Us pod

     

    
      
        	
          Note: Users can be authorized to only see the pod or both the pod and the Chat Now button by using signature options in their respective security group. This can be useful to only show a message with important numbers if the full chat feature is not fully enabled.

        
      

    

    After the user initiates the chat session, the system determines whether there are any logged in agents. If there are no agents available, the user is presented with a message that indicates that a chat cannot currently occur. If an agent is available, the user has three options when starting a chat, depending on system configuration. The first option is to have a general chat session configured for a single chat topic. This creates a service request and saves the chat history with the ticket. The second option is for the user to choose a chat topic if the system is configured for multiple topics. This allows the user to pick a topic and chat with a subject matter expert for the issue they are having. Like the single chat topic, this opens a new service request and saves the chat history as part of that new ticket. Lastly, the user can choose to chat about an existing request. The chat history is saved, but with the request that the user chose. Figure 9-24 shows a dialog that is configured for multiple chat topics.
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    Figure 9-24   Starting a chat and selecting a topic

     

    
      
        	
          Note: Chat topics are displayed in the dialog only if there is an agent available to handle the chat request.

        
      

    

    Figure 9-25 shows the chat interface from the user perspective. 
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    Figure 9-25   Starting a chat from the user perspective

    9.2.9  Working with assets

    The My Assets pod, which is shown in Figure 9-26, shows a list of assets for which the logged-in user is a custodian or a user. 

    [image: ]

    Figure 9-26   My Assets pod

    It allows the user to update information or report an issue for an asset, in this example TUSC1056, by submitting a service request from the detailed dialog of the asset by clicking Open a Service Request as shown in Figure 9-27. This helps your organization to maintain the accuracy of asset data. 
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    Figure 9-27   Viewing asset details

    9.2.10  My News

    The My News pod is used in the same way as the Bulletin Board. The pod shows the latest messages about critical problems and incidents, and information that is broadcast through the environment by an administrator. Figure 9-28 shows the My News pod. 
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    Figure 9-28   My News pod

    9.3  Administering the Self Service Center

    This section shows how to perform common administrative tasks for the Self Service Center.

    9.3.1  Setting the Self Service Center as a user’s default application

    You can make the Self Service Center the first page that users see when they log in to IBM SmartCloud Control Desk. This is set by security group. To do this, complete these steps:

    1.	Click Go To → Security → Security Groups.

    2.	Select the security group that you are setting the default for. 

    3.	In the Group tab, set the Default Application as SRMSSCTR as shown in Figure 9-29.
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    Figure 9-29   Setting the Self Service Center as the default application at login

     

    
      
        	
          Note: If a user is in more than one security group with different default applications sets, they are taken to the start center.

        
      

    

    9.3.2  Authorizing users for the Self Service Center

    The Self Service Center can be easily customized for different user groups. All links in the navigator, pods, and toolbar options can be individually granted to different groups of users. For example, some users might only be able to report issues using the Self Service Center, while another group is able to use the Service Catalog but not cart templates.

    9.3.3  Adding and modifying solutions

    Solutions are administered by using the Solutions application.   For more information about creating offerings, see Chapter 8, “Service Operations” on page 409. Only Solutions that are marked to be included in the Self Service Center are visible.

    9.3.4  Adding and modifying ticket templates and service offerings

    Ticket templates and service offerings can be made to display for all users in the frequent request category of the navigator by selecting a flag that is displayed in both the Ticket Templates and Offerings applications. See the details for administering quick inserts and service offering below.

    Ticket Templates

    Ticket Templates, also called Quick Inserts, are administered by using the Ticket Templates application. Ticket Templates are also used to define the topics that are used for chat. For more information about creating templates, see Chapter 8, “Service Operations” on page 409. Only Ticket Templates that are of class Service Request and marked for Self Service Access are seen in the Self Service Center.

    Service Offerings

    Service offerings are administered by using the Offerings application. For more information about creating offerings, see Chapter 6, “Service catalog management” on page 321. By default, all offerings that a user is entitled to are displayed under Request a new service in the navigator.

     

    
      
        	
          Hints and tips: Offerings that are marked as Service Desk Offering can be found under the Report an Issue link, whereas those unmarked are found in the Request a New Service link.

          An Offering that is marked as a Frequent Request shows up in the System Wide Frequent Requests folder.

        
      

    

    9.3.5  Adding bulletin board messages to My News

    The My News pod can display bulletin board messages that the user has not yet viewed. To add a bulletin board message, use the Bulletin Board application under Administration → Bulletin Board.

    9.4  Configuring the Self Service Center

    This section shows how to perform some common configuration tasks for the Self Service Center. You can configure any of these aspects of the Self Service Center application:

    •The items included in the navigator, the order in which they are displayed, and their appearance. Links can be added to display a Tivoli's process automation engine dialog, an external web page, or start another application.

    •Icons in the navigator toolbar.

    •The Contact Us pod display messages.

    •The items and behavior that are displayed in the My Requests pod.

     

    
      
        	
          Note: The dialogs that are used in the Self Service Center can be configured by using the Application Designer except for the Show All My Requests dialog. Configuration information for that dialog can be found below.

        
      

    

    9.4.1  Self Service Center configuration files

    The Self Service Center has three primary configuration files, one of which is used at run time. The first configuration file, configMaster.properties, contains the latest default configuration with all of the most recent configuration changes. Config<version>Delta.properties contains any new properties that have been added as part of that version. During an upgrade, the delta properties are merged as part of the installation process into the runtime version of the file. For fresh installs, the master configuration is used. Config.properties is the runtime version of the configuration file. 

     

    
      
        	
          Note: The Self Service Center properties files are found on the administrative workstation at this location:

          <drive>:\ibm\SMP\maximo\applications\maximo\maximouiweb\webmodule\webclient\javascript\com\ibm\ism\pmsc\dojo

        
      

    

    If you modify the Self Service Center properties file, you must then rebuild and redeploy the maximo.ear file. However, for development purpose, you can modify the copy of the file that is stored on your Java Platform, Enterprise Edition server. By doing this, you can test the changes made before final deployment. 

    For IBM WebSphere Application Server, the default location is:

    <WebSphere_folder>\AppServer\profiles\ctgAppSrv01\installedApps\ctgCell01\MAXIMO.ear\maximouiweb.war\webclient\javascript\com\ibm\ism\pmsc\dojo\config.properties

    9.4.2  Modifying the navigator

    The navigator can be modified by changing what is shown in the toolbar and the links in the Navigator. The following simple display properties can be modified in the config.properties file.

    Modifying links in the navigator

    The options that are displayed in the navigator can be changed by using the config.properties file.

    Initially, there are four items available on the navigator, which are defined inside config.properties file by linkx entries. The initial version of the file contains the tasks available is displayed in Example 9-1.

    Example 9-1   Initial link entries in config.properties
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    link0=id:BrowseSolution

    link1=id:Catalog

    link2=id:Issues

    link3=id:Favorites
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          Guideline: In the most recent release, BrowseSolution replaces the previous Solution link that was used to start the search solutions dialog. Generally, use BrowseSolution to provide a consistent user experience.

        
      

    

    To add or remove a new task, edit the config.properties file, and rebuild the EAR. Each task represents one of the actions available in the Self Service Center. The default links can be excluded if necessary, too.

    Each linkx entry represents a new task in the navigator. These are the entries that are added or removed from the config.properties file. Linkx are defined with the following syntax: 

    linkx=id:id, image:imagefile, type:linktype, target:linktarget, label:"linklabel", description:"linkdescription"

    The following items can be included in a linkx:

    •Link

    Describes the position of the task in the menu. The first one must be link0. The next tasks are defined by sequential numbers. If a number is missing, the processing stops at the last sequential number.

    •Id

    Id is a required parameter. It identifies the function that is executed by this task. It is a free entry field, except for the default values on the navigator (BrowseSolution, Solution, Issues, Catalog, and Favorites). If one of the default values is entered as the ID, type and target fields are ignored. Otherwise, this field is used only as an identifier, and the functions that are run are defined by other fields.

    •Image

    Optional parameter that defines the image that is displayed near the task on Self Service Center. If no image is defined, a default image that is associated with the type of task is used. Define the images that are used in this item in:

    <install_folder>\maximo\applications\maximo\maximouiweb\webmodule\webclient\javascrip\simplesrm\srm\dijit\images\icons

    •Type

    Optional parameter that is used to identify the type of function that is run using this task. There are four types that are available:

     –	Dialog is used to display a dialog defined in the Self Service Center presentation file, SRMSSCTR, or the library.xml file. In Application, you can the existing dialogs for the application and the dialogs available in the library.xml file.

     –	Url is used for external web pages. A Launch in Context action must be available when this type is chosen.

     –	Application is used to access SmartCloud Control Desk applications, with the option to return to Self Service Center.

     –	Script is used for user-supplied Dojo classes.

    •Target

    Optional parameter that is used to identify which function is run. This parameter is associated with the option selected in type parameter. It can define the dialog or application that is run, the URL that is accessed, or the script that is run.

    •Label or labelkey

    Optional parameter that is used to specify the name of the option that is displayed in bold in the navigator. It can be defined as a string if a label is used, or as a key in a globalization resource bundle defined in uiNavigatorStringTable.js., if labelkey is used.

    •Description or desckey

    Optional parameter that is used to show a description of the task, displayed under label. It can be defined as a string if description is used, or as a key in a globalization resource bundle that is defined in uiNavigatorStringTable.js., if desckey is used.

    For each link added to config.properties, a new signature option must be created for the Self Service Center application. The signature option name must be SHOWSSC<link_name>. 

    In the Application Designer, select the application Self Service Center (SRMSSCTR) and click Select Action → Add/Modify Signature Options. Add a signature option for each link added, using the format described. An example is displayed in Figure 9-30.
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    Figure 9-30   Signature options

    If the type used is URL, an extra signature option must be created with the same name of the launch in context ID.

    The added signature options must be authorized for each security group that needs to have access to the link created. This can be done by using the Security Groups application.

    Select the security group you want, and, in the Application tab, select Self Service Center. A check box for each signature option created is available, and to make the link visible to the user, select Grant Access.

    Sample links

    This section illustrates examples of how links can be created for each type. In these examples, the links do not specify the optional image tag.

    To create a new link to a dialog, the dialog must be available in the Self Service Center or library.xml. An example is the dialog to create a service request. This dialog is defined for the Self Service Center application. An easy way to check the available dialogs is to use Application Designer. The available dialogs for the application can be found by clicking Edit Dialogs. A list of available dialogs for this application are displayed, as shown in Figure 9-31.
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    Figure 9-31   Edit Dialogs window

    A new link must be created in the config.properties file as shown in Example 9-2.

    Example 9-2   Dialog link
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    link4=id:CREATESR, type:dialog, target:srmsscreatesr, label:Create SR, description: Create a Service Request
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    Label and description are the definitions used in the Self Service Center navigator window.

    To create an application link, a similar process is used. The difference is that the type is defined as application and target is the name of the application as shown in Example 9-3.

    Example 9-3   Application link
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    link5=id:GOTOSR, type:application, target:sr, label:Service Request Application, description:Launch Service Request Application
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    If it is necessary to create a URL link, an extra step is required. The target that is used for this type of link is a Launch in Context, which must be defined to use this link type. 

    To create a Launch in Context, access the application by clicking System Configuration → Platform Configuration → Launch In Context.

    To create a new Launch in Context, click New and complete the required fields. Define the field Target Browser window as _blank, as shown in Example 9-4.

    Example 9-4   URL link
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    link6=id:IBMSITE, type:url, target:ibmsitelaunch, label:IBM Website, description:Go to IBM Website
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    If the type is a script, the new script that is to be used in the link must be created as shown in Example 9-5.

    Example 9-5   Script link
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    link7=id:TESTSCRIPT, type=script, target:testScript, label:Dojo Script, description: Execute Dojo test script
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    For this example, both link4 and link5 are added to the config.properties file. The EAR must be rebuilt and redeployed into the server for the changes to take effect. The list of customized links in the config.properties file is defined as shown in Example 9-6.

    Example 9-6   Customized links for config.properties
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    link0=id:BrowseSolution

    link1=id:Issues

    link2=id:Catalog

    link3=id:Favorites

    link4=id:CREATESR, type:dialog, target:srmsscreatesr, label:Create SR, description: Create a Service Request

    link5=id:GOTOSR, type:application, target:sr, label:Service Request Application, description:Launch Service Request Application
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    When users who have been granted the correct access to the new links log in to the system again, the initial window looks like the one in Figure 9-32.
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    Figure 9-32   New links displayed on the home window

    Modifying the toolbar

    The toolbar in the navigator shows buttons for a shopping cart, cart templates, and creating a new service request. The buttons on the navigator top bar are enabled by default. However, there might be cases where they must be disabled. Examples of reasons might include the following:

    •Hiding the shopping cart and cart templates where Service Catalog Offerings are not used in the deployment.

    •Hiding the shopping cart and cart templates where only a single Offering can be requested and the add to cart option is removed from the dialogs.

    •Hiding the create service request button to force users to browse the solutions in the knowledge base or use the report an issue link in the navigator.

    The buttons can be hidden by using the properties that are shown in Example 9-7 by setting their values to true.

    Example 9-7   Self Service Center button and tooltip settings
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    #Hide shopping cart icon

    hidecarticon=false

     

    #Hide cart template icon

    hidecarttemplateicon=false

     

    #Hide create SR icon

    hidecreatesricon=false
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    Navigator browsing properties

    When browsing the navigator, some additional information can be displayed by the use of tooltips. Currently for Offerings and Ticket Templates, a portion of the long description text is displayed as the user is browsing. Enabling the flyover help shows more information from the long description text and is enabled by default.

    In the most recent version, tree navigation has been added when browsing solutions, requesting new services, and reporting issues. Users in the Self Service Center can toggle the tree view by clicking the folder icon when navigating. The config.properties file enables the tree view by default, but can be configured to use just the folder view. The properties are shown in Example 9-8.

    Example 9-8   Configuring the config.properties file to show only the tree view
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    #Use dojo tooltip for flyover help

    tooltip=true

     

    #Default view in Navigator: tree or folder

    navigatorView=tree
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    9.4.3  Modifying the pods

    This section addresses how to modify the appearance of the pods.

    Updating the Contact Us pod message

    The message in the Contact Us pod can be configured to show information from the help desk. This can include hours of live chat availability, important phone numbers, and any links to information. The message that is displayed in the Contact Us pod can be configured by using the Administration → Resources → Person Groups application. Inside the application, select Configure Chat Settings to configure the message in the pod. Figure 9-33 shows the configuration dialog. 
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    Figure 9-33   Configuring chat settings

    In addition, the initial message that is shown in the user chat dialog can be configured in the same dialog.

    Changing the pod auto refresh intervals

    The default refresh rate of all the pods is set to 60000 milliseconds (one minute). Example 9-9 is an excerpt from the properties file. You might want to change the settings to improve system performance. For example, as a user’s assets typically do not change every minute, you might want to set AssetsAutoRefresh=120000 or a higher value to reduce the amount of fetches for updates.

    Example 9-9   Auto refresh interval settings
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    # overview pod auto refresh intervals (msecs).

    # missing values disable auto refresh

    RequestsAutoRefresh=60000

    MessageAutoRefresh=60000

    AssetsAutoRefresh=60000
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    Configuring the My Requests pod

    The View All My Requests dialog that is started from the My Requests pod can be changed according to your organization’s needs. The changes are implemented by using the Application Designer application, which can be opened by clicking System Configuration → Platform Configuration → Application Designer.

    Using Application Designer, select the application SRMSSCTR - Self Service Center and export the presentation XML file by clicking Export Application Definition.

    To change the View All My Requests dialog, the XML file must be changed. To modify the columns that are displayed in the Self Service Center, find the tag requestspod and change it. The initial definition is displayed in Example 9-10.

    Example 9-10   Initial definition for the My Request pod
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    <requestspod columns="ticketid,status,pmsccrid,statusdate,affectedperson" id="my_requests_pod" label="ServiceRequestsPod"/>
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    In columns, the columns available in the view are displayed, and in label, the title of the section.

    After the changes are made, the XML must be reimported into the application using Import Application Definition from the Application Designer application.

    In addition to configuring the columns, the initial number of rows that are shown in the dialog can also be configured. This is useful when there are restrictive standard screen resolutions used when browsing requests. The default value is configured to match the standard supported resolution. To configure the number of rows in the View All My Requests dialog, modify the property in Example 9-11.

    Example 9-11   Changing the number of columns displayed
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    #Default number of rows in My Requests grid(table)

    MyRequestsGridRows=15
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    Configuring the number of service requests

    The default number of recent requests fetched is 500 requests. Example 9-12 shows an excerpt from the properties file. If your system has a large number of service request records, you might want to reduce this to help improve load time.

    Example 9-12   Configuring the number of service requests
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    #Default number of most recent service request records retrieved in My Requests Pod

    #MaxRequestsPodRecords=500
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    9.4.4  Changing the number of search results

    The default number of records returned by search results and recent requests fetched is 500 records. Example 9-13 shows an excerpt from the properties file. If your system has many offerings, solutions, and templates, you might want to reduce this to help improve search time.

    Example 9-13   Self Service Center search retrieval settings
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    #Max number of search results to display

    SrmNavigatorMaxResults=500
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    9.4.5  Adding a background image to Self Service Center

    To change the background image that is used in the Self Service Center, for example to add the logo of your company, complete the following steps:

    1.	Check the current background image that is used in the system. By default, the image is ge1600_background.jpg. Find all of the *maximo*.css files under <install_folder>\maximo\applications\maximo\maximouiweb\webmodule\webclient that must be changed.

    The default files that are used for SmartCloud Control Desk to change the background image for Self Service Center are in: <install_folder>\maximo\applications\maximo\maximouiweb\webmodule\webclient\javascript\simplesrm\srm\dijit\themes

    The two files that must be changed are RTLSimpleSRM_Tundra.css and SimpleSRM_Tundra.css.

    2.	Edit the css files and find the entries on this file that are related to the background image. Change them to the new image to be used as the background.

    3.	Add the background image on the directory <install_folder>\maximo\applications\maximo\maximouiweb\webmodule\webclient\javascript\simplesrm\srm\dijit\themes\images.

    4.	Rebuild the EAR and redeploy it in the server.

    5.	Restart the server.

    6.	Clear your browser cache.

    It is possible to make changes to the buttons and other background images that are used in Self Service Center. The procedure is similar. Check the images used in the application on folder <install_folder>\maximo\applications\maximo\maximouiweb\webmodule\webclient\javascript\simplesrm\srm\dijit\themes\images.

    9.4.6  Extra configuration

    The following are other changes that can be made in the config.properties file:

    •maxURL

    The URL that specifies the SmartCloud Control Desk application. If the UI host used is the same as maximo host, use /.

    •QueryTimeout

    Defines the maximum time in seconds that the system waits for the result of a query. Any value lower than 0 means that there is no time limit.

    •MyRequestsGridRows

    Defines the number of rows that are displayed in the View All My Requests dialog. The default value is 15.

    If you use many long descriptions on the offerings and tickets used by Self Service Center, and the performance is being affected, you can improve the performance by truncating the long description fields. To do that, complete the following steps:

    1.	Find the property PMSC_SSC_TRUNC_LD in the System Properties application. 

    2.	Change the value of the property to 0.

    3.	Save the record.

    4.	Select the record and click Live Refresh.

    9.5  Conclusion

    This chapter described how IBM SmartCloud Control Desk self-service applications can be used to benefit your organization. It showed how the self-service application can be configured and used to enable your users to be more self-sufficient and knowledgeable.
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Survey management

    This chapter describes the use of surveys on IBM SmartCloud Control Desk to perform customer satisfaction surveys. 

    This chapter includes the following sections:

    •Survey management overview

    •Survey management using IBM SmartCloud Control Desk

    10.1  Survey management overview

    This overview section introduces the following aspects:

    •Survey management process

    •Survey management roles

    •Survey management capabilities

    10.1.1  Survey management process

    Survey management is not a process in itself in ITIL, but it is a part of the Business relationship management process. Survey management covers one of the business relationship subprocesses, named customer satisfaction survey.

    Those surveys can be to solicit feedback about the quality of a service provided by an IT organization, and to gain a better understanding of how customers perceive the organization’s service desk customer service.

    Customer satisfaction surveys are used to gather qualitative evaluations and, with a service desk’s performance metrics, enhance management’s ability to obtain an overall representation of the service desk performance. The results of those surveys are typically used as a tool to evaluate the work of the service desk and service desk management teams. This evaluation helps to understand what can be improved to help customers have a better experience when they contact the service desk teams.

    For example, you can create surveys that assess the resolution of incidents, problems, service requests, or the fulfillment of catalog requests.

    10.1.2  Survey management roles

    The roles for survey management are defined in Table 10-1. 

    Table 10-1   Survey management roles

    
      
        	
          Role

        
        	
          Responsibility

        
      

      
        	
          Customer Satisfaction Analyst

        
        	
          The Customer Satisfaction Analyst has responsibility for running various Customer Satisfaction Surveys, reviewing, interpreting, and analyzing data derived from all forms of Customer Satisfaction Feedback. The analyst provides reports and information on Customer Satisfaction status as appropriate.

        
      

      
        	
          Customer Satisfaction Manager

        
        	
          The Customer Satisfaction Manager performs the day-to-day overall management of the process. This role ensures that all process activities are being performed, and that they are staffed adequately. The manager is responsible for creating, managing, and closing the surveys.

        
      

      
        	
          Survey users

        
        	
          Users of survey management, responsible to submit answers to survey requests.

        
      

    

    10.1.3  Survey management capabilities

    You can use Surveys application in SmartCloud Control Desk to perform these tasks:

    •Create surveys.

    •Send surveys to users, either automatically, using escalations, or manually.

    •Access surveys from service desk applications to conduct a telephone survey with users, and record survey responses.

    •Self-service users can access and take surveys at any time.

    10.2  Survey management using IBM SmartCloud Control Desk

    The administration and creation of surveys is handled by using the applications that are listed in Table 10-2.

    Table 10-2   Survey applications

    
      
        	
          Application

        
        	
          Description

        
      

      
        	
          Questions

        
        	
          In this application, the Customer Satisfaction Manager can define the questions and allowable answers for each question that is included in the surveys.

        
      

      
        	
          Surveys

        
        	
          In this application, the Customer Satisfaction Manager first defines the questions, allowable answers, and the application where this survey will be available. There are two types of surveys:

          •Tracked

          This type of survey requires that the user logs in to the system to be able to answer a survey. The Surveys application tracks who the survey is sent to, and ensures that only those users can access and complete the survey.

          •Untracked

          The user does not need to log in to access and complete the survey.

          Also, in this application, the user can find the results of a survey in case the survey is closed.

        
      

      
        	
          Survey templates

        
        	
          In this application, you can define a template to be used to future surveys. When a new template is created, it is identified with a new TemplateName, which can be chosen by the Customer Satisfaction Manager when a new Survey is created.

        
      

    

    To create a survey, the Customer Satisfaction Manager must first define the answers and question types to be used in the survey. After that, the survey itself can be created and activated, so it becomes available to be sent to users who can then start submitting their answers.

    The creation of survey templates is optional, but it can make the overall process easier when many surveys must be created.

    The next section shows how to work with surveys, create surveys, use templates, create questions, use escalations, and activate a new survey and retrieve the results from it.

    As an example, an organization wants to know how its service desk is being evaluated by the users. To do that, it is necessary to create a survey for Service Request users, with some questions about the quality of the service. Also, the organization might define that the new survey will be available to all users that had their service requests resolved in the last seven days, including some specific customers.

    10.2.1  Creating a Survey Template

    For the example, this step is optional. Use survey templates to define some common information that stay available for all surveys.

    To create a new Survey template, complete these steps:

    1.	Click Administration → Survey Management → Survey Templates.

    2.	Click New Survey Template. 

    3.	Select the values according to your needs. An example of a survey template is shown in Figure 10-1.
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    Figure 10-1   Survey template example

    4.	In the dialog shown in Figure 10-1 on page 579, you can select the following fields:

     –	Template Name

    Define the name of the new template that can be used when a new Survey is created.

     –	Header

     –	SubHeader

     –	Footer

     –	Show Image?

    Defines whether the survey has an image displayed.

     –	Image

    Defines the image to be displayed on the new survey.

    10.2.2  Creating Questions

    To create questions and the allowable answers for these questions, complete the following steps:

    1.	Click Administration → Survey Management → Questions.

    2.	Click New Question.

    The dialog shown in Figure 10-2 is displayed.
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    Figure 10-2   Question application

    3.	Complete the following fields according to your needs:

     –	Question

    Describes the question that is displayed for users.

     –	Type

    There are three options of question type:

     •	Radio

    The user can select multiple answers to a question, as shown in Figure 10-3.
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    Figure 10-3   Radio type question

     •	Checkbox

    The user can select only one answer to a question, as shown in Figure 10-4.

    [image: ]

    Figure 10-4   Checkbox type question

     •	Freeform

    The user has a text box available to provide an answer, as shown in Figure 10-5.
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    Figure 10-5   Freeform type question

     –	Site

     –	Organization

     –	Answers

    In this area, define all the answers available for this question. The number of available answers depends on the type of the question. If it is a Freeform type question, no answers are required because the user fills a text box with the answer to the question. If it is a CheckBox type question, you can define as many answers as necessary, and the user can select as many as necessary. If it is a Radio type question, you can define as many answers as necessary, but only one can be selected by the user.

    To define a new answer, click New Row and complete the following fields:

     •	Answer

    Defines the answer that is displayed for the user

     •	Weight

    The Weight field is used in the calculations for Survey reports. The Weight is a number that indicates a weight for that answer. For example, you can use the numbers 1-5 for the weight, where 1 is a very important answer, 2 is important, 3 is somewhat important, 4 is less important, and 5 is not important. Then, based on this value, the Survey Report can calculate, from all the answers that users submitted, how many users answered the important questions or how many chose other questions.

     •	Order

    Defines the order that this answer is displayed for this question.

    4.	After your question is defined, it is automatically saved as a draft. It is necessary to activate the question to include it in a survey. To do so, click Select Action → Change Status.

    An example of a finished question is shown in Figure 10-6.
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    Figure 10-6   Question example

    10.2.3  Creating a Survey

    To create a Survey, complete the following steps:

    1.	Click Administration → Survey Management → Surveys.

    2.	Click New Survey.

    3.	Select the values according to your needs. An example of a survey is shown in Figure 10-7.
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    Figure 10-7   New Survey window

    The following fields that must be defined when a new Survey is created:

     –	Survey

    Name of the new survey.

     –	Description

     –	Applies To

    Application to which the new survey applies to.

     –	TemplateID

    A new or an existing Survey Template can be applied to the survey being created. All data that are defined on the survey are is applied to the new survey.

     –	Site

     –	Organization

     –	Questions

    Questions that are defined with the Questions application, like the example in 10.2.2, “Creating Questions” on page 580, can be added to a new survey. To do so, click Select Questions and select the questions for your survey. Only active questions can be applied to a new survey.

     

    
      
        	
          Tip: Do not add too many questions to a survey unless you are required to do that. Users feel more comfortable answering short surveys.

        
      

    

     –	Escalation

    Optionally, an escalation can be created to be used with a survey when necessary. To do this, click New Row in the escalation section, then click the icon to create an escalation. For more information about escalations, see 10.2.4, “Defining escalations for survey” on page 587.

     

    
      
        	
          Important: An existing escalation cannot be associated with a survey. You must create an escalation to be used with a survey.

        
      

    

     –	TrackedURL

    This is a read-only option. It defines the URL link of the tracked survey, which is the survey that the users must log in to before they can answer it.

     –	UnTrackedURL

    This is a read-only option. It defines the URL link of the untracked survey, which is the survey that the users do not need to log in to before they can answer it.

    10.2.4  Defining escalations for survey

    Optionally, it is possible to create escalations to be used with surveys. This can be done by creating an escalation and defining the requirements that you need for it. For example, you might send a survey to all users who have had a ticket resolved in the last seven days. By using escalations, this kind of scenario can be achieved.

    An example of an escalation for the scenario is shown in Figure 10-8.
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    Figure 10-8   Sample escalation used by survey

    On this escalation, the following are the defined fields:

    •Applies To

    Defines the application that this escalation can be applied to.

    •Condition

    Defines which tickets apply to the condition defined. In this example, the condition is defined as: 

    INTERNALPRIORITY=1 AND STATUS = (select value from synonymdomain where domainid='SRSTATUS' and maxvalue='CLOSED') AND (current timestamp - STATUSDATE >=7)

    This means that all Service Request tickets resolved in the last seven days apply to this condition.

    •Schedule

    Defines the interval in which this condition is checked. In this example, every 24 hours.

    •Notifications → Role/Recipient

    Defines the users who receive the survey. In this example, this field is set to AFFECTEDBY, REPORTEDBY. 

    This means that the users that are defined in those two fields in the Service Request ticket receive the survey.

    •Notifications → Subject

    Defines the subject of the email that is sent to the user. In this example, the field is defined as 

    :CLASS :TICKETID has been closed. Please give your feedback using the link in your mail. 

    The items with a colon are replaced by the class name and the ticketid number of the Service Request to which this escalation applies to.

    •Notifications → Message

    Defines the body of the message that is sent to the user. In this example, the field is defined as 

    Report Date - :REPORTDATE  Classification - :CLASSSTRUCTURE.DESCRIPTION  Summary - :DESCRIPTION  http://localhost:7001/maximo/ui/maximo.jsp?event=loadapp&value=surveyreq&uniqueid=1&recordclass=:CLASS&recordkey=:TICKETID.

    Like in the previous bullet, items with a colon are replaced according to the information from the ticket.

    10.2.5  Activating the survey and sending it to users

    The following steps are required to activate and send a survey:

    1.	If you want to check how your survey looks, there are two options to check the survey outlook. You can use the Survey Preview tab, or click Select Action → UnTracked Survey Preview

    2.	After the steps above are completed, activate the new survey, which is initially saved in Draft state. With the survey selected, click Select Action → Change Status, and changing the status to Active.

    3.	At this point, the survey is active. There are two options to invite the users to answer it:

     –	Send the survey automatically

    This can be done by using an escalation. When an item meets the escalation requirements, the survey is automatically sent.

     –	Send the survey manually

    Select the current survey and click Select Action → Send Survey. In this option, you must select the fields that are included in a message to the user. The field message must contain the link to the survey, which can be obtained on the survey application. You must select which type of survey is sent, a trackedURL or an untrackedURL survey. Include the correct type in the message.

    An example of the options of sending surveys is displayed in Figure 10-9.
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    Figure 10-9   Send Survey window

    4.	Click Send and the survey is sent as an email to the selected users.

     

    
      
        	
          Tip: TrackedURL surveys require that the users log in to the system to answer the survey. UnTrackedURLs do not have this requirement. Consider that before you send surveys to users.

        
      

    

    10.2.6  Checking the survey results

    To be able to check the results, you must change the status of the survey to Closed. To do that, click Select Action → Change Status, and select Closed.

    After you do that, a new tab named Survey Results is displayed. This tab provides the details of the survey answers.

    An example of how the survey results are displayed is shown in Figure 10-10.
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    Figure 10-10   Survey Results tab

    When the question type has been defined as freeform, the results are displayed as a list, as shown in Figure 10-11.
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    Figure 10-11   Survey Results, freeform

     

    
      
        	
          Important: After a survey is closed, it cannot be reopened.

        
      

    

    10.2.7  Modifying user access for survey management applications

    Some changes can be made to limit access for users who handle survey management applications. Make those changes in the Security Groups application using these available options:

    •Send Survey

    Enable the option for the user to send surveys manually. This is usually available for Customer Satisfaction Analyst users.

    •Show Survey Preview tab in Survey Management

    Enable the tab that allows the user to see a preview of the survey being created. This is usually available for Customer Satisfaction Manager users.

    •Show Survey Results tab in Survey Management application

    Enable the tab that allows the user to see the results of a survey after it is closed. This is usually available for Customer Satisfaction Manager users.

    •Untracked Survey Preview

    Enable the option that allows the user to see a preview of the untracked survey. This is usually available for Customer Satisfaction Manager users.

    10.3  Conclusion

    This chapter described the use of the customer satisfaction survey process in IBM SmartCloud Control Desk, focusing on the questions, survey template, and survey applications.

    Use surveys as a way to interact with users, collecting their feedback to improve your organization’s service quality.

    Some aspects need to be considered when a new survey is created. It can be adapted for the needs of your organization, by using the untracked or tracked options, by creating the questions and answers necessary for each survey, and by using the option to send the survey manually or automatically.
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Change management

    This chapter provides information about the use and configuration of IBM SmartCloud Control Desk for Service Desk for Change Management. It presents an end-to-end scenario and information about the supporting change applications.

    This chapter includes the following sections:

    •Change management overview

    •Change management using IBM SmartCloud Control Desk

    •Supporting change applications

    11.1  Change management overview

    Change management is the practice of ensuring that all changes to information technology assets are carried out in a planned and authorized manner. Change management starts with the creation of a change request, then continues through assessment, approval, scheduling, and implementation. Finally, there is a post-implementation review.

    Typically, the scope of changes includes hardware, communications equipment and software, system software, live application software, and all documentation and procedures associated with running, supporting, and maintaining the production environment:

    •Planned changes, standard changes (pre-approved by policy), normal changes (in policy), and emergency changes (policy exception request).

    •Application and infrastructure changes.

    •Establishing both recurring and one-time only schedules (change windows) during which changes can be performed without negatively affecting projected availability or service level agreement (SLA) commitments.

    •Enforcement of standard methods and procedures from request for change through post implementation review.

    •Establishing regular meetings and communication schedules to evaluate proposed changes and schedules.

    •Control and management of the implementation of those changes that are then approved.

    •Maintenance of open channels of communications to promote smooth transition when changes take place.

    •Increased visibility and communication of changes to both business and support staff.

    Implement change management with configuration management. This helps ensure that selected components of a complete service, system, or product (the configuration) are identified and baselined as a configuration item (CI) in a Configuration Management Database (CMDB). Change management controls changes to all CIs. Conversely, the CI information in the CMDB helps change management, for example, by ensuring that the assessed impact of a change is accurate before approving and implementing the change.

    Change management can be tightly integrated with release management, which is responsible for planning, scheduling, and controlling the deployment of releases into the IT environment. A release can be deployed as a single change, or as a group of changes that are related to one another. For example, if the release includes an operating system and a middleware product, these might be deployed through two changes that take place on consecutive weekends. If the first change fails, the second change cannot happen because the release control process ties the two together into a single release, and the release cannot be only partially deployed.

    11.1.1  Change management roles

    The main roles that are involved with change management are described in Table 11-1.

    Table 11-1   Change management roles

    
      
        	
          Role

        
        	
          Description

        
      

      
        	
          Change analyst

        
        	
          The change analyst uses deep technical knowledge and subject matter expertise to understand business and technical issues and impacts of the proposed change. Analysis involves the understanding of causes and effects. The analyst uses the knowledge gained from analysis to make recommendations or resolutions.

        
      

      
        	
          Change approver

        
        	
          Responsible for reviewing and approving some aspects of the change.

        
      

      
        	
          Change implementer

        
        	
          Responsible for individual implementation steps, including building and testing.

        
      

      
        	
          Change manager

        
        	
          Primarily responsible for the definition and the overall quality of the change management process.

        
      

      
        	
          Change owner

        
        	
          The change owner is responsible for an individual change. The change owner follows the change from beginning to end, bringing in analysts and specialists as needed to complete the project. The change owner is responsible for seeing that analysts and specialists bring the change to a close. 

        
      

      
        	
          Change requester

        
        	
          The requester submits requests to the IT organization. These requests can come in the form of an incident, a service request, a request for change, a request for information, or some other type of request. 

        
      

    

    11.1.2  Change management process flow

    Change management involves the following main activities:

    •Create and record a change request 

    The activity of formulating the information about any proposed or retrospective change. The request contains a defined outline of informational sections that are established as necessary so it can be progressed into assessment and the further activities of change management. Information can vary depending upon the context, scale, and potential impact of the requested change.

    •Accept and categorize change 

    This involves the examination of the change request to determine whether it can be accepted for consideration. To accept a change request, all required information must be logged. Omitted or incomplete information can cause a change request to be returned. After initial acceptance, the change request is categorized. Categorizing consists of identifying whether the change request fits categories such as these:

     –	Standard change, which is typically pre-approved

     –	Normal change, which requires control that uses the designed, preferred change management process and procedures

     –	Exception change (such as an emergency change), which requires change management control, but under non-preferred circumstances

    Based on the categorization of the change request, ITIL recommends that different process models be followed. For instance, a standard change usually skips assessments, approvals, and scheduling, and goes directly to implementation.

    •Assess change

    In this activity, the change is analyzed to determine its effect on existing and planned CIs, and the effect on the resources required to build and deploy the change. This involves identifying the appropriate change model for handling the change, scheduling a CAB meeting if specified by the change model, and obtaining a complete set of analysis results and issues. The effect of a change is evaluated from both the IT and business perspectives. This process helps ensure that the change can be successfully implemented with a minimal impact to committed services and still meet business requirements. 

    •Schedule and authorize change 

    This activity represents a decision checkpoint against the change that is based on effect. It examines the analysis results from the assess change step and determines whether to approve the change. Scheduling involves determining the deployment approach and timing, and keeping the deployment activities within the constraints of the IT environment. Authorization represents a decision checkpoint against the change that is based on its assessed and scheduled effects on the IT environment. The result is an updated change schedule that contains details of all approved changes and their implementation dates.

    •Coordinate change implementation 

    This activity takes an approved change and coordinates its implementation. If the approved change involved creating or updating a solution, the solution components must be built first. 

    •Review and close change 

    This activity contains the tasks that are involved in reviewing all implemented changes after a predefined period has elapsed or another review trigger has been activated. It ensures that the change has had the wanted effect and met its objectives, and that the users and customers are content with the results. Conversely, it can help identify any shortcomings. The review activity determines whether the implementation plan or the back-out plan worked correctly, and whether the change was implemented on time and to cost. It determines whether any follow-up action (such as the creation of a new change request) is required. A formal close of the change is performed. The closure of a change includes updating other process areas of the status of the change.

    Change progress maps

    In IBM SmartCloud Control Desk, progress maps depict a representation of the change process flow as it is run through the workflow. Figure 11-1 shows the Advanced ITIL V3 Change Process for emergency and normal changes, which starts with a change that has been created and recorded. This helps to give the user a visual indication of the current state of the change at any point in time. 
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    Figure 11-1   Change progress map for emergency and normal changes

     

    
      
        	
          Changing the flow: There are two major decisions that might change the change management process map. Based on the selected Change Type field, the process flow steps change. Also, a particular job plan can optionally override the steps of the change process that is followed for this type of change request.

        
      

    

    Note that the authorize and schedule activity has been broken up into separate progress states, as is the case for coordinate change implementation and review and close change.

    Figure 11-2 shows the Advanced ITIL V3 Change Process for standard changes.
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    Figure 11-2   Change progress map for standard changes

    There are three different progress maps for change, one for each type of change: Emergency, normal, and standard.

    The available values for each progress map are defined in the System Properties application:

    •pmchg.progressmap.emergency.change.seq

    This property is used for the emergency change type. It contains the following default values:

     –	PMCHGACCCAT - Accepted and Categorize

    Step where the process request is approved.

     –	PMCHGASSESS - Assess

    Performed by the change owner. In this process, the accuracy of the information that is provided in the change request is verified.

     –	PMCHGSCHED - Schedule

    Individual tasks are assigned, and it is possible to define when the tasks and change request are scheduled to be concluded.

     –	PMCHGAUTH - Authorize

    Different levels of approval can be required depending on the tasks that are defined for the change request. In this step, all required tasks are authorized.

     –	PMCHGIMPL - Implement

    Change request is ready to be implemented, but the start time that is defined in the schedule is not reached yet.

     –	WOSTATUS|INPRG - Change work order in progress

    Step where the change request is implemented.

     –	WOSTATUS|COMP - Mark change work order as complete

    State where the change is completed, and available for review and test.

     –	PMCHGREVIEW - Review

    The change is reviewed and if it is correct, the change work order is closed.

     –	WOSTATUS|CLOSE - Close the Change work order

    Change work order is closed and the change request is completed.

    •pmchg.progressmap.normal.change.seq

    This property is used for the normal change type. It contains the following default values:

     –	PMCHGACCCAT - Accepted and Categorize

     –	PMCHGASSESS - Assess

     –	PMCHGSCHED - Schedule

     –	PMCHGAUTH - Authorize

     –	PMCHGIMPL - Implement

     –	WOSTATUS|INPRG - Change work order in progress

     –	WOSTATUS|COMP - Mark change work order as complete

     –	PMCHGREVIEW - Review

     –	WOSTATUS|CLOSE - Close the Change work order

    •pmchg.progressmap.standard.change.seq

    This property is used for the standard change type. It contains the following default values:

     –	PMCHGACCCAT - Accepted and Categorize

     –	PMCHGIMPL - Implement

     –	WOSTATUS|INPRG - Change work order in progress

     –	WOSTATUS|COMP - Mark change work order as complete

     –	WOSTATUS|CLOSE - Close the Change work order

    Progress maps and job plans

    The progress maps can be altered by a jobplan. Based on the available status that is defined on the domain, a custom progress map can be created.

    To apply a custom progress map using a jobplan, select the jobplan you want, and click the detail menu for Progress Map Sequence. Then, select the change domain. A list of possible values for the progress map is displayed as shown in Figure 11-3.
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    Figure 11-3   Progress map options

    Select the options you want and the sequence that is used by the progress map in the Modified Sequence section. The Progress Map Sequence field defines the order in which the options are displayed on the map, starting from the lowest to the highest values. 

    An example of a custom progress map is shown in Figure 11-4.
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    Figure 11-4   Custom progress map sequence

    When the new jobplan is applied to a change request, the progress map that is displayed is the map defined for the jobplan. An example is shown in Figure 11-5.
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    Figure 11-5   New progress map

    11.2  Change management using IBM SmartCloud Control Desk

    The end-to-end scenario in this section demonstrates some key features in the use of IBM SmartCloud Control Desk for change management. The examples are based on the optional contents package.

    11.2.1  Request for change, change acceptance, and categorization

    A request for change in IBM SmartCloud Control Desk is captured in a process request record. The process request allows for the recording of a request from a user who does not necessarily know all the technical details that are required to create change.

    Alternatively, some organizations find the use of a separate record type unnecessary because an unapproved change work order can also be considered a request for change. These organizations might want to simplify the change process by not using the process request object in some or all situations. Choose the strategy that best meets your organizational needs.

    Consider whether to use process requests as shown in the following scenario.

    James Ponder is a DBA responsible for adding a database to an existing DB2 instance that supports the billing business application. He knows that the DB2 instance is configured to host only the actual number of active databases. In preparation for the addition of a new database, James must request that the value of the NUMDB instance configuration parameter for the instance is increased by 1. The following paragraphs describe different circumstances that might hold true:

    1.	James has not been given access to the IBM SmartCloud Control Desk system. Therefore, he needs to request support from his business representative, Steve O’Hara, who does have access to the system to request the change for him. Steve, however, does not have any enough technical knowledge about the change, and therefore benefits from being able to raise a simple request for change using a process request.

    2.	James has not been given access to the IBM SmartCloud Control Desk. He is, however, able to call the service desk and ask them to log a request on his behalf. The service desk can capture this request for change in the service request ticket that is logged for the call. The service request can be used to create a change record for recording the change request and for acceptance. Or, a process request can be generated on behalf of James by the service desk. This situation, however, places a burden on the service desk to process such requests for change, which is typically not in the scope of a service desk. It also assumes that your service desk has the appropriate access.

    3.	James has access to the IBM SmartCloud Control Desk system. Self-service offerings have been created in his organization so that he can request a change. The self-service offering lets him generate a service request for fulfillment, and also automatically creates the change record. This record can be pre-approved, or it can have to go to the appropriate workgroup for acceptance. You do not use a process request in this situation because the service catalog only allows creating a work order or change orders.

    4.	James has access to the IBM SmartCloud Control Desk system and is adding a database to the DB2 instance as the result of an incident or problem. He can create the change by directly linking to the incident or the problem, or he can create a process request for the change.

    Using a process request

    This example shows the use of a process request in logging a request for change using the circumstance 1 on page 602 from the scenario.

    1.	Having received a request from James about the required change, Steve logs in to the IBM SmartCloud Control Desk system. He is presented with the Process Management Requester start center shown in Figure 11-6.
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    Figure 11-6   Process Management Requester start center

    2.	Steve clicks the New Process Request link in the Quick Insert portlet. This takes him to the process request application as shown in Figure 11-7 on page 604. He enters the following information:

     –	Description: Increase the number of active databases for the billing application.

     –	Details: To support the addition of an extra database in the billing application, the NUMDB db2 instance configuration parameter must be increased by 1.

     –	Required Completion: Steve enters a date 2 weeks in advance.

     –	Impact: 2 - High

     –	Urgency: 2 - High

     –	Priority: 2 - High

     –	Process Manager Type: Change

     –	Configuration Item: DB2 INSTANCE ~69242

     

    
      
        	
          Tip: This field can be left blank if unknown.
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    Figure 11-7   New process request

    3.	Steve then clicks Submit in the navigation toolbar to initiate the request for change. The process state of the record changes to SUBMITTED, and the status of the request changes to QUEUED.

    Steve has now completed the creation of the change request. The request now must be reviewed by a change manager, Franklin.

    4.	The workflow that is used for the change approval starts, and the first step is the change manager approval. Franklin accesses the process request, and, on the process request record, clicks Accept on the toolbar. This step creates a new change work order, which handles the changes for the request that was submitted by Steve.

    5.	After the process request is approved, Franklin has a chance to review the new change work order created as shown in Figure 11-8.
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    Figure 11-8   Reviewing the work order

    Franklin can choose if he wants to review and make any changes to the change work order, or continue to the process request record. In this scenario, Franklin selects the first option and clicks OK.

    6.	The change work order is created now, and is displayed for the user as shown in Figure 11-9.
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    Figure 11-9   New change work order created

    Creating a change directly

    A change record that is not yet assessed and approved can also be considered a change request, depending on your organizational policies. The next steps show how to create a change directly.

    In the problem management example in Figure 8-68 on page 478, a change was created by Nancy from the problem management workflow. She can do this manually by clicking Select Action → Create → Change, or, she can navigate to the change application and added a record. In this latter case, the New Change dialog is displayed as shown in Figure 11-10.
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    Figure 11-10   New change: Quick Insert

    The New Change dialog has the following fields:

    •Change

    The identifier defined for the new change request.

    •Summary

    Description of the change request.

    •Details

    Detailed description of the expected change to be made.

    •Change Type

    Defines the type of change that is created. This can be emergency, normal, or standard. 

    •Take ownership?

    Select this check box if the user who is creating the change request is responsible for resolving the request.

    •Start Change process workflow?

    Select this check box if the change workflow should be initiated when the new change request is created. 

    After you specify the information that you want to supply in this dialog and click OK, the new change record is saved. The change is then displayed in the change tab. You can now supply more information for the change, or you can return to the change and supply the information later.

    To alter the workflow, check the Start Change process workflow box to start the workflow for the submission of the simple change dialog. If the box is selected, the record by default starts in the PMCHGFIXD1 (express Change) workflow. You can change the workflow that is started by altering the system property pmchg.process.workflow in the Go To → System Configuration → Platform Configuration → System Properties application.

     

    
      
        	
          Changing appearances: You can modify the simple change dialog to resemble the new incident and service request dialog. For more information, see 8.3.4, “Modifying and disabling the new service request, and new incident and new change dialogs” on page 505.

        
      

    

    No matter how a change is requested, an accepted change should result in a change record with an ACC_CAT status ready to be categorized.

    Accepting the change for processing

    No matter if the change is created by using a process request or not, change manager Franklin can now pick up changes in the WAPPR status to accept further processing. If the workflow was started by the change requester, the status of change is not WAPPR. For this scenario, assume that the change requester did not start the change workflow.

    Franklin can navigate to the Changes application and query for WAPPR changes as shown in Figure 11-11.
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    Figure 11-11   Querying for WAPPR changes

    When you locate the change record created from the process request, you see that all the relevant information from the process request has been copied to the change work order. 

    At this point, you are still preparing the Change work order. Note that the change has not progressed in the status flow, as shown in Figure 11-12 on page 610.

    Franklin can cancel or reject the change request, effectively rejecting the request for change by changing its status.

    [image: ]

    Figure 11-12   Rejecting a change that is waiting for approval

    Or, to accept and categorize the change for processing, Franklin starts the change record in the PMCHGMAIN1: Advanced ITIL V3 Change Process by completing these steps:

    1.	Before starting the workflow, review the information about the change. A change type and classification are required for the workflow processing:

     –	Change Type. The system defaults this value to NORMAL. The change type field determines a number of pre-set values, such as job plan, necessary assessment, and approvers by applying a response plan to the Change. Change this setting at this stage to reflect if the change is a standard or emergency change. Leave the change type as NORMAL for this scenario.

     –	Impact and Urgency. These settings help to determine other calculations and need to be set as appropriate. They default to 3: Medium and 4: Low respectively.

     –	Priority. The priority of the change is copied from the process request.

     –	Failure Probability. This represents an assessment of the probability that the change implementation will fail. At this stage, this is likely not known. It defaults to a value of 2: Medium.

     

    
      
        	
          Tip: You can change the default values for the impact, urgency, and failure probability by using the Go To → System Configuration → Platform Configuration → Database Configuration application. Locate the WOCHANGE object and alter the attributes PMCOMIMPACT, PMCOMURGENCY, and PMCHGPROBABILITYFAILURE.

        
      

    

    2.	To start the Change workflow, either route the workflow and select the PMCHGMAIN1 process, or click the workflow go button that has been added to the navigation toolbar. See Figure 11-13. For information about how to add/modify workflow buttons, see 8.3.5, “Creating a workflow go button” on page 509.

    [image: ]

    Figure 11-13   Advanced change status workflow button

    The workflow automatically makes the following calculations:

     –	A Priority based on the Impact and Urgency field values, if provided. It does not overwrite any priority value already given.

     –	Risk for the change based on the provided Impact and Failure Probability field values.

    In addition, the workflow applies a response plan that is related to the Change type. This plan provides the defaults for the job schedule, assessments, and required approvals so that you do not have to enter this information every time a change is created. Response plans are selected based on the matching of predefined conditions on the change. For more information about response plans, see “Using Response Plans” on page 456.

     

     

    
      
        	
          Tip: The three response plans provided for the change types are PMCHGSTAND (standard), PMCHGEMERG (emergency), and PMCHGNORML (normal). You can alter these response plans from the Go To → Service Level → Response Plans application for your organizational needs.

        
      

    

    3.	You also must specify an owner for the change. The change owner is responsible for taking the change through its various stages. To specify an owner, click Select Owner from the toolbar or the frequent tasks section of the navigation frame. Set the owner to be the PMCHGOWN group.

    4.	Route the workflow when this is done. The Change is set to ASSESS in status and in the process map, and a new assignment is added to the specified owner group to perform their preliminary assessment as shown in Figure 11-14.

    [image: ]

    Figure 11-14   Change record in accept and categorize

    At this stage, the change manager Franklin has accepted the request and assigned it to the PMCHGOWN as the owner group of the change.

    Specifying the Change work order

    Now, look at the request from the Lucy, the Change Owner’s perspective. The change owner follows the change from beginning to end, bringing in analysts, subject matter experts, approvers, and implementers as needed to complete the change.

    On logging in to the IBM SmartCloud Control Desk, Lucy sees an assignment in her workflow inbox for the change that has been assigned to her group as shown in Figure 11-15.
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    Figure 11-15   Change owner start center

    To indicate that she is taking ownership of the change record, she clicks the link in her inbox that takes her to the change record. From here, she can take ownership of the record by clicking Take Ownership in the navigation toolbar.

    As the change owner, Lucy needs to review the change for correctness and update it so that it is ready authorization. This involves these steps:

    •Reviewing the Change specification

    •Reviewing the Change schedule

    •Reviewing the Change assessment requirements

    •Reviewing the Change authorization requirements

    Reviewing the change specification

    In addition to reviewing the information that is already on the change for correctness, Lucy must complete these steps as well: 

    1.	Provide the correct Change Category. The change category might be major, minor, significant, or any value that consistent with organization’s change policy. The change type is used along with the change category to determine how the change is processed. For this example, set the change category to minor.

    2.	Provide the correct CI to the change. The change owner might need to consult with a subject matter expert. In this case, the CI is updated to be AVALANCHE.LAB.COLLATION.NET:DB2INST1~2740 and the outage field is set to offline, assuming that the database must be restarted after changing the property. See Figure 11-16.
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    Figure 11-16   Target CI details for change

    Reviewing the change schedule

    For this example, the response plan applied for a normal change is generic ready for use, and only contains a single generic task: Implement the Change, as shown in Figure 11-17.
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    Figure 11-17   Implemented changes

     

    
      
        	
          Remember: Tasks flagged as Implementation Tasks are the ones that actually modify the target CI. These tasks are the only ones that are scheduled for execution within Change windows that apply to the target CI.

        
      

    

    Lucy also adds two tasks to the job plan, one to check prerequisites and one to validate the change implementation. In a real life situation, these tasks are usually performed by different owner groups. To simplify the scenario, assume that they are both performed by the PMCHGIMP group. To do so, complete these steps:

    1.	Click the Schedule tab and look in the Tasks for Change section.

    2.	Use New Task to create two tasks with the following details:

     –	Task ID: 5

     •	Sequence: 5

     •	Description: Verify prerequisites

     •	Under Flow Control: Selected

     •	Owner Group: PMCHGIMP

     •	Implementation Task: Cleared

     •	Estimated Duration: 1:00

     –	Task ID: 15

     •	Sequence: 15

     •	Description: Validate change implementation

     •	Under Flow Control: Selected

     •	Owner Group: PMCHGIMP

     •	Implementation Task: Cleared

     •	Estimated Duration: 1:00

    3.	Update the predecessors for each task under scheduling information such that the implementation task is dependent on task 5, and the validation task is dependent on the implementation task (Figure 11-18).
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    Figure 11-18   Setting task predecessors

     

    
      
        	
          Note: The predecessor relationships only apply when Under Flow Control is selected. The system uses these relationships to automate the flow of status changes between the work order and its tasks. When a task is completed, the next task in the flow is initiated.

        
      

    

    Lucy has now completed the initial plans for the change. Change analysts will validate the plans and estimates, and update the change as it progresses through the next stages.

    Reviewing the change assessment requirements

    Default assessment requirements are defined in the job plan that is applied by the response plan matching the change. Reviewing and verifying these requirements is the responsibility of the change owner. 

    There are two types of assessments: Business and technical. To specify which assessments are needed for this change, Lucy completes the following steps:

    1.	Click the Assessments tab and see which assessments were added by the response plan. 

    2.	Delete or add any assessments that might be required for the change. For this example, OS and Network technical assessments are not required, and SOX and Financial business assessments are also not required as shown in Figure 11-19.

    After Lucy indicates that her preliminary assessment activities are complete, the system automatically notifies the assessment groups that of that their input is needed.
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    Figure 11-19   Technical and business assessments

    Reviewing the change authorization requirements

    Next, the approval requirements for the change must be assessed. The change owner must do this in the Authorization tab of the change. Default change authorizations also come from the job plan that was attached to this change by the response plan. When the change records reach the authorization stage, approval requests are sent to the specified approvers.

    When you are specifying approvals, these characteristics apply:

    •They can be specified as either a group or and individual. If a group is specified by default, anyone from the group can approve.

    •They have a level. The more complex the change, the greater the impact to the business, which typically requires a higher level of approval. By default there are three levels of approval as shown in Figure 11-20.

    •They are tied to the risk of the change. A risk value of 1 requires level 1 approval, a risk value of 2 requires a level 2 approval, and so on. A risk value of 5 or no risk value requires the user to select the required approval level.

    •An approval from the highest level progresses the change

    There is no need to change the default approvals for this example.
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    Figure 11-20   Change approval levels

     

    
      
        	
          Tip: The approval rules are configurable. They are primarily contained within the PMCHGAUTH1 workflow. You might want to revise this workflow to match the approval flow based on your organization’s requirements.

        
      

    

    After she reviews the specification of the change. Lucy clicks her current workflow assignment and indicates that the change is fully specified and that preliminary assessment is completed as shown in Figure 11-21. This action creates task assignments for the required technical and business assessment owners.
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    Figure 11-21   Completing the preliminary assessment

    11.2.2  Providing change assessments and implementation tasks

    In our example Lucy defined both technical and business assessments for the change, and the same change analyst group was used for all assessments. In real life, each different technical assessment required is typically assigned to a different subject matter expert group and similarly the business assessments.

    Technical assessments are intended to provide technical risk analysis and recommendations to modify the change schedule to minimize outages and other adverse effects that are related to the change implementation. Some organizations also use the technical assessment to validate back-out plans for the change. 

    Business assessments provide a similar avenue from business stakeholders of the potential impacts of the change and their associated effort and cost. Business assessments will be assigned after the completion of all technical assessments.

    Nancy is a change analyst in the group that was assigned to perform the assessments. When Nancy logs in to IBM SmartCloud Control Desk, she can select from a list of assessment activities that have been assigned to her based on her job profile:

    1.	The first thing Nancy does as a change analyst is to review the details of the change, including which assessments they are assigned to complete. She is able to add any assessment rows that she thinks are required.

    2.	Next, Nancy completes her assessments with the following information where applicable (Figure 11-22):

     –	Results.

     –	Implementation notes. The assessor can suggest changes to the implementation plan, but should not manually alter the change plans.

     –	Cost.

     –	Effort.

     –	Assessor. If the assessment is assigned to a group, use this field to indicate who will complete the assessment.
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    Figure 11-22   Technical assessment example

    3.	Nancy finds her assignment in the Current Workflow Assignment section. and clicks the link to complete her assignment as shown in Figure 11-23.
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    Figure 11-23   Completing assessment task

    Nancy must complete all the other technical and business assessments for the example to progress the change, following the same steps as above.

    4.	When all the assessments are complete, the change is returned to the Change Owner, Lucy, to review the completed assessments. In this example, Nancy added an implementation note about capacity monitoring. Lucy considers this and chooses to add a task to update the monitoring rules in their monitoring software to the implementation plan for this change.

    Add a task to the tasks for change with the following information:

     –	Task ID: 20

     •	Sequence: 10

     •	Description: Update monitoring rules

     •	Under Flow Control: Selected

     •	Owner Group: PMCHGIMP

     •	Implementation Task: Cleared

     •	Estimated Duration: 0:30

     •	Predecessors: 10

    5.	Update the verification task (task 15) with task 20 as a predecessor, such that verification of the change happens after the monitoring rules are updated.

    6.	Complete the assignment to indicate that all implementation tasks are created. The workflow begins an impact calculation for the change based on the new task plan, and also recalculates the risk of the change. Messages are displayed to notify you of the recalculations as shown in Figure 11-24.
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    Figure 11-24   Impact calculation result

    The impact calculation is based on the information that is available in the CMDB. Click the Impacts tab to see the results of the calculation. Both a list of impacted CIs and a topology view of the CIs can be seen as shown in Figure 11-25. 
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    Figure 11-25   Example impact calculation topology view

    The impact analysis engine can be configured with a number of parameters. For more information, see 11.3.4, “Impact analysis configuration” on page 640.

     

    
      
        	
          Note: When you view the topology, you can specify the detailed view or the business view. The detailed view shows all related CIs of all types. The business view shows a subset of all CI types based on whether the associated CI classification has Show in business view selected. By default, CI types such as application servers and services are displayed in the business view.

          Change this by using the Go To → Administration → Classifications application or the Deployer’s Workbench to modify the CI type information.

        
      

    

    The change is now fully assessed and the change moves into the schedule stage.

    11.2.3  Scheduling the change

    The change starts in the scheduling change with an assignment to the Change Owner as shown in Figure 11-26.
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    Figure 11-26   Change in scheduling stage

    Scheduling the change involves figuring out when the change can be implemented to meet the requirements of the requester while observing the availability policies. IBM SmartCloud Control Desk provides an automated scheduler application to help with scheduling the implementation tasks.

    The scheduler application takes the following into account (if defined):

    •Blackout periods

    •Change windows

    •Predecessors for tasks

    •Estimated duration of tasks

    •Task owners work shifts 

    To schedule the change, complete these steps:

    1.	Click the Schedule tab in the change. In the schedule section, complete the dates as appropriate:

     –	Target Start 

     –	Target Finish

     –	Start No Earlier Than

     –	Start No Later Than

    These constraints are considered in the project schedule. 

    2.	From the Scheduler Project field, click the detail menu and choose select a Project Schedule as shown in Figure 11-27. 
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    Figure 11-27   Creating a project schedule from change

    This takes you to the Scheduler application and automatically brings in the tasks from the change for scheduling. See Figure 11-28.
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    Figure 11-28   Scheduling a change

    Release management also shares the use of the scheduler application for scheduling releases. For more information about use of the scheduler, see “Scheduling release implementation” on page 678.

    3.	After you are finished with the schedule and commit the changes, click Return With Value in the navigation bar. You now have the scheduled start and finish dates and the scheduler project fields completed. Also, schedule all your implementation tasks. Complete the current workflow assignment to indicate that scheduling is complete and progress the record in the flow. 

    4.	The workflow runs a check for schedule conflicts. If you deliberately turned off some constraints, or if new conflicts are detected since your scheduling, a task is assigned back to the change owner to rectify the conflicts. You can see the conflicts on the schedule tab as shown in Figure 11-29.
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    Figure 11-29   Change in schedule conflicts detection

    5.	You can return to the scheduler application to resolve the conflicts. After you do so, click Update Conflicts in the schedule conflicts section to recalculate the conflicts.

    6.	The workflow keeps looping until you resolve all schedule conflicts. You can, however, manually indicate to proceed with conflicts. See Figure 11-30.
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    Figure 11-30   Skipping schedule conflict detection

    7.	If you choose to proceed without resolving schedule conflicts, the system checks whether any approvers are associated with the conflicting constraints add them to the Schedule Approvers for Change section in the Authorization tab. See Figure 11-31.
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    Figure 11-31   Schedule approvers

    The system checks for blackout period approvers and change window approvers for the target CIs and any impacted CIs.

    8.	The change owner must review the schedule approvers. Approvals are then sent out to the schedule approvers to ensure that they are aware of and approval of the conflict. The change cannot proceed without all schedule approvals. Any rejections result in the change owner having to reschedule the change. 

    It is also possible to add schedule approvals if you so require. For example, if you wanted the change coordinator to review the schedule before it goes for CAB authorization, you can add it here before or during the review of schedule approvers.

    The completion of any schedule approvals completes the scheduling stage. The change then enters the authorization stage.

    11.2.4  Change authorization

    The authorization phase is intended to give all the stakeholders an opportunity to review the change and either approve or disapprove its continuation.

    In the example change, the change owner Lucy proceeded with the default levels of authorization specified, which are CAB, IT Management Board, and Business Executive Board.

    To get authorization, complete these steps:

    1.	When Lucy routes the change for approval after completing assessments, the required Change Authority Level is calculated based on risk value of the change. See Figure 11-32.
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    Figure 11-32   Change authority level

    2.	The risk value for this change is 2 and so a change authority level of 2 is required. In this example, the job plan attached to the change determines that the IT Management Board is required to approve a change that requires authority level 2. The system sends out approval assignments to the IT Management Board.

    3.	Jane is part of the IT Management Board. When she logs in to IBM SmartCloud Control Desk, she sees an inbox assignment notifying her of the approval request. When she clicks to complete the workflow for the assignment, Jane is presented with the option to approve or reject the change as shown in Figure 11-33.
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    Figure 11-33   Change authorization, approve or reject

    On approval, the Authorization Decision is updated to Approved on the Authorization tab and the change status is set to the ready to implement (IMPL) state. The progress map shows the change in the IMPL phase, which indicates that it is ready for implementation with no current workflow assignments (Figure 11-34). 
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    Figure 11-34   Progress map showing a change ready for implementation

    11.2.5  Change implementation

    The change remains in IMPL state until the scheduled start time of the implementation tasks. When the start time is reached, IBM SmartCloud Control Desk automatically changes the status and progress of the change to INPRG (In progress) and starts the first implementation task. 

    The progress map looks like Figure 11-35.
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    Figure 11-35   Progress map for in progress change

    In IBM SmartCloud Control Desk, change tasks and assignments are treated a bit differently. Assignments are communicated through the workflow Inbox, whereas tasks assigned to a user show up in the My Work portlet in the Start Center.

    To implement the change, complete the following steps:

    1.	Log in to the systems as Schroeder. A My Work portlet with the change tasks that require action is displayed as shown in Figure 11-36.
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    Figure 11-36   My Work with change tasks ready for implementation

    2.	To work with the task, click the link from the My Work portlet. This opens the task in the Activities and Tasks application that displays the details of the task to be performed to the user.

    3.	The task is completed when the user Schroeder changes the status of the task to Completed. You can do this by clicking Complete Activity on the toolbar or by using the change status dialog. See Figure 11-37.
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    Figure 11-37   Completing a task

    After completing this task, the user continues with the next task. When all tasks are completed, the progress status of the change automatically changes to COMP (completed). With this, the overall process is assigned back to the change owner to verify the CMDB updates. See Figure 11-38.
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    Figure 11-38   Completed change implementation process flow

     

    
      
        	
          Note: The change application also has a new Workplan Map tab that provides a graphical view of the tasks, their status, dependencies, and sequence. For more information, see “Workplan Map” on page 667.

        
      

    

    11.2.6  Bringing the change to closure

    From completion of the implementation, the Change Owner must make sure that any changes that were implemented are recorded in the CMDB. The change must then be reviewed before it is closed out.

    Verifying CMDB updates

    Updating CI information in the CMDB is the responsibility of the Configuration Management process. 

    If you find discrepancies between the Change specifications and the CI attribute information in the database, the Change Owner, must submit a CI Update request for the current Change so the Configuration Librarian can perform updates to the database.

    To initiate a CI update request from the change, click Select Action → Create → Process Request. This brings you to the process request application, where you specify the process manager type as Configuration. This request then goes to the configuration librarians who review it and perform the CI update.

    For this example, there is no need to update the CMDB. Log in as Lucy and route the workflow to complete the verification assignment. This moves the change to REVIEW status as shown in Figure 11-39.
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    Figure 11-39   Change for review progress map

     

    
      
        	
          Tip: Some organizations prefer to route the assignment of verifying the CMDB updates directly to a configuration librarian group. This can be done either through workflow, or by creating a task in the job plan (as a non-implementation task) to avoid the use of process requests. This integrates the CI Update tightly with the Change process, and relieves some of the burden on the Change Owner by moving it to the Configuration Librarian.

        
      

    

    Reviewing the change

    The purpose of the final review is to allow the change owner a chance to probe the stakeholders for their satisfaction. This review is of the whole change. 

    If the change has not met requirements, this effectively ends the change process. The change is set to a status of FAILFPIR: Failed Post Implementation Review, which is a final status. The change owner is presented with options to follow up as shown in Figure 11-40. Note that there is no progress map node for a failed change.
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    Figure 11-40   Follow up options for change failing post implementation review

    For this example, assume that the change met stakeholder requirements. Lucy completes the review assignment and indicates change success. This changes the status of the change to CLOSE, which is a final status and the end of the progress map as shown in Figure 11-41.
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    Figure 11-41   Progress map for closed change

    If the change was created by using a process request, the originating process request is automatically changed to CLOSED.

     

    
      
        	
          Tip: In addition to the Advanced ITIL workflow, the optional content packages also include simplified ITIL workflows that are less complicated, but provide significantly less automation and assisted processing. When you implement change management, you might want to start with a simplified workflow to familiarize users with the tool and process before you implement more advanced automation and assistance to optimize operation. Check out the other simple workflow provided:

          •PMCHGFIXD1: Change ITIL Process - wizard flow. This is the default flow that is initiated by the new change dialog. It operates like a wizard, guiding the Change through a series of steps to the completion of the process. It ensures that all steps are completed in a certain order. 

          •PMCHGPRFL: Change ITIL Process - Full - Wizard Flow. An alternate wizard workflow with no scheduling.

          •PMCHGFLEX1: Change ITIL Process - short flows. This express workflow completes only the steps for the current phase, updates the status, and exits. The user clicks the workflow icon again to start the next step in the process. This workflow is flexible. You can change the status to an earlier phase in the process and redo that earlier phase.

        
      

    

    11.2.7  Standard and emergency changes

    The change workflow considers the change type.

    An emergency Change is one that must be done immediately. It is high priority. An example of an emergency Change is the installation of new antivirus software during a period of severe viral infestation across the data center. Emergency Changes are ones that are typically not performed often. An emergency Change contains all of the process steps that are followed for a normal change. However, some of the steps might be abbreviated and occur more quickly. For example, you might specify fewer assessments or approvals, or elect not to seek approvals for scheduling conflicts. In the advanced ITIL workflow, the scheduling of emergency changes is skipped.

    Standard Changes are relatively low-risk and well understood. Standard Changes are ones that you process frequently, such as installing a Java Platform, Enterprise Edition application or implementing a database, middleware, or server build modification. These Changes do not have wide-ranging impacts on business-critical CIs, and are processed so often that they do not need to be assessed, approved, or reviewed. A standard Change contains only two phases: Accept and Categorize, and Implement. A standard change is closed after implementation is completed.

    11.2.8  Automated changes

    You can process Changes that do not require human interaction. These fully automated Changes are typically used for common operations such as modifying user passwords, performing regularly scheduled server updates, and so on. Fully automated Changes typically use the standard Change process because they do not require assessments, authorization, or scheduling.

    In fully automated Changes, confirmation dialog boxes are skipped. During the Accept and Categorize phase, the manual examination of the Change to determine whether it is within policy is skipped, and no assessment, authorization, and scheduling assignments are issued. During implementation, the update of CIs to reflect the Change implementation is skipped. During the Review and Close phase, the verification of the Change implementation is skipped. All process steps occur completely without human interaction.

    The Fully Automated field is used to indicate that a Change is processed in this way. The Fully Automated field can be set in the Schedule tab of a Change, or it can be set by a job plan that is applied to the Change. When you create job plans that are used for automated Changes, select Fully Automated to indicate that the tasks are completed without human interaction.

    11.3  Supporting change applications

    This section covers the following items that support change applications:

    •Blackout change periods

    •Change schedule

    •Change window calendars

    •Impact analysis configuration

    11.3.1  Blackout change periods

    Blackout change periods are predicted periods of time during which the system or part of the system is partially or completely unavailable. Change owners must be aware that during these periods, changes might be affected. Some examples of a blackout period are the week before Christmas, or the day of payroll for payroll applications. There are business reasons that mandate that the system be continuously available during these times.

    To define or change a blackout period, click Changes → Blackout Periods.

    The following fields are defined for a blackout period: 

    •Blackout period

    Identifier of the blackout period that is being defined or changed

    •Start Time

    Start time of the blackout period

    •End Time

    End time of the blackout period 

    •Type

    Type of the blackout. It can be of two types:

     –	Lockdown change period

    Make no changes on the system during the blackout period

     –	Restricted change period

    Restricted changes are allowed to the system, although they are not recommended. 

    You can add users or groups of users as approvers for the change requests that are made on blackout periods by using the Approves section. 

    The blackout period can be applied to all items on the system, or for specific items. This filter is set by using Scope of Blackout Period section.

    An example of a blackout period is displayed in Figure 11-42.
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    Figure 11-42   Blackout period

    In this example, a new blackout period is defined for the period starting on December 23, at 18:00, and ends on January 2, 8:00. If a change request is needed, it must be approved by a user from the PMCHGCAB group. 

    11.3.2  Change schedule

    Change schedule is a read-only application that shows the calendar view of the change and release work orders that are planned to be applied in the system, and when they will be applied. It provides an easy way to check the calendar of changes and releases that will be applied to the system. 

    An example of the change schedule is displayed in Figure 11-43.
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    Figure 11-43   Change Schedule view

    This window shows a list of changes and release work orders that are planned to be applied. Queries can be defined and saved to help you find the changes that you are interested in. In Figure 11-43, two changes and one release are scheduled.

    11.3.3  Change window calendars

    This application defines predefined periods that are used for changes on the system. For example, a predefined weekly period can be defined for maintenance, usually a period during the night or during the weekend.

    To create a new change window calendar, click Changes → Change Window Calendars.

    You can define the following fields:

    •On Change Window Calendar tab

     –	Change Window Calendar

    The identifier and description of the new calendar being created.

     –	Start Date

    The initial date that the window will be applied.

     –	End Date

    The final date that the window will be applied.

    This defines the period where the change window is created, but you must also define a frequency inside this period available for changes. To do that, click Select Action → Schedule Change Windows.

    A new window is displayed with the option for selecting the duration and the interval of the new change window. The interval can be defined as daily, weekly, monthly, or yearly. Use the duration field to define the amount of time for each change window. For example, a change window created for weekly changes, every Friday from 22:00 to 2:00, can be defined as shown in Figure 11-44.
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    Figure 11-44   Setting a schedule for change window application

    The list of dates where the change window is defined can be seen from the Change Window Calendar tab or the Change Window Schedule tab. There are two different views for each period: Administrative, where the user can change the defined window, or Merged, where the user can only view the window periods.

    An example of the calendar view is displayed in Figure 11-45.
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    Figure 11-45   Calendar view

    Friday and Saturday each have two hours defined because the change window was defined to start on Friday at 22 PM, and to end on Saturday at 2 AM.

    On the CIs tab, you can define the configuration items that are taken out of service during the change window. One or more configuration items can be selected.

    To select a new configuration item, click Select CIs → Select Value. This displays a list of the configuration items available to be included on the change window. If you prefer, you can filter configuration items by attributes or classification by selecting one of the other options in the Select CIs menu.

     

    
      
        	
          Tip: A configuration item can be associated with only one change window. If a configuration item already assigned to another change window is reassigned, the most recent assigned window is used.

        
      

    

    11.3.4  Impact analysis configuration

    This application is used to allow administrators to configure the rules that the impact analysis engine uses to detect the possible effects of change requests. It uses the impact analysis engine as a tool to calculate the effect of the changes. The goal is to identify CIs that can be effected during changes if another item is included in a change request. For example, taking a database offline for a change request can impact the applications that use this database.

    Some rules are predefined in the system, but you can define your own rules according to your business needs.

    To create or modify a rule, complete the following fields:

    •Rule Name

    Identifier of the rule being defined

    •Relationship Name

    Name of the relationship that is defined in the Relationships application. The relationship contains the rules that are verified by the analysis engine.

    •Impact Direction

    There are two possible values for this field:

     –	Source

    Analysis is performed using the selected configuration item as the source configuration item of the relation. 

     –	Target

    Analysis is performed using the selected configuration item as the target configuration item of the relation.

    •Description

    Description of the rule that is being defined

    •Target Condition

    Conditions that are used for the target configuration item

    •Source Condition

    Conditions that are used for the source configuration item

    An example of an impact rule is displayed in Figure 11-46.
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    Figure 11-46   Impact rule

    You can have as many rules as necessary for impact analysis.

    To manually run the impact analysis, select the configuration item to be analyzed and click Test Rules. A list of relationships that use the impacted configuration item and the results of the analysis are displayed.

    As an example, one of the existing Configuration Items, CAESAR.LAB.COLLATION.NET~1880, is tested using the application. The relationships that are displayed are shown in Figure 11-47.
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    Figure 11-47   Impact Analysis Relationships

    The details of the analysis are shown in Figure 11-48.
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    Figure 11-48   Impact Analysis details

    For each item found on relationship section, an analysis is run. If you click each item on the relationships section, you can see the results for the relationship. 

    If an impacted configuration item is found, it is displayed in the impact details section in the Impacted column. 

    The following properties, among others, are used for this application:

    •pmchg.ci.impacts.maxrecords

    The maximum number of CI targets that the Change impact analysis will process. By default, this is 10.

    •pmchg.historical.impacts.maxrecords

    The maximum number of targets that the Change historical impact analysis will process. By default, this is 10.

    •pmchg.ia.impactsTasklimit

    Maximum number of tasks that are examined for historical impact analysis results. By default, this is five.

    •pmchg.ia.impactsTimelimit

    Oldest task to examine for historical impact analysis results (in days). By default, this is 365.

     

    
      
        	
          Guideline: Include impact analysis as part of the workflow that is used for change requests. The workflow PMCHGMAIN1 runs the impact analysis.

        
      

    

    11.4  Conclusion

    This chapter described how IBM SmartCloud Control Desk can be used to manage your change process. The example showed an advanced change scenario.

    It also described the different applications that are used to set up and manage the change process, and presented some simplified options for your consideration.
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Release management

    This chapter provides key concepts on the release management process. It describes how the release management features in IBM SmartCloud Control Desk can help you to manage the implementation of approved complex changes. These include composite changes that must be coordinated across a number of CIs, and mass rollouts of software updates. These types of changes are commonly implemented through releases.

    This chapter includes the following sections:

    •Release management overview

    •Release management using IBM SmartCloud Control Desk

    •Integrations

    12.1  Release management overview

    The goal of this section is to explain the main purposes of the release management discipline.

    12.1.1  Release management process overview

    Release Management is the controlled deployment of approved changes within the IT infrastructure, and the establishment of effective use of the service to deliver value to the users or customers.

    ITIL defines release and deployment management as follows.

     

    
      
        	
          Definition: Release and deployment management aims to build, test, and deliver the capability to provide the services specified by service design and that will accomplish the stakeholder’s requirements and deliver the intended objectives.

        
      

    

    The trigger of the release management process is one or more approved changes. Release management can in many ways be regarded as an add-on to Change Management that provides facilities to orchestrate the implementation of multiple changes as a single unit. You can think of release management as a wrapper around multiple changes or multiple target CIs. This capability is used for complex changes where, for example, the scope of the change is unknown, or the changes must be implemented in a specific sequence. Application of fix packs, mass deployment of virus checking signatures, and deployment of an entire application stack across multiple systems are just a few examples of infrastructure modifications where release management capabilities are used. 

    The nature of releases is that at the outset, you are uncertain about the content and scope of the release. The release is basically a project in which you define what needs to be done, and then do it. This is different from the way changes are processed. During change processing, you have a set number of ways to process the change. Based on certain attributes, a specific path (or workflow) is followed, taking the change through a set of predetermined steps. 

    The main reason for implementing multiple changes into a release is that you can treat the release as a unit when scheduling, tracking progress, and obtaining approval. This makes the management process much smoother than having to manage and synchronize multiple changes individually. However, the individual changes that are members of a release go through the normal change processing for categorization, assessment, and approval before they are added to a release. It is still the responsibility of the change team to properly assess and approve each change that becomes part of a release. However, when a change is added to a release, the release team becomes responsible for the planning, scheduling, and coordination of the change implementation. 

    The objective of release management is to ensure these considerations are met:

    •Release and deployment plans are in place.

    •Release packages are deployed successfully.

    •Knowledge transfer to the users or customers take place.

    •There is a minimum disruption to the service.

    Effective release management contributes to the business in these ways:

    •Changes are realized faster, cheaper, and with fewer risks.

    •The implementation approach is more consistent, and the traceability requirements are complied more closely

    Release management phases

    In essence, the release management process is similar to a project. When processing a release, you basically define a project in which the results of earlier tasks and activities can affect the decision to run tasks later on. Depending on the nature of the task at hand, the project contains different tasks that must be run in a specific sequence. This plan is similar to the job plans used in a change. Release management can be divided into two distinct phases: 

    •Release, in which you specify, plan, schedule, and approve the release 

    •Deployment, in which you implement the outcome of the previous phase 

    Figure 12-1 provides an overview of the release management process as depicted in IBM Tivoli Unified Process.
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    Figure 12-1   Release management process in IBM Tivoli Unified Process

     

    
      
        	
          Interaction with change management: Notice how the release management process relies heavily on the change management process. In fact, releases are created based from changes. Then, during processing of the release, change management is responsible for accepting the validation as well as the implementation the release.

        
      

    

    Depending on the nature of the release, the detailed work that is performed in each phase varies. A set of general milestones characterizes each major activity of the ITIL-aligned release process. For specific releases, you might emphasize certain steps, while de-emphasizing or even skipping others. For example, if a release does not involve software distribution, the Distribute and Install activity might not apply. 

    The following are the major release activities:

    •Plan

    After a new release is created, you determine which changes will go into the release. Multiple changes can be added to a release. When you add a change to a release, the source and target configuration items (CIs) for the change are also associated with the release. A basic task list is defined, and then refined during the roll-out planning. The overall structure of the release plan is the final goal of this stage. 

    •Design and Build

    The installation scripts and packages to be deployed are designed and created during this activity. The software is not created, but it is packaged for deployment. Installation scripts and mechanisms, communication, and education plans, and back out procedures are also developed.

    •Test and Accept

    During this step, the release package is tested to ensure that is free of errors. The release is also reviewed to determine whether it can be accepted for deployment. Copies of the package are added to the definitive media library (DML). 

    •Plan Rollout

    Detailed plans, including release dates and deliverables, are created for rolling out the release to each site. For each site, delivery is scheduled for any new assets that are part of the release, and the release deployment is also scheduled. If training is needed, it is scheduled, as are any communications that are needed. 

    •Communicate and Prepare

    During this activity, you ensure that all stakeholders, users, and support personnel are aware of the changes that will occur when the release is deployed. To ensure that a site is ready for a release, you can schedule site-specific testing, system shutdowns, reminders about the release, and so on. 

    •Distribute and Install

    As the Distribution and Installation activity gets underway, you check with Configuration Management to determine the status of CIs that are involved in the release to ensure that the target CIs are ready for the release. Finally, the release is distributed to all of the target CIs. 

    Release management roles

    An overview of roles and responsibilities for release management is provided in Table 12-1.

    Table 12-1   Release management roles and responsibilities

    
      
        	
          Role

        
        	
          Responsibilities

        
      

      
        	
          Release administrator

        
        	
          Responsible for administering the release process, and the base definition such as classifications or job plans

        
      

      
        	
          Release deployment specialist

        
        	
          Performs software deployments that are defined for a release

        
      

      
        	
          Release manager

        
        	
          Manages and assesses the effectiveness of the overall process, making changes as needed to ensure efficiency

        
      

      
        	
          Release owner

        
        	
          Creates releases, and manages the tasks and activities within each assigned release

        
      

      
        	
          Release specialist

        
        	
          Responsible for performing the actual work that is required by release tasks and activities

        
      

    

    12.1.2  Product capabilities

    In IBM SmartCloud Control Desk, the release management implementation has these characteristics:

    •The release management process is driven by standard job plans and task automation.

    •Sample job plans are provided.

    •Approved changes can be imported into a release to reference CIs.

    •The Scheduler application facilitates the schedule of releases. Results are added to the Change Schedule.

    •Software images are registered in the DML.

    •Can use Operational Management Products for automated software deployment, or backup and restore.

    When planning a release using IBM SmartCloud Control Desk, a release owner performs these tasks:

    •Relate to change records.

    •Create a job plan, or use provided job plans to specify what needs to be done.

    •Define dependencies between tasks.

    •Classify the tasks.

    •Apply flow actions and assisted workflow.

    •Assign ownership for each task.

    When building a release using IBM SmartCloud Control Desk, a release specialist performs these tasks:

    •Identify and document hardware requirements.

    •Identify software installation images and register them in the CMDB.

    •Create installation and customization instructions.

    •Create automation scripts for software installation, customization, and integration.

    When testing and verifying the release package using IBM SmartCloud Control Desk, the release deployer performs these tasks:

    •Document the results of the release package.

    •Register the software package in the DML upon acceptance.

    When planning the rollout of the release using IBM SmartCloud Control Desk, the release owner and release deployer perform these joint tasks:

    •Create detailed plans with dates and deliverables for the rollout to each site.

    •Schedule delivery of any new CIs, such as hardware, to each site.

    •Schedule the release implementation.

    •Schedule training.

    When communicating the release implementation schedule using IBM SmartCloud Control Desk, the release owner performs these tasks:

    •Inform stakeholders, users, and support personnel about the upcoming event.

    •Tracks the notifications from the release record.

    •Schedules site-specific testing, system shutdowns, reminders about the release, and so on.

    When implementing the release using IBM SmartCloud Control Desk, the release owner performs these tasks:

    •Oversees the progress of implementation tasks.

    •Communicates with configuration management to verify that the expected modification is performed.

    When reviewing and closing the release using IBM SmartCloud Control Desk, the release owner performs these tasks:

    •Collects user feedback.

    •Examines the information that relates to the usage of the release.

    12.2  Release management using IBM SmartCloud Control Desk

    This section demonstrates the use of IBM SmartCloud Control Desk through an end to end release management scenario.

    Pre-implementation tasks are described, and the management of the release record through the different phases of the product, from initiation to implementation.

    12.2.1  Pre-implementation tasks

    This section addresses the following details:

    •PMCHGREL and PMCHGWAIT escalations

    •Creating a definitive media library (DML)

    •Creating a software CI

    •Disabling DML Tivoli Application Dependency Discovery Manager integration

    •Assigning change windows to release target CIs

    •Creating a release from the change record

    •Making a change available to any release

    PMCHGREL and PMCHGWAIT escalations

    IBM SmartCloud Control Desk provides a function that controls the closure of changes that are related to releases. This is controlled by two escalations:

    •PMCHGREL: Updates change wait-for-release task status to either SUCCESS or FAIL based on the release status

    •PMCHGWAIT: Notifies the change that an associated release is finished

    By default, these examine the status of the changes and releases every 12 hours and 24 hours respectively. 

    For this example, the two escalations that register change release relationships and automated change completion run in a shorter time frame this is more appropriate for the exercise environment. The schedule is set to run these escalations every 5 minutes.

    Creating a definitive media library (DML)

    The software deployment feature of release management in IBM SmartCloud Control Desk is designed to work only with software images that are stored in the Definitive Media Library. 

    A definitive media library (DML) is defined as follows:

     

    
      
        	
          Definitive media library: One or more locations in which definitive and approved versions of all software Configuration Items are securely stored.

        
      

    

    The DML is a single logical storage area even if there are multiple locations. All software in the DML is under the control of change and release management, and is recorded in the configuration management system. Only software from the DML is acceptable for use in a release.

    For the following end to end use case, a new DML must be created that is used to store information about available software images.

     

    
      
        	
          Security consideration: The DML must be protected by strict security and access control. For this reason, only release administrators and release managers are usually authorized to create DMLs and register software in them.

        
      

    

    A new DML is created from the Definitive Media Library application, which is you can open by clicking Go to → Release → Definitive Media Library. Enter the information detailed in Table 12-2.

    Table 12-2   Definitive Media Library information

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Name

        
        	
          ITSO_DML

        
      

      
        	
          Description

        
        	
          ITSO Definitive Media Library

        
      

      
        	
          Classification path

        
        	
          DSLREP \ FILESYST

        
      

      
        	
          Production?

        
        	
          Selected

        
      

    

    Many extra options can be used to specify properties for auditing, capacity, and backup/restore, just to name a few. 

    Figure 12-2 shows the DML created for this use case.
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    Figure 12-2   Definitive Media Library application

     

    
      
        	
          Management application: The management application allows you to link the DML to the Operational Management Product (OMP) that owns the resources in the DML. IBM Tivoli Provisioning Manager is a software distribution tool that provides tight integration with the DML and release management capabilities of IBM SmartCloud Control Desk. To integrate IBM Tivoli Provisioning Manager with your DML, select the Tivoli Provisioning Manager type of DML.

        
      

    

    Creating a software CI

    After you create the DML, the environment is ready to track software images that are authorized to be used in the production environment. 

    When you are dealing with software deployments, special CIs are needed that serve as the source for the software deployment. This CI is a SOFTWAREIMAGE configuration item that identifies the software image in the DML that must be used for software deployment. This software CI is the set of binary files that is built, tested, and deployed as part of the Release process.

    For this example, a software image CI, named websphere application server v7 fixpack 123, was created in the Configuration Items application, as shown in Figure 12-3.
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    Figure 12-3   Software image CI

    Disabling DML Tivoli Application Dependency Discovery Manager integration

    When you register software images in a DML that is associated with an OMP, IBM SmartCloud Control Desk by default tries to import all the details about the software images and the OMP that are known to the IBM Tivoli Application Discovery Dependency Manager discovery tool.

    If you are not using IBM Tivoli Application Discovery Dependency Manager, disable this feature to avoid error messages later on. The feature can be changed from the System Properties application. 

    The property to be changed is istaddminuse, as shown in Figure 12-4.
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    Figure 12-4   istaddminuse system property disabled

    IBM SmartCloud Control Desk does not attempt to contact IBM Tivoli Application Discovery Dependency Manager when new software image CIs are registered in the DML.

    Assigning change windows to release target CIs

    The release scheduling process does not use the impact analysis module to calculate impacted CIs the same way the change management module does. This means that when scheduling releases, only the change window and black out period that apply to the target CIs of a release are taken into account.

    Change windows and blackout periods usually already exist in the system. They are not specifically built as part of the Release process. However, to demonstrate their use in this example, the CIs that will become targets of the release are associated with a change window calendar. From the Change Windows Calendar application, a new change window is created for CIs classified as WebSphere Application Servers, as detailed in Table 12-3.

    Table 12-3   Change Window Calendar

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Name

        
        	
          SAT7AM5PM

        
      

      
        	
          Description

        
        	
          Saturday 7 AM to 5 PM maintenance for WebSphere servers

        
      

      
        	
          Schedule

        
        	
          Every one week, on day Saturday, at time 07:00 AM

        
      

      
        	
          Duration

        
        	
          10:00

        
      

      
        	
          CIs

        
        	
          Classification CIROOT \ CI.APPSERVER \ CI.J2EESERVER \ CI.WEBSPHERESERVER

        
      

    

    This ensures that the tasks that affect the availability of the CIs can only be scheduled in accordance with the specifications in the SAT710AM calendar.

    Creating a release from the change record

    The end to end release use case is based on an approved change that was transferred to the release team for implementation. The change was created and processed by using IBM SmartCloud Control Desk change management applications.

    The purpose of the change is to apply a new fix pack to a WebSphere Application Server supporting a critical billing application.

    The creation and processing of the change record is not detailed in this chapter. For more information about the change management module and capabilities, see Chapter 11, “Change management” on page 593. Table 12-4 provides a summary of the approved change that will be managed by the release team for implementation.

    Table 12-4   Originator change summary

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Description

        
        	
          Update Billing server to WebSphere Application Server v7 fix pack 123

        
      

      
        	
          Details

        
        	
          Install fix pack 123 on WebSphere Application Server V7 supporting billing application

        
      

      
        	
          Status

        
        	
          INPRG

        
      

      
        	
          Source CI

        
        	
          WebSphere Application Server v7 fix pack 123

          (CI.SOFTWAREIMAGE)

        
      

      
        	
          Target CIs

        
        	
          HELIOS:SERVER1

          HELIOS.SERVER3

          (CI.WEBSPHERESERVER)

        
      

      
        	
          Job plan

        
        	
          PMRELCHG

        
      

    

    Because the change is meant to take a critical business application offline, the change owner has decided to transfer the implementation to the release team so it is formally tested and accepted. Furthermore, the application server is deployed across multiple computer systems, so it must be carefully planned.

    To help the release team, the change owner provides as much information as possible, including:

    •Assign all the relevant configuration items as target CIs. The target CIs for the change are defined as the configuration items classified as CI.WEBSPHERESERVER for which a relationship exists with a computer system. That is, the change owner has identified where the WebSphere Application Server installation files are located. In this case, a physical server (HELIOS.SERVER1) hosts the deployment manager and two nodes. A second physical server (HELIOS.SERVER3) hosts nodes three to six.

    •Assign a job plan that includes only one task that waits for the associated release to complete before completing the change. This ensures that there is no overlap between the change and the release.

    •Create a software image CI to represent the fix pack installation image, and assign it as the source CI during the change.

    After the change is approved and moved to in progress, the change owner transfers the responsibility of the implementation to the release team by creating a release record from the change. This is done by clicking Select Action → Create → Release. 

    This process creates a new release record, which is populated as per the change, and a relationship between the records is established.

    Making a change available to any release

    After the change is approved and moved to in progress, IBM SmartCloud Control Desk provides another option for the change owner to transfer the responsibility of the implementation to the release team. From the Select Action menu, the change owner can select Make the change available to any release. 

    Figure 12-5 shows where a user can find the action Make the change available to any record.
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    Figure 12-5   Making the change available to any release

    The end to end release management use case that is detailed later also includes a change that was transferred to release implementation by using this action.

    This additional change is also meant to apply the fix pack 123 for WebSphere Application Server v7 supporting the order management application. A summary of this change is provided in Table 12-5. Again, because the change is meant to take offline a critical business application, the change owner decides to implement it into production through release. This process means it will be formally planned, tested, and deployed through the release process. 

    Table 12-5   Extra change summary

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Description

        
        	
          Update order management server to WebSphere Application Server v7 fix pack 123

        
      

      
        	
          Details

        
        	
          Install fix pack 123 on WebSphere Application Server V7 supporting order management application

        
      

      
        	
          Status

        
        	
          INPRG

        
      

      
        	
          Source CI

        
        	
          WebSphere Application Server v7 fix pack 123

          (CI.SOFTWAREIMAGE)

        
      

      
        	
          Target CIs

        
        	
          CAESAR51:SERVER1

          (CI.WEBSPHERESERVER)

        
      

      
        	
          Job plan

        
        	
          PMRELCHG

        
      

    

    When a change owner selects Make available for any release, the system creates a process request where the process manager type is automatically set to Release. The status of the process request is initially awaiting approval. To approve the process request and continue on with the release management process, a release administrator can perform either of these actions:

    •Work on the process request to ensure that individual changes included in the request have been categorized, assessed, and approved, so that all information is provided to plan, schedule, and coordinate the release. Then, approve the release record.

    •Select the available change to add it to an existing release record, which automatically approves the related process request and creates the relationships between the records.

    12.2.2  Release management end to end use case

    Reusing the pre-implementation activities, this section describes an end to end release management scenario, consisting of multiple changes, using IBM SmartCloud Control Desk.

    Plan release

    The plan, or specification, phase of the release process, is one of the most critical activities when managing releases. During specification, you make decisions that are critical for how the release processing takes place, and which aspects of the change to include. That is, you must decide which job plan to assign to the change. 

    Defining the release scope

    The first task for a release owner is to define the scope of the release project. That is, to identify the approved changes that will be implemented through the release. In this example, two changes are included in the release:

    •An originator change, as described in “Creating a release from the change record” on page 657, from which the release record was created. This change is meant to update the application server that supports the billing application. Because the release record was created from this change directly, IBM SmartCloud Control Desk automatically created the relationships between the records and populated the release record as per the change. Therefore, the scope of the release already includes this change. 

    •An approved change that was made available to any release by the change owner, as described in “Making a change available to any release” on page 658. This change is meant to update the application server supporter order management application. This created a process request that is waiting for approval. 

    When defining the scope of the release, a release administrator must consider all changes that have been approved and are ready for implementation through release. A list of such changes is available by clicking Select action → Manage Changes → Requests. This opens a dialog as shown in Figure 12-6 from which the release administrator can select changes that apply to the planned release.
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    Figure 12-6   Requests to add changes to a release

    Additionally, the changes added are listed on the release as well as source CIs and target CIs that these changes brought. When you select a change from the Requests to add change to a release dialog, the associated process request is resolved and a new relationship is created. This request was automatically created when the change was made available to any release. The release record is now related to two change records and a process request, as shown in Figure 12-7.
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    Figure 12-7   Release related records

    The relationship between the changes and the target CIs can be extended by the release administrator, who can select additional target CIs for the release. To facilitate the selection of target CIs based on existing relationships, IBM SmartCloud Control Desk provides the option From WO hierarchies and relationships in the Target CIs section of the release application that filters CIs based on associated records, as shown in Figure 12-8.
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    Figure 12-8   Selecting CIs from Hierarchies and Relationships

    In this example, the system associated extra target CIs automatically upon creation of the relationships. There are no target configuration items to add. The release record has now defined the scope of the release that will be processed in this example. Both changes are related to the release record, and their respective CIs are defined.

    The release administrator must now move on to the next task, which involves creating the task list for the release project.

    Job plans

    Release management in IBM SmartCloud Control Desk does not use workflows to process the release, as change processing does. All the processing occurs in the job plans. These activities and tasks are assigned to help you perform specific steps of the release processing. You can regard the different job plans provided in IBM SmartCloud Control Desk as templates that you can use to minimize the amount of customization you must perform during the specification of the change. 

    IBM SmartCloud Control Desk optional content provides seven different job plans, each of which includes one or more predefined activities. These activities in turn contain the individual tasks. The following release-specific job plans are available: 

    •PMRELEASE: This job plan can be used ready for use 10 plan and structure-specific release work plans. The built-in job plan is derived from the Release Management process description that is stored in IBM Tivoli Unified Process Composer. This job plan is a template that mirrors a standard release process in a typical IT environment. It contains all of the activities and tasks that are typically used for release processes. 

    •PMRELDB: This job plan can be used to install a database in your data center. 

    •PMRELMW: This job plan can be used to install middleware in your data center.

    •PMRELSB: This job plan can be used to build a server in your data center. 

    •PMRELBLDTE: This job plan can be used to build and test a release package that you do not want to deploy immediately. Activities in this job plan ensure that the release is adequately planned, designed and built, tested and verified, and reviewed and closed. The release is ready for deployment when you determine deployment is needed. 

    •PMRELDPY: This job plan can be used to plan, prepare, and deploy a release package. 

    •PMRELSEDPY: This job plan can be used to plan, design and build, and test and verify a new release package, and to distribute and install the release to the IT infrastructure. 

     

    
      
        	
          Release response plan: Notice that despite job plans being provided, IBM SmartCloud Control Desk does not provide any built-in response plans. 

        
      

    

    Each job plan includes one or more activities, which in turn include the specific tasks that must be performed during each activity. When specifying the release, it is the responsibility of the release manager or release owner to select the correct job plan. That person must take a critical look at each of the activities to determine whether the specified tasks are relevant for the current release. 

    Tasks

    During the processing of a release, tasks are assigned to users who are associated with specific roles. As part of the task definition, automated actions can be run to provide some level of automation in the tool. This automation is associated with the tasks, so it is required that the tasks are initiated and completed to ensure that the automation is applied. 

     

    
      
        	
          Task classification: Some tasks are classified, whereas others are not. IBM SmartCloud Control Desk uses the task classification to identify specific milestone, approval, or software deployment tasks so they can be highlighted in the Process details tab of the Release application. 

        
      

    

    Some tasks, for example the ones used to deploy software packages, are associated with assisted workflows. These are used to help the person who performs the task to complete the job at hand. Tasks and activities can be added or removed to the release after the initial job plan assignment.

    In this example, the release record was created directly from the change record. Upon creation, the release record is waiting for approval (WAPPR). The job plan must be assigned before the record is approved.

    The job plan is assigned from the Plan tab. For this example, the job plan PMRELEASE is assigned, which implements the ITIL V3 release process. It is applicable to almost any kind of change, from the simplest software deployment to the establishment of and migration to a new data center. 

    Figure 12-9 shows the activities included in the PMRELEASE job plan.
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    Figure 12-9   PMRELEASE job plan activities

    
      
        	
          Note: You see a number of activities that are not necessarily directly related to modifying the IT environment. Remember that a release package includes, as per ITIL, not only hardware, software, documentation, and processes, but also other components that are required to implement the approved changes. This implies that you must be able to manage all the activities of a release.

        
      

    

    After application of the job plan, notice how the progress map changes from the default to the release progress map that highlights the main activities of the assigned job plan, as shown in Figure 12-10.
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    Figure 12-10   Release progress map

    After the job plan is applied, the release owner must initiate the release by clicking Initiate Release on the navigation bar. Doing so updates the status of the release to In progress (INPRG), and starts the first activity.

    The release owner can now, but is not required to, schedule the release. Scheduling the release involves setting realistic scheduled start and end dates for the entire release, rather than individual tasks. Figure 12-11 shows the Dates section with scheduled start and end dates for this example.
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    Figure 12-11   Scheduled start and end dates for the entire release

    Process Details

    For the release owner to see the most important tasks included in the applied job plan, IBM SmartCloud Control Desk provides an overview in the Process Details tab, as shown in Figure 12-12.
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    Figure 12-12   Process Details tasks overview

    In this view, tasks are grouped into four main groups, based on the classification that is associated with the individual tasks:

    •Approval tasks: Lists tasks that are classified as Approval (PMAPPR)

    •Milestones: Lists tasks that are classified as Change Progress task (PMREL \ PMRELTSK \ PMRELCPR)

    •Implementation tasks: Lists tasks where Implementation task is selected. When scheduling these particular tasks, the calendar change window and blackout periods that apply to the target CIs are taken into account.

    •Software distribution tasks: Lists tasks that are classified as Software Distribution (PMREL \ PMRELTSK \ SWDIST)

    Workplan Map

    The workplan map is shown at the bottom of the Process Details tab. This map provides a graphic representation of the process with indication of status for each task activity and its related tasks. Initially, only the main activities are shown, but all the included tasks can be made visible by expanding any activity, as shown in Figure 12-13.
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    Figure 12-13   Process Details workplan map

    The release owner now completes all tasks included in the Release plan activity, including approvals, so that the release is marked as ready to be processed. As shown in Figure 12-14, the progress map changes upon completion of the activity to indicate what state the release record is in.
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    Figure 12-14   Progress map indicates that release is in the planned state

    Design and Build Release

    In this phase, the primary contributor is the release specialist. The release specialist is responsible for obtaining the necessary installation media, and for designing and building the scripts and procedures necessary to deploy the release. The tasks included in Design and Build Release activity are described in Table 12-6.

    Table 12-6   Design and Build Release tasks

    
      
        	
          Task #

        
        	
          Task name

        
        	
          Description

        
      

      
        	
          10

        
        	
          Design Release

        
        	
          Design the installation scripts and packages that will be deployed. This does not involve creating software to be deployed, but packaging the software so it can be deployed and creating any necessary installation scripts and mechanisms. Design back out procedures if the deployment is not successful.

        
      

      
        	
          20

        
        	
          Build Release

        
        	
          Create the release packages and installation scripts needed. In addition, create communication and education plans that are needed for deployment, and create back out procedures.

        
      

      
        	
          30

        
        	
          Update Release progress

        
        	
          Close the activity, update status of the release, and progress the release to the next activity.

        
      

    

    In this example, the fix pack to be applied to the application servers was already created as a software CI by the change management team, and defined as a source CI during the definition of the release.

    While designing and building the release package, a release specialist typically places the code in a shared location so that it can be used later on for testing and eventually be stored in the DML.

    To ensure the source CI, which represents the software image, has the correct configuration information, consider using the Move/Swap/Modify facility to apply details such as the name of the image, or a flag indicating that the software image is approved for test distribution, as shown in Figure 12-15.
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    Figure 12-15   Move/Add/Modify software image CI

    After performing the tasks, the release specialist will mark them as complete. When the three tasks are completed, the Design and Release activity moves to Complete automatically, and the next activity moves to in progress. The progress map is automatically updated to reflect the status of the release as shown in Figure 12-16.

    [image: ]

    Figure 12-16   Progress map indicates that release is built

    Test and Accept Release

    In this activity, the release deployer specialist tests and verifies the release package that is put in by the release specialist. This activity is intended to provide assurance that the installation of the updates runs smoothly and without problems. After it is verified that software package works as expected, it is registered in the DML.

    The tasks that are defined in Test and Accept Release activity are described in Table 12-7.

    Table 12-7   Test and Accept Release tasks

    
      
        	
          Task #

        
        	
          Task name

        
        	
          Description

        
      

      
        	
          10

        
        	
          Software distribution

        
        	
          Test the deployment of the release package. Note errors that occur. Use a controlled test environment to test all release packages.

        
      

      
        	
          20

        
        	
          Determine if release is accepted

        
        	
          Ensure that the appropriate approvals are obtained for the release before you update the DML.

        
      

      
        	
          30

        
        	
          Import software into DML

        
        	
          Put golden copies of the release package in the DML, and use the definitive hardware store for hardware that is needed to deploy the release.

        
      

      
        	
          40

        
        	
          Update release progress

        
        	
          Close the activity, update status of the release, and progress the release to the next activity.

        
      

    

    Software distribution for test and verification

    To properly test the software package, the release deployer must perform the exact same actions as are used when the release is implemented in production. 

    If operational management products for software distribution, such as IBM Tivoli Provisioning Manager, are used, the release deployer must create all the definitions in the OMP to run a realistic test. In this example, there is no integration between IBM SmartCloud Control Desk release management and OMPs, so the software distribution is done manually. For more information about the definition of software distribution tasks with an integrated OMP, see 12.3, “Integrations” on page 686.

     

    
      
        	
          Test environment: It is assumed that a representative test environment is available. If not, change the release plan to include the implementation of a test environment that can be used to thoroughly test the release.

        
      

    

    Assuming that all the prerequisites are in place, it is time for the release deployer to get started with the software distribution. In this process, the release deployer uses the software package developed by the release specialist, including the documentation. 

    The release deployer group or person that was assigned to the task receives a new task notification in their start center. Opening the task from the start center portlet takes the release deployer to the Activities and Tasks application. 

    The task is classified as an implementation task, which gives it the following attributes:

    •Software deployment ID: This is assigned by the system when creating deployments using an integrated operational management product.

    •Software Package: This references the software package (CI.SOFTWAREIMAGE) to be used, and must be set by the release deployer.

    After the software package is fully tested, and the rollback procedures are tested, the test is considered successful. The release deployer then documents the results, and marks the software distribution task as complete.

    Determining if release is accepted

    Double-check that the release was effectively accepted before the software package is captured in the DML. This task is typically assigned to a release specialist. However, it is also a good opportunity for the change management team who initially requested the release to review the results of the test and give their approval to continue.

    At any time, a user can see an overview of the release process and locate where the current record is at by using the workplan map feature available in Process Details tab. At this point of the process, the workplan map indicates that the task Determine if release is accepted is completed, and Import software into DML is in progress, as shown in Figure 12-17.
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    Figure 12-17   Import software into DML task is in progress

    Importing software into DML

    The purpose of this task is to capture the tested and verified software package, and load it into the DML. The release specialist is responsible for this task.

    When opening the task from the start center, the release specialist, who is responsible for this task, notices an attribute DML Name associated with the classification of the task: PMREL \ PMRELTSK \ RELIMPSW. The release specialist must update the value of the DML Name attribute to reflect the DML where the software package will be stored. In this example, the DML Name attribute is set to the DML created in the pre-implementation tasks, as shown in Figure 12-18.
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    Figure 12-18   DSLNAME attribute

    After the DML is set, the release specialist must add the software package to it. To facilitate this, the current task Import Software into DML, as defined by the release process job plan, provides an assisted workflow. 

     

    
      
        	
          Assisted workflow: IBM SmartCloud Control Desk allows you to use assisted workflow capabilities within a task to guide users during the processing of the task. These assisted workflows are optional. Users might be more comfortable starting the applications directly themselves.

        
      

    

    When an assisted workflow is assigned to a task, a Start Assisted Workflow button is available for the user to initiate the current task, as shown in Figure 12-19.
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    Figure 12-19   Assisted workflow

    When the release specialist clicks Start Assisted Workflow, the Definitive Media Library application opens so the release specialist can select the software configuration item associated with the release. In this example, the release specialist uses the option to Select from CMDB because the software package is known as a CI. 

    The DML for this example includes only one software image, as shown in Figure 12-20.
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    Figure 12-20   Adding source CI to the DML

    The release specialist now completes the task Import Software into DML, which automatically marks the activity Test and Accept as complete, and updates the progress map as shown in Figure 12-21.
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    Figure 12-21   Progress map indicates that release is accepted

    Plan Release Rollout

    In this activity, the deployment plan details are generated. They specifically focus on what will be performed during deployment of the release.

    When you create tasks in a planned rollout, each task is an implementation task. Implementation tasks affect CIs, and planned rollouts by definition affect CIs. All current and upcoming implementation tasks that are scheduled in your data center are displayed in the Change Schedule application. This application allows you to identify potential conflicts and dates that are most appropriate for the implementation to be performed.

    For each software distribution roll-out task, specify a software image CI reference so that it can be used as the course for the deployment. Not only does this capture CI data for auditing purposes, but it also captures the data necessary for performing the task. 

    In this example, only one implementation task is required because a single software package is deployed to multiple targets. Because the job plan already defines the implementation plan, all that must be done is to select the target CIs.

     

    
      
        	
          Note: When deploying an entire business application that involves multiple software packages to multiple targets, you must create implementation tasks for each unique combination of software package and target CI. All of these tasks are defined during the Develop Roll out plans task.

        
      

    

    A typical release roll-out plan includes the tasks that are listed in Table 12-8.

    Table 12-8   Plan release rollout tasks

    
      
        	
          Task #

        
        	
          Task name

        
        	
          Description

        
      

      
        	
          10

        
        	
          Develop site roll-out plans

        
        	
          Create the plans for rolling out the release to each site to which the release is rolled out. Plans must include release dates and deliverables. Refer to related requests for changes, problems, and known errors that are addressed in the release.

        
      

      
        	
          20

        
        	
          Schedule asset delivery

        
        	
          Schedule the delivery of required assets to the sites where the release is rolled out

        
      

      
        	
          30

        
        	
          Schedule release implementation

        
        	
          Schedule the deployment of the release to the site.

        
      

      
        	
          40

        
        	
          Coordinate with communication and training

        
        	
          Determine when training related to the release will be provided. Schedule the delivery of communications concerning the release.

        
      

      
        	
          50

        
        	
          Identify new CIs involved with release

        
        	
          Determine of all CIs affected by the release are identified as target CIs. Identify and include extra ones if applicable.

        
      

      
        	
          60

        
        	
          Approve roll out plan

        
        	
          Approve the roll-out plan.

        
      

      
        	
          70

        
        	
          Approve impacted CIs list

        
        	
          Approve impacted CIs list.

           

        
      

      
        	
          80

        
        	
          Update Release progress

        
        	
          Close the activity, update status of the release, and progress the release to the next activity.

        
      

    

    Not all tasks apply to this example. This section focuses on the Develop site roll out plans task (task 10), Schedule release implementation task (task 30) using the Scheduler application, and Approve roll out plan task (task 60).

    Developing site roll-out plan

    When developing the site roll-out plan, the release owner must ensure that the implementation activity Distribute and Install Release in the release contains the necessary implementation tasks to implement the changes. These tasks must be in the correct sequence, and in the correct schedule that takes into account availability of target configuration items and people.

    In this example, a new fix pack is deployed to multiple WebSphere Application Servers. Three target configuration items are identified, representing two business applications in two separate environments:

    •The first environment, running the Billing application, consists of two physical servers. The server where the deployment manager process is running (HELIOS:SERVER1) must be updated first. The server where the nodes are hosted (HELIOS:SERVER3) can be updated after.

    •The second environment, running the order management application, consists of only one physical server: CAESAR51:SERVER1

    To reflect these dependencies in the plan, the implementation task defined by the job plan assigned must be modified to point to the deployment manager target. Then, similar tasks need to be created that point to the remaining targets. In addition, the release owner must define the sequence by defining the predecessors for each task.

     

    
      
        	
          Note: The implementation tasks to be included in the release vary in nature. For example, depending on the type of release and the scope of it, a release owner might consider adding implementation tasks such as installation of new racks, upgrading of the cooling capacity, creation of virtual systems, updating network information, or mass roll out of a security update to multiple sites.

        
      

    

    As defined in the PMRELEASE job plan that is assigned to the release, a typical Distribute and Install Release activity includes the tasks listed in Table 12-9.

    Table 12-9   Distribute and Install release tasks

    
      
        	
          Task #

        
        	
          Task name

        
        	
          Description

        
      

      
        	
          10

        
        	
          Obtain status of CIs in Release

        
        	
          Ensure that required CIs exist and are operational.

        
      

      
        	
          20

        
        	
          Software Distribution

        
        	
          Prepare deployment.

        
      

      
        	
          30

        
        	
          Software Distribution

        
        	
          Default deployment task to deploy software to the target.

        
      

      
        	
          40

        
        	
          Update Release progress

        
        	
          Close the activity, update status of the release, and progress the release to the next activity.

        
      

      
        	
          50

        
        	
          Update CI status

        
        	
          Update the status or specifications of the CI if applicable

        
      

      
        	
          60

        
        	
          Update Release progress

        
        	
          Close the activity, update status of the release, and progress the release to the next activity.

        
      

    

    To modify the predefined list of tasks and align it with the requirements of the current release, the release owner opens the activity Distribute and Install release in the Activities and Tasks application. In the Plans tab, the release owner performs these tasks:

    1.	Rename task 20 to: Prepare for software deployment

    2.	Rename task 30 to: Install fix pack 123 on Deployment manager

    3.	Select configuration item HELIOS:SERVER1 as the target of task 30. This refers to the deployment manager instance of the application server that runs the billing application.

    4.	Ensure task 20 is defined as a predecessor of task 30

    5.	Click New row to create a new task to install fix pack on the server that hosts the nodes, with the details listed in Table 12-10.

    Table 12-10   Details of task Install fix pack 123 on Nodes

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Number

        
        	
          31

        
      

      
        	
          Description

        
        	
          Install fix pack 123 on Nodes

        
      

      
        	
          Sequence

        
        	
          31

        
      

      
        	
          Classification 

        
        	
          PMREL \ PMRELTSK \ SWDIST

        
      

      
        	
          Under flow control?

        
        	
          Selected

        
      

      
        	
          Assisted Workflow

        
        	
          PMRELSWDST

        
      

      
        	
          Implementation task?

        
        	
          Selected

        
      

      
        	
          Owner group

        
        	
          PMRELDEP

        
      

      
        	
          Configuration Item

        
        	
          HELIOS:SERVER3

        
      

      
        	
          Estimated duration

        
        	
          4:00

        
      

      
        	
          Predecessors

        
        	
          30

        
      

    

    6.	Click New row to create a task to install fix pack on the server that hosts the order management application, with the details listed in Table 12-11.

    Table 12-11   Details of task Install fix pack 123 on order management server

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Number

        
        	
          32

        
      

      
        	
          Description

        
        	
          Install fix pack 123 on Order management server

        
      

      
        	
          Sequence

        
        	
          32

        
      

      
        	
          Classification 

        
        	
          PMREL \ PMRELTSK \ SWDIST

        
      

      
        	
          Under flow control?

        
        	
          Selected

        
      

      
        	
          Assisted Workflow

        
        	
          PMRELSWDST

        
      

      
        	
          Implementation task?

        
        	
          Selected

        
      

      
        	
          Owner group

        
        	
          PMRELDEP

        
      

      
        	
          Configuration Item

        
        	
          CAESAR51:SERVER1

        
      

      
        	
          Estimated duration

        
        	
          4:00

        
      

      
        	
          Predecessors

        
        	
          20

        
      

    

    7.	Update the predecessors list of task 40 Update Release progress to: 31, 32

    To assign the software package to the implementation tasks, the release owner must open each software distribution task in the Activities and Tasks application, and set the Software package attribute SWPKG to the software CI that was tested and accepted previously.

    After the implementation tasks are created and the sequence is defined, the release owner can return to the Release application. Verify that the tasks were properly defined. In this example, the workplan map of the exploded Distribute and Install release activity looks like Figure 12-22.
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    Figure 12-22   Verifying the roll-out plan with workplan map

    The roll-out plan for the release is now defined. Implementation tasks have been created, sequenced, and assigned to source and target configuration items.

    Scheduling release implementation

    Ultimately, the release modifies components in your infrastructure. It must be processed according to the policies set forth by your organization. Therefore, create an implementation schedule that takes into account change windows and blackout periods that are associated with the targets of the release.

    Now, the roll-out plan is fully specified, identifying all the implementation tasks and their targets. But before the roll-out plan can be approved, it must be scheduled.

    Scheduling the release is performed by using the Scheduler application. This provides a Gantt chart view of your release project that gives you graphical capabilities to manipulate activity and task dates, duration, and relationships. In addition, it visualizes availability of both CIs and people that are assigned, so you can adjust the plan to meet the available resources. When you define a new project, one or more queries are specified to filter that tasks to be included in the schedule. 

     

    
      
        	
          Using the Scheduler: To use the Scheduler application for a release, create your own scheduler project. Specify the query to include the activities and tasks from the release that you want to schedule. This flexibility allows you to include the same tasks in several projects, or multiple projects for a single release. For example, you can create a project to help you plan and manage the develop, build, test, and plan activities, and another scheduling project for the implementation activity.

        
      

    

    In this example, a schedule is created to plan the tasks within the Distribute and Install release activity. From the Scheduler application, the release owner creates a new schedule as per Table 12-12.

    Table 12-12   Scheduler project details

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Description

        
        	
          Schedule of WebSphere Application Server v7 fix pack 123 deployment

        
      

      
        	
          Start Date

        
        	
          11/15/12 09:00:00

        
      

      
        	
          Refresh when opening Gantt view?

        
        	
          Selected

        
      

    

    To filter the tasks included in the project to the ones that are part of the Distribute and Install release activity, a work query is defined as per Table 12-13.

    Table 12-13   Scheduler project work query

    
      
        	
          Field

        
        	
          Value

        
      

      
        	
          Data Source

        
        	
          WOACTIVITY

        
      

      
        	
          Query name

        
        	
          Implementation activity for Release 1210

        
      

      
        	
          Description

        
        	
          Implement WebSphere Application Server v7 fix pack 123

        
      

      
        	
          Where condition

        
        	
          wonum = ‘1244’ and siteid = ‘PMSCRTP’

        
      

    

    The work order number defined in the query refers to the Distribute and Install release activity defined in the release example. After the query is set and the project is saved, the release owner can ensure that the expected tasks are included in the schedule by opening the Gantt view tab. 

    As shown in Figure 12-23. all tasks are included as expected.
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    Figure 12-23   List of tasks that are included in the schedule

    From the Gantt view tab, IBM SmartCloud Control Desk provides an automated way to recalculate the schedule of the whole project. It takes into account the resource constraints marked as enforced, such as dependencies, or availability of resources. After the release owner clicks the Perform Critical Path Method on All Rows icon from the toolbar, the task dates are automatically modified to look like Figure 12-24.
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    Figure 12-24   Automatically calculated critical path for the schedule

    This shows that the installation activity is spread across ten days. IBM SmartCloud Control Desk automatically scheduled the three software distribution tasks during the change window for application servers defined during pre-implementation, on Saturdays from 7 am to 5 pm. Because the change window time frame was not long enough for the three deployments to be completed, the update to the application server that hosts the order management application was automatically moved to the next weekend. 

    To turn off the resource constraints, such as change windows or blackout periods, the release owner can clear the Enforce check box.

    To rearrange the schedule of individual tasks, for example to avoid too much time between the preparation tasks and the deployment, the release owner can select the graphical representation of the task and drag it to a better date and time. 

    Only after the release owner clicks the Commit Changes icon from the toolbar, saving the project, does IBM SmartCloud Control Desk apply the calculated dates to the tasks. 

    Approving roll-out plan and impacted CIs list

    After the release is planned and scheduled, the system generates a task to the release administrator to approve both the roll-out plan and the list of impacted CIs.

    To facilitate the decision, the release administrator can open the release record and see the information required:

    •The list of target CIs is available on the main tab of the application, including targets and source CIs

    •The detail of the plan is available from the Process details tab. Because the changes were committed from the scheduling project, the scheduled start and end dates are now displayed in the list of tasks, as shown in Figure 12-25 on page 682.
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    Figure 12-25   Updated schedule of tasks

    After review, the release administrator approves and completes the last task of the Plan Release Roll out release, which updates the progress map as shown in Figure 12-26.
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    Figure 12-26   Progress map indicates that release is scheduled

    Communicate, prepare, and train for release

    Beside the task information and progress, the training preparation and delivery is not performed using IBM SmartCloud Control Desk. In terms of communication, the product sends notifications to a requester or other user from the release record. To do so, click Select action → Create → Communication.

    When you create a communication, you can use a communication template to complete the default data or create a free-form communication. If you use a template, the system might enter data such as the identifier, subject, and solution data from the originating record. For tracking and auditing purposes, the communication that is sent is added to the communication log for this record.

    In this example, no training is required to accompany the deployment of the fix pack for WebSphere Application Server. The tasks are then marked as completed, so the release record moves into the deployment phase as shown in Figure 12-27.
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    Figure 12-27   Progress map indicates that release is communicated

    Distributing and installing release

    In this phase, the release is now the responsibility of the deployer group. The list of tasks that are included in this activity, as modified during the roll-out plan, is shown in Figure 12-28.
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    Figure 12-28   Tasks for Distribute and Install release activity

    The installation actually takes place during software distribution tasks 30 to 32. However, before distributing the software, the release deployer must obtain the status of the source and target CIs, and ensure that they are in operational state. After they are operational, the release deployer can complete any required steps to prepare for deployment. This task can include steps like obtaining the correct credentials, stopping components that rely on the target CI, or backing up the existing configuration. These steps depend on the specific requirements of the release, and are defined during the roll-out planning.

    As defined in the job plan, when the first automate distribution task completes, the next one is automatically started and assigned. Because there is no integration with an operational management product in this scenario, such as IBM Tivoli Provisioning Manager, when it comes to the software distribution tasks, the release deployer assigned to the work must manually install the software package on the target CI specified on the task.

    IBM SmartCloud Control Desk provides several ways to notify the deployment specialist of the work to be performed:

    •Based on an escalation, the system can send an email notification to the user when the record matches defined criteria such as status or scheduled start date.

    •Based on a query, the system can display in a result set portlet of the start center a list of tasks that match certain conditions. Typically, a release deployer finds two lists of tasks in the start center: 

     –	My Active Tasks: This query (Example 12-1) shows the tasks that are assigned to the current user if their status is either in progress or approved. The result list is ordered by scheduled start date to facilitate the priority of the work.

    Example 12-1   My Active Tasks query
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    (woactivity.owner in (select personid from maxuser where userid=:USER) or woactivity.ownergroup in (select persongroup from persongroupteam where resppartygroup in (select personid from maxuser where userid=:USER ))) and (woactivity.istask=1) and (woactivity.status in (select value from synonymdomain where maxvalue in ('INPRG','APPR') and domainid='WOSTATUS')) and (woactivity.classstructureid is null or woactivity.classstructureid <> 'PMAPPR') order by schedstart
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     –	My Late Tasks: This query (Example 12-2) shows the tasks that are assigned to the user if they match the active criteria from the previous query and the scheduled start date or scheduled finish date is passed. 

    Example 12-2   My Late Tasks query
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    (woactivity.owner in (select personid from maxuser where userid=:user) or woactivity.ownergroup in (select persongroup from persongroupteam where resppartygroup in (select personid from maxuser where userid=:user ))) and (woactivity.istask=1) and (woactivity.schedfinish < current timestamp or woactivity.schedstart < current timestamp) and (woactivity.status in (select value from synonymdomain where maxvalue in ('INPRG','APPR') and domainid='WOSTATUS')) and (woactivity.classstructureid is null or woactivity.classstructureid <> 'PMAPPR') order by schedstart
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    Figure 12-29 shows a start center where result sets are associated to these queries. 
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    Figure 12-29   My Tasks result sets in start center

    The release deployer documents the work that is performed and the final status in the work log. The task is then marked as complete. Complete the tasks until the activity is completed. Eventually, the progress map of the release record indicates that the release as complete, as shown in Figure 12-30.
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    Figure 12-30   Progress map indicates that the release is complete

    Reviewing the release implementation

    The purpose of the review is to verify that the release implementation was carried out successfully, and achieved the expected outcome. This can be included as an activity in the final step of the release, in which case the release owner must perform it.

    This release scenario example was based on two approved changes. The relationship between the records was automatically established by the system, either directly or through a release process request. Escalations were configured to automatically complete the changes upon completion of the release.

    The result of this application can be seen by the change management on the change records that now show a COMP status, or by the release management team on the related records tab of the release, as shown in Figure 12-31.
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    Figure 12-31   Originator changes completed

    12.3  Integrations

    In the previous release end to end scenario, the deployment of the software was performed manually by a deployer specialist. However, operational management products, such as IBM Tivoli Provisioning Manager, are often used to run the actual deployment.

    This section provides guidance and references on how to integrate IBM SmartCloud Control Desk release management with IBM Tivoli Provisioning Manager.

    12.3.1  Integration modules for Operational Management Product 

    IBM SmartCloud Control Desk provides integration modules (IMs) that enable you to integrate your release management processes with an operational management product (OMP): IBM Tivoli Provisioning Manager version 7.2.x. 

    This product allows you to use the configuration item in the CMDB to provide information directly to IBM Tivoli Provisioning Manager. Although the actual implementation of the deployment is run by IBM Tivoli Provisioning Manager, it is still controlled through the release management process in IBM SmartCloud Control Desk.

    Using the IM integration capabilities, you can run launch-in-context, software distribution, and DML-related operations:

    •IM launch-in-context support

    If you are using IBM Tivoli Provisioning Manager with the IM that is provided with this product, you can start directly from the GUI to Tivoli Provisioning Manager. You can, for example, check the status of a deployment during software distribution or logical device operation.

    •IM software distribution support

    The IMs help streamline operations in which you use a release to distribute software packages. Define a software distribution task as part of the release work plan. A user who creates or performs the task can define the source software image CI to be deployed. The software distribution task also includes information about target CIs and the OMP to be used. A single click then carries out the distribution.

    The Deployments application is used to carry out deployments. The source CI that you specify for a deployment is a software image CI that is stored in a DML repository.

    •DML integration

    The product provides comprehensive features that enable you to manage DML repositories in which to store and protect the definitive, authorized versions of all of the software package CIs that are registered to the Configuration Management Database (CMDB). A DML repository might consist of one or more software libraries or file-storage areas. You can add, remove, and import software image CIs to a repository. If a software image CI is imported from an OMP, you can use the CI as a source for a deployment using a Software Distribution task.

    The integration module for IBM Tivoli Provisioning Manager can be installed from the installation launchpad. 

    12.3.2  Deploying using an Operational Management Product

    When operational management products are used for software distribution, such as IBM Tivoli Provisioning Manager, the release deployer specialist must create a deployment for each combination of software package and target systems.

    In the previous example, where one software package is deployed to three target configuration items, three deployments must be created. That is, one is needed for each software distribution task that was created in the roll-out plan.

    When deploying the software as per the schedule in the roll-out plan, a task classified as software distribution is assigned to the release deployer. As per the PMRELEASE job plan provided with IBM SmartCloud Control Desk, software distribution tasks are set with an assisted workflow to guide the user.

    When the release deployer clicks Start Assisted Workflow, the system automatically creates a new deployment record populated as per the task information, and takes the user to the Deployments application. The Deployments application is used to distribute software packages to a set of target computer system CIs. 

     

    
      
        	
          Note: To use Tivoli Provisioning Manager for a deployment, you must have installed the associated IM. If you have a different OMP that you want to use for deployments, create a custom IM and set up deployments that use that OMP.

        
      

    

    In a deployment, the deployer specialist specifies the OMP to use, the necessary parameters to interact with the OMP, the source and target CIs, and optional configuration parameters that are required by the installation procedure. You can think of deployments as fully automated change implementation tasks, with specific capabilities to interact with a software distribution OMP:

    •The software package referenced as SWPKG in the software distribution task is transferred to the deployment as the source CI.

    •The target CI indicated in the software distribution task is transferred to the deployment as the target CI.

    •The release deployer must defined the operational management product in the OMP ID field, which displays read only information in the OMP information section.

    To trigger the deployment, the release deployer can click Deploy at the bottom of the console, as shown in Figure 12-32.

    [image: ]

    Figure 12-32   Deployment

    Upon completion, the deployment record status changes to Success.

    12.4  Conclusion

    This chapter described how IBM SmartCloud Control Desk Release Management features help you manage complex changes with built-in dependencies. 

    The end to end scenario focused on running a mass roll-out of WebSphere updates to a number of servers in your infrastructure. It presented different ways to transfer the implementation of the change to the release team, whether by using a direct change or through a release process request. To facilitate the processing of the release record from initiation to implementation in accordance to ITIL best practices, a job plan was applied with powerful flow control and automation features to manage the work.

    You experienced how the DML is used to control your approved installation code and other media, such as documentation. You also experienced how the scheduler application features can help you to find time slots for the implementation tasks when outages to the target CI are tolerated by your organization. 
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Service Provider

    The Service Provider Edition is designed to support service as a business. For IT organizations that operate as a profit center, rather than as a cost center, the customers are billed in the form of chargebacks for the assets managed and the services provided. External IT service providers maintain the assets of their customers and provide services to them for a fee. 

    In each case, the service provider has a number of customers, and has one or more customer agreements with each of them. Periodically, the customers are charged back or billed according to the provisions of the customer agreement between the IT organization and the customer.

    This chapter includes the following sections:

    •Service provider overview

    •Service provider capabilities in SmartCloud Control Desk

    13.1  Service provider overview

    It is critical that a service provider be successful in three areas: 

    •Controlling costs.

    To control the costs of deployment and infrastructure management, a service provider must be able to manage the assets of their internal or external customers on a single database. In the SmartCloud Control Desk Service Provider Edition, create and manage your customers, and associate each customer with the locations, assets, and configuration items that you are managing for that customer. You can also link customers to service level agreements, response plans, domain values, solutions, classifications and attributes, and bulletin board messages so that service delivery can either be global or tailored to the needs of individual customers. Security access can be defined so that a user can have access to all customers, a group of customers, or a single customer.

    •A consistent response to any request from a customer.

    Consistent, repeatable delivery of services in response to any anticipated service request or the fulfillment of service catalog requests is a major factor in the efficiency and profitability of service providers. The use of the response plan can automatically assign the appropriate person or group to be responsible for handling each request. It can also select the appropriate job plan or template to accomplish the requested work, notify the appropriate individuals about the work in process, and determine the next steps that are needed.

    •Timely and accurate chargebacks and billing.

    IBM Maximo for Service Providers maintains the agreements that exist between the service provider and each customer.

    The customer agreements specify the maintenance services that are performed so that each request for service can be validated to ensure that the customer is entitled to that service under the requested conditions. They are also used to calculate the prices that are charged for these services.

    Maximo for Service Providers can calculate prices in various ways:

     –	Automatic monthly billing (these transactions are generated automatically by billing schedules):

     •	Fixed Fees. Fixed monthly fees for services or for equipment service agreements, or for scheduled usage, or planned services are generated and included in a billing batch.

     •	Fees for managing assets. A base price is specified for the asset or configuration item classification, and extra incremental prices are added by examining the features and configuration of each asset or configuration item. Each managed asset is billed on a separate line in the billing batch.

     •	Fees for asset usage are calculated by multiplying the usage units (for example, GB of storage, # of pages printed, miles driven, or square feet of space) by a unit price. Asset usage is measured, and a price is calculated as a product of the unit price for the type of usage that is multiplied by the measured usage units.

     –	Work order and ticket pricing (these prices are calculated according to price schedules):

     •	As maintenance activities are performed, prices are calculated based on the cost of the labor, materials, services, and tools used. Additionally, pricing for the use of labor, can be calculated by using a published list price, or pricing for service items. Or material can be calculated by using a published list price or a discount from that list price.

     •	A quoted price can be specified; either a fixed quote or a “not to exceed” quote. A fixed quote is used as the price, and a “not to exceed” quote is used as the price if the calculated price exceeds the quote.

     •	Minimum prices can be defined, and included charges (such as billing a work order only after a threshold has been reached) can be specified.

     •	Asset performance can be measured by a KPI (key performance indicator), and a price is calculated from the level of performance measured.

     •	One-time charges for asset moves, adds, or changes are calculated by using the price that is specified for the specific service requested.

     

    
      
        	
          Watch your pricing: All of these calculations are governed by the pricing rules that are contained in the customer agreement.

        
      

    

    Periodically, the work orders, tickets, and sales orders that contain these calculations are extracted by the billing process and collected into a batch. There is one batch for each customer agreement. This batch is then reviewed by the service provider who can review the details of the bills, and adjust the pricing, if necessary. Limited details of the batch can also be reviewed by the service provider’s customers so that the customer can pre-approve the invoice. This process can speed up payment of the invoice.

    After the reviews are complete, the billing batch can be forwarded to the service provider’s accounting system so that a customer invoice can be prepared.

    13.2  Service provider capabilities in SmartCloud Control Desk

    The SmartCloud Control Desk Service Provider Edition provides extra functions by adding new applications that are unique to the Service Provider Edition and by expanding functionality in many of the existing applications.

    13.2.1  Applications

    The applications within the Service Provider Edition that deliver this functionality are described in Table 13-1.

    Table 13-1   Application overview 

    
      
        	
          Application

        
        	
          Description

        
      

      
        	
          Customer

        
        	
          This application is used to manage information about the customer such as billing address, currency, contact persons, communications log, and so on. Customers own the customer agreements and the agreement’s price schedules. Customers are associated with persons, locations, assets, and configuration items. When a ticket or work order is created, the customer is copied to the ticket, sales order, or work order based on these relationships.

           

          The relationship between a customer and any object is used by the security processes within the service provider to ensure that access to any customer information is controlled. This ensures that only authorized users can view or update information that is related to a customer.

        
      

      
        	
          Customer Agreement

        
        	
          The customer agreement contains the customer billing address, the customer business address, the general terms and conditions of the agreement, including the start date, expiration date, and billing frequency. Customer agreements own the agreement price schedules, which contain the business rules that are used to calculate prices on work orders, tickets, and sales orders. They also own the billing schedules that automatically generate repetitive billing for fixed fees, items under agreement, planned usage, managed assets, and actual usage. Customer agreements are revisable objects. After an agreement is approved, it might not be changed. Instead, a revision of the agreement can be created. After the revision is approved, the approved revision replaces the prior revision.

        
      

      
        	
          Agreement Billing Schedules

        
        	
          IT organizations typically base their chargebacks to internal customers on the number and type of assets that are under management or on the use of those assets. Billing schedules can automate this process. A billing schedule has a start bill date, and a term (in months). The billing schedule identifies the list fixed fees, items under maintenance, scheduled service charges, planned usage charges, managed assets, and actual usage that is billed. Each month, a bill batch is created, and each of the detail elements specified on the billing schedule is created as a line item in that bill batch.

        
      

      
        	
          Agreement Price Schedules

        
        	
          Agreement price schedules are used to calculate pricing on work orders (activities, changes, releases) or tickets (service requests, incidents, problems). A customer agreement can contain any number of agreement price schedules, each of which contain price calculation rules. Prices in SmartCloud Control Desk Service Provider can be fixed prices. They can be specified as a list price (electricians are $55 per hour, or evening work is $75 per hour, or a hydraulic pump is priced at $2,308.56), or they can be calculated as a function of cost (that is, a mark-up). A price can also be selected based on an attribute on the work order, ticket, or sales order that is independent of cost. For example, a price schedule can specify that labor is priced as a 20% mark up of the labor cost. Alternatively, a price schedule might say that support services for class C application servers that are running critical applications are priced as $735 a month. Price schedules are owned by customer agreements. They contain a set of pricing rules, and a set of conditions that specify when and under what conditions the price schedules are used.

        
      

      
        	
          Customer Billing

        
        	
          The Billing application provides batch control functions. A billing batch is created for each customer agreement according to the billing frequency specified in the agreement. The batch consists of all the work orders, tickets, and sales orders that were completed during the billing period (and unbilled transactions from prior billing periods). If specified by the price schedule, approved transactions on open work orders are included in the bill batch. The Billing application is used by the service provider to review (and adjust, if necessary) any transactions in the batch. After the service provider reviews the batch, they can allow their customer to review the batch before the batch is sent on to the service provider’s accounting system for invoicing. There is a separate application (Bill Review) that is intended to provide a secure, and less detailed view of the batch for the customers’ view.

           

          Bill batches can also be created automatically by the billing schedules in the customer agreement. These bill batches contain bill lines for fixed fees, items and service items listed in service agreements, managed assets, and asset or location usage.

        
      

      
        	
          Billing Review

        
        	
          This application is used by the service provider’s customers to review the work orders, tickets, and sales orders that are included in the batch. If the customer has questions on any of these work items, they can be discussed with the service provider and answered before the bill is finalized.

        
      

      
        	
          Work Order, Activities, Changes, Releases

        
        	
          For the Service Provider Edition, these applications have been enhanced to include the customer information, and billing status and billing history. Prices are calculated whenever planned or actual transactions are added to the work order. The ability to add miscellaneous fees and charges (for example a trip charge) is included. The enhancements also support the use of price quotes on a work order. There are two types of quotes that are used in SmartCloud Control Desk Service Provider: Fixed price quotes and not to exceed price quotes. The enhancements to the Work Order application are included in the Activities, Changes, and Releases applications because these all share an MBO.

        
      

      
        	
          Service Request, Incidents, and Problems

        
        	
          For the Service Provider Edition, these applications have been enhanced to include the customer information, and billing status and billing history. Prices are calculated whenever planned or actual transactions are added to the incident. As with work orders, the ability to add miscellaneous fees and charges is included.

        
      

      
        	
          Sales Order

        
        	
          The sales order is used to bill adjustment transactions for manually issued credits for adjustments. Sales orders are generated automatically by the billing schedule for monthly maintenance fees, the billing for IT asset management, usage, or performance, and the issuance of credits.

        
      

      
        	
          SLA

        
        	
          Service level agreements (SLAs) calculate target dates and times for tickets and work orders. Functionality includes the support of the SLA hold function, and the use of de-centralized calendars to support the use of SLAs by clients who operate in multiple time zones. In the service provider context, service level agreements can be associated with one or more customers, or they can be global. 

        
      

      
        	
          Response Plan

        
        	
          Response plans are used to provide consistency in the service management process and in the fulfillment of service catalog offerings. It does this by removing the need for service agents or maintenance supervisors to decide what processing takes place in a specific situation. For example, if the conditions can be defined for when a template is applied to a ticket, this template can be applied automatically by the response plan. This eliminates the need to train the service agent to recognize when to apply a certain template, and also removes a source of error from the process. Response plans can be associated with one or more customers, or they can be global.

           

          The Response Plan uses a rules engine to determine: 

          •The Person or Group responsible for the work order or ticket

          •The Vendor to whom work must be assigned

          •The Job Plan to be used for a work order

          •The Ticket Template to be used for a Ticket

          •The Solution to be used for the Ticket

          •The Supervisor for the Ticket or Work Order

          •The Lead for the Work Order

          •The Work Group for the Work Order

          •The Crew to be assigned to the Work Order

          •Notifications to be issued for the Ticket or Work Order

          •Additional Actions to be performed to complete the repair or service delivery.

        
      

      
        	
          Location

        
        	
          Locations can be linked to one or more customers, and usage information can be input or imported for a location.

        
      

      
        	
          Asset

        
        	
          Assets can be linked to one or more customers, and usage information can be input, or imported for a location. The classification of an asset, and the specifications (for example, memory size and operating system) are used to calculate the monthly asset management fee, according to the rules defined in the customer agreement. If the asset is linked to a CI, the customers are synchronized between the asset and CI.

        
      

      
        	
          Configuration Item

        
        	
          Assets can be linked to one or more customers, and usage information can be input, or imported for a location. The classification of an asset, and the specifications (for example, memory size and operating system) are used to calculate the monthly asset management fee, according to the rules defined in the customer agreement. If the CI is linked to an asset, the customers are synchronized between the CI and the asset.

        
      

      
        	
          Security Groups

        
        	
          Security groups are used to define the authority that users (group members) have to access applications and to access data within an application. In SmartCloud Control Desk Service Provider, this application provides a simple method of specifying the authority to access customer information by users who are members of the group. Generally, these authority rules are set up differently for users who work for the service provider and for those users who work for the service provider’s customers. The following access options are provided:

          •Authorize Group for All Customers including customer level information that is not related to a Customer

          •Authorize Group only for Customer level information that is not related to a Customer.

          •Authorize Group for Person’s Customer/Vendor, but not for Customer level information that is not related to a Customer

          •Authorize Group for Customers in Person’s Customer Access List and for Customer level information that is not related to a Customer

          •Authorize Group for Customers that are listed on the Security Group and for Customer level information that is not related to a Customer

        
      

      
        	
          Customer Objects

        
        	
          The Customer Objects application is used with the database configuration tools that allow a Maximo administrative user to add tables and relationships to the Maximo database. The Customer Objects application allows the specification of the security access rules for any newly created table that is related to the customer object.

        
      

      
        	
          Classifications and Attributes

        
        	
          Classification structures are used to categorize information in SmartCloud Control Desk and to assign attributes related to a classification. For example, desktop computers have disk size, processor speed, and memory size as attributes, whereas computer operating systems have a version number.

           

          SmartCloud Control Desk Service Provider adds a customer link to both the classification structure and the attribute. For example, a service provider can allow one customer to track just the version number for their operating system assets, and allow another customer to track the version number and patch level for operating systems.

        
      

      
        	
          Domains

        
        	
          In the Service Provider Edition, the synonym, ALN, and numeric domains allow a domain value to be customer-specific. Filtering and validation of domain entries is based on the customer (or primary customer) on the object to which the domain value is being added.

        
      

      
        	
          Solutions

        
        	
          In the Service Provider Edition, solutions can be global or customer specific. Filtering and validation of a solution is based on the customer and the object to which the solution is being associated.

        
      

      
        	
          Bulletin Boards

        
        	
          In the Service Provider Edition, bulletin board entries can be customer-specific. A customer sub tab has been added to the audience tab, and the user’s security group is used to filter bulletin board messages that are displayed on the start center and broadcast through email.

        
      

      
        	
          Item Master, Offerings, and Service Items

        
        	
          A customer association has been added to the item table, and a tab has been added to display the history of list prices for the item. The list price history is a view of the prices, and the effective date of those prices, that were defined in price books that reference this item or service Item.

        
      

      
        	
          Price Books

        
        	
          There are four types of price books that define list prices for items, offerings, service items, and tools. There can be more than one price book for each type to allow service providers to offer varying levels of prices to different categories of customers. A price book can be revised to reflect price changes, and revision effective dates are used to determine the price that is to be used for a specific transaction. Price schedules and billing schedules allow the selection of a price book for any pricing rule that references list price. The service catalog uses the price book to access the estimated price for an offering.

        
      

    

    13.2.2  Use cases and scenarios

    Many IT organizations operate as a profit center, and use charge backs to bill their services to the operational departments that they serve. Commercial IT asset management companies use a similar, but more formal process, to generate revenue for their business. Consider these use cases:

    •An Electronic Support Systems Company (ESS) provides IT support for their clients. ESS bills each of their clients a monthly fee. The fees for managing IT assets depend on the type of asset that is being managed, and the features or configuration of those assets. Additionally, ESS provides services to their clients and bills the clients based on the usage of those services. For example, for email services or storage services, clients are billed based on the amount of storage space that is used. For backup and restore services, clients are billed based on the backup file size, the frequency of backups, and the number of generations of backups stored.

    •On a monthly schedule, customers are billed for the managed asset charges. The process consists of scanning the configuration database, and for each asset for which there is a management charge, calculating a price for that asset. The price is the sum of the unit price for the type of asset and any surcharges for the features or configuration of the asset.

    •Also, on the same monthly schedule, the values in the various usage meters are used to generate billing for the recorded usage of the assets.

    13.2.3  Customer management

    Use the Customers (SP) application to create, view, modify, and delete customer records. Customer records contain the following information about your customers:

    •Business and billing addresses

    •Internal contacts and customer contacts

    •Associations with customer agreements and price schedules

    •Associations with parent or child customers.

    •Customer logs

    Creating customers

    To create a customer and associate a person with the new customer, complete these steps:

    1.	Click Go To Service Provider → Customers (SP).

    2.	From the Toolbar menu, click the New Customer icon. The system displays a blank customer form that is ready for input as shown in Figure 13-1 on page 701.
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    Figure 13-1   New customer entry form

    3.	Enter the information for the customer and change the Status to ACTIVE. After the customer is active, you can associate the customer with these items:

     –	Assets

     –	Locations

     –	CIs

     –	Solutions

     –	Service level agreements

     –	Response plans

     –	Bulletin board messages

     –	Classifications and attributes

     –	Persons

     –	Deployed assets

     –	Reconciliation tasks and rules

    Placing restrictions on customer information

    You can restrict the customer information that users have access to by using security groups that the users are assigned to. Use the customer tab in the Security Groups application to define these access rules, as shown in Figure 13-2.
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    Figure 13-2   Customer access options

    There are five types of access to customer information that can be granted to members of a Security Group, as listed in Table 13-2.

    Table 13-2   Customer access options

    
      
        	
          Access option

        
        	
          Description

        
      

      
        	
          All customer information 

        
        	
          The user has access to all customers and customer level data for all customers.

        
      

      
        	
          No customer restricted information 

        
        	
          The user has access only to unrestricted customer level information.

        
      

      
        	
          Only information for the customer on the user’s person record

        
        	
          The user has access to customer data for the customer that is referenced on the user’s person record. This is the customer referenced in the field Customer/Vendor.

           

          The user has no access to unrestricted customer-level objects. There is one exception: The user has access to unrestricted classification and attribute records.

        
      

      
        	
          Customer information about the user’s customer access list

        
        	
          The user has access to customer-level information for customers on the person’s customer access list and to all unrestricted customer-level information.

        
      

      
        	
          Customer information listed below 

        
        	
          The user has access to customer-level information for customers on the security group’s customer access list and to all unrestricted customer-level information.

        
      

    

    Filtering of customer information

    In addition to the restriction of access to customer information based on the authority of the user, customer information is also filtered. This filter can be based on the customer association with a work order, ticket, asset, location, or configuration item. For example, when a classification is added to an asset, a classification can be selected only if the classification is a global classification or if the classification is associated with the customer who is the primary customer for that asset. After the classification is linked to the asset, the attributes for the classification are similarly filtered. Attributes are copied to the asset only if they are global, or if they are associated with the primary customer on the asset.

    13.2.4  Customer agreements

    Customer agreements are used to define the pricing and billing rules for the services to which customers are entitled. Customers are billed or charged back for services in two ways:

    •Charges for the work performed or the services delivered. The labor, material, services and tools, and any special one time charges are recorded on tickets or work orders, and the pricing rules defined on a price schedule are used to calculate the price of the service.

    •Charges for managing assets or for the usage of assets. The billing schedule is used to define the monthly charges for managing assets or for usage.

    Creating and revising agreements

    Use the Customer Agreements (SP) application to create, manage, and revise customer agreements, as shown in Figure 13-3 on page 705.
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    Figure 13-3   Customer agreement

    Price schedules

    There can be any number of price schedules for a customer agreement. Each price schedule specifies the conditions when that price schedule is linked to a ticket or work order, and defines the pricing rules that are used to calculate the prices.

    In this example, the price schedule is used to calculate the price for a non-emergency change request related to server management, as shown in Figure 13-4.

    [image: ]

    Figure 13-4   Price schedule

    The pricing rules in this case specify that a fixed amount of $100.00 is charged for the change. This is just one of many options for pricing tickets or work orders. Prices can be specified as fixed hourly rates, or calculated as a percentage markup from the cost of labor or materials or services that are used to perform the work.

    Billing schedules

    Billing schedules are used to generate billing transactions for fixed monthly fees, and for monthly bills for managing assets for actual usage of an asset or a location. Billing schedules can also be used to bill for fixed rental or capacity charges. There can be any number of billing schedules defined by a customer agreement. After a billing schedule is created, the fixed fees, assets, and usage are billed automatically each month. The amount charged for each managed asset is calculated by using the amount specified for the asset’s classification as the base amount, and adding to it the price for the capacity or configuration of the asset.

    In the example shown in Figure 13-5, assets that are classified as servers are charged 12.75 per month as a base charge. During the monthly billing cycle, a billing transaction is created for each asset classified as a server, and the price is calculated after examining the attribute values of the asset. The number of processors is multiplied by 2.5, the memory size in GB is multiplied by 0.75, and the disk size in GB is multiplied by 0.5. The result of these calculations is added to the base fee of 12.75. Finally, if the server’s operating system is Linux, an additional charge of 3.25 is added. 

    [image: ]

    Figure 13-5   Billing schedule with asset management pricing

    Usage pricing, shown in Figure 13-6, is specified by defining a price for each type of usage. 
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    Figure 13-6   Actual usage pricing

    Usage values can be manually entered or imported into usage meters that are associated with assets or locations. During the billing cycle, the usage that has been recorded is collected, and a billing transaction is created for each type of usage specified in the billing schedule. The price is calculated by multiplying the number of units recorded by the unit price specified in the billing schedule.

    13.2.5  Customer billing

    Customer billing is the process of collecting the billing transaction into a bill batch and reviewing the transactions. Transactions can be adjusted or corrected during the review process. After the review process is complete, the transactions in the bill batch are forwarded to an accounting system to be processed in the ledger.

    The billing process

    Bill batches are created automatically by the billing schedule for fixed fees, usage, and managed assets. Bill batches are created manually for the billing of transactions such as work orders and tickets.

    The bill batch is created during the INPROGRESS status, and is moved through a series of statuses during the review process. After the status of the bill batch is changed to BILLED, the transaction in the bill batch are forwarded to the accounting system. As shown in Figure 13-7, the billing process begins with the customer and the customer agreement. The price schedules are used to add the prices to the tickets and work orders, and the billing schedules generate sales orders for fixed fees, asset management, and asset usage charges. In both cases, the resulting billing batches are reviewed before being exported to the accounting system for final processing. 
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    Figure 13-7   The billing process

    On-demand bill batches

    Use the Customer Billing (SP) application to create a bill batch. Enter the customer and customer agreement, the bill end date, and the financial period, as shown in Figure 13-8.
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    Figure 13-8   Creating a bill batch

    You have the option of selecting ticket, work order, or sales orders for the bill batch, or you can select Copy WOs, Tickets and SOs. Depending on your selection, the bill batch will collect and display work orders (including changes, activities, and releases), tickets (including service requests, incidents, and problems), and sales orders (used for credits and adjustments) that are ready for billing. Transactions will be selected if they are in the proper status, and if the completion date is on or after the bill end date or if the transaction’s financial period is on or before the specified financial period.

    Automatic bill batches created from billing schedule

    These bill batches are created automatically by the billing schedule. The billing schedule specifies the initial status of the bill batch. If that initial status is BILLED, the bill batch does not require review, and is sent directly to the accounting system. If the initial status is INPROGRESS, the bill batch is reviewed in the customer billing application, and then sent to the accounting system.

    13.3  Conclusion

    This chapter reviewed the SmartCloud Control Desk Service Provider Edition, which adds functions to SmartCloud Control Desk to enable the IT organization to be run as a profit center or as a business unit. It includes a customer management module that allows the IT organization to manage multiple customers or organizations in a single database. This function provides the ability to restrict a user’s access to only one customer and to restrict access to only a subset of the customers. It includes a customer agreement module that allows the IT organization to identify and enforce variable entitlement and pricing rules for the services delivered. And it includes a customer billing module that can collect and export the financial information related to chargebacks and billing to the accounting system after it has been reviewed and corrected.
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Appendixes
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Troubleshooting

    This appendix addresses how to resolve issues that you might encounter, and what extra information to collect when you are working with support. The miscellaneous section addresses some of the more common issues that are encountered by users.

    This appendix includes the following sections:

    •What to look for

    •What support must help you with

    •Miscellaneous issues

    What to look for

    This section lists the various logs to use when dealing with issues in different areas of IBM SmartCloud Control Desk. 

    The approach of what to do with that information is the same for all:

    1.	Inspect the log to find any errors or messages that seem to coincide with the issue you are trying to troubleshoot.

    2.	If the message does not give you a clear direction, search the SmartCloud Control Desk product page for technotes.

    3.	If all else fails, contact support with the collected logs. For more information, see “Logs for Self Service Center” on page 717.

    Inspecting the logs and error messages

    Error messages found in the logs and those displayed on the panel are in the form of five letters, four numbers, and then a message type single character. For example, BMXAA4211E. If the text of the message does not reveal an action for you to take, search the SmartCloud Control Desk product page for the error message number.

    Take note that the identifier itself gives you a clue of the source of the error. Message codes that begin with BMXAA are generated from the Tivoli's process automation engine code. This is an indication of something more fundamental that needs to be addressed. Message codes that begin with CTG are generated from some of the apps that have to do with the Service Desk, Service Catalog, and Tivoli Change and Configuration Management Database (CCMDB) functions. These are typically CTGIN or CTGCC.

    After you have a message code, search for technotes of known issues. Go to the SmartCloud Control Desk support product page at:

    http://www.ibm.com/support/entry/portal/overview/software/tivoli/ibm_smartcloud_control_desk

    Enter the error message ID in the Search support and downloads field.

    Logs for app use

    The most common use of SmartCloud Control Desk is working in the various apps and the Start Center. When issues arise here, capture the systemout.log and systemerr.log files from the App Server immediately after you re-create the issue. For most cases, you do not need to turn up the logging. If you do need to, go to the Logging app (Go To → System Configuration → Logging) and set the appropriate logger for that app to DEBUG.

    In addition, if there was an error on the panel, get a snapshot of it as well.

    Logs for Self Service Center

    If you encounter an issue on the Self Service Center user interface that is not in the equivalent apps in standard user interface, capture the Java Console. The Java Console is something that you access through your web browser.

    Tivoli Integration Composer

    Tivoli Integration Composer execution messages are stored in fusion.log files found in the Integration_Composer/log directory. The size and number of these logs are controlled by properties in the Integration_Composer/data/properties/logging.properties file. 

    log4j.appender.A2=org.apache.log4j.RollingFileAppender

    log4j.appender.A2.File=fusion.log

    log4j.appender.A2.MaxFileSize=5MB

    log4j.appender.A2.MaxBackupIndex=5

    log4j.appender.A2.Append=false

    If Tivoli Integration Composer is run in debug mode, the fusion.logs file will probably roll over. You can use these properties to modify the size and number of the logs, or you can pipe the Tivoli Integration Composer execution standard output to a file.

    The fusion.properties file must contains the following property: 

    mxe.fusion.mapping.showRecordCounts=true

    The Tivoli Integration Composer output contains an execution summary for the number of database entries created, updated, and deleted. It also shows the number of major errors Tivoli Integration Composer encountered, and the total execution time that was required. 

    Duplicate DIS GUIDs

    Tivoli Integration Composer 7.5 might generate duplicate DIS GUIDs1 for virtual computer systems. Complete the following steps on all environments that first installed SmartCloud Control Desk 7.5 to validate/fix the cleansing rules file:

    1.	Access the Integration Composer directory (usually named Integration_Composer) and edit file Integration Composer\data\properties\nrs\cleansingRules.xml.

    2.	Look for the following lines at the end of the file:

    	<Rule major="ComputerSystem" minor="VMID">

    		<Regex pattern=".*" format="" />

    	</Rule>

    3.	If these three lines exist, delete them and save the modified file.

    This file was fixed in Tivoli Integration Composer 7.5.0.1. However, if you started with SmartCloud Control Desk 7.5, verify that the rule for VMID no longer exists in the cleansingRules.xml file.

    Understanding filtering

    For a fresh Tivoli Integration Composer 7.5 installation, the default filtering is to use the authorized CI promotion scope. If Tivoli Integration Composer was installed as a 7.5 upgrade, the default type of filtering used is classification filtering (setting -1 to a classification name in the ccmdb.properties file to skip importing those types of CIs.)

    To verify which type of filtering is enabled, open the file Integration Comoposer\data\properties\provider\ccmdb.properties and search for the property ccmdb.actualci.filtering.level=. The value 0 indicates that Tivoli Integration Composer classification filtering is being used. The value 2 indicates that the Auth CI promotion scope is used to filter out both classifications and attributes. In other words, only actual CIs that are promoted into authorized CIs are imported from Tivoli Application Dependency Discovery Manager.

    It is important to note that using Auth Promotion Scope filtering during an Tivoli Integration Composer delta load (when importing only new and changed actual CIs) results in updating existing actual CIs only if a linked authorized CI also exists. Any CIs existing in Tivoli Application Dependency Discovery Manager but not in the SmartCloud Control Desk database is imported as new. 

    An example might help clarify this:

    1.	Tivoli Integration Composer is used for the first time to import Tivoli Application Dependency Discovery Manager CI data as actual CIs into the SmartCloud Control Desk database using Auth Scope filtering.

    2.	Tivoli Integration Composer is run a second time to import new Tivoli Application Dependency Discovery Manager CI data, and to update existing actual CIs to match modified Tivoli Application Dependency Discovery Manager CIs:

    a.	If a CI exists in Tivoli Application Dependency Discovery Manager, but not in the SmartCloud Control Desk database, then it is imported.

    b.	If a CI was modified in Tivoli Application Dependency Discovery Manager and there exists both an actual CI and an authorized CI, the actual CI is updated to reflect the data found in Tivoli Application Dependency Discovery Manager.

    c.	If a CI was modified in Tivoli Application Dependency Discovery Manager and only an actual CI exists, the actual CI is NOT updated. The reasoning here is that because the actual CI was not promoted into an authorized CI, it is not being managed. Therefore, there is no need to keep the actual CI up-to-date until it is promoted to an authorized CI. 

    Debugging classifications

    What happens if Tivoli Integration Composer does not create actual CIs for classifications you were expecting? Assuming that this was not due to an Tivoli Integration Composer or Tivoli Application Dependency Discovery Manager exception, complete these steps to debug the system:

    1.	Determine what type of filtering Tivoli Integration Composer is using. This is found in the ccmdb.properties file as property ccmdb.actualci.filtering.level=0|2. In this property, 0 means that classifications set to -1 in the ccmdb.properties file are NOT imported, and a 2 value means that only classifications found in the Auth CI promotion scope are imported.

    2.	For classification filtering (property set to 0), ensure that the missing classification is not set to -1, that is ccmdb.classification.depth.DEV.STORAGEVOLUME=-1

    For Auth Scope filtering, ensure that the missing classification exists as an authorized CI classification. The Auth Promotion Scope can be viewed by using the Deployer’s Workbench.

    3.	Validate that there is a path for Tivoli Integration Composer to follow to reach the missing classifications. This involves knowing which classifications are set to Active, what depths are being used to pull data from Tivoli Application Dependency Discovery Manager, and what is being filtered out. 

    For example, if you want to import CIs of classification FileSystem and the SYS.ComputerSystem is set to Active, use depth 2. In this case, Tivoli Integration Composer imports the ComputerSystem and the OperatingSystem. However, the bootsFrom relationship between OperatingSystem and FileSystem is not followed because the maximum depth of 2 was reached at OperatingSystem.

    Another example is connecting a ComputerSystem to a Business Application and running Tivoli Integration Composer with a depth of 3 with App.Application set to Active. If the topology generated looks like Application → FunctionalGroup → AppServer → ComputerSystem, a depth of 4 is necessary to reach Computer System.

    To determine why Tivoli Integration Composer did not import an expected Tivoli Application Dependency Discovery Manager CI, use the Tivoli Application Dependency Discovery Manager API command-line interface to see what Tivoli Integration Composer receives from Tivoli Application Dependency Discovery Manager starting at a top-level GUID.

    The Tivoli Application Dependency Discovery Manager api.sh and api.bat can be located at <taddm install directory>/dist/sdk/bin.

    To view the same type of data Tivoli Integration Composer receives from Tivoli Application Dependency Discovery Manager for a specific top-level CI GUID, run the following command:

    ./api.sh –u <userid > –p <password>  find –depth 4 –guid “A9A6F80AD02D3845BB924D7CFD26615C” 

    For this example, the output resembles the following:

    <Application array="1" guid="A9A6F80AD02D3845BB924D7CFD26615C" lastModified="1350562340943" xsi:type="coll:com.collation.platform.model.topology.app.Application">

     

    	<groups array="1" guid="284F0186EFD13A45A45B41E2C951C11D"      lastModified="1348955766545"    xsi:type="coll:com.collation.platform.model.topology.app.AppServerFunctionalGroup">

     

    		<members array="1" guid="C308DC3407EE347B8A47A7D32D434F22"    lastModified="1350072328679" xsi:type="coll:com.collation.platform.model.topology.app.web.apache.ApacheServer">

     

    			<host guid="335F9D19025A3364A5C31FE92D93C92B" lastModified="1350247649374" 

    xsi:type="coll:com.collation.platform.model.topology.sys.linux.LinuxUnitaryComputerSystem">

    			<type>ComputerSystem</type> 

    You can tell by the xml indentation the four depths that are found. 

    Debugging import

    There are two common reasons that Tivoli Integration Composer does not import all Tivoli Application Dependency Discovery Manager attributes.

    The first reason is that Tivoli Integration Composer is using Auth Promotion Scope filtering and the attribute is not part of the scope. 

    The less obvious reason is that Tivoli Application Dependency Discovery Manager attributes are not part of the Common Data Model. If a new attribute is added to Tivoli Application Dependency Discovery Manager, Tivoli Integration Composer will not pick up the new attribute until it is associated with a classification.

    If you add an attribute to Tivoli Application Dependency Discovery Manager, it must also be added to the SmartCloud Control Desk database. This is done by running the CI Type Tivoli Integration Composer adapter. You can verify that the new attribute was added by using the SmartCloud Control Desk UI console and viewing the attributes using the Class structure application.

    Deployer’s Workbench (DW)

    For issues with Deployer’s Workbench, it is helpful to turn on the informational logging. To do so, complete these steps:

    1.	In the Deployer’s Workbench, click Windows → Preferences → Deployer’s Workbench → Logging.

    2.	Select Log all information logging calls.

    After re-creating the issue, open the .log (the log file name only has an extension, no name) in this directory. In the case of a standard installation, this location is:

    C:\Program Files\IBM\Deployers Workbench\DeployersWorkbench\workspace\.metadata

    For Deployer’s Workbench installation issues, check this directory:

    C:\Program Files\IBM\Deployers Workbench

    You are looking for this file:

    IBM_Tivoli_Deployer's_Workbench_InstalllLog.log

    Installation

    For SmartCloud Control Desk install issues, check all the following directories on your Admin Workstation. Depending on what was being installed and how far along the installation has come, you might not have all of these directories or log files in them. Usually you want to look at the latest log files in these directories. Specifically start with the ones named as messaging logs. All these directories assume a default installation on Windows:

    C:\ibm\SMP\logs

    C:\ibm\SMP\solutions\logs

    C:\ibm\SMP\wasclient\logs

    C:\ibm\SMP\maximo\tools\maximo\log

    Performance issues

    For performance issues, first look at the environment, such as system speed, network speed, and database speed. Check whether any of these had contention with other applications for the same services. For example, are your application server and your database server on the same machine?

    In addition to checking for environment factors, open the Logging app and set the SQL logger to DEBUG to debug. This puts the SQL statement and how long they took in the Application Servers system logs.

    What support must help you with

    If you have looked at the logs and need the assistance of support, they need some extra information. Collecting all of the following information up front helps you get a speedier resolution:

    •Logs, as explained previously in this appendix

    •Version information

    •Re-create steps

    •Explanation of what you were expecting it to do

    •Explanation of what it did instead

    •Screen captures of the error and the setup

    The following sections have specifics of the above for different components within SmartCloud Control Desk. With all of the following special cases, you still need the general information and logs. That is, gather the SmartCloud Control Desk version information and the application server system logs for these as well.

    General issues with apps

    For all issues that you send to support for SmartCloud Control Desk, they need your core installed versions. To get this from the Start Center, click Help → System Information and then copy the text from the pop-up window. The text listing of your component versions is more useful for support than a picture is.

    Because SmartCloud Control Desk is a nice graphical user interface, most issues are helped by sending in a screen capture of the error and app in use.

    Integration Composer (Tivoli Integration Composer)

    With Tivoli Integration Composer, you do not just need the fusion.log. First, ensure that you have both the beginning and the end of the fusion.log. Sometimes Tivoli Integration Composer runs so long that the beginning of the log gets overwritten. The beginning contains some version information that support needs. In addition, the end of the log has the summary of the Tivoli Integration Composer run and which mapping was used.

    These are the relevant logs:

    <ITIC_Install_Dir>\IBM_Tivoli_Integration_Composer_InstallLog.log 

    <ITIC_Install_Dir>\log\fusion.log 

    <ITIC_Install_Dir>\log\fusion.properties 

    These are the Tivoli Application Dependency Discovery Manager associated log files:

    <ITIC_Install_Dir>\log\l2.log 

    <ITIC_Install_Dir>\log\error.log

    Read fusion.properties to locate the performance monitor log file and collect it.

    Also, support needs to know the Tivoli Application Dependency Discovery Manager version.

    Deployer’s Workbench

    When dealing with the Deployer’s Workbench, send in the Deployer’s Workbench log (.log file), but first create a project within the Deployer’s Workbench and attempt to re-create the issue with it. Starting clean with a new project has the advantage to removing hidden configuration changes that have been forgotten This can both solve some problems and other make the re-creation scenario simpler.

    After creating a project and re-creating the issue, export the project by clicking File → Export → Export Deployer’s Workbench Project. Support needs the exported project.

    Finally, support needs the version of your Deployer’s Workbench. Click Help → About Deployer’s Workbench. Copy the text from this pop-up or send them a screen capture of it.

    Miscellaneous issues

    These are miscellaneous tips or issues discovered by IBM.

    Setting up Tivoli Integration Composer to delete Configuration Items

    Tivoli Integration Composer and SmartCloud Control Desk need to be set up properly to delete the actual CIs from SmartCloud Control Desk that have been deleted from Tivoli Application Dependency Discovery Manager:

    1.	Enable deletes in Tivoli Integration Composer. Check the fusion.log in Tivoli Integration Composer for the following message. This message indicates that deletes are turned off:

    Example A-1   Sample from fusion.log

    [image: ]

    22 Jun 2011 11:38:18:878 [INFO] TADDMActualCI._loadResources: TADDM 

    deleted GUIDs will not be logged; actual CI deletion is disabled.

    [image: ]

    Enable it by changing this property file:

    <ITIC>\data\properties\provider\ccmdb.properties

    With that file, set the ccmdb.enable.actualci.deletion value to true.

    2.	Set up the escalation. You can enable or disable escalations in the Escalations application. To open this application, click Go to → System Configuration → Platform Configuration → Escalations. 

    The escalation that processes the actual CIs that have been flagged for deletion is called CCIDELETEACTCI. If you disable this task in the Escalations application, CIs that have been identified as deleted in Tivoli Application Dependency Discovery Manager are not deleted from Change and Configuration Management Database. 

    3.	Tivoli Integration Composer completes. When it completes successfully, the value for CCIITICCOMPLETE (in maxvars table) is set to YES. This is what the escalation looks for to know whether it needs to run. After the escalation runs, it will return it to NO so that it does not do anything until the next Tivoli Integration Composer run. 

     

    
      
        	
          Run a test first: If you want to test it before the real deletion of actual CIs, enable Tivoli Integration Composer but disable the escalation. The actual CIs marked for deletion are reported in the CCIDELETEACTCI table. If you find that these CIs should not be deleted, clear the table so the actual CIs do not get deleted after you turn on the escalation.

        
      

    

    Global Search does not find anything

    The Global Search app requires the Lucene index to first be populated. This is done by enabling a cron task that periodically updates the index. The first time this cron task is run, it will take longer than usual. SmartCloud Control Desk is not creating the Lucene index because the directory objsearchindex_EN does not exist.

    Check to see whether system property LUCENEOBJINDEX is set. It should be empty, or you can set it to the full path where objsearchindex_EN will be created. When property LUCENEOBJINDEX is empty, objsearchindex_EN is created in the <WAS install>\AppServer\profiles\<instance name> directory of SmartCloud Control Desk installation. 

    Complete the following procedure to change a system property: 

    1.	Log on to SmartCloud Control Desk as an administrator with authority to perform system configuration tasks. 

    2.	From the Go To menu on the Navigation Toolbar, select System Configuration → Platform Configuration → System Properties. 

    3.	On the System Properties window, search for the system property that you want to modify. 

    To search, open the Filter and type the property name (LUCENEOBJINDEX) in the filter field in the Property Name column. Then, press Enter. 

    4.	Click View Details next to the property name to display the Global Properties Details section of the window. 

    5.	Enter the new setting in the Global Value field: 

     –	For the LWDICT property, enter the full directory path (drive and directory) of the new location for the IBM LanguageWare® Dictionary files. 

     –	For the LUCENEOBJINDEX property, enter the full directory path of the new location for the Lucene index files. 

     –	For the ATTEXT property, enter the file types to be supported by attachment searches as a comma-separated list. For example, enter .properties, .txt, .html. 

     

    
      
        	
          Tip on file types: If you specify file types other than text-based files, the files are indexed but not searched. The attachment search works only on text files. Non-text file types, such as audio and video files, .ppt files, and .xls files, are not supported.

        
      

    

     –	For the PmObjSearchCron.maxFileLength property, enter the maximum size of attached text files that you want to be indexed. If this property is not set, only files less than or equal to 1 MB in size are indexed. 

     –	For the mxe.doclink.maxfilesize property, set the maximum size of files that a user can attach to a record. 

    6.	From the Select Action menu on the application toolbar, select Live Refresh.

    7.	Click OK on the Live Refresh dialog.

    The new property value is displayed in both the Global Value and Current Value fields. The new property setting is now in effect. Repeat this procedure to change more property values. 

    After the change to LUCENEOBJINDEX, WebSphere Application Server must be restarted to clean the cache and the new path to take effect. But perform the next step first.

    8.	Click Go To → System Configuration → Platform Configuration → Cron Task Setup. Search for PmObjSearchCron cron task and make sure that it is active.

     

    

    1 Read this important technote for more details: http://www.ibm.com/support/docview.wss?uid=swg21589561
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SmartCloud Control Desk Reports

    This appendix provides a list of the main reports available for SmartCloud Control Desk 7.5 in Table 13-3.

    Table 13-3   List of reports

    
      
        	
          Name

        
        	
          Report File Name

        
        	
          Description

        
        	
          Parameters

        
        	
          Application

        
      

      
        	
          adHoc_solutions_tsd.rptdesign

        
        	
          Incidents and Problems with Informal Solutions

        
        	
          As a Knowledge Manager, I want to see which Incidents and Problems have been associated with informal solutions (i.e. solutions published within the ticket text only) so that I can judge whether these solutions might need to be more formally published in the Solutions application and possibly shared to a wider community.

        
        	
          Start Date

          End Date

          [Date Range for when Incident/Problem was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SOLUTION

        
      

      
        	
          asset_autoflagci_list.rptdesign

        
        	
          Assets with Missing Generic CIs

        
        	
          As a Configuration Librarian or CI Owner, I want to determine if any of my Assets, which should have CIs automatically created and linked, are NOT linked to a CI.

        
        	
          none

        
        	
          ASSET

        
      

      
        	
          asset_ci_linked_list.rptdesign

        
        	
          Assets Linked to CIs

        
        	
          As a Configuration Librarian or Asset/CI Owner, I want to see which Assets are linked to which CIs, when they were linked, who linked them, and why they were linked.

        
        	
          Assets linked on or after (date), 

          Assets linked on or before (date)

        
        	
          ASSET

        
      

      
        	
          asset_generic_ci_list.rptdesign

        
        	
          Assets Linked to Generic CIs

        
        	
          As a Configuration Librarian or Asset/CI Owner, I want to see which Assets are linked to CIs which are classified as “generic”. These CIs might have been automatically created and might need additional configuration.

        
        	
          Assets linked on or after (date), 

          Assets linked on or before (date)

        
        	
          ASSET

        
      

      
        	
          assetpurchcost.rptdesign

        
        	
          Asset Purchase Cost Rollup

        
        	
          As an Asset Manager, I want to see the purchase price for each child asset in an asset subassembly. I also want to see a total price of all combined child assets for each asset.

        
        	
          none

        
        	
          ASSET

        
      

      
        	
          avg_close_time_tsd.rptdesign

        
        	
          Average Time to Close Incidents (Problem, Service Request)

        
        	
          As a Ticket Manager, I want to track the average amount of labor time spent on closing tickets so that I can gauge effectiveness. Tickets are grouped by internal priority.

        
        	
          Start Date

          End Date

          [Date Range for when ticket was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

          Service

          Service Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          avg_cost_tsd.rptdesign

        
        	
          Average Cost Per Incident (Problem, Service Request)

        
        	
          As a Ticket Manager, I want to track the average labor cost on tickets so that I can gauge effectiveness. Tickets can be in any status to be included in this report, and the status can be specified. Tickets are grouped by internal priority.

        
        	
          Start Date

          End Date

          [Date Range for when ticket was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

          Service

          Service Group

          Status

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          ci_asset_linked_list.rptdesign

        
        	
          CIs Linked to Assets

        
        	
          As a Configuration Librarian or Asset/CI Owner, I want to see which CIs are linked to which Assets, when they were linked, who linked them, and why they were linked.

        
        	
          CIs linked on or after (date), 

          CIs linked on or before (date)

        
        	
          CI

        
      

      
        	
          ci_autoflagasset_list.rptdesign

        
        	
          CIs with Missing Generic Assets

        
        	
          As a Configuration Librarian or Asset/CI Owner, I want to determine if any of my CIs, which should have Assets automatically created and linked, are NOT linked to an Asset.

        
        	
          none

        
        	
          CI

        
      

      
        	
          ci_generic_asset_list.rptdesign

        
        	
          CIs Linked to Generic Assets

        
        	
          As a Configuration Librarian or Asset/CI Owner, I want to see which CIs are linked to Assets which are classified as “generic”. These Assets might have been automatically created and might need additional configuration.

        
        	
          CIs linked on or after (date), 

          CIs linked on or before (date)

        
        	
          CI

        
      

      
        	
          computercounts.rptdesign

        
        	
          Computer Counts by Role

        
        	
          As an Asset Manager, I want to see the count of computers by role.

        
        	
          none

        
        	
          DPLDASSET

        
      

      
        	
          cpuaudit.rptdesign

        
        	
          Processor Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total license capacity for specific products, the total discovered capacity (the Sums of Number of Processors multiplied by Core Multiplier Value), and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          cpucoreaudit.rptdesign

        
        	
          Processor Core Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total license capacity for specific products, the total discovered capacity (the Sums of Number of Cores Processors multiplied by Core Multiplier Value), and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          deleted_actualci.rptdesign

        
        	
          Deleted actual CIs

        
        	
          As a Configuration Auditor, Configuration Librarian, or CI Owner, I want to see which actual CIs have been deleted. A date range for when the deletion occurred can be specified. A specific actual CI or source token can be specified.

        
        	
          Start Date, 

          End Date, 

          actual CI Name, 

          actual CI Number, 

          GUID or Source Token

        
        	
          ACTUALCI

        
      

      
        	
          deleted_ci.rptdesign

        
        	
          CIs Linked to Deleted actual CIs

        
        	
          As a Configuration Auditor or Configuration Librarian, I want to see the authorized CIs that are associated actual CIs that have been deleted.

        
        	
          Start Date,

          End Date,

          Configuration Item

        
        	
          CI

        
      

      
        	
          dormant_cis.rptdesign

        
        	
          Dormant CIs

        
        	
          As a Configuration Auditor or Configuration Librarian, I want to see which CIs have not been recently refreshed with actual CI data so that I can determine if there is out of date information.

        
        	
          Actual Configuration Item Last Modified Date is Before, 

          Minimum number of Days Since the Actual Configuration Item Was Modified* (Default 30)

        
        	
          CI

        
      

      
        	
          elapsed_time_to_close_problems_tsd.rptdesign

        
        	
          Elapsed Time for Unresolved Problems

        
        	
          As a Problem Manager, I want to see the amount of time that unresolved problems have been open so that I can determine if there are any fulfillment concerns.

        
        	
          Start Date

          End Date

          [Date Range for when problems were reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          flagged_actualci.rptdesign

        
        	
          Actual CIs Flagged for Deletion

        
        	
          As a Configuration Librarian or CI Owner, I want to see which actual CIs have been flagged for deletion. These are CIs that have been deleted from TADDM, but I have not executed the automated escalation to delete them. 

        
        	
          Actual CI Number, 

          GUID or Source Token

        
        	
          ACTUALCI

        
      

      
        	
          formal_solutions_tsd.rptdesign

        
        	
          Incidents and Problems with Formal Solutions

        
        	
          As a Knowledge Manager, I want to see which Incidents and Problems have been associated with formal solutions (i.e. solutions published in the Solutions application) so that I can judge whether fulfillment teams are documenting and publishing re-usable knowledge.

        
        	
          Start Date

          End Date

          [Date Range for when Incident/Problem was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SOLUTION

        
      

      
        	
          inc_sla_compliance_noncompliance_tsd.rptdesign

        
        	
          SLA Compliance for Incident Management

        
        	
          As an Incident Manager, I want to identify which Incidents are in and out of compliance with SLAs. I can see a pie chart of internal priority % for both cases and a list of Incidents based on the date range and subgroup criteria. 

        
        	
          SubGroup By (defaults to ticketid, used in list)

          Start Date (of target)

          End Date (of target)

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          INCIDENT

        
      

      
        	
          inc_survey_tsd.rptdesign

        
        	
          Incident Survey

        
        	
          As an Incident Manager, I want to review the results of the Standard Incident Survey in the specified date range so that I can gauge customer satisfaction. This report can also serve as an example for creating custom survey reports.

        
        	
          Start Date

          End Date

          [Date Range for when results were received]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          INCIDENT

        
      

      
        	
          incident_disposition_tsd.rptdesign

        
        	
          Disposition Report for Incident Management

        
        	
          As an Incident Manager, I want to see what Incidents have spawned other work items (such as other ticket types or work orders).

        
        	
          Start Date

          End Date

          [Date Range for when Incident was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          INCIDENT

        
      

      
        	
          incident_volume_tsd.rptdesign

        
        	
          Volume Report for Incidents

        
        	
          As an Incident Manager, I want to see the Incidents in the date range grouped by the criteria I specify so that I can analyze the Incident activity.

        
        	
          Group By (default to Internalpriority)

          SubGroup By (default to ticketid)

          [Valid values for group and subgroup: Status, Owner, Internalpriority, Reportedpriority]

          Start Date

          End Date

          [Date Range for when Incident was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          INCIDENT

        
      

      
        	
          installaudit.rptdesign

        
        	
          Install Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total license capacity for specific products, the total discovered capacity for computers where the software is installed and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          installedswcounts.rptdesign

        
        	
          Installed Software Counts by Application

        
        	
          As a Software Asset Manager, I want to see the count of distinct software installations by application.

        
        	
          Manufacturer,

          Managed As

        
        	
          DPLDASSET

        
      

      
        	
          IT_active_change_status.rptdesign

        
        	
          Active IT Changes Grouped by Status

        
        	
          As a Change Manager, I want to see the changes that have not been closed, completed, or cancelled. A date range can be optionally provided.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          IT_change_avg_complete_by_type.rptdesign

        
        	
          Average Days to Complete IT Changes Grouped by Type

        
        	
          As a Change Manager, I want to see the average time (in days) it takes my fulfillment team to complete changes in each classification grouping. A date range encompassing the actual start and finish dates can be optionally provided. Note that if changes are not classified, they will not be included in this report.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          IT_change_by _classification.rptdesign

        
        	
          IT Changes Grouped by Classification

        
        	
          As a Change Manager, I want to see a list and pie chart of all changes grouped by classification type so that I can see if a particular class of changes needs more attention. A date range encompassing the actual start and finish dates can be optionally provided.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          IT_change_by_priority.rptdesign

        
        	
          Percentage of IT Changes by Priority

        
        	
          As a Change Manager, I want to see a list and pie chart of all changes grouped by priority. A date range encompassing the actual start and finish dates can be optionally provided.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          IT_change_CI.rptdesign

        
        	
          IT Changes for Configuration Items

        
        	
          As a Change/Configuration Manager, I want to graphically see the number of Changes for each CI so that I can roughly gauge the operating cost in terms of Changes. Four optional input parameters are provided to narrow the report scope.

        
        	
          Change Actual Start Time, Change Actual End Time,

          CI Name, 

          CI Classification

        
        	
          CHANGE

        
      

      
        	
          IT_change_CI_detail.rptdesign

        
        	
          IT Changes Associated with Each CI Detail

        
        	
          As a Change/Configuration Manager, I want to see a list of the Changes for each CI so that I can analyze my ongoing operating costs in detail. Four optional input parameters are provided to narrow the report scope. 

        
        	
          Change Actual Start Time,

          Change Actual End Time, 

          CI Name, 

          CI Classification

        
        	
          CHANGE

        
      

      
        	
          IT_change_final_state_status.rptdesign

        
        	
          Percentage of IT Changes in Final State Grouped by Status

        
        	
          As a Change Manager, I want to see a list and pie chart of the changes that are in a Complete, Closed, or Canceled state. A date range for the actual finish dates can be optionally provided. A change owner can be optionally provided.

        
        	
          Start Date,

          End Date,

          Owner 

        
        	
          CHANGE

        
      

      
        	
          IT_change_impacted_CI.rptdesign

        
        	
          IT Changes Impacting Configuration Items

        
        	
          As a Change Manager, I want to see a list of CIs that are impacted by changes so that I can analyze if these changes have an adverse impact on my business.

        
        	
          Start Date,

          End Date,

          Configuration Item

        
        	
          CHANGE

        
      

      
        	
          IT_change_impl_task_group_by_owner.rptdesign

        
        	
          Scheduled Implementation Tasks Grouped by Owner

        
        	
          As a Change Manager, I want to see a list of change workorders (implementation tasks) that are pending completion and have them grouped by owner. A date range for the scheduled start and end dates can be optionally provided. A change owner can be optionally provided.

        
        	
          Scheduled Start Date,

          Scheduled End Date,

          Owner 

        
        	
          CHANGE

        
      

      
        	
          IT_change_impl_task_group_by_ownergroup.rptdesign

        
        	
          Scheduled Implementation Tasks Grouped by Owner Group

        
        	
          As a Change Manager, I want to see a list of change workorders (implementation tasks) that are pending completion and have them grouped by owner group. A date range for the scheduled start and end dates can be optionally provided. A change owner group can be optionally provided.

        
        	
          Scheduled Start Date,

          Scheduled End Date,

          Owner Group

        
        	
          CHANGE

        
      

      
        	
          IT_change_impl_task_group_by_supervisor.rptdesign

        
        	
          Scheduled Implementation Tasks Grouped by Supervisor

        
        	
          As a Change Manager, I want to see a list of change workorders (implementation tasks) that are pending completion and have them grouped by supervisor. A date range for the scheduled start and end dates can be optionally provided. A change supervisor can be optionally provided.

        
        	
          Scheduled Start Date,

          Scheduled End Date,

          Supervisor

        
        	
          CHANGE

        
      

      
        	
          IT_change_prior_CI_outage.rptdesign

        
        	
          Configuration Item Outages Caused by Prior Change Implementation Tasks

        
        	
          As a Change Manager, I want to see a list of CIs that had an outage due to a previous change workorder. One reason I might want to run this report is so that I can determine if I am potentially in danger of going over an SLA for uptime when I schedule changes for a specific CI.

        
        	
          Actual Start Date,

          Actual End Date,

          Configuration Item

        
        	
          CHANGE

        
      

      
        	
          IT_change_process_request.rptdesign

        
        	
          Change Process Requests in New State by Age

        
        	
          As a Change Manager, I want to see the list of change process requests in a New state and the number of days since they were created. Optionally, a number of days can be given which will restrict the list to change process requests that have been open at least that number of days.

        
        	
          Number of Days (defaults to 0)

        
        	
          CHANGE

        
      

      
        	
          IT_change_scheduled_CI_outage.rptdesign

        
        	
          Configuration Item Outages Caused by Scheduled Change Implementation Tasks

        
        	
          As a Change Manager, I want to see a list of CIs that will have an outage due to a scheduled change workorder. I might want to run this report to determine if I will potentially go over an SLA for uptime.

        
        	
          Scheduled Start Date,

          Scheduled End Date,

          Configuration Item

        
        	
          CHANGE

        
      

      
        	
          IT_change_target_CI.rptdesign

        
        	
          IT Changes Targeting Configuration Items

        
        	
          As a Change Manager, I want a list of the changes that are affecting CIs. Optionally I can restrict the list to changes scheduled within a start and end date. I can also restrict the list to specific CIs.

        
        	
          Start Date,

          End Date,

          Configuration Item

        
        	
          CHANGE

        
      

      
        	
          IT_change_window_conflict.rptdesign

        
        	
          Implementation Tasks with Change Window Conflicts

        
        	
          As a Change Manager, I want to see a list of changes which have been marked as having a change window conflict. Optionally I can restrict the list to changes scheduled within a start and end date

        
        	
          Task Start Date,

          Task End Date

        
        	
          CHANGE

        
      

      
        	
          IT_forwardsched_releases.rptdesign

        
        	
          Forward Schedule of IT Releases

        
        	
          As a Release Manager, I want to see a list of releases ordered by scheduled start and end dates. Date range, owner(s), and owner group(s) can be specified.

        
        	
          Owner,

          Owner Group,

          Start Date,

          End Date

        
        	
          RELEASE

        
      

      
        	
          IT_forwardsched_releasesByCIs.rptdesign

        
        	
          Forward Schedule of Releases by CIs

        
        	
          As a Release Manager, I want to see a list of releases grouped by CI and ordered by scheduled start and end dates. Date range and CIs can be specified.

        
        	
          Configuration Item,

          Start Date,

          End Date

        
        	
          RELEASE

        
      

      
        	
          IT_process_request_final_states.rptdesign

        
        	
          IT Change Process Requests in Final States

        
        	
          As a Change Manager, I want to see a pie chart showing the percentage of resolved and closed change process requests by process state.

        
        	
          Start Date,

          End Date,

          Owner 

        
        	
          CHANGE

        
      

      
        	
          IT_releasesByClassifications.rptdesign

        
        	
          Releases by Classification

        
        	
          As a Release Manager, I want to see a list and pie chart of releases within specific date ranges grouped by classification. Scheduled date ranges and actual date ranges can be specified. Specific CIs can also be specified.

        
        	
          Classification Id,

          Scheduled Start: From,

          To,

          Scheduled End: From,

          To,

          Actual Start: From,

          To,

          Actual End: From,

          To

        
        	
          RELEASE

        
      

      
        	
          IT_releasesByPriorities.rptdesign

        
        	
          Releases by Priority

        
        	
          As a Release Manager, I want to see a list and pie chart of releases within specific date ranges grouped by priority. Scheduled date ranges and actual date ranges can be specified. Priority can also be specified.

        
        	
          Priority,

          Scheduled Start: From,

          To,

          Scheduled End: From,

          To,

          Actual Start: From,

          To,

          Actual End: From,

          To

        
        	
          RELEASE

        
      

      
        	
          IT_releasesByProcessStates.rptdesign

        
        	
          Releases by Process Status

        
        	
          As a Release Manager, I want to see a list and pie chart of releases within specific date ranges grouped by process status. Scheduled date ranges and actual date ranges can be specified. Process status can also be specified.

        
        	
          Status,

          Scheduled Start: From,

          To,

          Scheduled End: From,

          To,

          Actual Start: From,

          To,

          Actual End: From,

          To

        
        	
          RELEASE

        
      

      
        	
          IT_releasesByProgress.rptdesign

        
        	
          Releases by Progress

        
        	
          As a Release Manager, I want to see a list and pie chart of releases within specific date ranges grouped by progress states. Scheduled date ranges and actual date ranges can be specified. Progress states can also be specified.

        
        	
          Progress,

          Scheduled Start: From,

          To,

          Scheduled End: From,

          To,

          Actual Start: From,

          To,

          Actual End: From,

          To

        
        	
          RELEASE

        
      

      
        	
          IT_releasesByTypes.rptdesign

        
        	
          Releases by Type

        
        	
          As a Release Manager, I want to see a list and pie chart of releases within specific date ranges grouped by type. Scheduled date ranges and actual date ranges can be specified. Release type can also be specified.

        
        	
          Type,

          Scheduled Start: From,

          To,

          Scheduled End: From,

          To,

          Actual Start: From,

          To,

          Actual End: From,

          To

        
        	
          RELEASE

        
      

      
        	
          IT_schedule_conflict.rptdesign

        
        	
          IT Changes with Schedule Conflicts

        
        	
          As a Change Manager, I want to see the change work orders which have been identified as having schedule conflicts.

        
        	
          Scheduled Start Date,

          Scheduled End Date,

          Owner,

          Owner Group

        
        	
          CHANGE

        
      

      
        	
          itclasscounts.rptdesign

        
        	
          IT Asset Counts by Classification

        
        	
          As an Asset Manager, I want to see the summarized count of all IT assets by classification and broken down by their location and status.

        
        	
          none

        
        	
          ASSET

        
      

      
        	
          licensedetails.rptdesign

        
        	
          License Details

        
        	
          As a Software Asset Manager, I want to list the details of each License details with info such as Licensed Products, Capacity, and Capacity Unit.

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          mainframevuaudit.rptdesign

        
        	
          Mainframe Value Unit Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total license capacity for specific products, the total discovered capacity (the Sums of Value Units of the computers where the software is installed, which is calculated by multiplying the MSUs with the Value Unit Exhibit Table based on the product licensed), and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          mlcflataudit.rptdesign

        
        	
          MLC Flat Based Audit

          (MLC = Monthly License Charge)

        
        	
          As a Software Compliance Auditor, I want to run the MLC (Monthly License Charge) based License audit report which displays the total license capacity for specific products, the total discovered capacity (the Sums of MSUs of the computers where the software is installed, irrespective of the VMs), and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          msuaudit.rptdesign

        
        	
          MSU Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total license capacity for specific products, the total discovered capacity (the Sums of MSUs of the computers where the software is installed), and the variance (the total license capacity minus total discovered capacity). (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          open_tickets_cust_tsd.rptdesign

        
        	
          Open Ticket Detail (Customer)

        
        	
          As a Ticket Manager, I want to review open tickets grouped by customer. This report is similar to the “Open Ticket Detail” report with the addition of customer fields.

        
        	
          Customer

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          orderreceipt.rptdesign

        
        	
          Partial Orders

        
        	
          As an Asset Manager, I want to run a report which displays items that have been in the Ordered status for more than the specified number of days

        
        	
          Days Approved

        
        	
          PO

        
      

      
        	
          pmcfg_ci_list.rptdesign

        
        	
          CI List

        
        	
          As a Configuration Auditor or Configuration Librarian, I want to see a list of all my authorized CIs. This list is grouped by classification.

        
        	
          none

        
        	
          CI

        
      

      
        	
          pmcfg_rcncirslt_detail.rptdesign

        
        	
          CI Reconciliation Result Details

        
        	
          As a Configuration Manager, I want to see the details behind a specific reconciliation result so that I can understand why the data copy between an actual and authorized CI succeeded or failed.

        
        	
          none

        
        	
          RCNCIRSLT

        
      

      
        	
          pmcfg_rcncirslt_list_byci.rptdesign

        
        	
          CI Reconciliation Results by CI

        
        	
          As a Configuration Manager, I want to see a list of all the reconciliation results grouped by CIs so that I can determine if there were any issues copying data between actual and authorized CIs.

        
        	
          none

        
        	
          RCNCIRSLT

        
      

      
        	
          pmcfg_rcncirslt_list_byrule.rptdesign

        
        	
          CI Reconciliation Results by Rule

        
        	
          As a Configuration Manager, I want to see a list of all the reconciliation results grouped by reconciliation rules so that I can determine if there were any issues that might indicate I have an invalid reconciliation rule.

        
        	
          none

        
        	
          RCNCIRSLT

        
      

      
        	
          pmcfglc_lifecycles.rptdesign

        
        	
          CI Lifecycles

        
        	
          As a Configuration Manager, I want to see the CI lifecycle definitions including the states.

        
        	
          none

        
        	
          PMCFGLCAPP

        
      

      
        	
          pmcfgwo_detail.rptdesign

        
        	
          Configuration Process Details

        
        	
          As a Configuration Manager, I want to see the details of specific configuration processes. This report can be accessed through the Configuration Manager application or as a drill-through report from the Configuration Process List report.

        
        	
          none

        
        	
          PMCFGWO

        
      

      
        	
          pmcfgwo_list.rptdesign

        
        	
          Configuration Process List

        
        	
          As a Configuration Manager, I want to see a list of the configuration processes that exist on my system. The list of configuration processes can be filtered through the filter in the Configuration Processes application before running the report.

        
        	
          none

        
        	
          PMCFGWO

        
      

      
        	
          pmcfgwo_list_byclassification.rptdesign

        
        	
          Configuration Processes by Classification

        
        	
          As a Configuration Manager, I want to see a list of the configuration processes grouped by classification. The list of configuration processes can be filtered through the filter in the Configuration Processes application before running the report.

        
        	
          none

        
        	
          PMCFGWO

        
      

      
        	
          pmcfgwo_list_bystatus.rptdesign

        
        	
          Configuration Processes by Status

        
        	
          As a Configuration Manager, I want to see a list of the configuration processes grouped by status. The list of configuration processes can be filtered through the filter in the Configuration Processes application before running the report.

        
        	
          none

        
        	
          PMCFGWO

        
      

      
        	
          pmcomByClassification.rptdesign

        
        	
          Process Request by Classification

        
        	
          As a Process Request Manager, I want to see process requests within a specific date range grouped by classification.

        
        	
          Start Date,

          End Date

        
        	
          PMCOMSR

        
      

      
        	
          pmcomByOwner_chrt.rptdesign

        
        	
          Process Requests by Owner

        
        	
          As a Process Request Manager, I want to see process requests with a certain criteria grouped by owner.

        
        	
          Start Date*,

          End Date*,

          Type*,

          Status*,

          Site*

        
        	
          PMCOMSR

        
      

      
        	
          pmcomByPriority_chrt.rptdesign

        
        	
          Process Requests by Priority

        
        	
          As a Process Request Manager, I want to see process requests with a certain criteria grouped by priority.

        
        	
          Start Date*,

          End Date*,

          Type*,

          Status*,

          Site*

        
        	
          PMCOMSR

        
      

      
        	
          pmcomByStatus_chrt.rptdesign

        
        	
          Process Requests by Status

        
        	
          As a Process Request Manager, I want to see process requests with a certain criteria grouped by status.

        
        	
          Start Date*,

          End Date*,

          Type*,

          Site*

        
        	
          PMCOMSR

        
      

      
        	
          pmcomByType_tbl.rptdesign

        
        	
          Process Requests by Type

        
        	
          As a Process Request Manager, I want to see process requests with a certain criteria grouped by type.

        
        	
          Start Date*,

          End Date*,

          Type*,

          Status*,

          Site*

        
        	
          PMCOMSR

        
      

      
        	
          pmsccr_delivery_sc.rptdesign

        
        	
          Catalog Request Performance

        
        	
          As a Service Execution Manager, I want to review the amount of time it has taken to close approved catalog requests so that I can determine where we might have service bottlenecks.

        
        	
          none

        
        	
          SR

        
      

      
        	
          pmsccr_details_sc.rptdesign

        
        	
          Catalog Request Details

        
        	
          Appropriate for multiple roles, this report shows details of a specific catalog request, showing its status, associated service request, order date, and requestor.

        
        	
          none

        
        	
          SR, PMSCVIEWCR

        
      

      
        	
          pmsccr_list_sc.rptdesign

        
        	
          Catalog Request List

        
        	
          As a Service Execution Manager, I want to see a list and pie chart of my catalog requests and their status so that I can monitor catalog request fulfillment.

        
        	
          none

        
        	
          SR

        
      

      
        	
          pmsccrwappr5_sc.rptdesign

        
        	
          Catalog Requests Awaiting Approval More Than 5 Days

        
        	
          As a Service Execution Manager, I want to see which catalog requests have been waiting longer than 5 days in approval so that I can determine if there is a service bottleneck.

        
        	
          none

        
        	
          SR

        
      

      
        	
          pointsaudit.rptdesign

        
        	
          Points Based Audit

        
        	
          As a Software Compliance Auditor, I want to compare the total license capacity for the specific product with total discovered capacity, which is the summary count of the computer with the software installed multiplied by the points values specified for each product. (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          pro_inc_gen_known_error_tsd.rptdesign

        
        	
          Incident Generation for Problems with Known Errors

        
        	
          As a Problem or Incident Manager, I want to identify problems with known errors (i.e. documented solutions) have spawned incidents so that I can determine if there are actions to take (e.g. publish solution to user community) to reduce duplicate incidents or problems. 

        
        	
          Start Date

          End Date

          [Date Range for when problems were reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          pro_inc_gen_unknown_error_tsd.rptdesign

        
        	
          Incident Generation for Problems with Unknown Errors

        
        	
          As a Problem or Incident Manager, I want to identify problems with unknown errors which have spawned incidents so that I can determine if there are actions to take (e.g. document solution) to prevent repeat incidents and problems. 

        
        	
          Start Date

          End Date

          [Date Range for when problems were reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          pro_sla_compliance_noncompliance_tsd.rptdesign

        
        	
          SLA Compliance for Problem Management

        
        	
          As a Problem Manager, I want to identify which Problems are in and out of compliance with SLAs. I can see a pie chart of internal priority % for both cases and a list of Problems based on the date range and subgroup criteria. 

        
        	
          SubGroup By (defaults to ticketid, used in list)

          Start Date (of target)

          End Date (of target)

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          pro_survey_tsd.rptdesign

        
        	
          Problem Survey

        
        	
          As a Problem Manager, I want to review the results of the Standard Problem Survey in the specified date range so that I can gauge customer satisfaction. This report can also serve as an example for creating custom survey reports.

        
        	
          Start Date

          End Date

          [Date Range for when results were received]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          problem_disposition_tsd.rptdesign

        
        	
          Disposition Report for Problem Management

        
        	
          As a Problem Manager, I want to see what Problems have spawned other work items (such as other ticket types or work orders).

        
        	
          Start Date

          End Date

          [Date Range for when Problem was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          problem_resolution_tsd.rptdesign

        
        	
          Problem Resolution

        
        	
          As a Problem Manager, I want to review the Problems with known errors (i.e. published solutions) and unknown errors so that I can determine if further actions, such as documenting or publishing solutions, would reduce future problems

        
        	
          Start Date

          End Date

          [Date Range for when Problem was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          problem_volume_tsd.rptdesign

        
        	
          Volume Report for Problem Management

        
        	
          As a Problem Manager, I want to see the Problems in the date range grouped by the criteria I specify so that I can analyze the Problem activity.

        
        	
          Group By (default to Internalpriority)

          SubGroup By (default to ticketid)

          [Valid values for group and subgroup: Status, Owner, Internalpriority, Reportedpriority]

          Start Date

          End Date

          [Date Range for when Problem was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          PROBLEM

        
      

      
        	
          pvuaudit.rptdesign

        
        	
          PVU Based Audit

        
        	
          As a Software Compliance Auditor, I want to run the license audit report which displays the total Full-Capacity Processor Value Unit (PVU) license capacity for specific products, the total discovered PVUs for the computers where the software is installed and the variance. (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          pvusubaudit.rptdesign

        
        	
          PVU Sub Capacity Based Audit

        
        	
          As a Software Compliance Auditor, I want to see the total Sub-Capacity Processor Value Unit (PVU) license capacity for specific products, the total discovered PVUs for the computers where the software is installed and the variance. (See More Info tab)

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          servoffsr_details_sc.rptdesign

        
        	
          Offering Details

        
        	
          Appropriate for multiple roles, this report provides details of a specific service catalog offering.

        
        	
          none

        
        	
          PMSCOFFER

        
      

      
        	
          servoffsr_frequency_sc.rptdesign

        
        	
          Offerings Order Frequency

        
        	
          As a Service Level Manager, I want to see the how many times each catalog offering has been ordered so that I can understand what services are in demand and determine if changes are needed.

        
        	
          Enter the itemnum of the offering

        
        	
          PMSCOFFER

        
      

      
        	
          servoffsr_list_sc.rptdesign

        
        	
          Offerings List

        
        	
          As a Service Level Manager, I want to see a complete list of all catalog offerings and their current status.

        
        	
          none

        
        	
          PMSCOFFER

        
      

      
        	
          servoffsr_notordered_sc.rptdesign

        
        	
          Offerings Not Ordered

        
        	
          As a Service Level Manager, I want to review which catalog offerings have not been ordered in a particular date range so that I can determine if an offering needs to be redesigned or reconsidered.

        
        	
          Start Date

          End Date

        
        	
          PMSCOFFER

        
      

      
        	
          solution_change_history_tsd.rptdesign

        
        	
          Solution Change History

        
        	
          As a Knowledge Manager, I want to track the creation and changes made to published solutions. Note that this report requires auditing be turned on for the Solutions object in the Database Administration application.

        
        	
          Start Date

          End Date

          [Date Range for when Solution was changed]

          [Date range can be open ended or blank]

        
        	
          SOLUTION

        
      

      
        	
          sr_disposition_tsd.rptdesign

        
        	
          Disposition Report for SR Management

        
        	
          As a Service Request Manager, I want to see what SRs have spawned other work items (such as other ticket types or work orders).

        
        	
          Start Date

          End Date

          [Date Range for when Service Request was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SR

        
      

      
        	
          sr_from_catalog_sc.rptdesign

        
        	
          Service Requests Created By Catalog Orders

        
        	
          As a Service Level Manager, I want to see what SRs have been created by Service Catalog offerings so that I can analyze the effectiveness of my catalog portfolio.

        
        	
          none

        
        	
          SR

        
      

      
        	
          sr_sla_compliance_noncompliance_tsd.rptdesign

        
        	
          SLA Compliance for Service Request Management

        
        	
          As a Service Request Manager, I want to identify which SRs are in and out of compliance with SLAs. I can see a pie chart of internal priority % for both cases and a list of SRs based on the date range and subgroup criteria. 

        
        	
          SubGroup By (defaults to ticketid, used in list)

          Start Date (of target)

          End Date (of target)

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SR

        
      

      
        	
          sr_survey_tsd.rptdesign

        
        	
          SR Survey

        
        	
          As a Service Request Manager, I want to review the results of the Standard Service Request Survey in the specified date range so that I can gauge customer satisfaction. This report can also serve as an example for creating custom survey reports.

        
        	
          Start Date

          End Date

          [Date Range for when results were received]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SR

        
      

      
        	
          sr_volume_tsd.rptdesign

        
        	
          Volume Report for Service Request Management

        
        	
          As a Service Request Manager, I want to see the SRs in the date range grouped by the criteria I specify so that I can analyze the SR activity.

        
        	
          Group By (default to Internalpriority)

          SubGroup By (default to ticketid)

          [Valid values for group and subgroup: Status, Owner, Internalpriority, Reportedpriority]

          Start Date

          End Date

          [Date Range for when SR was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          SR

        
      

      
        	
          survey_volume_tsd.rptdesign

        
        	
          Surveys Sent and Received

        
        	
          As a Ticket Manager, I want to see the number of surveys that have been sent out for SRs, Incidents, or Problems, and the number of receipts so that I can determine if we are getting an accurate gauge on customer satisfaction.

        
        	
          Application (default to Incident)

          [Valid values are SR, Incident, or Problem]

        
        	
          SR

        
      

      
        	
          swvendlic.rptdesign

        
        	
          Software Products by Vendor and License

        
        	
          As a Software Asset Manager, I want to see the licenses associated with each vendor and the software products associated with each license.

        
        	
          none

        
        	
          TLOAMLIC

        
      

      
        	
          ticket_ci.rptdesign

        
        	
          IT Tickets (Incidents, Problems, SR) for Configuration Items

        
        	
          As a Ticket Manager, I want to graphically see the number of tickets (SRs, Incidents, Problems) created against each CI so that I can assess CI operating costs in terms of tickets. Four optional input parameters are provided to narrow the report scope.

        
        	
          Ticket Actual Start Time,

          Ticket Actual End Time,

          CI name,

          CI Classification

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          ticket_ci_detail.rptdesign

        
        	
          IT Tickets Associated with CI Details

        
        	
          As a Ticket Manager, I want to see a list of tickets (SRs, Incidents, Problems) that have been created against each CI so that I can analyze the issues affecting specific CIs. Four optional input parameters are provided to narrow the report scope. 

        
        	
          Ticket Actual Start Time,

          Ticket Actual End Time,

          CI name,

          CI Classification

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          ticket_cust_tsd.rptdesign

        
        	
          Incident (Problem, Service Request) List (Customer)

        
        	
          As a Ticket Manager, I want to see a list of all my tickets grouped by customer and status. This report is similar to the “Incident (Problem, Service Request) List” report with the addition of customer fields.

        
        	
          none

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tloamdpaswdetails.rptdesign

        
        	
          Deployed Software Details

        
        	
          As a Software Asset Manager, I want to list the details of each Software Inventory Records with info such as Install Products, Install Path, Install date, Uninstall date, and manufacturer name

        
        	
          none

        
        	
          TLOAMDPASW

        
      

      
        	
          tlsm_1stLevelResolution.rptdesign

        
        	
          Requests Resolved at 1st Contact

        
        	
          As a Customer Satisfaction Manager, I want a list of the number of tickets by group that were resolved on initial contact and the percentage of the total for that group across a date range

        
        	
          Start Date,

          End Date,

          Owner Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Aging_Report_Summary.rptdesign

        
        	
          Aging Report Summary (Age Breakout Report)

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want a list of the number of open tickets grouped by age (0, 1-2, 3-4, etc), and detail provided for each ticket grouped by ownergroup.

        
        	
          Owner Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_amt_changes_implemented_wo_approval.rptdesign

        
        	
          Percentage of Changes that are Complete or Closed and not Approved

        
        	
          As a Change Manager, I want to compare the % of changes implemented with and without approval across a date range

        
        	
          Owner Group,

          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_Change_Detail.rptdesign

        
        	
          Change Detail

        
        	
          As a Change Implementer, I want to list detailed information about a change and all associated records. 

        
        	
          Work Order Number* (Change number)

        
        	
          CHANGE

        
      

      
        	
          tlsm_Change_Schedule_Meeting.rptdesign

        
        	
          Change Schedule Meeting

        
        	
          As a Change Assessor, I want to list summary and detail data for all open approved changes by scheduled start date across a date range.

        
        	
          Site,

          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_Changes_Approved.rptdesign

        
        	
          Status of Approved Changes

        
        	
          As a Change Manager, I want to know the number of approved changes by status and detailed information for each change across a date range.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_Changes_by_change_category.rptdesign

        
        	
          Changes by Change Category

        
        	
          As a Change Assessor, I want to see the % of changes per category, the number of changes per category for each status, and detailed information of changes by ownergroup across a date range.

        
        	
          Owner Group,

          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_changes_by_failure_probability.rptdesign

        
        	
          Changes by Failure Probability

        
        	
          As a Risk Analyst, I want to know the number of changes per failure probability, the category of changes per probability failure, and a list by ownergroup of changes across a date range.

        
        	
          Owner Group,

          Start Date,

          End Date,

          Date Field Selection

          [Date Field Selection determines which date field to consider in the date range:

          1 = Report Date (default)

          2 = Scheduled Start Date

          3 = Scheduled Finish Date]

        
        	
          CHANGE

        
      

      
        	
          tlsm_Changes_By_Status_Value.rptdesign

        
        	
          Changes by Status Value

        
        	
          As a Change Manager, I want to see the number of changes per status and detailed information for each change across a date range.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_Classifications.rptdesign

        
        	
          Classification and Descriptions

        
        	
          As an Incident/Problem/Request Fulfillment Analyst, I want a list of classifications available for the ticket type.

        
        	
          none

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Daily-morning-tickets.rptdesign

        
        	
          Daily Morning Tickets

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want a summary and detailed list of all open tickets 

        
        	
          none

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_ElapsedTimeForUnresolvedTickets.rptdesign

        
        	
          Amount of time in days incidents (problems, service requests) have been unresolved

        
        	
          As a Customer Satisfaction Manager, I want a summary of open tickets by number of days open per month across a date range.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_IMAC_Changes_By_OwnerGroup.rptdesign

        
        	
          List of IMAC changes by ownergroup

        
        	
          As an Asset Analyst, I want a list of changes with an IMAC classification by ownergroup across a date range.

        
        	
          Owner Group,

          Start Date,

          End Date,

          Date Selection (1-3)

          [Date Selection determines which date field to consider in the date range:

          1 = Report Date (default)

          2 = Scheduled Start Date

          3 = Scheduled Finish Date]

        
        	
          CHANGE

        
      

      
        	
          tlsm_Manage_Top_Tickets.rptdesign

        
        	
          Manage Top Tickets

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to determine the most common ticket classifications for each month across a date range.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_MinimizeLifeCycleForTicket.rptdesign

        
        	
          Amount of time for groups to close finished incidents (problems, service requests)

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to find the average time spent to close tickets after work has completed, sorted by internal priority to identify which groups are closing tickets in a timely manner.

        
        	
          Start Date,

          End Date,

          Owner Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Monthly_OOC_Expanded_Summary.rptdesign

        
        	
          Monthly Out Of Criteria Expanded Summary

        
        	
          As a Compliance Manager, I want to list the total and Percentage of each month's tickets that were out of criteria.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_MonthlyOOCMeasurement.rptdesign

        
        	
          Monthly Out of Criteria - Incident (Problem, Service Request)

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to list detailed information for tickets that are out of criteria by ownergroup.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_OOC.rptdesign

        
        	
          Monthly OOC Measurement

        
        	
          As a Compliance Manager, I want a list of the number and percentage of OOC tickets by Reported Date, Actual Finish, or Closed Date and Owner Group.

        
        	
          Date Type,

          Start Date,

          End Date

          [Date Type determines which date field to consider in the date range:

          1 = Report Date (default)

          2 = Scheduled Start Date

          3 = Scheduled Finish Date]

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_PastDue_Open_Changes.rptdesign

        
        	
          Past Due Open Changes

        
        	
          As a Compliance Auditor, I want to know how many changes were past due compared to the total for open changes per month across a date range.

        
        	
          Start Date,

          End Date,

          Filter By

          [Filter By determines which date field to consider in the date range:

          1 = Report Date (default)

          2 = Scheduled Start Date

          3 = Scheduled Finish Date]

        
        	
          CHANGE

        
      

      
        	
          tlsm_Percentage_of_Endorsed_Changes.rptdesign

        
        	
          Percentage of Endorsed Changes

        
        	
          As a Compliance Analyst, I want a list of changes with work orders or tasks that have been deleted.

        
        	
          Start Date,

          End Date

        
        	
          CHANGE

        
      

      
        	
          tlsm_Percentage_Priority_ticket.rptdesign

        
        	
          Percentage of Priority Tickets not fixed within the specified time period.

        
        	
          As a Compliance Manager, I want to list the number and percentage of closed tickets by priority that were not fixed by the specified date across a date range.

        
        	
          Start Date*,

          End Date*,

          Filter By*,

          Owner Group

          [Filter By determines which date field to consider in the date range:

          1 = Actual Finish

          2 = Report Date]

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_ticket_by_internalpriority.rptdesign

        
        	
          Incident (Problem, Service Request) Summary By Internal Priority

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to know the number of tickets by priority.

        
        	
          Start Date,

          End Date,

          Owner Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Ticket_by_Ownergroup.rptdesign

        
        	
          Ticket by Ownergroup

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to know the total number of tickets that were not late for each ownergroup followed by the count for each month across a date range.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_ticket_InternalPriority_1and2.rptdesign

        
        	
          Severity 1 and 2 for Incident (Problem, Service Request)

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want to know the percentage of sev 1 and 2 tickets per group, and the number of open, closed, and resolved tickets across a date range.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Ticket_Queue_Hopping.rptdesign

        
        	
          Ticket Queue Hopping

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want a count per month and list of tickets that have been reassigned more than 5 times across a date range

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Ticket_Timeframe.rptdesign

        
        	
          Tickets Against Timeframe

        
        	
          As an Incident/Problem/Request Fulfillment Manager, I want a chart of the number of tickets by priority that were “in criteria”, a summary of the count and percentage in and not in criteria, and list of the tickets including ID, description, actualfinish, targetfinish, reportdate, and status.

        
        	
          Start Date,

          End Date, 

          Owner Group

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_Total_Number_of_Tickets.rptdesign

        
        	
          Total number of incidents (problems, service requests) by internal priority

        
        	
          As a Ticket Manager, I want to see the total number of tickets in a specific date range sorted by internal priority.

        
        	
          Start Date,

          End Date

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          tlsm_WorkgroupID.rptdesign

        
        	
          Workgroup ID

        
        	
          As a Change Manager, I want a list of persons or owners of existing changes by persongroup.

        
        	
          none

        
        	
          CHANGE

        
      

      
        	
          totals_tsd.rptdesign

        
        	
          Total Number of Incidents (Problems, Service Requests) 

        
        	
          As a Ticket Manager, I want to review all my tickets in a specific date range sorted by status.

        
        	
          Start Date

          End Date

          [Date Range for when ticket was reported]

          [No End Date defaults to today's date; No Start Date defaults to 30 days before End Date]

        
        	
          INCIDENT, PROBLEM, SR

        
      

      
        	
          warrantyassetsdue.rptdesign

        
        	
          Warranty Assets Due

        
        	
          As an Asset Manager, I want to see a list of assets associated with maintenance contracts that are scheduled to end.

        
        	
          Days Forward

        
        	
          CONTWARRTY
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Examining the Actual CI adapter

    This appendix takes a closer look into the SmartCloud Control Desk Tivoli Application Dependency Discovery Manager Actual CI Adapter and provides more information than what is available in the InfoCenter.

    This appendix is targeted towards an audience that is already familiar with the Tivoli Application Dependency Discovery Manager Actual CI Adapter. 

    This appendix includes the following sections:

    •Supported properties within the ccmdb.properties file

    •How Tivoli Integration Composer determines which CIs to process

    •How Tivoli Integration Composer creates and then deletes the Actual CI relationships

    •How Tivoli Integration Composer marks Actual CIs for deletion

    •How Tivoli Integration Composer supports a partial execution

    Supported properties within the ccmdb.properties file

    The Tivoli Application Dependency Discovery Manager Actual CI Adapter reads the Integration_Composer/data/properties/provider/ccmdb.properties file to modify its default behavior. This section examines these in more detail and explains their use. Some of these properties might not be in the version of your property file because they were provided to help work around specific situations. If a property was not available in Tivoli Integration Composer 7.5.0, the release it was first made available is listed in the description.

    •ccmdb.itic.status.frequency=<default value: 500>

    Tivoli Integration Composer can be configured to print incremental status messages to help determine how long the Actual CI mapping execution takes to complete. The output status message includes the total number of top-level CIs to be processed, and how many of these CIs have been processed so far. You can determine the completion percentage from this information.

    The message also includes the total number of Actual CIs processed so far and the number of Actual CIs processed during that frequency interval. You can use this to determine the average number of CIs processed per top level Actual CI. Also, because the status message contains a time stamp, you can calculate the average amount of time Tivoli Integration Composer spends to process each CI. 

    The value of this property represents the number of top-level CIs for the Tivoli Application Dependency Discovery Manager Adapter to process before printing a status message. The default value is 500 top-level CIs. 

    If this property value is set to 0, no status messages are printed. If this property is deleted or commented out, or the value is set to null, the default value of 500 top level Actual CIs is used. 

    The numbers printed by the status message represent the Actual CIs processed from Tivoli Application Dependency Discovery Manager, whereas the Tivoli Integration Composer summary outputs the number of records that are inserted, updated, or deleted from the target database tables. These numbers might not match. 

    This property was available before 7.5.0. 

    •ccmdb.enable.actualci.deletion=<true|false>

    The deletion property is used to indicate whether Tivoli Integration Composer flags Actual CIs for deletion when the CI no longer exists in Tivoli Application Dependency Discovery Manager. This processing occurs before Tivoli Integration Composer's normal mapping execution. If this property does not exist, the default behavior is not to do delete processing. 

    This property was available before 7.5.0.

    •ccmdb.itic.num.of.delete.time.partitions=<numeric value>

    This optional property was made available to work around situations where Tivoli Integration Composer delete processing failed with a Tivoli Application Dependency Discovery Manager timeout exception while reading the change history data. The value is used to divide the number of days between now and the last time Tivoli Integration Composer successfully completed the deletion processing. For example, if the last time Tivoli Integration Composer marked Actual CIs for deletion was 2 months ago and the partition is set to 4, the duration that is used to search for deleted Tivoli Application Dependency Discovery Manager CIs is 15 days. 

    This property was made available with Tivoli Integration Composer 7.5.0.1 and later.

    •ccmdb.delete.class.<SHORT.CLASSNAME=1>

    This optional property was made available to work around situations where Tivoli Integration Composer delete processing cannot complete successfully because of Tivoli Application Dependency Discovery Manager timeout exceptions while reading the change history data. There can be multiple properties starting with prefix ccmdb.delete.class that contain a classification name. When one or more of these properties are set the Tivoli Integration Composer, the delete process only searches for deleted Tivoli Application Dependency Discovery Manager CIs of the classification types listed. This is used if Tivoli Integration Composer successfully processed most classifications for deletion, but failed for a few classifications. You can then use this to force only the failed classifications to reprocess while also using the num.of.delete.time.partitions property to make the Tivoli Application Dependency Discovery Manager search duration shorter. 

    This property was made available with Tivoli Integration Composer 7.5.0.1 and later.

    •ccmdb.actualci.filtering.level=<0|2>

    This is a required property, and must be set for Tivoli Integration Composer to process the Actual CI mapping. There is no default setting for this property so if it does not exist, Tivoli Integration Composer will exit. If Tivoli Integration Composer 7.5.0 is a fresh installation, this property value is set to 2. If Tivoli Integration Composer 7.5.0 was installed as an upgrade, this property value is initially set to 0 so processing resembles the old Tivoli Integration Composer version. 

    A value of 0 causes Tivoli Integration Composer to search for properties in this file starting with ccmdb.classification.depth. Actual CIs are NOT imported for those classifications set to “-1”. It is valid for this property to be set to 0 with no classifications set to be filtered out. 

    The default value of 2 causes Tivoli Integration Composer to import only Actual CIs and attributes found in the promotion scopes. If multiple promotion scopes exist, Tivoli Integration Composer uses the superset. It is not valid for this property to be set to 2 if no promotion scope exists. 

    This property was made available with Tivoli Integration Composer 7.5.0 and later.

    •ccmdb.classification.depth.xxx.xxxx=<numeric value>

    This optional property can be used as a way to filter out Actual CIs of a specific type by setting a value to “-1”. 

    While Tivoli Integration Composer is processing a top-level CI to the max depth, when it reaches a related CI of a type that is set to be skipped, it stops processing that branch. This means that CIs related to the skipped classification type are also not imported. 

    This property can also be used to override the default depth setting that is set with the property ccmdb.classification.default.depth.

    For example, if you normally only needed to import at a depth of 2, but for Application CI types you required a depth of 3, you can use this property to achieve that. 

    Note that since 7.5.0.1 HF 2, a subclass is processed at the super class's depth unless the subclass is specifically set to a different depth. Therefore, if Application was set to depth 3, the subclass of VApp is also processed at depth 3. 

    If Tivoli Integration Composer 7.5.0 was a fresh install, the ccmdb.properties file contains a default list of classifications set to -1 so they are not imported. If Tivoli Integration Composer 7.5.0 was installed as an upgrade, the filtering is identical to that of the older version of Tivoli Integration Composer.

    Generally, filter out the following classifications: 

    ccmdb.classification.depth.APP.CONFIGFILE=-1

    ccmdb.classification.depth.APP.DB.DB2.DB2DATABASECONFIGVALUE=-1

    ccmdb.classification.depth.APP.DB.DB2.DB2INSTANCECONFIGVALUE=-1

    ccmdb.classification.depth.APP.DB.DB2.DB2SYSTEMCONFIGVALUE=-1

    ccmdb.classification.depth.APP.PROCESSPOOL=-1

    ccmdb.classification.depth.CORE.LOGICALCONTENT=-1

    ccmdb.classification.depth.DEV.DISKDRIVE=-1

    ccmdb.classification.depth.DEV.DISKPARTITION=-1

    ccmdb.classification.depth.DEV.MEDIAACCESSDEVICE=-1

    ccmdb.classification.depth.DEV.STORAGEVOLUME=-1

    ccmdb.classification.depth.SYS.AIXSOFTWARECOMPONENT=-1

    ccmdb.classification.depth.SYS.DATAFILE=-1

    ccmdb.classification.depth.SYS.SOFTWARECOMPONENT=-1

    ccmdb.classification.depth.SYS.WINDOWS.WINDOWSSERVICE =-1

    ccmdb.classification.depth.SYS.ZOS.ZREPORTFILE=-1

    This property was available before 7.5.0. 

    •ccmdb.classification.default.depth=<default value: 3>

    This property is used as the depth for all active top-level classifications unless overridden by the ccmdb.classificaiton.depth property. If this property is missing, a default depth of 3 is used. It is invalid to set this property to a negative number. 

    This property was available before 7.5.0.

    •ccmdb.taddm.exclude.filter=0

    By default, Tivoli Integration Composer queries Tivoli Application Dependency Discovery Manager to determine whether it supports the excluding clause. If supported, Tivoli Integration Composer uses this as part of the query to retrieve top-level CI data when filtering out any of the default classifications. Tivoli Application Dependency Discovery Manager versions 7.2.1 and later support this option. 

    The following query is used to determine whether Tivoli Application Dependency Discovery Manager supports the excluding clause:

    "select * excluding preferences from UserPreference"

    Using the Tivoli Application Dependency Discovery Manager excluding clause helps performance because the excluded classifications are excluded by Tivoli Application Dependency Discovery Manager rather than by Tivoli Integration Composer. 

    This property was available before 7.5.0.

    •ccmdb.taddm.locationtag.filter=<format example: CustomerTag1|CustomerTag2>

    This optional property only works with Tivoli Application Dependency Discovery Manager release 7.2.1.1 and higher. It can be used to filter the imported CIs based on the Tivoli Application Dependency Discovery Manager LocationTag attribute value. With the example above, only CIs where the top-level CI is owned by either CustomerTag1 or CustomerTag2 are imported. This processing assumes that any related CI to the imported top-level CI is also valid for these LocationTag values. 

    This property was made available with Tivoli Integration Composer 7.5.0 and later.

    •ccmdb.enable.explicit.relationships=<true|false>

    This property is used to import explicit relationships from Tivoli Application Dependency Discovery Manager. Extra Tivoli Application Dependency Discovery Manager API calls are required to import these relationships, which affects Tivoli Integration Composer performance. The default setting is false. If set to true, the following relationships are imported:

    core.Dependency

    app.dependencies.IpDependency

    app.dependencies.ServiceDependency

    app.dependencies.SystemDependency

    app.dependencies.TransactionalDependency

    dev.BasedOnExtent

    dev.RealizesExtent

    These relationships are imported based on the Actual CIs processed. If Actual CI abc is processed, Tivoli Integration Composer searches where abc is either the source or target of an explicit relationship. 

    This property was available before 7.5.0.

    •ccmdb.explicit.relationship.DEV.REALIZESEXTENT=1

    This optional property is used to modify the default explicit relationship list. If the property ccmdb.enable.explicit.relationships equals true, the seven explicit relationships are imported unless this property is also found. If this property is used, the default list is ignored and only explicit relationship with the prefix ccmdb.explicit.relationship. are imported. Therefore, if you just wanted to add one explicit to the list, you must have a property for the original seven plus the new one: 

    ccmdb.explicit.relationship.APP.DEPENDENCIES.APPLICATIONTOAPPLICATIONDEPENDENCY

    ccmdb.explicit.relationship.CORE.DEPENDENCY 

    ccmdb.explicit.relationship.APP.DEPENDENCIES.IPDEPENDENCY

    This property was available before 7.5.0.

    •ccmdb.itic.num.of.threads=<thread count:cached CI data i.e. 5:20>

    By default, Tivoli Integration Composer uses multiple threads to retrieve the top-level CI data from Tivoli Application Dependency Discovery Manager. This optional property can be used to specify the maximum number of threads to be created and how much CI data can be cached at a time.

    A warning message is logged if this property is used and the NO_CACHE_LOAD option is not part of the following lines in the fusion.properties file:

    mxe.fusion.referencecache.Actual_Target_CI=1000,Guid,ALTERNATE_KEY,NO_CACHE_LOAD

    mxe.fusion.referencecache.Actual_CI=1000,Guid,ALTERNATE_KEY,NO_CACHE_LOAD

    If the NO_CACHE_LOAD option is used and this property is not set, the default number of threads is 10 for 64-bit operating systems, and 5 for 32-bit operating systems. The default number of cached top-level CI data is 50 for 64 bit, and 25 for 32 bit. 

    The system property os.arch is used to make this determination. Because this is not always consistent, a 64-bit system might get thread setting for a 32-bit system. If that happens, this property can be used to correct the setting. 

    This property was made available with Tivoli Integration Composer 7.5.0 and later.

    •ccmdb.itic.thread.max.wait.time=<milliseconds i.e. 600000>

    This optional property controls how long Tivoli Integration Composer waits for Tivoli Application Dependency Discovery Manager to return data to the thread. The data that the Tivoli Integration Composer is waiting for are from the executeQuery API asking for a top-level CI for a specific depth. The default value is 600000 milliseconds (10 minutes). If this time is reached and Tivoli Application Dependency Discovery Manager has not returned data, Tivoli Integration Composer stops all processing. Ten minutes is the default for Tivoli Integration Composer 7.5.0.1, but the default was just 1 minute in Tivoli Integration Composer 7.5.0 making it more likely that you need this property.

    This property was made available with Tivoli Integration Composer 7.5.0 and later.

    •ccmdb.enable.skip.unavailable=<true|false>

    This optional property can be used to stop Tivoli Integration Composer from creating Actual CIs with an ACTCINUM value of UNAVAILABLE. If set to true and Tivoli Integration Composer processes a Tivoli Application Dependency Discovery Manager CI containing no value for the Label or DisplayName attribute, a warning message is logged and Tivoli Integration Composer skips that CI until a Label or DisplayName value is available. 

    A message is posted containing the GUID name of the CIs that were skipped.

    The Tivoli Integration Composer Summary contains an extra line to post the number skipped:

    Number of skipped Tivoli Application Dependency Discovery Manager CIs: 2

    After it is set, the ACTCINUM is never modified. However, the ACTCINAME is modified to reflect the value of the CI's Label or DisplayName attribute. The ACTCINAME is usually what is displayed on the SmartCloud Control Desk console, but many users prefer to skip CIs discovered at level 1 until they are discovered at a higher level so that they contain more data. 

    This property was made available in Tivoli Integration Composer 7.5.0.1 Hot Fix 2.

    •ccmdb.enable.depth.for.non.top.level.classes=<true|false>

    This optional property causes Tivoli Integration Composer to follow relationships for ACTIVE non-top level classifications. 

    Normally Tivoli Integration Composer does NOT process relationships for ACTIVE non-top level classifications. This property modifies that behavior. All ACTIVE classifications are traversed to the depth specified. 

    There are few cases where this property is required. In most situations, start importing from a top-level class and allow the non-top-level CI classes to be imported based on their relationship with a top-level class. With this property set to true, if you activate a non-top level classification that is related to an ACTIVE top-level classification, you cause Tivoli Integration Composer to process Actual CIs multiple times. This in turn degrades performance. Use this property with caution. 

    How Tivoli Integration Composer determines which CIs to process

    After the initial load, Tivoli Integration Composer will want to just process Tivoli Application Dependency Discovery Manager CIs that have changed for the ACTIVE classifications. The fsnlastscan SmartCloud Control Desk database table is used to determine whether Tivoli Integration Composer does a full or partial load. If there are no records in the fsnlastscan table for the mapping name being run, all Tivoli Application Dependency Discovery Manager CIs are processed for those activated classifications. 

    If you want to force Tivoli Integration Composer to reimport all CIs for the active classifications, clear the fnslastscan table for the mapping name you are using. This can be done by using the Tivoli Integration Composer console with the Delete Mapping Last Scan History option, as shown in Figure C-1 on page 767, or by using the following SQL:

    delete from maximo.fsnlastscan where mappingname='mymappingname' 
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    Figure C-1   Selecting Delete Mapping Last Scan History

    If you just want Tivoli Integration Composer to reprocess one GUID, remove it from the fsnlastscan table using the following SQL command:

    delete from maximo.fsnlastscan where mappingname='mymappingname' and sourceid='myguidId'

    Conversely, if you create a new mapping and do NOT want Tivoli Integration Composer to process all CIs from Tivoli Application Dependency Discovery Manager, use SQL to rename the old mapping name to the new mapping name so Tivoli Integration Composer continues to process where it left off: 

    update maximo.fsnlastscan set mappingname='newmappingname' where mappingname='oldmappingname'

    Although this is helpful to know, there can be good reasons to have Tivoli Integration Composer reprocess all the Actual CIs. For instance, if you have upgraded Tivoli Integration Composer to a major release, there might be updates that must be applied to all Actual CIs. 

    If there is even just one GUID listed in the fsnlastscan table for the mapping name being run, Tivoli Integration Composer checks for updated Tivoli Application Dependency Discovery Manager CIs to process instead of processing all Tivoli Application Dependency Discovery Manager CIs. This is done in two steps:

    1.	For the active classifications, the Tivoli Application Dependency Discovery Manager LastModifiedTime is compared to the LastScanDT column in the ACTCI database table. Actual CIs that have a LastScanDT time stamp older than the Tivoli Application Dependency Discovery Manager LastModifiedTime are considered updated candidates. 

    Tivoli Application Dependency Discovery Manager CIs with no matching Actual CI are considered new and are imported.

    2.	The Tivoli Application Dependency Discovery Manager LastModifiedTime represents the last time the CI was discovered, not the time stamp it was actually modified. Because the CI could have been discovered but nothing changed, Tivoli Integration Composer uses the Tivoli Application Dependency Discovery Manager change history table to validate that updates did take place. 

    As you can see, the Tivoli Application Dependency Discovery Manager's change history table plays an important role in this delta processing. If you deleted all entries in the change history table, Tivoli Integration Composer does not consider any existing Actual CIs as updated and only processes new CIs. If the change history table is configured to track every minor update, Tivoli Integration Composer considers every fresh discovery as having updated CIs, which causes more processing than necessary. If the change history table contains six years of updates, it will be slow to query for recent changes and affect Tivoli Integration Composer performance. 

    You can configure what Tivoli Application Dependency Discovery Manager stores as updates in the change history table with the file:

    <taddm install directory>/dist/ect/changeserver.xml 

    This file already contains good examples on the syntax that is required to configure Tivoli Application Dependency Discovery Manager to ignore tracking updates to specific attributes, classes, and packages. It is worth your time to review it. 

    When retrieving the Tivoli Application Dependency Discovery Manager GUIDs for the ACTIVE classifications, Tivoli Integration Composer obtains GUIDs for all subclasses. For example, if AppServer is activated, Tivoli Integration Composer can be expected to process ApacheServers, WebServers, CICSRegions, DominoServers, and so on. The filter setting affects which Actual CIs are imported. 

    For classification filtering (ccmdb.actualci.filtering.level=0), if a non-active classification that is set to -1 is a subclass of an active classification, the subclass Tivoli Application Dependency Discovery Manager CIs are ignored and not imported.

    For the authorized promotion scope filtering (filtering level = 2), the Tivoli Application Dependency Discovery Manager CIs imported must be part of a promotion scope. Furthermore, when using the Promotion Scope filtering, it is important to understand that Tivoli Integration Composer only updates existing Actual CIs if they are linked to an Authorized CI. 

    An example might help clarify this:

    1.	Tivoli Integration Composer is used for the first time to import Tivoli Application Dependency Discovery Manager CI data as Actual CIs into the SmartCloud Control Desk database using Auth Scope filtering. 

    2.	Tivoli Integration Composer is run a second time to import new Tivoli Application Dependency Discovery Manager CI data and to update existing Actual CIs to match modified Tivoli Application Dependency Discovery Manager CIs:

    a.	If a CI exists in Tivoli Application Dependency Discovery Manager but not the SmartCloud Control Desk database, it is imported.

    b.	If a CI was modified in Tivoli Application Dependency Discovery Manager and both an Actual CI and an Authorized CI exist, the Actual CI is updated to reflect the data found in Tivoli Application Dependency Discovery Manager. 

    c.	If a CI was modified in Tivoli Application Dependency Discovery Manager and only an Actual CI exists, the Actual CI is NOT updated. The reasoning here is that because the Actual CI was not promoted into an Authorized CI, it is not being managed. Therefore, there is no need to keep the Actual CI up-to-date until it is promoted to an Authorized CI. 

    After establishing the initial list of GUIDs to process, Tivoli Integration Composer uses the depth setting to import the Tivoli Application Dependency Discovery Manager CIs that are related to the top-level CIs. Define the depth setting within the ccmdb.properties file. The default depth is only used if no other depth applies to the active classification. A subclass obtains its parent depth unless explicitly overridden. Tivoli Integration Composer logs which classifications and depths are processed so you can review this in the fusion.log. 

    The following two DEBUG properties provide more details of Actual CI processing:

    log4j.logger.fusion.provider.cmdbapi=DEBUG

    log4j.logger.fusion.provider.taddmactualci=DEBUG

    How Tivoli Integration Composer creates and then deletes the Actual CI relationships

    Tivoli Integration Composer retrieves data from Tivoli Application Dependency Discovery Manager for a top-level GUID to a specific depth. Tivoli Integration Composer traverses through the ModelObject data, first for the primitive attributes (which are stored in the ACTCISPEC table), and then for attributes that represent a relationship.

    If the target classification is to be filtered out, the relationship is ignored and the next relationship is processed. 

    Otherwise, the RELATIONRULES table is consulted to see whether there is a rule that matches the source classification, relationship name, and target classification. If there is no rule, the reverse is searched: Target classification, relationship name, and source classification. If a reverse rule is found, the source and target CIs are swapped to match the rule when they are stored in the ACTCIRELATION table. The ACTCIRELATION.SWAPPED column is set to 1 if the relationship was modified from the order found in Tivoli Application Dependency Discovery Manager. 

    If a rule was not found, the relationship is added as is to the ACTCIRELATION table.

    After the relationship is saved, the target ModelObject data is traversed so that the target Actual CI and its attributes are created. If the maximum depth has not been reached, the target's relationships are pursued. 

    This process is repeated for all relationships until the depth setting is reached. 

    The top level Actual CI processing starts at depth one. This means that you import Actual CI data at the depth specified, but process relationships for the depth minus one. 

    For example, if you had a depth setting of two for computer systems, you get the computer system CIs imported, the relationships for the computer system are followed, and those target CIs are also imported. However, the target CIs' relationships are not followed because depth two is reached when processing the computer system relationship targets. 

    ComputerSystem → OperatingSystem represents depth two. CIs related to the operating system are not created. 

    Tivoli Integration Composer deletes relationships only if both the source and target CI were processed. Otherwise, Tivoli Integration Composer cannot tell if the relationship that exists in the database was there by following a different path and therefore is still valid. For example, if a relationship exists between an application server and a computer system in the database, if Tivoli Integration Composer only processes the computer system, there is no link to the application server. But Tivoli Integration Composer should not delete that relationship unless the application server was also processed and there still was no relationship found between the two CIs. 

    This behavior allows the use of smaller depth settings to still reach the same overall depth. For example, If you needed a depth of 3 for computer system data but your Tivoli Application Dependency Discovery Manager topology looked like Business Application → Functional Group → AppServer → ComputerSystem, to have three levels for computer system, you need a depth of 6 when starting from the Business Application.

    Instead, if you activated Application and set depth to 3, Tivoli Integration Composer reaches AppServer. You also must activate AppServer to at least a depth of 2 to pick up the relationship to ComputerSystem. ComputerSystem must be active and set to depth 3 to pick up the additional data you wanted to manage. 

    Trying to determine what classifications to set to ACTIVE for what depth can be difficult. If you have a Tivoli Application Dependency Discovery Manager GUID for the topology, and Tivoli Integration Composer will be importing CIs, you can use the Tivoli Application Dependency Discovery Manager command line API interface to extract the type of data Tivoli Integration Composer will see. 

    The Tivoli Application Dependency Discovery Manager api.sh and api.bat are at the <taddm install directory>/dist/sdk/bin location.

    ./api.sh –u <userid > –p <password> find –depth 4 –guid “A9A6F80AD02D3845BB924D7CFD26615C”

    For this example, the simplified output is shown in Example C-1.

    Example C-1   api.sh output

    [image: ]

    <Application array="1" guid="A9A6F80AD02D3845BB924D7CFD26615C"

    lastModified="1350562340943"

    xsi:type="coll:com.collation.platform.model.topology.app.Application">

    	<groups array="1" guid="284F0186EFD13A45A45B41E2C951C11D"

    	lastModified="1348955766545"

    	xsi:type="coll:com.collation.platform.model.topology.app.AppServerFunct

    	ionalGroup">

    		<members array="1" guid="C308DC3407EE347B8A47A7D32D434F22"

    		lastModified="1350072328679"

    		xsi:type="coll:com.collation.platform.model.topology.app.web.apache.Apa

    		cheServer">

    			<host guid="335F9D19025A3364A5C31FE92D93C92B"

    			lastModified="1350247649374"

    			xsi:type="coll:com.collation.platform.model.topology.sys.linux.LinuxUni

    			taryComputerSystem">

    			<type>ComputerSystem</type>

    [image: ]

    You can tell by the xml indentation the four depths found:

    Application → FunctionalGroup → AppServer → ComputerSystem

    How Tivoli Integration Composer marks Actual CIs for deletion

    Tivoli Integration Composer does not directly delete Actual CIs, but you can configure it to mark Actual CIs for deletion by setting the following ccmdb.properties entry to true:

    ccmdb.enable.actualci.deletion=true

    When this property is set to true, Tivoli Integration Composer checks for deleted Tivoli Application Dependency Discovery Manager CIs before looking for new and updated CIs. The MAXVARS table contains the time stamp that is used as the start criteria when searching for deleted CIs: 

    select varvalue from maxvars where varname='CCIITICDELETETS'

    This value is in milliseconds. You can use a date to millisecond calculator to help convert this value to a date/time format, but make sure that it is 13 digits if you modify it.

    If the CCIITICDELETETS value is null, Tivoli Integration Composer uses a start time stamp two months before the current date and time. 

    Tivoli Integration Composer runs the Tivoli Application Dependency Discovery Manager getChangedClasses API to identify all Tivoli Application Dependency Discovery Manager classifications that have deleted CIs since the start date defined by the MAXVARS CCIITICDELETETS value.

    For the classifications that exist in the ACTCI table and contain Tivoli Application Dependency Discovery Manager deleted CIs, the Tivoli Application Dependency Discovery Manager findChangesForDeltaSyncing API is run. This API returns a list of GUIDs that were deleted since the start date.

    The Tivoli Application Dependency Discovery Manager GUIDs that were deleted (and not rediscovered) are added as entries to the SmartCloud Control Desk database table CCIDELETEDACTCI. 

    The CCIDELETEACTCI escalation is created to delete the Actual CIs found in the CCIDELETEDACTCI table.

    If you want to see what will be deleted before deletion, deactivate the escalation through the Escalations application, which can be started under the Platform Configuration as shown in Figure C-2. 

    [image: ]

    Figure C-2   Activating the Escalations application

    To deactivate the escalation, clear the Active check box as shown in Figure C-3. Otherwise, the default is to run every 5 minutes looking for Actual CIs to delete, which is depicted in the Schedule field.

    [image: ]

    Figure C-3   Configuring the Escalations application

    When the Tivoli Integration Composer delete process completes successfully, it updates the MAXVARS table setting VARVALUE to YES where the VARNAME = CCIITICCOMPLETE.

    The escalation does not run unless CCIITICCOMPLETE is set to YES and it is in the Active state. 

    Troubleshooting hints for delete processing

    The following entry in the Integration_Composer/data/properties/logging.properties file logs the details of the delete processing. Use it if errors occur. 

    log4j.logger.fusion.provider.taddmactualci=DEBUG

    If the Tivoli Integration Composer delete processing hangs, receives an exception that the connection timed out, or receives an out of memory exception, it is usually because too much data is being requested from the Tivoli Application Dependency Discovery Manager change history table. 

    1.	Determine whether the search time frame is reasonable and not for a larger duration than necessary:

    select varvalue from maximo.maxvars where varname='CCIITICDELETETS'

    Remember that this value is in milliseconds. If you decide to modify this value, ensure that it is a 13-digit number. If you use an epoch converter, you will have 10 digits. Add three zeros to the right of that number or use a millisecond converter instead. 

    2.	If the time stamp is valid but for a large interval, you can partition the time stamp so that Tivoli Integration Composer does multiple searches against the change history table. Use the ccmdb.itic.num.of.delete.time.partitions= property to divide the time frame days into partitions. For example, if the time duration is for a year, you might want to use a partition value of 12 so that Tivoli Integration Composer requests one month worth of data at a time. 

    When the Tivoli Integration Composer delete process fails for one classification, it continues to look for deleted CIs for other classifications. However, the search time in the MAXVARS table is not updated. This means that the next time Tivoli Integration Composer runs, it unnecessarily reprocess those classifications that were successfully processed for deleted CIs already. If you have a long search duration, this process might take several extra hours. If you know which classifications failed, it saves you time to use the ccmdb.delete.class.<SHORT.CLASSNAME=1> property: 

    ccmdb.delete.class.NET.L2INTERFACE=1

    ccmdb.delete.class.SYS.WINDOWS.WINDOWSSERVICE=1

    This causes Tivoli Integration Composer to only look for deleted Actual CIs within those two classifications.

    You must have at least Tivoli Integration Composer 7.5.0.1 to use this property.

    How Tivoli Integration Composer supports a partial execution

    Tivoli Integration Composer can be configured to process a list of GUIDs read from a file rather than going to Tivoli Application Dependency Discovery Manager to determine which Actual CIs have changed. The GUIDs must still be of a classification that is set to ACTIVE. 

    The Tivoli Integration Composer Actual CI Adapter reads the system property GuidFileForPartialRun. If this property is set, the adapter tries to open the file to read in a list of GUIDs for processing.

    The property should contain the fully qualified file name to read and only one GUID per line. 

    If the property was set and Tivoli Integration Composer cannot open the file, an exception is generated and Tivoli Integration Composer stops processing. If Tivoli Integration Composer successfully reads the file, a message is logged that contains the number of GUIDs read. 

    The easiest way to set this property is to copy the executeMapping.bat or .sh file, and name the new version something that you will remember runs Tivoli Integration Composer in this special way. 

    Modify the two lines that start with “java” to include the -D option: 

    -DGuidFileForPartialRun="C:\Integration Composer\partial.file"

    This way, you run executeMapping for normal Tivoli Integration Composer processing, and this new .bat/.sh for this partial execution.

  
    Related publications

    The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this book.

    IBM Redbooks

    The following IBM Redbooks publications provide additional information about the topic in this document. Note that some publications referenced in this list might be available in softcopy only. 

    •Deployment Guide Series: IBM Tivoli Application Dependency Discovery Manager V7.1, SG24-7616

    •End-to-End Service Management Using IBM Service Management Portfolio, SG24-7677

    •IBM Tivoli Application Dependency Discovery Manager Capabilities and Best Practices, SG24-7519

    •IBM Tivoli Change and Configuration Management, SG24-7879

    •Implementing IBM Tivoli Service Request Manager V7.1 Service Desk, SG24-7579

    •Migration Use Cases with the Migration Manager, SG24-7906-01

    •Tivoli Integration Scenarios, SG24-7878

    You can search for, view, download or order these documents and other Redbooks, Redpapers, Web Docs, draft and additional materials, at the following website: 

    ibm.com/redbooks

    Online resources

    These websites are also relevant as further information sources:

    •All IBM SmartCloud Control Desk product manuals can be found in the online InfoCenter at:

    http://pic.dhe.ibm.com/infocenter/tivihelp/v50r1/index.jsp?topic=%2Fcom.ibm.tusc.doc%2Fic-homepage.html

    Help from IBM

    IBM Support and downloads

    ibm.com/support

    IBM Global Services

    ibm.com/services

  
     

     

    IT Service Management Best Practices: Using IBM SmartCloud Control Desk

     

     

     

  
    IT Service Management Best Practices

    Using IBM SmartCloud Control Desk

    Automation using response plans, scripting, escalations, actions, and workflows

Best practices configuration and customization examples

Implementation of typical real-world use cases

    SmartCloud Control Desk is a comprehensive IT Asset and Service Management solution that helps reduce cost and minimize service disruptions. It does so through automated service request handling, efficient change management, and optimized asset lifecycle management across IT and enterprise domains.

    SmartCloud Control Desk helps to reduce total cost of ownership by using one unified solution to license, install, and manage multiple ITIL processes under one price point. It can also help reduce business risk by using advanced impact analysis and defining automated change procedures that ensure integrity of existing infrastructure while supporting business agility.

    SmartCloud Control Desk improves efficiency and quality of service by unifying asset, change, and problem management. It lowers cost and mitigates license compliance risk by performing end to end software asset management. 

    It also delivers an adaptive, role-based simplified UI that can be more intuitive for novice users, which reduces training costs, while allowing access from anywhere at anytime through mobile device support that includes BlackBerry, iOS, and Android. 

    This IBM Redbooks publication covers IBM SmartCloud Control Desk product configuration, customization, and implementation best practices.

    Back cover

    Acrobat bookmark 
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